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1. Introduction

SpiraTeam® is an integrated Application
Lifecycle Management (ALM) system that
manages your project's requirements, releases,
test cases, issues and tasks in one unified

environment:

SpiraTeam® contains all of the features
provided by SpiraTest® - our highly acclaimed
quality assurance system and SpiraPlan® - our
agile-enabled project management solution.
With integrated customizable dashboards of key
project information, SpiraTeam® allows you to
take control of your entire project lifecycle and
synchronize the hitherto separate worlds of

development and testing.

This user manual outlines the features and
functionality available in SpiraTeam®, and
demonstrates how to use the application for
managing the quality assurance and project

management processes on a typical project.

1.1. Quality Assurance

Quality Assurance is a key component of the
Software Development Life-Cycle (SDLC), which
needs to be integrated into the planning and
management of a program or project from its
inception. Too often though, QA is implemented
as Quality Control - whereby testing that the
required functionality works as expected, is
performed at the end, when it is most costly to

make corrections and changes.

To manage QA across a project from day one, it
is imperative that the original requirements are
documented together with the use-cases that

validate the desired functionality. These use-
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cases then form the basis of the test
scripts that can be executed to validate
that the functionality has been correctly
built, and that the requirements have
been satisfied. During the execution of
these test scripts, failures may occur,
which are recorded as incidents - either
to be fixed or documented depending on

the severity.

Typically, these activities require people
to use at least three different types of

software:
> Requirements Management
» Test Script Management
> Defect/ Issue / Bug Tracking

However, this stove-piped approach has
many limitations and drawbacks, most
importantly the fact that there is no
traceability between the different
artifacts. How can the project manager
know that all the requirements have
been tested? Conversely, how can the
developer know which test script was

responsible for a recorded bug —
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needed to accurately reproduce the issue?

1.2. Project Management

As described in the Agile Manifesto, traditional
waterfall software methodologies and lifecycles
have failed to delivery projects on-time and on-
budget. In addition, many systems built this way
will fail to provide the expected business value
as there is no ability to quickly refine the

requirements as the project progresses.

Consequently software development has been
transformed with these new ideas and concepts,
with new methodologies such as Extreme
Programming (XP), Scrum, Kanban, DSDM and
AUP becoming common. However the traditional
tools of project management - requirements
specifications, high level project plans, GANTT
charts, white-board schedules and top-down
task management - are too cumbersome and

not well suited.

SpiraTeam® provides a complete Agile Project
Management System in one package, that can

manages your project's requirements, releases,
iterations, tasks and issues in one environment,

fully synchronized.
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2. Functionality Overview

This section outlines the functionality provided by SpiraTeam® in the areas of requirements management,
test case management, release planning, iteration planning, incident tracking, task management and

project / user management.

Please note, that SpiraTeam® is designed for use on a very wide range of devices from desktops, to
tablets, to smartphones. This guide is written using desktop conventions (e.g. using ‘click’ throughout
where ‘tap’ would apply on mobile devices) but the functionality remains very similar throughout the

application across all devices and platforms. See section 14 for more information.

2.1. Requirements Management

SpiraTeam® provides the ability to create, edit and delete project scope / requirements in a hierarchical
organization that resembles a typical scope matrix. Each requirement is associated with a particular
importance level (ranging from critical to low) and a status identifier that designates where the
requirement is in the development lifecycle (requested, planned, in-progress and completed). The
requirements can be organized according to which part of the system they relate to (called the
Component) as well as being organized into different types (features, qualities, use cases, etc.). Certain

types (such as use cases) also allow you to define the scenario steps that help describe requirement.

In addition, each requirement is mapped to one or more test cases that can be used to validate that the
functionality works as expected. This mapping is called the “Requirement Test Coverage”, since the test
cases “cover” the requirement so that if all the tests can be executed successfully, then the requirement is

validated.

At the same time, from a development perspective, the team begins initial estimation of the lowest-level
requirements in the requirements matrix to determine the complexity and associated resourcing. Once the
high-level release schedule has been determined, the requirements can then be prioritized and scheduled

against the appropriate release according to their business priority.

Once the release is underway, the requirements are further decomposed into their constituent low-level
project tasks that can be assigned to the project team. The system will track the progress and revised
estimates for the tasks and display them against the requirements so that risks to the schedule can be

quickly determined.

2.2. Test Case Management

SpiraTeam® provides the ability to create, edit and delete project test cases that are stored in a
hierarchical folder structure that resembles Windows Explorer ®. Each test case consists of a set of test

steps that represent the individual actions a user must take to complete the test. These test steps also
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contain a description of the expected result and any sample data elements that the tester should use
when performing the action. When a user executes a test case, the results are stored in a test run that
contains the success/failure status of each test step as well as the actual observed result that the tester

experienced.

In addition each test case is mapped to one or more requirements that the test is effectively validating,
providing the test coverage for the requirement. During the execution of the test case, each failure can be
optionally used to record a new incident, which can then be managed in the incident tracking module (see
below). This provides complete traceability from a recorded incident to the underlying requirement that

was not satisfied.

To streamline the assignment and tracking of multiple test cases, SpiraTeam® allows users to select
groups of test cases and arrange them into test sets. Each test set can contain test cases from a variety

of different folders and can be associated with a specific release of the system being tested.

2.2.1. Test Automation

As well as being able to store and manage manual test cases, SpiraTeam® can be used to manage the
scheduling and execution of automated test scripts for a variety of third-party test automation engines.
This allows you to centrally plan your automated testing and monitor the results of automated unit,
functional and load testing remotely. For example, you could schedule a set of automated functional tests
to run on five different machines (each with a different browser/OS combination) at 2:00 AM and have the

results be ready for the next morning.

2.3. Release Planning

SpiraTeam® provides the ability to track different versions / releases of the application being tested. Each
project in the system can be decomposed into an unlimited humber of specific project releases, denoted
by name and version number. Requirements and Test Cases developed during the design phase can
then be assigned to these different releases. When a tester executes a series of test cases, they are able
to choose the version of the project being tested and the resulting test run information is then associated

with that release.

From a project planning perspective, the releases are the major milestones in the project, which are
further sub-divided into iterations which are separate mini-projects with associated project scope and
tasks. The project’s requirements are scheduled at a high-level against the releases and the detailed

tasks are scheduled against specific iteration within the release.

In addition, all incidents raised during the testing process are associated with this release, allowing the

development team to easily determine which version of the project is affected. Finally as the incidents are
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resolved and verified during the testing phase, the appropriate release can be selected to indicate which

release the incident was resolved and/or verified in.

2.4. Iteration Planning

As described in section 2.3, in addition to high-level project releases, SpiraTeam® can also track the
individual iterations that comprise a release, giving the project manager the option to manage agile
methodology projects within the SpiraTeam® environment. Unlike the release planning stage, where
high-level requirements are estimated and scheduled, the iteration planning phase involves assigning
each of the requirements, incidents and tasks in the project backlog against a specific iteration until the

available effort in the iteration has been completely allocated.

When you first create iterations, you specify the start and end-dates together with the notional number of
project resources assigned to the iteration and any non-working days. SpiraTeam® uses this information
to calculate the planned effort available to the iteration, from which it will subtract the estimated task and

incident effort values to determine how much effort is available to schedule.

2.5. Incident Tracking

SpiraTeam® provides the ability to create, edit, assign, track, manage and close incidents that are raised
during the testing of the software system under development. These incidents can be categorized into
bugs, enhancements, issues, training items, limitations, change requests, and risks, and each type has its
own specific workflow and business rules. Typically each incident is raised initially as a ‘New’ item of type
‘Incident’. Following the review by the project manager and customer, they are changed to one of the
other specific types, given a priority (critical, high, medium or low), and status changed to ‘Open’. Once it

is assigned to a developer for fixing, it is changed to status ‘Assigned’.

The developer now works to correct the incident, after which time its status changes to ‘Fixed’ or ‘Not
Reproducible’ depending on the actions taken (or not taken). Finally the project manager and customer
verify that it has indeed been fixed, and the status is changed to ‘Closed’. SpiraTeam® provides robust
sorting and filtering of all the incidents in the system, as well as the ability to view the incidents associated
with particular test cases and test runs, enabling drill-down from the requirements coverage display, right

through to the open incidents that are affecting the requirement in question.

2.6. Task Management

As described above, in addition to storing the requirements for a project, SpiraTeam® includes the
capability of drilling each lowest-level requirement down further into a series of work items called ‘Tasks’.
These tasks are the discrete activities that each member of the development team would need to carry

out for the requirement to be fulfilled. Each task can be assigned to an individual user as well as
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associated with a particular release or iteration. The system can then be used by the project manager to

track the completion of the different tasks to determine if the project is on schedule.

The tasks can be organized into different folders as well as categorized by different types (development,
testing, infrastructure, etc.), each of which can have its own workflow which defines the process by which

the task changes status during the project lifecycle.

2.7. Projects and Users

SpiraTeam® supports the management of an unlimited number of users and projects, which can be
administered through the same web interface as the rest of the application. All artifacts (requirements,
tests and incidents) are associated with a particular project, and each user of the system can be given a
specific role for the particular project. So, a power user of one software project may be merely an
observer of another. That way, a central set of users can be managed across the enterprise, whilst
devolving project-level administration to the manager of the project. In addition to these administration
functions, each user profile and project has its own personalized dashboard view of all the pertinent and
relevant information. This feature reduces the information overload associated with managing such a rich
source of project information, and allows a single user or project snapshot to be viewable at all times for

rapid decision-making.

2.8. Document Management

SpiraTeam® includes an integrated document management collaboration system that can be used to
upload, manage and share documents between the different members of the project. This module
includes support for uploading files and URLSs, versioning of documents, the ability to organize into folders

and categorize and search using meta-tags.

2.9. Source Code Tracking

SpiraPlan® and SpiraTeam® provide the ability to browse your source code repository from within the
main web application. This is an excellent way for managers and casual users of the project to browse
the files and revisions of the software code without needing to install the version control software on their
own workstations. In addition all users have the ability to link source code revisions with SpiraTeam®
artifacts—providing traceability from requirements, incidents, and tasks to the code changes that were
made to implement the required feature, or fix the identified defect. Should a defect resurface later, you
can view the associated source code revisions to determine which changes were made and did they truly

correct the defect.

2.10. Build Management

SpiraTeam® includes the ability to integrate with a variety of continuous integration / automated build

servers so that the results of automated builds can be displayed in SpiraTeam linked to the associated
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release or iteration. In addition, the results of automated tests and source code operations can be linked
to the build events, providing traceability from a specific build to the bugs that were fixed, tests that were

run and source code files that were modified.

2.11. Instant Messenger

SpiraTeam® comes with a build-in integrated instant messaging capability. This lets users see which
users are currently logged-into the system, maintain a list of contacts and where available, send short
instant messages to other users. Any messages exchanged can then be posted to relevant artifacts in the

system as permanent comments.

2.12. Miscellaneous

2.12.1. Artifact Relationships

The sections above have outlined the different features and functions available in the system, and have
described the various artifacts managed in the system (e.g. projects, users, requirements, tests, etc.). To
aid in understanding how the information is related, the following diagrams illustrates the relationships

between the different artifacts and entities:

User
Role Project
Requirement Release Test Case Test Set Incident

Figure 1: The main entities that comprise a SpiraTest project.
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Requirement

Release

Task

Incident Test Step

Test Coverage Test Case

Test Set fm‘"
Test Mapping Test Run Step

Figure 2: The relationships between the various SpiraTest entities

With these overall concepts in mind, the rest of this help manual will outline the functionality in each of the

SpiraTeam® screens, and provide specific information on how to manage each of the artifacts illustrated

above. Note that this manual does not explain the Administration-level functionality of the system; for that,

please refer to the SpiraTeam® Administration Guide.

2.12.2. Artifact Naming Conventions

On various screens in the system, you will see lists of artifacts (requirements, test cases, etc.) together

with a unique identification number. In order to make it easier to recognize at a glance which type of

artifact the identification number refers to, SpiraTeam® uses a system of two-letter prefixes which help

identify the type of artifact being displayed. The current prefixes used by the system are:

Artifact Prefix Artifact Prefix
Project PR Project Group PG

User us Incident Type IT

Requirement RQ Incident Priority IP

Requirement Step RS Incident Severity v

Test Case TC Workflow WK

Test Step TS Workflow Transition WT
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Test Run

Test Run Step

Incident

Incident Status

Custom List

Document Type

Automation Host

Release/lteration

In addition, certain artifacts in the system are displayed with an icon that helps distinguish them from each

TR

RS

CL

DT

AH

RL

Custom Property Values
Project Role

Task

Test Set

Document

Document Folder

Build

Component

other, and provides additional context on the state of the artifact:

Icon

Artifact Description

RX

TK

X

DC

DF

BL

CP

[l
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Summary Requirement

Detailed Requirement

Use Case Requirement

Use Case Scenario Step

Test Folder

Test Case with Test Steps

Test Case without Test Steps

Test Set

Test Run

Test Step

Linked Test Case

Release
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Iteration / Sprint

* [E

Component
g Task
] Incident
iy Source Code Revision
&2 Project Resource
- Test Automation Host
b Build
m Artifact has an Attachment

3. User/Project Management

This section outlines how you can log into SpiraTeam®, view your personalized home-page that lists the
key tasks that you need to focus on, and drill-down into each of your assigned projects in a single
dashboard view. In addition to your personal homepage, each of your projects has its own dashboard that

depicts the overall project health and status in a single comprehensive view.

3.1. Login Screen

Upon entering the SpiraTeam® URL provided by your system administrator into your browser, you will

see the following login screen:
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spira leam

Please Login

O Keep me logged in

You need to enter your given user-name and password into the system in the appropriate boxes then

click the Log In button to gain access to the application. Normally you only remain logged in to the

application whilst in active use, and you will be asked to log-in again after either closing the browser or 20

minutes of inactivity. To prevent this, and to stay logged-in to SpiraTeam® regardless of browser window

closing or inactivity, select the “Keep me logged in” check-box before clicking the Log In button. Note that

this setting is specific to each individual computer you are logging-in from, and that it will be reset when

you explicitly log-out with the log-out link (described in more detail in section 3.3).

If for any reason you are unable to login with the provided username/password combination, and error

message will be displayed. If you cannot remember the correct log-in information, click on the “Forgot

your password” link and your password will be emailed to the email address currently on file. The reset

password screen is illustrated below:
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Forgot Your Password?

If you don’t have a SpiraTeam® account setup, clicking on the “Register for an account?” link will take you
to a form that you need to fill-in, which will be forwarded to the system administrator, who will need to

approve your account before it is active in the system. This screen is illustrated below:
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In addition, the system will prevent you logging on to the system with the same username at the same
time on multiple computers. This is to avoid the system getting confused by a user trying to make
contradictory actions at the same time. If for any reason you do try and log in to the system when you

already have an active session in progress, you will see the following screen:

Your user account is currently signed into
SpiraTeam in multiple locations.

Youcaneither LogQut |and tryadifferentuser-

name or:

Sign Off The Other Locations eiigsngu=

locations to log-out.

You have two choices: you can either click the “Log Out” link and try logging in as a different user, or if
you want to log-off any other active sessions (e.g. you closed the browser and the session is still listed as

active), simply click the “Sign Off The Other Locations” link, and you will be logged in to the application.

Since SpiraTeam®is licensed to organizations for a specific number of concurrent users — unless they
have purchased an unlimited Enterprise license — only a fixed number of users may be active at the same
time. So, for example if an organization has a five (5) concurrent user license and a sixth user tries to log-

in, they will be presented with the following screen:

You have exceeded the allowed number
of concurrent users.
Alogged in user needs to log-out before
you can proceed.

Change License Details Return to Login page.
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This means that one of the other users who is already logged-in, needs to click the “Log Out” button so
that one of the concurrent licenses is freed for your use. If the user has logged out by closing the browser,
the system may not have detected the logout. In this case, the other user needs to log back in, and then
click the “Log Out” link.

3.2. My Page

Once you have successfully logged in, you will initially be taken to your personalized home page called
“‘My Page”. Please note, that the very first time you log in you will be asked if you want to take a quick

orientation tour of the application (which will look similar to the screenshot below).

x

o+

My Page sy

Publish Date

Project Name

14 hours 22 minutes
ago

Welcome to Spiral b amizor
We want to quickly show you how to get around the application. It will 1 41012017
take less than @ minute and then you can explore on your own p——

Name 1 4l4l2017

No Thanks

Name Project Importance Status Creste Incident in: | - Chogse Projact - o+
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@ % Olibrary Information System v Planning ~  Testing ~  Tracking ~  Reporting Fred Bloges

My Page > Fred / My Timecard / Administration

All Projects Current Project o+

My Poge Fred Bloggs

Project Name Group Creation Date Headline Author Publish Date

webmaster@inflectracom  4/18/2017

Library Inf ion System Internal Projects 30-MNov-2005 Ra

30-Nov-2003

webmaster@inflectracom 4/

30-Mov-2005 webmaster@inflectracom  4/17/

& webmaster@inflectracom 4/10/2017

webmaster@inflectracom  4/7/2017

Name Project
Library Information System Delete "J
Create Incident in: | Library Information Syster ~ | 4
Library Information System Delete "_J
Library Information System Delete B
Library Information System Delete B
Name Department Online  Operations
3 High Priority Late Tasks ary Information System e E -
¥ High Priority Late Tasks Library Information Systerm Delste ) Smith 0A send Message | Remove
25 Mot Executed Test Sets Library Information System Delete B _ Remaove
) -
ol
Project Importance  Status Name Project Type Priority Date Opened
Library Information ISGHEESIN I Progress " multiple Library
X 3 X = L5 S ’ Enhancement  [ISCHBEEIN 16-Nov-2003
Library Information .. |2 =High Planned Information ..
ibrary Information - Hi = Library =
Library Informatior 2= idi Planned E'&L System Limitation sy Limitation = CRBESIN 3-Dec-2003
Information
Library Information 2 - High In Progress
. . . . JE Library o - N I
Library Information .. |3 - Medium  Requested 1) Test Training ttem Information . raining ISCRGBESNN 2-Dec-2003

Note that once you have successfully logged-in and chosen a project, SpiraTeam® remembers this
selection, and on subsequent log-ins will automatically select that project, and highlight it for you in the

“My Projects” list (see 3.2.1 below).

Your homepage contains all the information relevant to you—consolidated onto a single page for you to
take immediate action. By default the page lists the information for all projects that you are a member of.

However, you can choose to filter by the current project, to get a more focused list.

Next to some of the widgets is an RSS icon (".J), this allows you to subscribe to the information as a
Really Simple Syndication (RSS) newsfeed. This can be useful if you want to be notified about recently
assigned items without having to setup email notifications or being logged into SpiraTeam continuously. If
you don’t see an RSS icon next to the widgets on your My Page it means that you have not enabled RSS
newsfeeds in your profile. For more details on configuring your RSS preferences, please refer to section
3.6 (My Profile).

Initially the page is loaded in ‘view mode’ which means that the various ‘widgets’ on the page are
displayed with minimum visual clutter (no toolbars or control icons) that makes it easy to scan the items
on the page and see what work has been assigned. To switch the page to ‘edit mode’, click on the button

with the cog icon () on the right:
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@ 4 QLibrary Information System Planning ~ Testing ~ Tracking - Reporting

My Page »  Fred /" My Timecard / Administration
My Poge Fred B oggs All Projects | Current Project D |+
- E-33 - X
Project Name Group Creation Date Headline Author Publish Date
Internal Projects 30-Nov-2005
30-Nov-2005
30-Nov-2005 = B
Create Incident in: | Library Information Systen v | 4
#x
Project o £4x
Library Information System Delete 2] Name Department Online  Operations
Library Information System Delete "J T QA Remove
Library Information System Delete B8 L - Remove
Library Information System Delete "J
o E X
&) High Priority Late Tasks Library Information System Delete "J o
Project Type Priority Date Opened
X3 Not Executed ary Information System e E .
2| Not E Library Information Syster Delete ) tigle Library ) ) " ) .
. Enhancement  INSSCREIEEIN 16-Nov-2003
Information
= Library Limitation ISR 2 Dec-2003
- | £33 Information
Name Project Importance Status :;JEI::L“M Training 1= Critical | 2-Dec-2003
&) Ability t Library Information .. [ISSCREEEIN In Progress .
5 Library
£ Ability tc ary Information - a ; u - 3-Nov-2003
T Ability t Library Informatior 2 - High Planned \nformation Bug 2 - High Nov-200.
& Ability to li ary Information . - Hi E
& Ability t Library Informatior 2 - High Planned Library ~ ) e s eeoa00s
&4 whilit tn Aslata avicting aithnre librans Infarmation (9 2 bink In Drnarace Infarmatinn rEning - e 2rheea00

In this mode, each of the ‘widgets’ displayed on the page can be minimized by clicking on the arrow icon
(w) in the top-left of the window, or closed by clicking-on the cross icon (X) in the top-right of the window.
This allows you to customize your page to reflect the types of information that are relevant. If you have
closed a widget that you subsequently decide you want to reopen, you can add them back to the page
display by clicking the “Add Items” button at the top of the page. In addition, the various widgets have a
“settings” icon (¥#) that allows you to customize how that widget appears. The settings are specific to
each widget and in general allow you to specify how many rows of data are displayed and what columns

are displayed.

You can move and reposition the various widgets on the dashboard by clicking the mouse on the title bar
of the widget you want to move and dragging it to the desired location. This change will be remembered
when you next login to the system. Once you have the dashboard configured the way you like it, you can

click “Return to Normal View” to switch back to ‘view mode’.
When you load your ‘My Page’ for the first time it will consists of the following main elements:
> My Projects

» My Saved Searches

\4

My Assigned Requirements

A 4

My Assigned Test Cases
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>» My Assigned Test Sets
» My Pending Test Runs
> My Assigned Incidents
>» My Detected Incidents
» My Assigned Tasks
» Quick Launch
>» My Contacts
However these are not the only widgets available. If you click on the “Add/Remove” items hyperlink it will

display the list of any additional widgets that are available:

Add/Remove Items

Choose which items you'd like to add

Available Widgets
My Saved Reports
ed Artifacts

as

Addto| LeftSide * | Add Close

You can add the additional widgets by selecting the appropriate checkbox, choosing the destination
location (left side vs. right side) and then click the [Add] button. The additional widgets available in the My

Page are:
» My Saved Reports
> My Subscribed Artifacts
>» My News Feeds

3.2.1. My Projects

This section lists all the projects you have been given access to, together with the name, description,
project group and date of creation. To view the description of the project, simply position the mouse

pointer over the link, and a tooltip window will popup containing the description.
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When you initially view the page, all of the projects will be shown as links. When you click on a project to
view, you will be taken to that project’s home-page, and that project will be set as the current project. That
project will now appear highlighted in your home-page (see above screen-shot). To change the currently
selected project, simply click on the link of another project name. You can always change your current
project by clicking on the drop-down-list of projects displayed on the global navigation bar to the right of
the “Search” box.

If you are a project group member, the name of the project group will also be displayed as a hyperlink. In
which case, clicking on the project group hyperlink will take you to the Project Group dashboard (see

section 3.5).

3.2.2. My Saved Searches

This section lists any filters/searches you have saved from the various artifact list screens throughout the
application. This allows you to store specific combinations of searches that you need to perform on a
regular basis (e.g. display all newly logged incidents, display all requirements that are completed but have

no test coverage).

The name of the saved search is displayed along with an icon that depicts which artifact it’s for and the
project it refers to. Clicking on the name of the saved search will take you to the appropriate screen in the
project and set the search parameters accordingly. Clicking the “Delete” button next to the saved search
will delete it. Clicking on the RSS icon will allow you to subscribe to the specific search so that it will be
displayed in your RSS newsreader. This allows you to setup customized lists of information that can be

displayed outside of SpiraTeam.

3.2.3. My Assigned Requirements

This section lists all the requirements you have been made owner of, across all the different projects you
are a member of. This typically means that the project manager has assigned you to be responsible for
either developing the supporting test cases or decomposing the requirement into its detailed work
breakdown structure of project tasks. The requirement name is displayed, along with its status

(requested, accepted, in-progress, etc.) and its importance.

3.2.4. My Assigned Test Cases

This section lists all the test cases you have been made owner of, across all the different projects you are
a member of. This typically means that the project manager has assigned you to be responsible for
executing the assigned test scripts. To aid in this process, the script name is displayed, along with its last
execution status (failed, passed or not-run) and date of last execution. This enables you to see how

recently the tests have been run, and whether they need to be re-run.
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If you click on the test-name hyperlink, you will be taken to the details page for this test-case (see section
5.2) and the project that the test-case belongs to will be made your current project. If you click on the play
button to its right you will launch the test-case in the test-case execution module (see section 5.4) so that

you can easily retest failed cases.

3.2.5. My Assigned Test Sets

This section lists all the test sets (groups of test cases) you have been made owner of, across all the
different projects you are a member of. This typically means that the project manager has assigned you to
be responsible for executing the test cases contained within the test set against a specified release of the
system under test. To aid in this process, the test set name is displayed, along with its status, the project
it belongs to, the number of remaining test cases to be executed, and the date by which all the tests need

to have been run.

If you click on the test-set name hyperlink, you will be taken to the details page for this test-set (see
section 5.6) and the project that the test-set belongs to will be made your current project. If you click on
the play button to its right you will launch the test-cases contained within the test-set in the test-case

execution module (see section 5.4) so that you can easily carry out your assigned testing task.

3.2.6. My Pending Test Runs

This section lists any test runs that you started executing in the test case module but haven't yet
completed. Until a test case or test set is fully executed, a pending test run entry is stored in the system

so that you can continue execution at a later date.

Name Project Last Updated Progress

I‘.‘»_] Adding new book and author to library  Library Information

. 20-Apr-2017 x | i

Any pending test run can be either deleted or resumed by clicking on the appropriate button. In addition,

there is the option to reassign the test run to another user that is a member of the project.

3.2.7. My Assigned Tasks

This section lists all the project tasks that you have been made the owner of across all the different
projects you are a member of. This typically means that the manager of the project in question has
assigned development tasks to you that need to be completed so that a release can be completed and/or

a requirement can be fulfilled. The tasks are listed in ascending date order so that the items with the
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oldest due-dates are displayed first. In addition, each task is displayed with a progress indicator that
graphically illustrates its completion against schedule. See section 8 — task management for details of the

different progress indicators.

Clicking on the task name hyperlink will take you to the task details page. This page will describe the task
in more detail, illustrate which requirement and release it is associated with, and also allow you to view

the change log of actions that have been performed on it.

3.2.8. My Assigned Incidents

This section lists all the open incidents you are the owner of, across all the different projects you are a
member of. This typically means that the project manager has assigned you to be responsible for
resolving the incident. In the case of a bug, this can mean actually fixing the problem, whereas for other
incident types (e.g. training item) it may mean simply documenting a workaround. In either event, this
section highlights the open incidents you need to manage, ranked by importance/priority and categorized

by type, with the open date displayed to give you a sense of the age of the incident.

Clicking on the incident name hyperlink takes you to the incident details page (see section 6.2) that
describes the incident in more detail, and allows you to add new information or change its status to
indicate actions taken. In addition, if you position the mouse pointer over the name of the incident, a more

detailed description is displayed as a “tooltip”.

3.2.9. My Detected Incidents

This section lists all the open incidents that you have detected, across all the different projects you are a
member of. These incidents are not necessarily ones that you need to take an active role in resolving, but
since you were the originator — either by executing a test case or just logging a standalone incident — you

can watch them to make sure that they are resolved in a timely manner.

Clicking on the incident name hyperlink takes you to the incident details page (see section 6.2) that
describes the incident in more detail, and allows you to add new information or change its status to
indicate actions taken. In addition, if you position the mouse pointer over the name of the incident, a more

detailed description is displayed as a “tooltip”.

3.2.10. Quick Launch

This widget allows users to quickly record a new incident in any of the projects that they belong to. It's a
shortcut that avoids having to first select a project, go to Tracking > Incidents and then click “New
Incident”. Instead you simply choose the project from the dropdown list and click the arrow icon to bring

up the new incident creation screen.
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3.2.11. My Contacts

This widget displays a list of any other users in the system that you have listed as a personal contact:

My Contacts

Name Department Online Operations

® QA Send Messag Remove
€@ System Administrat - end Message Remove

Each user is displayed along with their graphical avatar, department and a colored indicator that lets you
know if they are online or not. If they are online you can then send them an instant message (which will
be described later in section 3.3. To remove an existing contact, just click on the ‘Remove’ button. To add
a new user, simply locate them in the Tracking > Resources page and then use the <Add As Contact>
button.

3.2.12. My Saved Reports

This section lists any reports you have saved from the reports center. This allows you to store specific
combinations of report elements, format, filters and sorts (see the section on Reporting for more details

on how to configure a report) for reports that you need to run on a regular basis:

My Saved Reports

Name Project

Library Information System Delete

Version 1.0 Release Report Library Information System Delete

3.2.13. My Subscribed Artifacts

This widget displays a list of all the artifacts in the system that you have subscribed to (by clicking on the
Subscribe icon on the item). You can display the item by simply clicking on the hyperlink. In addition, if
changes are made to any of the artifacts an email notification will be sent to you. You can click on the
“Unsubscribe” button to remove the item from this list.
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My Subscribed Artifacts &

Name Project Last Updated

j;‘] Ability to add new books to the system Library Information ... 1-Dec-2003 > Unsubscribe
&Y Ability to create new book Library Information ... 1-Dec-2003 > Unsubscribe
91] Cannot install system on Oracle 9 Library Information... 1-Dec-2003 > Unsubscribe

3.2.14. My News Feeds

This widget allows you to subscribe to an external newsfeed and have the results be displayed inside
SpiraTeam. By default it will be set to the newsfeed from the Inflectra website that displays a list of recent
company and product announcements. You can add multiple instances of the widget to the dashboard,
allowing you to read multiple news sources at once. Typical uses for this widget are to add news from
project management and testing news sites/blogs or to add information from other tools in your
organization that can display their data in RSS format.

My News Feeds

Headline Author Publish Date
nflectra to Sponsor the First Annual Test Leaders (2" webmaster@inflectra.com 3/29/2016
Vhat to Do When Your Testers Are Addicted to Word &' webmaster@inflectra.com 3/25/2016
Tips and Tricks Using Rapise (' webmaster@inflectra.com 3/22/2016

Eirst Alpha Release of SpiraTeam v5 &' webmaster@inflectra.com 3/16/2016

SmarteSoft and Inflectra Partner to Optimize QA an (&' webmaster@inflectra.com 3/9/2016

3.3. Global Navigation

Regardless of the page you are on, SpiraTeam® will always display the global navigation bar, consisting
of the SpiraTeam® icon, the current Project Group or Project, the main artifact sections (Planning,
Testing, Tracking and Reporting) that correspond to the main activities that take place in the system, the
global search bar, and the user profile avatar menu.

% | O Library Informa Planning~  Testing~  Trac

My Page » Tec 5 My Timecard Administration
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Under the various icons and headings are several secondary menu options that are displayed when you
click the dropdown arrow to the right of the heading (as illustrated below):
» SpiraTeam Icon
> My Page (described above)
> My Timecard (described in Section 3.7)
> Administration (described in the separate SpiraTeam Administration Guide)
» Project Group Home Page (described in Section 3.5)
> Planning (described in Section 13)
» Project Home Page (described in Section 3.4)
» Planning
> Requirements (described in Section 4)
> Planning Board (described in Section 13)
> Releases (described in Section 7)
> Documents (described in Section 10)
> Testing
[> Test Cases (described in Section 5)
[> Test Sets (described in Section 5.7)
> Test Runs (described in Section 5.5)
> Automation Hosts (described in Section 5.9)
>» Tracking
D> Incidents (described in Section 6)
[> Tasks (described in Section 8)
> Resources (described in Section 9)
>  Source Code (described in Section 12)
» Reporting (described in section 11)
» User Profile Icon
> My Profile (described in Section 3.6)
> Log Out (described in Section 3.3.2)

> Help? (described in Section 3.3.3)
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Note: The main section headings will take you to the appropriate artifact type (requirement, test case,

incident, etc.) for the currently selected project.

3.3.1. Global Search

SpiraTeam includes a global search bar that can be used to search across project and artifact type for

items that include the entered keywords in either the name or description field:

create hoold [ Q
n n, H x
create book": 94 matching result(s) sort: | relevance | date
I: Filter: All Artifacts + Al Projects ~
~
TK2 - Create book object insert method ~ Library Information System
Code the business object that inserts a new book row in the database
N Sunday, November 30, 2003
TKS - Create book object update method  Library Information System
£ Code the business object that updates an existing book record in the database
L 6 hours 27 minutes ago
£
i TK8 - Create book object delete method  Library Information System
Sunday, November 30, 2003
TK11 - Create book-subject mapping insert method  Library Information System
( Sunday, November 30, 2003
TK12 - Create book-subject mapping delete method ~ Library Information System
Sunday, November 30, 2003
TK13 - Create book-subject mapping queries  Library Information System
Sunday, November 30, 2003
TK19 - Create book object delete all method  Library Information System
Sunday, November 30, 2003
TS2 - Ability to create new book  Library Information System
User clicks link to create book
Sunday, November 30, 2003
TC2 - Ability to create newbook  Library Information System
Tests that the user can create a new book in the system N
hY 6 hours 20 minutes ago .

You can search for individual keywords by simply entering them in the search box and clicking the arrow
button on the right. You can search for phrases by enclosing the words in double quotes. You can also

search for a specific artifact by its unique two-letter prefix and ID number.

For example, searching on book name will find any artifacts that include either of the two words book and
name in the name or description. Searching on “book name” will only return items that have that exact

phrase in either the name or description. Searching on TC2 will display just the Test Case with ID=2:

o e

"TC2": 1 matching result(s) sot = relevance date ®

[ Filter:  All Artifacts »  All Projects +

TC2 - Ability to create new book  Library Information System

Tests that the user can create a new book in the system
1 6 hours 21 minutes ago
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When you get a list of search results, you can choose to order by relevance (the default) or by most

recent. Searching by relevance finds the artifacts that have the greatest match with the keywords:

ﬂ —— Q _

"create books": 94 matching result(s) sot:  relevance | date

[ Filter: All Artifacts +  All Projects ~

TK2 - Create book object insert method  Library Information System
Code the business object that inserts a new book row in the database
1 Sunday, November 30, 2003
TKS5 - Create book object update method  Library Information System
t Code the business object that updates an existing book record in the database
6 hours 30 minutes ago
TK8 - Create book object delete method ~ Library Information System
Sunday, November 30, 2003

TK11- Create book-subject mapping insert method  Library Information System
( Sunday, November 30, 2003

TK12 - Create book-subject mapping delete method  Library Information System
Sunday, November 30, 2003

The search by date is useful when you want to find recent items that match the search keywords:

create books Q P
"create books": 94 matching result(s) sort:  retevance | date | "
[ Filter: All Artifacts ~  All Projects ~

TC20- Create Author  Library Information System
Saturday. April 16, 2016
| TS39 - Create Book  Library Information System

Click on the 'Create new book' link
t Thursday, April 14,2016

¢ TS41 - Create Book Library Information System
H Click the 'Insert’ button

Thursday, April 14, 2016

TS42 - Create Author Library Information System
( Click on the ‘Create new author' link.

Thursday, April 14, 2016

TS40 - Create Book Library Information System

Enter in the new book information
Thursday, April 14,2016

In addition, you can filter the results by artifact type and/or project to narrow down the search:

. H x
"create books": 94 matching result(s) sot:  relevance | date
Filter: AllArtifacts v All Projects ~

S
TK2- Al Artifacts 4 nethc Al Projects 94 m
Code: serts e ase
' Sunday  Requirement 13 Current Project %4

TK5-  TestCase 12 s methtun - tumeiaad, atitraslem
Code idates an existing book record in the database

éhours  Incident ¢

TKS8- TestRun 17 method Library Information System

Sunday

TK11 Task 28 pinginsert method  Library Information System
Sunday TestStep 13

TK12 ping delete method  Library Information System

Sunday ~Document 3

For example, if you filter by requirement, the list of results will be narrowed accordingy:
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"create books": 94 matching result(s) sort: = relevance | date ®
[ Filter: Requirement~  All Projects ~

RQ30 - Creating a new hook inthe system  Library Information System
This use case defines the steps in creating a new book.

1 Tuesd cember 2, 2003

RQ12-
t This was requested to allow the disposal via charity of legacy editions to ensure out-of date material is removed
Sunday, November 30, 2003

RQ26-

Sunday, November 30, 2003

y to create different editions Library Information System

Library Information System

RQ32 - Deleting an existing book from the system  Library Information System
( This use case defines the steps when deleting a book record.
Thursday, December 4, 2003

RQ31 - Editing an existing book in the system  Library Information System
This use case defines the steps in editing an existing book record.
Wednesday, December 3, 2003

RQ3 - Book Management  Library Information System

3.3.2. Log Out

Clicking on the “Log Out” link will immediately log you out of your current session and return you to the
login page illustrated in section 3.1. If you had set the “Keep Me Logged In” option during your previous
login, that setting will be reset; so if you want to avoid having to keep logging-in, you’ll need to re-check

that box during your next log-in.

3.3.3. Help

Clicking on this link on any page will bring up the online version of this manual shown below:
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SpiraTeam User Manual Help viewer

& Contents  Q Index
5.4. Execute Test Case(s)

This section describes how a tester can follow the steps defined for a series of test cases and record what actually happened in the process. In addition
recorded failures of test cases can be used to automatically generate new incidents that will be added to the incident tracking module (see section )

> & 1. Introduction
> & 2. Functionality Overview
> & 3. User/Project Management
> & 4. Requirements Management
> & 5. Test Case Management
& 5.1. Test Case List

You start test case execution in SpiraTeam by either selecting test cases or test sets on their respective page(s) and then clicking the <Execute> button, or
by clicking the “Execute” link on the test cases / test sets listed on your personalized home page under “My Test Cases” or “My Test Sets”. If you execute a

F511 Insert
[35.1.2. Indent / Outdent
[315.1.3 Delete
5514 Execute
5515 Refresh
3 5.1.6. Eatt
2517 Show Level
[25.1.8. Show / Hide Columns
[215.1.9. Filtering
[215.1.10. Copying Test Cases
[315.1.11. Moving Test Cases
[315.1.12. Exporting Test Cases
[315.1.13. Adding Test Cases to a Releast
[315.1.14. Viewing the Test Status for a Re
[215.1.15. Printing ltems
E51.16 Right-Click Context Menu
& 5.2. Test Case Details
[215.2.1. Overview - Details
[35.2 2 Overview - Test Steps
[215.2.2. 1 Insert Step

test set then the values of the selected release and custom list properties for the test run are automatically populated from the test set, whereas if you
directly execute a test case itself, those values can be chosen by the tester.

Regardless of the route taken to launch the test execution module, the first screen that will be displayed will look like the following:

seBok
ceeely

0 E) g e ks st
Before actually executing the test scripts. you need to select the release (and optionally the specific build) of the system that you will be testing against and
any test run custom properties that have been defined by the project owner. This ensures that the resulting test runs and incidents are associated with the
correct release of the system, and that the test runs are mapped to the appropriate custom properties (e.g. operating system, platform. browser, efc.).

[

If you have not configured any releases for the project, then the release drop-down list will be disabled and the test runs/incidents will not be associated with
any particular release. If the test run was launched from a test set, the release and any list custom properties will be pre-populated from the test set itself
and will not be changeable on this screen (unless they weren't set by the test set)

Once you have chosen the appropriate release name and/or custom properties, click the <Next> button to begin executing test steps

[F5222 Insert Link

55223 Delete

25224 Copy

55225 Refresh

[215.2.2 6. Show / Hide Columns
[215.2.2.7. Editing Test Steps
[315.2.2.8. Editing Test Links
[315.2.2.9. Moving Test Steps
[215.2.2.10. Parameters

[315.2.3. Overview - Automation
[315.2.4. Overview - Comments
[315.2.5. Requirements Coverage
2152 6 Test Runs

[215.2.7 Releases

[215.2.8. Incidents

M 590 Attarhmante

(c) Inflectra Corporation 2006-2016

Clicking on any of the triangles expand links in the left hand table of contents will open up the detailed list
of topics for each of the main areas of the system. In each area, clicking on one of the individual links will
open the appropriate section in the help manual. By default, the reading-pane will open to the help item

that is most closely related to the screen you happened to be on when you clicked the “Help” link.
You can search the index by using the “Index” tab.

If you want to share a specific help page with a colleague in your organization, simply send them the url

from the address bar.

3.3.4. Choose Project or Project Group

Choosing a Project or Project Group from the list of your assigned projects in the drop-down-menu allows
you to quickly and easily jump between projects regardless of the page you happen to be on. When you
choose a project, you will be taken to the same page in the selected project (assuming that you have

permissions to view that page). The projects are listed under the appropriate group.

You can use CTRL+click to open the new project in a separate browser tab:

This document contains Inflectra proprietary information
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O Library Information System

B External Projects
0 Sample Application Two
| 2 Internal Projects SySte m PR1

Q Library Information System
©Q Sample Application One

Similarly you can choose a specific project group from the list of project groups, which will display the

project group dashboard for the selected project group:

® Internal Projects v

. B External Projects

QO Sample Application Two

I & Internal Projects nal PrOJeCtS PG2

O Library Information System

Sample Application One

3.3.5. Instant Messenger

The Spira instant messenger is available in both SpiraPlan® and SpiraTeam® and allows you to send
short messages instantaneously to other users in the system. You can see the status of other users by
looking for the small green circle next to the list of users in the ‘My Contacts’ widget as well as the various
user fields in the system:

Author:* Fred Bloggs W

When a user is online and available to communicate with, the small circle will be filled-in green. If you

click on the green circle, it will open up the instant messenger window for that user:
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e AR

. Fred BI
p. 4 red Bloggs

Hi Joe, what do you think of the latest build?

Hey Fred, I've not had a chance to look at it I

3 Fred Blogss

yet

Ok - no worries. Let me know when you have

iy AHTY

You can then enter in a message to the other user, which will then cause a conversation window to open

inside their web browser with your message displayed. The other user can then enter in their responses,

allowing the two users to have a real-time conversation:

Ok - no worries. Let me know when you have

Fred Blogzs

I'm interested in hearing yvour thoughts

To make it easier to see what’s new, all unread messages are displayed in a message box with a darker

shade. In addition, the user’s avatar image is displayed at the start of each message group.

If the message window appears on a SpiraTeam® window that contains a specific artifact (e.g. a

requirement, test case, task, etc.) there will be the option to ‘Post as Comments’. If you click this option,

any messages selected with a checkbox will be automatically posted to the current artifact as comments.

This is useful if you have a conversation related to a specific item and you want to have the outcome

permanently recorded as part of the audit trail. Otherwise, instant messages will be automatically purged

from the system after 90 days.
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o Jo= P Smith ﬁ i '
OK - I've taken a look at the add new I

author glitch again. There is 3 problem with
users with names over 20 characters

3 Fred Eloggs [}

1 Hmm. It could be we've limited the length !

| in the database. Great to have some more [
intel to go on - thanks

Post as Comments

3.4. Project Home

When you click on either the “Project Home” tab or the name of the project in the “My Page” project list,

you will be taken to the homepage of the specific project in question:

Library Information System pri General Development
Displaying: --- All Releases - % + @
View All
Sample application that allows users to manage books, authors and lending records for 2 Description Priority Owned By

typical branch libra
e v Cannot install system on Windows ME

Group Internal Projects
Web Site: braryinformationsystem.org 2
Owner(s): System Administrator

2 - High Joe P Smith

3 - Medium

3 - Medium Joe P Smith

Testing

Date Opened
30-Nov-2003
30-Nov-2003
30-Nov-2003

30-Nov-2003

View Al
#  Fred Bloggs modified Incident [N7] - Cannot add a new book to the system View All
! Description Priority Owned By Date Opened
#  Fred Bloggs modified Requirement [RQ-4] - Ability to add new books to the system
1 Sample Risk 1 - 9-Dec-2003
#  Fred Bloggs modified Test Step [T5:3] - User clicks link to create author sample Risk 2 2 - High 9-Dec-2003
1 Sample Risk 3 4 - Low Fred Bloggs 9-Dec-2003
#  Fred Bloggs modified Release [RL1] - Library System Release |
]
#  Fred Bloggs modified Test Case [TC:2] - Ability to create new book View Details
i
8
Total # Runs: 19
5
Name Creator . Daily Run Count:
~ . B 12/ 303
] Critical Not-Covered Requirements Fred Bloggs B R S
P H Priority -
gl y s
{9 High Priority Late Task Fred Bloggs Ej 5 2
n
. Il
View Details a
Failed Passed Mot Blocke Cautio
Status 1- Critical 2 - High 3 -Medium  4-low (None) TOTAL Run d n

This page summarizes all of the information regarding the project into a comprehensive, easily digestible

form that provides a “one-stop-shop” for people interested in understanding the overall status of the
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project at a glance. It contains summary-level information for all types of artifact (requirements, test

cases, incidents, etc.) that you can use to drill-down into the appropriate section of the application.

You will see a small “i" in a circle at the top right of every chart. Hovering or clicking on this will show you

information about that chart.

In addition to viewing the project home page, you can choose to filter by a specific release, to get the

homepage for just that release (and any child iterations).

Just like the ‘My Page’, the Project Home dashboard is initially loaded in ‘view mode’ with pre-configured
set of widgets. The Project Home also offers 3 versions you can quickly switch between. While each of
these can be customized as you want, by default they are designed to help different types of project

member — be they managers, testers, or developers.

General Development Testing

# 0+ [

To download an image of the entire dashboard click the ‘picture’ button beneath the currently selected

view.

To switch the page to ‘edit mode’, you should click on the button with the cog icon (%) below the currently

selected Project Home view.

Once in ‘edit mode’, each of the ‘widgets’ displayed on the project homepage can be minimized by
clicking on the arrow icon (=) in the top-left of the window, or closed by clicking-on the cross icon (%) in
the top-right of the window. In addition, the widgets allow you change their settings by clicking on the
settings icon (¥).This allows you to customize your view of the project to reflect the types of information
that are relevant to you. If you have closed a widget that you subsequently decide you want to reopen,
you can rectify by clicking the “Add Items” button at the top of the page, and locating the closed item
from the list of ‘Closed Widgets'.

When you load your ‘Project Home’ for the first time it will default to the “General” view. The following

table shows which widgets are displayed on the different views of the ‘Project Home’:

Widget Name General Development  Testing
Project Overview Y Y Y
Activity Stream Y Y Y
Shared Searches Y
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Requirements Summary Y

Requirements Coverage Y
Release Task Progress Y
Requirements Graphs Y
Late Finishing Tasks Y
Task Graphs Y
Top Open Issues Y
Top Open Risks Y
Test Execution Status Y
Release Test Summary Y
Incident Summary Y
Incident Open Count Y

Requirement Incident Count Y

Requirements Regression
Coverage

Test Set Status
Incident Aging

Incident Test Coverage
Tag Cloud

Recent Builds

Late Starting Tasks

All Pending Test Runs
Source Code Commits
Test Run Progress

Test Case Progress By Day
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Please note that different widgets are shown by default for the “Developer” and for the “Tester” views.

If you click on the “+ Add” items button it will display the list of any additional widgets that are available for

that view. Below is what this looks like for the ‘General’ view:

- Add/Remove ltems

Choose which items you'd like to add

Closed Widgets (0)

Available Widgets
Requirements Regression Coverage
Test Set Status
Incident Aging I
Incident Test Coverage ‘
Tag Cloud
Recent Builds
Late Starting Tasks
All Pending Test Runs
Source Code Commits

Test Run Progress

Add to | Left side v Add Close

You can add the additional widgets by selecting the appropriate checkbox, choosing the destination

location (left side vs. right side) and then click the “Add” button.
Each of the different widgets listed is described in more detail below:
3.4.1. Project Overview

This section displays the name of the project, together with a brief description, the web-site that points to

any additional information about the project, and the names of the owners of the project.
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3.4.2. Shared Searches

This section lists any filters/searches have been saved from the various artifact list screens throughout
the application and marked as shared filters. This allows users to store specific combinations of
searches that the project team needs to perform on a regular basis (e.g. display all newly logged

incidents, display all requirements that are completed but have no test coverage).

The name of the saved search is displayed along with an icon that depicts which artifact it's for and the
person who created it. Clicking on the name of the saved search will take you to the appropriate screen in
the project and set the search parameters accordingly. If you are the creator of the saved search, clicking
the “Delete” button next to the saved search will delete it. Clicking on the RSS icon will allow you to
subscribe to the specific search so that it will be displayed in your RSS newsreader. This allows you to

setup customized lists of information that can be displayed outside of SpiraTeam.

3.4.3. Requirements Summary

This section consists of a summary table that displays the aggregate count of requirements in the system
broken-down by importance (on the x-axis) and status (on the y-axis). This allows the project manager to
determine how many critical vs. low priority enhancements are waiting to be implemented, vs. actually
being implemented. In addition, it makes a distinction between those requirements simply requested and
those actually planned for implementation, so the project manager can see what the backlog is between
the customer’s demands, and the plan in place. Clicking on the “View Details” button at the top of the
table simply brings up a detail graph that you can customize by selecting the axes. Clicking on the
individual values in the cells will display the requirements list with the filter set to match the importance

and status of the value.

3.4.4. Requirements Coverage

This section consists of a bar graph that displays the aggregated count of requirements test coverage for
the project. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the total count of
requirements that have tests covering them, allocated across the execution status of the covering tests.
For example, if a requirement is covered by four tests, two that have passed, one that has failed and one
that has not yet been run, the counts would be passed = 0.5, failed = 0.25 and not-run 0.25. These
fractional quantities are then summed across all the requirements to give the execution status breakdown

of the covered requirements.

In addition to the five statuses for the covered requirements, the sixth (“Not Covered”) bar depicts the
total number of requirements that have no tests covering them, putting the five other bars into
perspective. Typically a project is in good health if the “Not Covered” bar is zero, and the count of

“Passed” requirements is greater than “Failed”, “Caution” or “Not Run”. The greatest risk lies with the
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“Blocked”, “Not Covered” and “Not Run” status codes, since the severity/quantity of any bugs lurking
within is not yet fully known.

If you position the mouse pointer over any of the four bars, the color of the bar changes slightly and the
underlying raw data is displayed as a tooltip, together with the percentage equivalent. Clicking on the any
of the bars in the chart will take you to the requirements list page (see section 4.1) with the corresponding
filters set.

When you filter the project home by releaseliteration, this widget will filter the requirements coverage
graph to only include requirements that are specifically mapped to the selected release/iteration.
This is useful when you want to determine the test coverage of new requirements that are being added to
the specific release/iteration. If instead you want to determine the regression test coverage for a release,

you should add the separate “Requirements Regression Coverage” widget to the page instead.

3.4.5. Requirement Incident Count

This section displays a count of the total number of incidents, and the number of open incidents mapped
against requirements in the system, sorted by the requirements that have the most open incidents first.
This section is useful for determining the parts of the application that have the most instability, as you can
look at the requirements that have yielded the greatest number of incidents. Clicking on any of the
requirements hyperlinks will take you to the detail page for the requirement in question (see section 4.2).
You can configure in the settings whether to include requirements with no open incidents, and also how

many rows of data to display.

3.4.6. Top Open Issues

This section displays a breakdown of the top issues logged against the project, in order of decreasing
priority. Note that items not given a priority are listed at the top, since critical issues could be lurking in
that list, and the project manager will want to immediately review these to assign priorities. Clicking on the
issue item hyperlink will take you to the incident details page for the issue in question (see section 6.2).
You can configure in the settings whether to use Priority or Severity for the display, and also how many
rows of data to display.

3.4.7. Top Open Risks

This section displays a breakdown of the top risks logged against the project, in order of decreasing
priority. Note that items not given a priority are listed at the top, since critical risks could be lurking in that
list, and the project manager will want to immediately review these to assign priorities. Clicking on the risk
item hyperlink will take you to the incident details page for the risk in question (see section 6.2). You can
configure in the settings whether to use Priority or Severity for the display, and also how many rows of

data to display.
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3.4.8. Release Test Summary

This widget allows you to quickly ascertain the test execution status of each of the active releases that
make up the current project in one snapshot. Each release is displayed together with a graphical display
that illustrates the execution status with different colored bars. In addition, if you hover the mouse over
the graphical display it will display a tooltip that provides a more detailed description of the number of

tests in each status.

Release Test Summary View Details
Release [ Iteration & Tests Execution Status

@ 1.0.0.0 - Library System Release 1 7
51202 fL em Release 1.1 5P1 7
[§1.0.1.0- Librar e 15P1 7
110.20- Librar em Release 1 5P2 7
& 1.1.0.0 - Liby em Release 1.1 g
E1.1.10- Librar em Release 1.1 5P1 7
G 1.2.00-Lib em Release 2 7

Each release will display the aggregate status of any test cases directly assigned to itself, together with
the test status of any child iterations that are contained within the Release. Clicking on one of the
releases will drill you down one level further and display the test execution status for the parent release

as well as each of the child iterations separately:

Release Test Summary View Details
Release / Iteration # Tests Execution Status

E 1.1.0. 0-Lib em Release 1.1 g

cl11 1-lte n 001 2

ot B 2 - Ite n 002 3

e I Ite n =

3.4.9. Incident Summary
This section consists of a summary table that displays the aggregate count of incidents in the system
broken-down by priority (on the x-axis) and status (on the y-axis). This allow the project manager to

determine how many critical vs. low priority incidents are waiting to be addressed, and how many new
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items need to be categorized and assigned. Clicking on the “View Details” link at the top of the table
simply brings up a detail graph that you can customize by selecting the axes. Clicking on the individual
values in the cells will display the incident list with the filter set to match the priority and status of the

value.

By default this summary table displays the total count of all incidents — regardless of type, however my
changing the drop-down list to a specific incident type (e.g. bug, enhancement, issue, etc.), the project
manager can filter the summary table to just items of that type. You can also configure in the settings
whether to use Priority or Severity for the x-axis

3.4.10. Test Execution Status

This section consists of a bar graph that displays the aggregated count of test cases in each execution
status for the project. Note that this graph does not consider past test-runs when calculating the totals in
each status (Passed, Failed, Not Run, etc.), it simply looks at each test-case and uses the last-run status
as the best health indicator. Thus if a test case that previously passed, has subsequently failed upon re-
execution, it will be considered a failure only.

If you position the mouse pointer over any of the five bars, the color of the bar changes slightly and the
underlying raw data is displayed as a tooltip, together with the percentage equivalent. Clicking on any of

the bars will bring up the project test case list (see section 5.1) with the appropriate filter applied.

In addition to the bar-chart, there is also a display of the total number of test runs recorded for the project,

and a list of the five most recent days of recorded test-runs, together with the daily count.

3.4.11. Release Task Progress

This widget allows you to quickly ascertain the task progress of each of the active releases that make up
the current project in one snapshot. Each release is displayed together with a graphical display that
illustrates the completion percentage and status with different colored bars. In addition, if you hover the
mouse over the graphical display it will display a tooltip that provides a more detailed description of the

number of tasks in each status.
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Release Task Progress

Release / Iteration

& 1.1.0.0 - Library System Release 1.1
1 1.1.0.0.0001 - Iteration 001
1 1.1.0.0.0002 - Iteration 002
] 1.1.0.0.0003 - Iteration 003

Tasks

|._

[«

[«

View Details

Est. Proj. Task Progress
86.%h 86.6h
29.0h 28.7h
27.0h 27 0h

30.0h 30.0h

Each release will display the aggregate progress of any tasks directly assigned to itself, together with the

task progress of any child iterations that are contained within the Release. Clicking on one of the releases

will drill you down one level further and display the task progress for the parent release as well as each of

the child iterations separately:

Release Task Progress

Release / Iteration

@ 1.1.0.0- Library System Release 1.1
] 1.1.0.00001 - Iteration 001
] 1.1.0.0.0002 - Iteration 002

1 1.1.0.0.0003 - Iteration 003

3.4.12. Late Finishing Tasks

Tasks

(=N |= |:

[«

View Details

Est. Proj. Task Progress
86.%h 86.6h
29.0h 28.7h
27.0h 27.0h

30.0h 30.0h

This section displays the list of any project tasks that have not yet been completed, but whose scheduled

end date has already elapsed. A graphical progress bar is included with each task in the grid, so that you

can easily see which tasks are nearest completion.

3.4.13. Late Starting Tasks

This section displays the list of any project tasks that have not yet started, but whose scheduled start date

has already elapsed:
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Late Starting Tasks View A

Mame Owner Priority Start Date
Fred Bloges 1 - Critical 10-har-2004
Joe P Smith 2-High &-Mar-2004
Joe P Smith 2-High 6-Mar-2004
Joe P Smith 2-High &-Mar-2004
Fred Bloggs 2-High 8-Mar-2004

Each task is listed along with its owner, priority and due-date so that you quickly ascertain how many
days late it will be starting, how important it is to the project, and who needs to be contacted to get more

information.

3.4.14. Requirements Regression Coverage

This section consists of a bar graph that displays the aggregated count of requirements test coverage for

the project in a similar fashion to the ‘Requirements Coverage’ widget:

Requirements Regression Coverage

19

(=]

Passed Failed Blocked Caution Mot Run Mot Covered

However, unlike the ‘Requirements Coverage’ widget, when you filter the project home by
release/iteration, this widget will filter the requirements coverage graph to include all requirements
(regardless of releasel/iteration), but only considering covering test cases that are associated with the
selected release/iteration. This is useful when you want to determine the regression requirements test
coverage of a specific release (i.e. does running all the tests relevant to this release cover all the

necessary requirements, not just new requirements).
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3.4.15. Test Set Status

This section consists of a bar graph that displays the aggregated count of test cases in each execution

status for each test set in the project:

Test Set Status View Details

Overdue Test Sets

X1 4-Feb-2007

Ka
(¥

TK2 | &-Feb-2007

TX5 9-Feb-2007

Failed Paszed Mot Run Blocked Caution

Therefore if you have the same test cases stored in multiple test sets, then this widget will display the
total test case count for all combinations of test set. This is useful if you have the same test cases being
executed in different environments — represented by different test sets — and you need to make sure that

the tests passed successfully in all environments.

If you position the mouse pointer over any of the five bars, the color of the bar changes slightly and the
underlying raw data is displayed as a tooltip, together with the percentage equivalent. Clicking on any of
the bars brings up the project test set list (see section 5.6) page with the appropriate filter applied. In

addition to the bar-chart, there is also a display of (up to) the five most overdue test sets in the project.

3.4.16. Incident Aging

This section displays the number of days incidents have been left open in the system. The chart is
organized as a histogram, with the count of incidents on the y-axis and different age intervals on the x-

axis.

3.4.17. Incident Test Coverage

This section displays a bar-graph that illustrates the execution status of any test cases that previously
failed and resulted in the generation of an incident that has subsequently been resolved. This is very
useful when a test case was executed in Release 1.0 and an incident was logged. That incident has now
been resolved in Release 1.1 (and is in a closed status) but we need to know that the test case that
caused the failure has been successfully re-run. Any test cases listed as Blocked, Caution, Not-Run, Not
Applicable, or Failed in this graph need to be executed to verify that all resolved bugs in the release have

truly been fixed.
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3.4.18. Task Graphs

This widget lets you quickly view the three main graphs used when measuring the progress of tasks in an

agile methodology:

1. Task Velocity — this graph shows the total estimated and actual effort delivered in each project

release and/or iteration

2. Task Burnup - this graph shows the cumulative amount of work outstanding for each
release/iteration in the project with separate lines for the estimated, remaining and completed

effort.

3. Task Burndown — this graph shows the remaining work that needs to be done for each
releaseliteration in the project with separate lines for the estimated, remaining and completed

effort.

For each of the three graphs you can click on the “Display Data Grid” link to display a grid of the
underlying data that is represented in the graph and also there are options to save the graph in a variety

of different image formats.

3.4.19. Tag Cloud

This widget lets you see the list of document tags being used in the project:

Tag Cloud
book managementerrorfunctional specification
libraries stack tracetESting user interface
wireframe

The size of the tag name indicates the relative frequency of its usage in the project. Clicking on a
document tag will open up the Document List page (see section 10.1) with the filter set to the tag you

clicked on. This will display a list of related documents that have been tagged with the same tag name.

3.4.20. Recent Builds

This widget displays a list of the most recent builds that have been performed as part of the current

release or iteration:
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Recent Builds

MName Status Creation Date

el Build 0015 Succeeded 3/11/2004 7:00:00 PM
el E 0014 Succeeded 3/10/2004 7:00:00 PM
Sﬂ E Failed 3/9/2004 7:00:00 PM
Sﬂ Build 0012 Failed 38/2004 7:00:00 PM
Sﬂ E Failed 3/7/2004 7:00:00 PM

For each build it will display whether the build succeeded or failed, the date the build occurred and the
name of the build together with a hyperlink to the build details (see section 7.2.7). Note: If no release or

iteration is selected then the widget will not display any data.

3.4.21. Requirements Graphs

This widget lets you quickly view four different graphs used when measuring the progress of requirements

in an agile methodology. They are described in more detail in Reports section (11.8) of this manual.

1. Requirement Velocity — this graph shows the actual velocity delivered in each project release

and/or iteration compared to the project average and the rolling average.

2. Requirement Burnup — this graph shows the cumulative number of story points outstanding for
each release/iteration in the project with separate lines for the actual and ideal burnup overlaid on

top of a bar-graph that shows the completed story points per release/iteration.

3. Requirement Burndown — this graph shows the remaining number of story points that needs to
be done for each releasel/iteration in the project with separate lines for the actual and ideal
burndown overlaid on top of a bar-graph that shows the completed story points per
release/iteration.

4. Requirements Coverage — this graph shows the number of requirements that have test cases
that are passed, failed, blocked, cautioned, not run as well those requirements that do not have
any test cases (not covered). Unlike the main Requirements Coverage graph on the home page,

this one is segmented by requirement importance.

For each of the three graphs you can click on the “Display Data Grid” link to display a grid of the
underlying data that is represented in the graph and also there are options to save the graph in a variety
of different image formats.
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3.4.21. Test Run Progress
This section consists of a chart that displays the last 30 days of test run activity, broken down, for each
day, by the test run status. This is a useful chart to quickly track the testing activity of the project — this is

not the same as overall project status.

12
1
10

0 o= k3 L e n @

11i4 1178 1112 111G 11720 11724 11728 1212

Failed Passed Mot Run MIA Blocked Caution

3.4.22. Test Case Cumulative Progress

This section consists of a chart that displays the last 30 days of test case executions cumulatively. That
means it will display for each day, the total number of test cases executed plus the status from any
previous days that have not been changed. Any test cases not executed up to that point will be
considered “not run” and will appear in the “not run” category. For example, if you have 10 test cases
created on day 1 you will see 10 test cases “not run” on day 1. On day 2, you execute 5 test cases and
fail them all, you will now see 5 test cases failed and 5 not run. On day 3, you execute 3 of the previous 5

test cases and pass them. You will now see 3 test cases passed, 2 failed and 5 not run.
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3.4.23. Source Code Commits

This section consists of a chart that displays the last 3 months of code commits to the project (if you are
using the source code functionality of the application). Commits are aggregated by week. The chart is
color coded by bottom quartile, the middle 50%, and the top quartile of activity.

1
]

4i15 422 4729 Big 513 Bi20 BI2T 63 G/10

3.4.23. Incident Open Count

This section show a bar chart to visualize the breakdown of all open incidents in the project by priority.
The chart’s bar match the color assigned to that priority. Clicking on the “View Details” link at the top of

the widget loads a chart builder where you can further refine and filter the chart to meet your needs.
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3.4.24. All Pending Test Runs

This section lists all the test runs that are currently being executed by testers in the project. Until a test

case or test set is fully executed, a pending test run entry is stored in the system so that you can continue
execution at a later date.

Name Tester Last Updated Progress

t>_‘| Adding new book and author to library 1 System Administrator 20-Apr-2017 x =

Any pending test run can be either deleted or reassigned to another user that is a member of the project
by the project manager or test manager.

3.5. Project Group Home

When you click on either the Project Group name in the global navigation or the name of the project

group in the “My Page” project list, you will be taken to the homepage of the specific project group in

guestion:
Praject Group: Internal Projects pca o+ @
Contsins the library project a pplication one Project Mame Weh Site Creation Date
Web Site

Lib ttp ationsstem ore 30-Nov-2005
Ounerts); Syst Sar D 30-Nov-2005
20
18 8
10 -
1
8
12
0 °
: .
] 3
¢ H
2
1
o
Passed Failed Blocked Caution Not Run Not Covered o
Failed Passed Not Run Blacked Caution
Project # Reqs Coverage
Project #Tests  #Runs  Execution Status
L 35
i 5 19
1
|
2
22
20 =
18 30
18
14 26
12 2
10
8 1
&
. 10
2 5
o
On Schedule Late Finish Late Stant Not Started o
3145 4580 8175 7800 >80
Project Tasks  Est Proj  Task Progress
Project

# Open Open By Priarity
Library Inform stem 39 1930 19i7h

Lib 34

Mo Tasks
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This page summarizes all of the information regarding the project group into a comprehensive, easily
digestible form that provides a “one-stop-shop” for people interested in understanding the overall status of
the group as a whole as well as the relative performance of the different projects that make up the group.
It contains summary-level metrics for all types of artifact (requirements, test cases, tasks, incidents, etc.)

that you can use to drill-down into the appropriate project for more details.

You will see a small “i" in a circle at the top right of every chart. Hovering or clicking on this will show you

information about that chart.

In a similar manner to the ‘My Page’, the Project Group Home dashboard is initially loaded in ‘view mode’
which means that the various ‘widgets’ on the page are displayed with minimum visual clutter (no toolbars
or control icons) that makes it easy to scan the items on the page and see the health of the status of the
project at a glance. To switch the page to ‘edit mode’, you should click the button with the cog icon (%) on
the right.

Once in ‘edit mode’, each of the ‘widgets’ displayed on the project group homepage can be minimized by
clicking on the arrow icon () in the top-left of the window, or closed by clicking-on the cross icon (X) in
the top-right of the window. In addition, the widgets allow you change their settings by clicking on the
settings icon (¥).This allows you to customize your view of the project group to reflect the types of
information that are relevant to you. If you have closed a widget that you subsequently decide you want to
reopen, you can rectify by clicking the “+ Add” button at the top of the page, and locating the closed item
from the list of ‘Closed Widgets'.

When you load the ‘Project Group Home’ for the first time it will consists of the following main elements:
» Group Overview
» Requirements Coverage
» Task Progress
>» Project List
> Test Execution Status
> Incident Aging
>» Recent Builds

However these are not the only widgets available. If you click on the “Add/Remove” items hyperlink it will

display the list of any additional widgets that are available:
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Add/Remove Items

Choose which items you'd like to add

Closed Widgets (0)

|_.-

Available Widgets
Top Open lssues

Top Open Risks

Addto| Left Side | Add Close

You can add the additional widgets by selecting the appropriate checkbox, choosing the destination
location (left side vs. right side) and then click the “Add” button. The additional widgets available in the

Project Group Home dashboard are:
>» Top Open Issues
» Top Open Risks

Each of the different widgets listed is described in more detail below:

3.5.1. Group Overview

This section displays the name of the project group, together with a brief description, the web-site that

points to any additional information about the project group, and the names of the owners of the project

group.

3.5.2. Project List

This section lists all the active projects that make up the group, together with the name, description,
project group and date of creation. To view the description of the project, simply position the mouse

pointer over the link, and a tooltip window will popup containing the description.

3.5.3. Requirements Coverage

This section consists of a bar graph that displays the aggregated count of requirements test coverage for
the entire project group. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the total count

of requirements that have tests covering them, allocated across the execution status of the covering tests

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the specific requirements coverage distribution for that project. That way you can see both the

aggregate coverage and also the relative coverage for the projects. You can configure in the widget
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settings whether you want to see the aggregate bar graph, and/or the project-specific requirements

coverage.

3.5.4. Task Progress

This section consists of a bar graph that displays the aggregated count of tasks by progress category for
the entire project group. The ‘On Schedule’, ‘Late Finish’, ‘Late Start’ and ‘Not Started’ bars indicate the

total count of tasks that are in that category for all the projects in the group.

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the specific task progress for that project (using the same coloring convention as the main
graph). That way you can see both the aggregate task progress and also the relative progress for each
project. You can configure in the widget settings whether you want to see the aggregate bar graph, and/or

the project-specific task progress.

3.5.5. Test Execution Status

This section consists of a bar graph that displays the aggregated count of test cases by execution status
for the entire project group. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the total

count of test cases that are in that category for all the projects in the group.

Under the main bar graph is displayed a table containing each project in the group and a colored bar
illustrating the specific test case execution status for that project (using the same coloring convention as
the main graph). That way you can see both the aggregate test status and also the relative status for
each project. You can configure in the widget settings whether you want to see the aggregate bar graph,

and/or the project-specific test status.

3.5.6. Incident Aging

This section displays the number of days incidents have been left open in the system. The chart is
organized as a histogram, with the count of incidents on the y-axis (for all projects in the group) and

different age intervals on the x-axis.

Under the main bar graph is displayed a table containing each project in the group and a colored bar

illustrating the distribution of open incidents by priority for that project. That way you can see both the

aggregate aging for the group and also the relative priority of open incidents for each project. You can
configure in the widget settings whether you want to see the aggregate aging histogram, and/or the

project-specific incident count by priority.
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3.5.7. Top Open Issues

This section displays a breakdown of the top issues logged against any of the projects in the group, in
order of decreasing priority. Note that items not given a priority are listed at the top, since critical issues
could be lurking in that list, and the project manager will want to immediately review these to assign
priorities. Clicking on the issue item hyperlink will take you to the incident details page for the issue in
guestion (see section 6.2). You can configure in the settings whether to use Priority or Severity for the

display, and also how many rows of data to display.

3.5.8. Top Open Risks

This section displays a breakdown of the top risks logged against any of the projects in the group, in order
of decreasing priority. Note that items not given a priority are listed at the top, since critical risks could be
lurking in that list, and the project manager will want to immediately review these to assign priorities.
Clicking on the risk item hyperlink will take you to the incident details page for the risk in question (see
section 6.2). You can configure in the settings whether to use Priority or Severity for the display, and also

how many rows of data to display.

3.5.9. Recent Builds

This widget displays a list of the most recent build and its status for each project in the program/project
group. For each project it will display whether the build succeeded or failed, the date the build occurred

and the name of the build together with a hyperlink to the build details (see section 7.2.7).

3.6. My Profile

When you click on the “My Profile” button in the global navigation, you will be taken to the page in the

system that allows you to view and edit your personal profile:
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Please review the

information listed below and make any changes if necessary

Click [Save] to save changes
User Logo:
The Avatar image cannot be more than 100k in size and no larger than 100x100
pixels square. Only JPG, GIF and PNG image types are allowed. You will need to
clear your browser cache to see the new avatar
User Name/ID:
First Name: System

Middle Initial

Last Name:

Enable RSS Feeds

RSS Token:

Department:

Organization:

Start Page:

Administrator

Yes

Generate New

My Page

Cancel

You can change your user information including your first-name, last-name, middle-initial, avatar icon,

department and your choice of start-page. Clicking the “Save” button will commit the changes, whereas

clicking <Cancel> returns you back to either “Project Home” or “My Page” depending on whether you

have a project currently selected or not.

If you want to be able to subscribe to RSS feeds of the information assigned to you in the “My Page”,

make sure that the “Enable RSS Feeds” switch is set to “Yes” and an RSS token has been generated

underneath.

You can change your start page to be any of the following:

e My Page — When you first log-in, you will be taken to your “My Page” dashboard

e Last Opened Project — When you first login-in, you will be taken to the home page for the project

you last had open

e Last Opened Project Group - When you first login-in, you will be taken to the home page for the

project group you last had open
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3.6.1. Change Password

In addition to being able to update your user information, you can optionally change your password at the
same time. To change your password, on the Change Password tab fill in the three boxes with your
current password, and your new password repeated for verification. Then when the “Save” button is
clicked, the system will update your password, otherwise you will simply get a warning message
indicating what needs to be corrected.

Passwords & Security Emzil Preferences LDAP Settings Regicnal Settings Actions

Change Passworc

To change your password, you must enter your current password and the password you would like to
change it to.

Current Password:
New Password:
Confirm Password:

Passwords are required to be a minimum of & characters in length

Change Password Question/Answer

To change your password security question/answer you need to enter your current password together with
the new question and answer

Current Password:
Question: What is 1+1?

Answer:

You can also change the current password retrieval question and answer by entering in your current

password (for security reasons) as well as the new password question and answer.

Note: If your SpiraTest user profile is linked to an account stored in an external LDAP server, you may
find the change password option is disabled. This is because the system uses the password held in the
external server. To change the password in this case, please contact your system administrator who will

be able to help you change the password in your LDAP environment.
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3.6.2. Email Preferences

Passwords & Security Email Preferences LDAP Settings Regional Settings Actions
Email Address: administrator@mycempany.com
Enable Email Yas

Motifications

If disabled, you will not get any notifications from the system
Here you can configure the email address that the application will send notifications to, and whether or
not you want to receive email notifications.
If the Enable Notifications cannot be changed, it means that the system is either not configured to send

out notifications, or the administrator has disabled user’s ability to opt out of notifications being sent.

3.6.3. LDAP Settings

This tab will show configured LDAP options for your account. At this time, no configurable options are on

this tab, it is for reference only.

3.6.4. Regional Settings

This tab will display the current culture and timezone associated with your profile:

Passwords & Security Emzil Preferences LDAP Settings Regional Settings Actions

Please choose your desired region from the list below. This setting determines which number/date formats
are used as well as which language is used throughout the application. If you don't choose a value, the

application's default value will be used
User Culture: -—- Use Application Default ---
User Timezone: --- Use Application Default ---

By default all profiles will be set to use the application’s default culture and timezone. This means that the
language, number formats and timezone used in the application will be the ones decided by the person
who installed the system. However there are cases where you want to use a different language, timezone
or number format (for example, a German employee working in the German office of a French company
might want to use the German culture instead of French). You can change the culture and/or timezone to

any of the options listed in the dropdown list.
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Note: The system will only be installed with a certain number of language packs, so in some cases a
selected culture will only change the number formats and not the languages displayed.

3.6.5. Actions

This tab displays the list of recent actions that you have performed in the system (across all projects):

Passwords & Sacurity Emazil Prefarences LDAP Settings Regional Settings Actions

Displaying 1 - O out of O items. Refresh | Y Filter | s

+ Change Date 4%  Project &% Artifact Type &% Artifact Name & Artifact ID &% Change Type &%
B | —Any - | W | - Any — | W B | - Any - w
Show | 15 % | roWs per page Displaying page = of 1

You can search and filter the grid to find changes by project, change date range, artifact type and type of
change (added, deleted, or modified).

3.7. My Timecard

When you click on My Page > My Timecard the system will display a timecard that allows you to enter the

effort worked on incidents and tasks currently assigned to you (across all your projects):

My Timecard reiso:

The following open artifacts are currently assigned to you
Please enter the hours worked and hours remaining in the appropriate effort entry boxes below:

My Assigned Tasks

Task Name Priority Start Date End Date Project Name Effort To Date  Additional Effort Remaining Effort
731 TK21  Develop new edition entry screen 10-Mar-2004  1-Mar-2004  Library Information System 7.0 hours hours 20 hours
'/_] TK22  Cre 10-Mar-2004  1-Mar-2004  Library Information System 33 hours. hours 25 hours
:] TKZ3 10-Mar-2004  11-Mar-2004 Library Information Systerm hours 30 hours
i] TK27 2 - High 8-Mar-2004  9-Mar-2004  Library Information Systam hours 60 hours
’_" TK28 2 - High 8-Mar-2004  9-Mar-2004  Library Information System 23 hours hours 25 hours
ZITK20  Write su 2 - High 8-Mar-2004  9-Mar-2004  Library Information Systam 08 haurs hours 23 hours
'/_] TK4D D 3 - Madium  25-Oct-2004 26-Oct-2004  Library Information System hours 70 hours
:] TK4l Create subject object 3 - Medium 25-Oct-2004 26-Oct-2004  Library Information System hours 50 hours
i] TK42 Write subject object 3 - Madium  25-Oct-2004 26-Oct-2004  Library Information System hours 30 hours
My Assigned Incidents
Incident Name Priority Severity Start Date Project Name. Effort Ta Date  Additional Effart Remaining Effort
s 19-Nov-2003 Library Information System Q. hours hours a3 hours

3 ystem Limitation 6-Dec-2003 Library Information System Q.7 hours hours 02 hours
BN Te ng Item 2 - High 3 Dec2003  Library Information System hours 04 hours
E] INg Editing the date on a book is clunky 2 - High 4 - Low 5-Nov-2003 Library Information System hours 02 hours
B A e ng Item 2 - High 3 Dec2003  Library Information System hours 03 hours
!] INS3 ge Request 3 - Medium 7-Dec-2003 Library Information System hours 04 hours
E] IN23  Ability to import data from excel 3 - Medium 2 - High 25-Nov-2003 Library Information System 0.3 hours hours ol hours
E" N8 Te: stem Limitation 3 - Medium 3 - Medium 6-Dec-2003 Library Information System 13 hours hours o1 hours
E] IN61  Sample Risk 3 4-Low 4 - Low 10-Dec-2003 Library Information System 0.8 hours hours a1 hours

Submit Timecard LY
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The system will only include projects that have time-tracking enabled for incidents and tasks, so if some
of your assigned incidents or tasks are missing, please check with the project owner of the projects
affected to have them enable time-tracking.

Each task or incident will be displayed along with its priority, severity, start-date, end-date, project name
effort remaining and effort expended to date. For each item you can then indicate the additional actual
effort performed (which will be added to the “actual effort”) and modify the amount of hours remaining.

Once you are satisfied, click [Submit Timecard] to commit the changes.
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4. Requirements Management

This section outlines how the requirements management features of SpiraTeam® can be used to develop
a requirements / scope matrix for a project, and how you can map any existing test-cases to the
requirements. Typically when starting a project, developing the requirements list is the first activity after
the Administrator has set up the project in the system.

4.1. Requirements List

When you click on the Planning > Requirements link on the global navigation bar, you will initially be

taken to the requirements list screen illustrated below:

IQ Planning = Testing =

You can search by keywords or by entering an artifact un
incident 45)

v OlLibrary Informat

Reporting

- - oken (e.g. INAS for
Requirements / PlanningBoard / Releases / Documents

Quick Filte a + Insert v X Delete = Indent 4= Outdent & Refresh Show Level v YrFiter v @Edit v RTools w Show/hide columns v
displaying 15 out of 35 requirement(s) for this projec
4 Critical Not-Cover... _
+ % Name Test Coverage Progress Importance Status Release Type D Difficulty
~ Any ~ Am v Any ~ Am v Any v RQ
Components m]
[m} In Progress Package RQ:1
& Administration
& Author Mar m. a In Progress Package RQ:2
& Book Management a 1-Critical Developed Package RQ:3
O% 1-Critical Developed 1 Feature RQ:4 Moderate
Releases m} 1-Critical Developed Feature ROES
4 @Library System... [m] 1- Critical Developed C Feature RQu6
4+ @ Library Syste.
E Developed 1 Feature ROQ:7
£ Iteration 001 o R ' ! *
8) Iteration 002 m] 1-Critical Developed L1 Feature RQ:8
B Iteration 003 m} 1-Critical Developed Feature ROQ:?
+ [ Library Syste... ] 1-Critical Developed 1 Feature RQ:10
ik teration 001 ] ed 1-Critical In Progress Package RO:11
a 2-High In Progress Package RQ:13
[m} 3-Medium Planned Package RQ:19
O ] No Task 3-Medium Requested Package RQ:22
O «Museca No Task Completed Package RQ:29
3 Library System... Show 1 ¥ rows per page Displaying page 1

The requirements list consists of a hierarchical arrangement of the various requirements and
functionalities that need to be provided by the system in question. The structure is very similar to the
Work Breakdown Structure (WBS) developed in Microsoft Project®, and users of that software package
will find this very familiar to use. When you create a new project, this list will initially be empty, and you

will have to start using the “Insert” button to start adding requirements.

Requirements come in two main flavors: summary items shown in bold-type, and detail items shown in
normal-type with a hyperlink. When you indent a requirement under an existing requirement, the parent is
changed from a detail-item to a summary-item, and when you outdent a child item, its parent will return to
a detail-item (assuming it has no other children). This behavior is important to understand, as only detalil
items are assigned a status themselves; the summary items simply display an aggregate of the worst-
case assessment of their children’s status. Both summary and detail items can be mapped against test-

cases for test-coverage, in addition the summary items display an aggregate coverage status.
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Each requirement is displayed along with its importance/priority (ranked from “Critical” to “Low”), its
completion status (from “Requested” to “Completed”), the version of the software that the requirement is

planned for, and graphical indicators that represents its test coverage status and its task progress.

For those requirements that have no test-cases covering them (i.e. validating that the requirement works
as expected) the indicator consists of a white solid bar, bearing the legend “Not Covered”. For those
requirements that have at least one test-case mapped against them, they will display a block graph that
illustrates the last execution status of each of the mapped test-cases. Thus if the requirement is covered
by two test cases, one of which passed, and one of which wasn’t run, the graph will display a green bar
(50% passed) and an equal length gray bar (50% not run). To determine the exact requirements
coverage information, position the mouse pointer over the bar-chart, and the number of covering tests,

along with the pass / fail / blocked / caution / not-run breakdown will be displayed as a “tooltip”.

For those requirements that have at least one task associated with them, they will display a block graph
that illustrates the relative numbers of task that are on-schedule (green), late-starting (yellow), late-
finishing (red) or just not-started (grey). These values are weighted by the effort of the task, so that larger,
more complex tasks will be change the graph more than the smaller tasks. To determine the exact task
progress information, position the mouse pointer over the bar-chart and the number of associated tasks,

along with the details of how many are in each status will be displayed as a “tooltip”.

4.1.1. Insert

Clicking on the <Insert> icon inserts a requirement above the currently selected requirement — i.e. the one
whose check-box has been selected, at the same level in the hierarchy. If you want to insert a
requirement below an existing item, you can use the Insert > Child Requirement option instead. If you
insert a requirement without first selecting an existing requirement from the list, the new requirement will
simply be added at the end of the list. Note that if the full list of requirements are paginated, the new

requirement will be at the bottom of the last page.

Once the new requirement has been inserted, the item is switched to “Edit” mode so that you can rename

the default name and choose a priority, status and/or author.

4.1.2. Delete

Clicking on the “Delete” button deletes all the requirements whose check-boxes have been selected. If
any of the items are summary items, the child requirements are also deleted. If all the children are deleted

from a summary item, it changes back into a non-summary item.
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4.1.3. Indent

Clicking on the “Indent” button indents all the requirements whose check-boxes have been selected. If
any of the items are made children of a requirement that had no previous children, it will be changed from

a detail item into a summary item.

4.1.4. Outdent

Clicking on the “Outdent” button de-indents all the requirements whose check-boxes have been selected.
If any of the items were the only children of a summary requirement item, then that item will be changed

back from a summary item to a detail item.

4.1.5. Refresh

Clicking on the “Refresh” button simply reloads the requirements list (not the entire page). This is useful
as other people may be modifying the list of requirements at the same time as you, and after stepping
away from the computer for a short-time, you should click this button to make sure you are viewing the

most current requirements list for the project.

4.1.6. Edit

Each requirement in the list has an “Edit” button display in its right-most column. When you click this
button or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit”

mode. The various columns are made editable, and “Update” “Cancel” buttons are displayed in the last

column:

S
v rnal Projects V'
Internal Project:

Reguirements

Documents

n Fred Bloggs Vv

Planning Board Releases

4 Insert v | X Delete | = Indent | % Outdent | - Show Level— v| SRefresh | @Edit v | @ Tools | v | - Showhide columns-- | v | ¥ Filter | v
Displaying 15 out of 38 requirement(s) for this project.
v % Name TestCoverage  Progress Importance Status Release Type D Edit

> Ay | v | (A v Ay | v —any- | v —any | v ay- | v| RQ Edit
4 ByUseCases NoTasks Completed Package RQ:29 Edit
NoTasks Completed Use Case RQ:30 Edit
NoTasks Completed Use Case RQ:31 Edit
NotCovered  NoTasks Completed Use Case RQ:32 Edit

u -None— | v @ InProgress one- v &= Package E3 «
u Developed Package RQ:3 Edit
D) Developed 10000001 Feature RQ:4 Edit
Developed 10000001 Quality RQ:s Edit
Developed Need RQ:6 Edit
. Developed Feature RQ7 Edit
Developed 11000001 Feature RQ:8 Edit
- Developed 11000002 Feature RQ:9 Edit
- Developed 1200 Feature RQ:10 Edit
4 yEdition Management NotCovered [N In Progress Package RQ:11 Edit
#)Ability to create different editions NotCovered [N In Progress 10000003 Feature RQ:12 Edit

Show 15 v rowsperpage ja«Displaying page| 1 |5 of 3pp

If you click “Edit” on more than one row, the “Update” and “Cancel” buttons are only displayed on the first

row selected. You can make changes to all the editable rows and then update the changes by clicking the
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one “Update” button. Also, if you want to make the same change to multiple rows (e.g. to change five
requirements from “In Progress” status to “Completed”), you can click on the “fill” icon to the right of the

editable item, which will propagate the new value to all editable items in the same column.

#)Deleting an existing book Not Covered No Tasks Completed UseCase RQ:32 Edit
7| Online Library Management € v = s v = Package m Cancel
Critial| v Developed v Package
LY Critical | v Developed| v/ v Feature | v
1-Ctical | v Developed| v v quality | v
1-Critical | v Developed| v/ v Need v
1-Critical Developed Feature RQ7 Edit

If you want to edit lots of items, first select their checkboxes and then click the [Edit] button on the same

row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Save” to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

4.1.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily view the
entire requirements list at a specific indent level. For example you may want to see all requirements
drilled-down to the third level of detail. To do this you would simply choose ‘Level 3’ from the list, and the

requirements will be expanded / collapsed accordingly.

4.1.8. Filtering

You can easily filter the list of requirements as illustrated in the screen-shot below:

V  Internal Projects Library Information System -n Planning -  Testing~  Tracking~  Reporting n Fred Bloggs Vv
Requirements / PlanningBoard / Releases / Documents
+ Insert | v % Delete = Indent | 4= Outdent | ---ShowLevel - v | CRefresh || (@ Edit v  %#Tools v  —Show/hidecolumns—| v ¥ Filter v
Displaying 11 out of 38 requirement (s) for this project. Filtering results by Status.| Clear Filters
v @ Name TestCoverage  Progress Importance Status Release Type D Edit
2 Any - v ~Any- ™ Any - v Requested v - Any - v - Any - v RQ Edit
4 [EOnline Library Management System In Progress Package RQ2 Edit
4 [ZjAdministration Functions Not Covered No Tasks 3- Medium Requested Package RQ:22 Edit
No Tasks 3-Medium Requested Feature RQ:23 Edit
No Tasks 4-Low Requested Package RQ:24 Edit
Q No Tasks 4-Low Requested Feature RQ:25 Edit
No Tasks 3-Medium Requested Feature RQ:26 Edit
tem No Tasks 3-Medium Requested Feature RQ:27 Edit
No Tasks In Progress Package RQ:33 Edit
No Tasks Requested Feature RQ:37 Edit
No Tasks Requested Feature RQ:38 Edit
No Tasks Requested Feature RQ:39 Edit
Show | 13 v rows per page ra«Displayingpage| 1 mof2mm

To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) then click the <Filter> icon or press
the <ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
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comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, requirement numbers). In the screen-shot

above, we are filtering on Status = Requested.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. If you
would like to share the filter with other members of the project, choose the “Share with other members of

the project” option. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

Displaying 11 out of 38 requirement(s) for this project. Filtering
Save Filter
v % Name JETESS
Please choose a name for this filter:
Bny - v
4 [FOnline Library Management System
_ . . . Share with other members of the project
4 [ZAdministration Functions Tasks
=4 Ability to completely backup the database ﬂ Cancel Tasks
=]
4 [FData Import Functionality Not Covered No Tasks
¥ ZjAbility to import from legacy system x N No Task
<=4 Ability to create new users in the system Not Covered No Tasks
=
<=4 Ability to modify existing users in the system Not Covered No Tasks
=]
4 [ZSystem Qualities Not Covered No Tasks
C eg Not Covere No Task
Not No Task
N ere No Task

Show | 15 ' | rows per page

As a shortcut, the left hand panel includes a set of Quick Filters that can be applied in a single-click:

e The topmost section — This displays any saved requirement filters created by the current user

alongside any ‘shared’ filters. The latter are marked with an icon showing a group of people.

¢ Components — This section lists the components defined for the current project. Clicking on any
of the components in the list will filter the requirements to only show those that belong to the

selected component.

e Releases — This section lists the releases and iterations defined for the current project. Clicking

on any of the releases or iterations in the list will filter the requirements by that release/iteration.

4.1.9. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the requirement list as columns

for the current project. To show a column that is not already displayed, simply select that column from the
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list of “Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.

4.1.10. Copying Requirements

To copy a requirement or set of requirements, simply select the check-boxes of the requirements you
want to copy and then select the Edit > Copy Items menu option. This will copy the current requirements
selection to the clipboard. Then you should select the place where you want the requirements to be

inserted and choose the Edit > Paste Items option.

The requirements will now be copied into the destination location you specified. The name of the copied
requirements will be prefixed with “Copy of...” to distinguish them from the originals. Note that copied

requirements will also include the test coverage information from the originals.

4.1.11. Moving Requirements

To move a requirement in the requirements hierarchy, there are two options:

1. Click on the requirement you want to move and then drag it to the location you want it moved. An

empty space will appear to show you where it will be inserted:

+ % Name Test Coverage Progress Importance Status Release Type D Edit

Anry - v - Any - v Ay v Ay v - Any - v Any - v RQ Edit

4 BUseCases Developed Package RQ:29 Edit
= 1-Critical

EETNCA—— EVe10pea B EIAPAUAY, U, PFag Need R EQIT

At Completed Use Case RQ:30 Edit

Comp Use Case RQ:31 Edit

i Completed Use Case RQ:32 Edit

In Progress Package RQ:2 Edit

1-Critical Developed Package RQ:3 Edit

2 1-Critical Developed 1000.0001 Feature RQ:4 Edit

1-Critical Devel Quality Q'S Edit

1-Critical Developed Feature RQ7 Edit

1- Critical Developed Feature RQ8 Edit

1- Critical Developed Feature RQ:9 Edit

1-Critical Developed 1200 Feature RQ:10 Edit

4 [EEdition Management Not Covered 1-Critical In Progress Package RQ:11 Edit

EAbilit 1- Critical In Progress 10000003 Feature RQ:12 Edit

Displayingpage, 1 |wof3mm

Once you have the requirement positioned at the correct place that you want it inserted, just release the
mouse button. To move multiple items simply select their checkboxes and then drag-and-drop one of the

selected items.

2. Alternatively you can simply select the check-boxes of the requirements you want to move and

then select the Edit > Cut menu option. This will cut the current requirements selection to the
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clipboard. Then you should select the place where you want the requirements to be inserted and
choose the Edit > Paste option. The requirements will now be moved into the destination location

you specified.

4.1.12. Exporting Requirements

To export a requirement or set of requirements from the current project to another project in the system,
all you need to do is select the check-boxes of the requirement(s) you want to export and then click the

Tools > Export To Project button. This will then bring up a list of possible destination projects:

+ Insert | v | % Delete = Indent 4= Outdent | --—- Show Level — v & Refresh @ Edit |v R Tools
Displaying 15 out of 38 requirement( ™"
Export Items
v % Name Test Coverage Progress
Please select the project you want to export to: - Ay -- v - Amy -~ v
4 [FUseCases -—Select Project --- v No Tasks

No Tasks

No Tasks
Cancel
Mot Covered No Tasks

4 3 Online Library Management System

4 [FBook Management

% ) Ability to add new books to the system

Once you have chosen the destination project and clicked the “Export” button, the requirements will be
exported from the current project to the destination project. Any file attachments will also be copied to the

destination project along with the requirements.

4.1.13. Creating Test Cases from Requirements

To quickly create test cases from a group of requirements, all you need to do is select the check-boxes of

the appropriate requirements and then click Tools > Create Test Cases. This will then create new test

cases based on the selected requirements.

4.1.14. Creating a Test Set from Requirements

To quickly create a new test set from a group of requirements, all you need to do is select the check-

boxes of the appropriate requirements and then click Tools > Create Test Set. This will then create new

test set containing the test cases that are already mapped to the selected requirement(s).

4.1.15. Printing Items

To quickly print a single requirement or list of requirements you can select the items’ checkboxes and
then click Tools > Print Items. This will open a new window containing a printable version of the selected

items.
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4.1.16 Focus-On Branch

Sometimes you will a list of filtered requirements displayed and you would like to view all of the items that

in the same branch of the requirements tree, even those that don’t match the current filter. To view the

branch, select the checkbox of the branch and then click Tools > Focus on, and the system will clear the

current filters and then expand just the selected branch.

4.1.17. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly

used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the

context menu, right-click on any of the rows in the requirements list and the following menu will be

displayed:
3 ¥ Creating a new book
rd ) Editing an existing book in the system k Open ltem |
J ¥ Deleting an existing book from the system @ OpeninNewTab  tred
4 [ Online Library Management System Focus On |
a [Z)Book Management + Insert I
S 25 Ability ¢ [# Edit ltems
) Ability t ® Delete
= Ability t = Indent
) Ability to ass ooks with different subje: 4 Outdent |
ﬁilzi ity to ass ooks with different authors £ Copy Items
= Ability to associate books with different editions 3¢ Cutltems |
) Ability to completely erase all books stored in th.. &, PasteItems |

4 [ Edition Management

=4 Print ltems

tred

You can now choose any of these options as an alternative to using the icons in the toolbar.

4.1.18. Viewing Requirements from Shared Projects

If you are displaying the requirements list for a project has required shared from other projects, you will

see the option on the top-right to view the requirements from the shared project(s):

Z Refresh
Displaying 1 out of 1 requirement(s) for this project.
¥ % Name TestCoverage  Progress
m] Any — ~ — Any
] ) Sample
Show 15 ~ rows per page

- Show Level — v ¥ Filter v
Importance Status

v ||| —ay- v ~Any v
2-High Completed

$Tools v | --Show/hidecolumns— v
Current Project Al Projects
Author Release Type D Edit
Any— |~ —Ay—- v Ay v RQ
Fred Bloggs Feature RQ:28
Displaying page 1 Sof1l

If you choose the option to show the requirement from ‘All Projects’ and not just the current project, the

shared projects are displayed, grouped under the name of the project they are being shared from:
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Z Refresh  —Show Level — Vv Y Filter v £} Tools | V| - Show/hide columns - | v/
Displaying 15 out of 36 requirement(s) for this project. Current Project | Al
+ Q Name Test Coverage Progress Importance  Status Author Release Type D
O —Any— | v —Ay— v —Ay— v | —Ay— v | —Any— v | —Any— | v | |—Any—- v |RQ
O  $sampleRequirement Not Covered No Tasks 2-High Completed Fred Bloggs Feature RQ:28
4 [ Library Information System
4 2 Functional System Requirements 1 In Progress Fred Bloggs Package RQ:1
4 [ZOnline Library Management System 1 In Progress Fred Bloggs Package RQ:2
4 T2Book Management Developed Fred Bloggs Package RQ:3
Q ) Ability to add new books to the system Developed Fred Bloggs 10000001  Feature RQ:4
) Ability to edit existing books in the system Developed Fred Bloggs 10000001  Feature RQ:S
) Ability to delete existing books in the system Developed Fred Bloggs 10000002  Feature RQ:6
) Ability to associate books with different subjects Developed Fred Bloggs 11000001  Feature RQ7
) Ability to associate books with different authors Developed Fred Bloggs 11000001  Feature RQ:8
) Ability to associate books with different editions Developed Fred Bloggs 11000002  Feature RQ:?
) Ability to completely erase all books stored in the system with one click Developed Fred Bloggs 1200 Feature RQ:10
[E Edition Management Not Covered [ ] In Progress Fred Bloggs Package RQ:11
73 Author Management 1 2-High In Progress Joe P Smith Package RQ:13
72 Subject Management Not Covered 3-Medium Planned Joe PSmith Package RQ:19
Show 15 v |rows per page Displaying page 1

Note: Any requirements shared from other projects will be

read-only and won’t display any of their custom

properties. However you can expand/collapse these shared requirements and filter using the standard

fields.

4.2. Requirement Details

When you click on a requirement item in the requirements

the requirement details page illustrated below:

-] o

& (B T PREITEE (W ~ [Dclone £ Refresh X Delete | ## Tools

£ ~

Display: Current Filter| & | &

4 T3 Functional System Require

= Online Library M . . B
# [ Online Library Manageme B Requirement [RQ:4] Type:" Feature

4 3 Book Management
| 1 asiity to add new bool

& Email

list described in section 4.1, you are taken to

7 Subscribe |

Ability to add new books to the system

Status™ Developed | Operationsv

Qvenizw Test Coverage Tasks Attachments History Associations

) Ability to edit existing

& Ability to delete existi.. P Time

) Ability to associate bo.. Importance: 1 - Critical

& Ability to ssociat

) Ability to associate bo Component: Book Management

2 Ability to a -

By Ability to associate bo.. URL- hitp://www libraries arg Estimate (points)- 20 160n

&) Ability to completely Author: Fred Bloggs

Difficulty: Moderate Review Date: 7/3/2012

a [ Edition Management Owner. Joe P Smith

Classification:

i3

Ability to create differ.
Ranking:
4 g Author Management

4 T3 Ability to add new au

) Ability to edit exist

Decimal:

——- Please Select
1

1234

The ability to add new books into the system, complete with ISBN, publisher and other related information

Show | 15 Vv | rows

This page is made up of three areas;

1.
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2. theright pane’s header, which displays: the operations toolbar; the editable name of the selected
requirement; and the info bar (with a shaded background), which also contains the workflow
status transitions (see below); and

3. theright pane’s tabbed interface with rich information related to the requirement.

Please note that on smaller screen sizes the navigation pane is not displayed. While the navigation pane
has a link to take you back to the requirements list, on mobile devices a ‘back’ button is shown on the left

of the operations toolbar.

The navigation pane can be collapsed by clicking on the “-“ button, or expanded by clicking anywhere on
the gray title area. On desktops the user can also control the exact width of the navigation pane by
dragging and dropping a red handle that appears on hovering at the rightmost edge of the navigation

pane.

The navigation pane shows a list of the peer requirements to the one selected. This list is useful as a
navigation shortcut; you can quickly view the coverage information of all the peer requirements by clicking
on the navigation links without having to first return to the requirements list page. The navigation list can
be switched between three different modes:

e The list of requirements matching the current filter
e The list of all requirements, irrespective of the current filter
e The list of requirements assigned to the current user

On the main right hand side of the page, which of the fields for the currently selected requirement are

available and which are required will depend on your stage in the requirement workflow. For example, a
requested requirement might not require a “Release” whereas a planned requirement could well do. The
types of change allowed and the fields that are enabled/visible/required will depend on how your project
administrator has set up the system for you. Administrators should refer to the SpiraTeam Administration

Guide for details on configuring the requirement workflows to better meet their needs.

Depending on the user’s role and whether they are listed as the owner or author of the requirement,
displayed in the info bar beneath the requirement name is the current workflow status and an “operations”

button which, when clicked, will show a set of allowed workflow operations:

= Type: Feature Status:* Developed | Operations~

Continue Development

Overview Test Coverage asks Attachments History Associations

Mark as Completed

Mark as Tested
Importance: 1 - Critical
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These workflow transitions allow the user to move the requirement from one status to another. For

example when the requirement is in the Developed status, you will be given the options to:
» Continue Development — changes status to “In-Progress”
» Mark as Completed — changes the status to “Completed”
» Mark as Tested- changes the status to “Tested”

After changing the status of the requirement by clicking on the workflow link, you can then fill in the
additional fields that are now enabled and/or required. Once you’'ve made the changes to the appropriate

requirement fields, you can either click “Save”, “Save and Close”, or “Save and New” to commit the

changes or “Refresh” to discard the changes and reload the requirement from the database. In addition

you can print the current requirement by clicking “Print”, which will display a printable version of the page
in a separate window.

Please note that if digital signatures have been enabled for a particular workflow operation (and therefore
a digital signature is required to confirm the status change. Workflow operations requiring a digital
signature are marked with a padlock icon:
Operations=
Continue Development &
Mark as Completed

Mark as Tested

On attempting to save changes made after clicking a workflow operation that requires a digital signature
you will be presented with the following popup:
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Enter Electronic Signature

Please enter your login/password together with the meaning and click
Sign:

Login: administrator

Password:

Changing Reguirement RQ:4 from 'Developed’ to 'In Progress’

Meaning:

Cancel

Using the “Email” button on the toolbar, you can send an email containing details of the requirement to an

email address or another user on the system:

Email this artifact to

*Project User:
Amy E Cribbins

Select a user in the project to send to

Email Addresses:

A list of email addresses, separated by ;

Message Subject:

Leave blank for default

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration

— Notification Templates.

To be notified of any changes made to the current artifact via email, click the “Subscribe” button. If you

already subscribed, the button will instead let you “Unsubscribe” to stop receiving emails about that
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particular artifact. Depending on your role, you may also see a dropdown arrow to the right of this button.

This will let you subscribe others in the project to this artifact.

The bottom part of the right pane can be switched between six views: “Overview”, “Test Coverage”,

“Tasks”, “Attachments”, “History” and “Associations”, each of which will be described in more detail below.

4.2.1. Overview - Details

The Overview tab is divided into a number of different sections. Each of these can be collapsed or
expanded by clicking on the title of that section. It displays the description, fields and comments

associated with the requirement.

The top part of this tab displays the various standard fields and custom properties associated with the
requirement. Fields (both standard and custom) are grouped under the collapsible headings (marked by
orange text and underline) in the screenshot below. For instance, all fields regarding dates are grouped

together in the “Dates and Times” area.

Overviaw Test Coverage Tasks Attzchments History Associations
Importance 1 - Critical
Component Book Management
URL http://www libraries org Estimate (points): 20 16.0h
Author: Fred Bloggs
Difficulty: Moderate Review Date 713/2012
Owner: Joe P Smith
Classification: --- Please Select ..
Ranking 1
Decimal 1234

4.2.1.1. Followers

Using the “Subscribe” button on the toolbar, you can quickly follow the item, and receive updates on
certain changes to it. Depending on your role, you may also see a dropdown to this button, which let's
you add another project member as a follower to this item.

— B e
-

B4 Email | 17 Subscribe | s

& Add Follower
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Add Follower

.o QloOWeE

Select a user in the project to follow this artifact

Amy E Cribbins v

Cancel

You can also quickly see who is following an incident under the “People” section in the Overview tab.

Followers (2)
T e
]

To view information about the follower, or to unfollow them from the item, hover over their avatar to

display a user profile card.

Amy E

Cribbins Remove
follower

4.2.2. Overview — Detailed Information

The Detailed Information section contains the long, formatted description of the requirement, as well as
any rich text custom fields. You can enter rich text or paste in from a word processing program or web
page into these fields. Clicking on the shaded areas of one of these detailed fields will display the rich text
toolbar.
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The ability to add new books into the system, complete with ISBN, publisher and other related information

Motes:

4.2.3. Overview - Comments

The Comments section allows you to add and view discussions relating to the requirement:

Displaying | newest first oldest first

1 OK, that's much better, thanks for adding the additional information.

- You're right, | have added some more detail and linked to some test cases that define how the functionality is expected to work.

1 Need to write a better definition of this requirement, it has too many loose-ends.

Format -  Font - Sz - B I U I, A-EB- I := XE 9

Existing comments are displayed in order underneath the textbox in date order (either newest first or

oldest first). To add a new comment, enter it into the textbox, and click the “Add Comment” button.

4.2.4. Overview — Scenario

If you are editing a ‘Use Case’ type of requirement, there will be a special ‘Scenario’ section where you

can enter in the scenario steps that define the use case:

© Copyright 2006-2017, Inflectra Corporation Page 70 of 312

)

@ 22| [ Source

= [ = |

This document contains Inflectra proprietary information




= Insert Step X Delete [0 Clone < Refresh

% Step Description ID Edit
) step 1 User logs into the system R=:1 Edi
) Step 2 User chooses option to create new baok RS2 Edit
] Step 3 User enters books name and author RS3 Edi
] Step 4 User chooses book's genre and sub-genre from list RS54 Edi
) step 5 User commits the changes and the new book is added to the system RSS Edit
Show | 15 v | rows per page Displaying page | 1 Zofl

This sections displays the various steps that a user would perform when carrying out the defined use
case. The list of use case steps displays the position number, and the description. If a test case is created

from this use-case, the steps will be used to create the test steps.

Clicking on the “Insert Step” button inserts a new step before the currently selected (by means of the
check-box) step. Clicking the “Insert Step” button without selecting an existing step will insert a new step
at the end of the list. When a new step is inserted, the fields are displayed in “Edit” mode, so the

description, field is editable, allowing you to enter the data:

+ Scenario

Insert Step Delete Copy Refresh
@ Step Description ID Edit
B I U A lal x

User logs into the system

#)Step 2 User chooses option to create new book RS:2 Edit
) Step 3 User enters books name and author RS:3 Edit
#)5tep 4 User choc yook's genre and sub-genre from list RS:4 Edit

#)Step 5 User commits the changes anc RS:5 Edit

Show | 15 v rOWS per page 4« Displayingpage 1 %oflpm

To move the steps in the list, click on the step you want to move and drag it to the location you want it

moved.

4.2.5. Test Coverage

This tab shows the test coverage information for the requirement in question:
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Add ® Remove | & Refresh T Filter
Displaying 1 - 3 out of 3 association(s)
¥ Type Name Status Execution Status Last Executed Priority Project Name D
— Any - | W —Any - | v || Ay — | W B —-Any - | v || Ay — | v

Library Information

Functional 23 Ability to create new bol Ready for Test |Passed 1-Dec-2003 1 - Critical - TC2
System
. Library Infarmation
Regression &7 Book management Ready for Test |Passed 1-Dec-2003 2 - High — TC8
Sys
. ew book and author to Library Information
Scenario LEneE : Approved Not Run 3 - Medium F‘ Ry dnrermatier TC13
System
Show | 15 % | rows per page Displaying page | 1 Zof 1

The tab displays a grid containing the test cases already mapped to this requirement. You can filter that
list by the test case type, name, status, execution status, execution date, priority, project name and ID.
You can remove an existing test case by selecting its check box and clicking the ‘Delete’ button. This

doesn’t delete the test case, just removes it from the requirement.

Hovering the mouse over the names of the test cases will display a “tooltip” consisting of the test case
name, place in the folder structure and a detailed description.

To add a new test case to the requirement, simply click on the ‘Add’ button:
Root + Q Search

~No matches found ~

Cancel + Create Test Case From This Requirement £73

You can search for a test case by its ID if you know it (make sure to include the “TC” prefix):

Root v  TC4 Q Search
v ID Name Project
O TC:4 X7 Ability to create new author Library Information System
Cancel + Create Test Case From This Requirement X7

Otherwise, you can search for the test cases by choosing a folder from the dropdown and/or entering a

partial name match:
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Root ~ | book

¥ ID Name

O Tc:s X7 Ability to edit existing book

[ Tce X7 Ability to reassign book to different author

[ 1c: 19 L_] Adding multiple new books

[ 1C: 18 L_] Adding new author and book

[ TC:21 X Create Book

[ 1c12 L_] Person loses book and needs to report loss
Cancel

Q Search

Project

Library Information System
Library Information System
Library Information System
Library Information System
Library Information System

Library Information System

+ Create Test Case From This Requirement 23

One you have found the desired test case(s), simply select their check boxes and click the ‘Save’ button

to add them to the current requirement:

Root »  book Q Search
v ID Name

[ Tc:3 X7 Ability to edit existing book

O T1c6 Z7 Ability to reassign book to different author

TC:19 X7 Adding multiple new books

TC: 18 X7 Adding new author and book

O TC:21 X9 Create Book

0112 l_] Person loses book and needs to report loss

2 Row(s) selected

‘: Cancel

Project

Library Information System
Library Information System
Library Information System
Library Information System
Library Information System

Library Information System

+ Create Test Case From This Requirement l_]

Finally, as a shortcut you can click the “Create Test Case from This Requirement” button to create a

new test case in the list of covered test cases that will be automatically linked to this requirement. This is

useful when you have created a new requirement and want to generate an initial covering test to be

fleshed-out later.

4.2.6. Tasks

This tab shows the list of project tasks that need to be completed for the requirement to be satisfied:

+ Mew Task ¥ Remove Z Refresh

T Filter | » — Show/hide columns —
Displaying 1 - 3 out of 3 task(s). Filtering results by Requirement #  Clear Filters
v % Name Progress Type Status
— Any — | W — Ay - | W | --Amy - | W
Developmeant Completed
Developmeant Completed
Developmeant Completed

v Est Effort 16.0h / Projected Effort 0.0h
Priarity Owner Release D & Edit
—Any - | W || ——Any — | v ||| Any — v || TK Edit
1 - Critical Fred Bloggs 10.0.0.0001 TK: Edit
1 - Critical Fred Bloggs TK:2 Edit
1 - Critical Fred Bloggs TK3 Edit
Displaying page = of 1

Each of the tasks is displayed together with, by default, its name, description (by hovering the mouse over

the name), progress, priority, start-date, current owner, estimated effort, projected effort and numeric task
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identifier. Clicking on the task name will bring up the Task Details page which is described in more detail

in section 8.2. This allows you to edit the details of an existing task.
You can perform the following actions on a task from this screen:

» New Task — inserts a new task in the task list with a default set of values. The task will be

associated with the current requirement.
» Remove —removes the task from this requirement without actually deleting the task

> Refresh — updates the list of tasks from the server, useful if other people are adding tasks to this

requirement at the same time.
> Filter / Apply Filter — Applies the entries in the filter boxes to the list of tasks

» Clear Filters — Clears the current filter, so that all tasks associated with the current requirement

are shown.

> Edit — Clicking the “Edit” button to the right of the task allows you to edit the task inline directly on

this screen. Only columns visible will be editable.
» Show/Hide Columns — Allows you to choose which Task columns are visible
The system has a series of shortcuts that simplify the editing of requirements and tasks:

> If you create a new task on the requirements page, the priority, release/iteration and owner are
automatically copied from the parent requirement. You can change these suggested values

before clicking “Save”

» When you assign a release/iteration to a requirement, its status automatically changes to
“Planned”

» When at least one task assigned to the requirement changes from “Not Started” to “In Progress”,

the parent requirement automatically switches from “Planned” to “In Progress”

>» When all the tasks under the requirement are completed, the parent requirement will switch to the

“Completed” status.

> If you manually move a requirement that has no associated tasks from “Planned” to “In Progress”,
the system will automatically generate one task under the requirement and use the requirement’s

planned effort field to generate the task’s estimated effort.
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4.2.7. Attachments
The attachment tab displays the list of documents, screenshots or web-links (URLS) that have been
“attached” to the requirement. The documents can be in any format, though SpiraTeam® will only display

icons for certain known types.

+ Add New S Add Existing Z Refresh —- Show/hide columns —— | & T Filter

Displaying 1 - 4 out of 4 attachment(s)

¥ Filename Type Size Edited By Edited On &% Authar D Edit
— Any — | w = — Any — | W =] — Any — | w | DC Edit
) Book Management Functional Spec.doc Functional Specification 285 KB Joe P Smith 29-May-2006 Fred Bloggs DCl Edit
Screen Layout 1009 KB Joe P smith 30-Apr-2006 Joe P smith DC:13 Edit
Functional Specification 0 KB Fred Bloggs 30-Apr-2006 Fred Bloggs DC5 Edit
P Book Management Screen Wireframea Screen Layout 392 KB Fred Bloggs 31-Mar-2006 Joe P Smith D Edit
Show | 15 v | rows per page Displaying page 1 Zofl

The attachment list includes the filename/URL that was originally uploaded together with the file-size (in
KB), name of the person who attached it and the date uploaded. In addition, if you position the pointer

over the filename and hold it there for a few seconds, a detailed description is displayed as a tooltip:

T ite
Book Management Functional Spec.doc
£ Filename: Book Management Functional Spec.doc & i
4 Document Type: Functional Specification A
~ | File Type: Word Document B8]
This document outlines the functional A
Description: specification for the book management part
= of the library management system. *
Version: 20
book management | | functional specification
Tags: o
libraries
Created By: Fred Bloggs 5/1/2006 8:00:00 PM
Edited By: Joe P Smith 3/29/2006 8:00:00 PM
1D: [DC:000001]
View Details Cancel

To actually view the document, click on the filename hyperlink and a new web browser window will open.
Depending on the type of file, this window will either display the document / web-page or prompt you for a
place to save it on your local computer. To remove an existing attachment from a requirement, simply
click the “Remove” button and the attachment will be removed from the list. Using the standard filter/sort

options you can also sort and filter the list of attachments to make it more manageable.
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If you are using SpiraPlan or SpiraTeam (but not SpiraTest) you can also choose to include file
attachments stored in a linked version control system (e.g. Subversion, CVS, Perforce, etc.) by selecting

the “Include Source Code Documents” option.

To attach a new document to the requirement, you need to first click the “Add New” button to display the

new attachment dialog box:

Add New Document Add New Document Add New Document
#* * *
Type ®File OURL O Screenshot Type File ®IURL O Screenshot Type' File ©'URL ® Screenshot
Filename:* Choose File | Mol chosen URL"
Description: Description:
4 4 Screenshot"
o i nal Sos ion
Document Type: Functional Specification | v Document Type:* Functional Specification | v

.
Document Folder: Root Folder v Document Folder:" | Root Folder v

Tags:

: Description:

Document Type:* Functional Specification | v
Document Folder:* Root Folder v

Tags:

There are three different types of item that can be attached to a requirement:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the “Upload” button to attach the web-link.

> To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”
to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the requirement.

To do that, click on the “Add Existing” button to bring up the add file association dialog box:
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http://mywebsite.com/?Document=1

Add Existing Document Add Existing Document

Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
®) Documents Source Code Documents [8] Source Code

Folder v Document Folder v File

&3 Root Folder Eli

~ Comment:
Cance!

m Canee

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.

4.2.8. History

This tab displays the list of changes that have been performed on the requirement artifact since its

creation. An example requirement change history is depicted below:

& Refresh | Y Filter | w | # Admin View

Displaying 1 - 2 out of 2 change(s).
Change ID Change Date ¥  Field Name 0Old Value New Value Changed By Change Type

[==] - Any —- | W - Any —- | W

12 2-May-2 Status In Progress Developed Fred Bloggs Modified
4 4-Mar-2005 Status Requested In Progress Joe P Smith Modified
Show | 15 | rOws per page Displaying page = of1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator

you can also click on the “Admin View” hyperlink to revert any unwanted changes.

4.2.9. Associations

This displays a list of any incidents, source code revisions or other requirements that are associated with

this requirement:

© Copyright 2006-2017, Inflectra Corporation Page 77 of 312 This document contains Inflectra proprietary information




+ Add | % Remove | & Refresh Y Filter  w

Displaying 1 - 4 out of 4 association(s)

5
g

¥ Type Artifact Type Mame Status Creation Date 4% Creator Comment Project Name

- Ay — v - Ay — v - Any — W — Any — | W Edit

acle ] Library Information
Related-to Incident Open 13-Mar-2004 Fred Bloggs  This bug affects the requirement ;_,Z,}W ermaton s Edit
s These two requirement .
Related-to Requirement Developed 11-Mar-2004 Fred Bloggs | o 0 (eduirements are " [rge] Edit
related
Related-to Requirement Completed 4-Dec-2003 Fred Bloggs This use case dafines the steps for & h on [rQ:30] Edit

creating & book
Test Run: Ability to create new

i nciden e 4 d -Nov-2003 oe P § " N7
Implicit Incident Assigne 3-Nov-2003 Joe P Smith boak [IN:7]

show | 15 v | rows per page Displaying page | 1 Tofl

The requirements in this list are those a user has decided are relevant to the current one and has created
a direct link between them. In the case of incidents, the association can be either due to the creator of an
incident directly linking the incident to the requirement, or it can be the result of a tester executing a test-

run and creating an incident during the test run. In this latter case, the check-box to the left of the

association will be unavailable as the link is not editable.

Each association is displayed with the type of association (related-to, vs. a dependency), name of the
artifact being linked-to, type of artifact (requirement, incident, etc.), the name of the person who created
the association, and a comment that describes why the association was made. In the case of an indirect

association due to a test run, the comment will contain the name of the test run.

In addition, when using SpiraPlan or SpiraTeam, the system automatically scans the source code

repository for any revisions that are linked to this artifact.

You can perform the following actions on an association from this screen:

» Delete — removes the selected association to the other artifact. This will only delete the
association, not the linked artifact itself.

> Refresh — updates the list of associations from the server, useful if other people are adding
associations to this requirement at the same time.

> Filter / Apply Filter — Applies the entries in the filter boxes to the list of associations

» Clear Filters — Clears the current filter, so that all associations for the current requirement are
shown.

» Edit — Clicking the “Edit” button to the right of the associations allows you to edit the association
type and comment fields inline directly on this screen.

To create a new association, click the “Add” button to display the add association panel:

Select Artifact Type ~ Filter by nan earchb c.8 ) Q search

Cancel
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If you know the ID of the requirement or incident you want to associate, you can enter its ID prefixed by

the appropriate token (“RQ” for requirement or “IN” for incident):

Select Artifact Type « ING

v D
[1IN:9

Type:

Name

E;“ Editing the date on an author is clunky

Related-to ~

Comment:

Cancel

Q Search

Project

Library Information System

Otherwise you should choose the Artifact Type (and Project if making a cross-project association):

Requirement ~  All Packages ~ Q, search
v ID Name

O ra:1 =) Functional System Requirements

[ RrRQ:2 % Online Library Management System

[ ra:3 % Book Management

O RrRa:S ] Avility to edit existing books in the system

O r:7 &) Ability to associate books with different subjects

O ra:8 ] Ability to associate books with different authors

[ RQ:S ] Ability to associate books with different editions

[] RQ:10 9 Ability to completely erase all books stored in the system with one click

Type: Related-to ~

Comment:

Cancel

You can narrow down your search by entering a keyword:

Requirement = All Packages = | associatel Q Ssearch

+ ID Name

O Ra:1 % Functional System Reguirements

O RQ: 2 | Online Library Management System

O RrRQ:3 7T Book Management

O RQ:7 ) Ability to associate books with different subjects
O rRQ:8 ) Ability to assoclate books with different authers
[ ra:? ) Ability to assoclate books with different editions
[ RQ: 13 % Author Management

[ Ra: 18 Y Ability to associate authors with subjects

Type: Related-to ~

Comment:

Cancel

Project

Library Information System
Library Information System
Library Information System
Library Information System
Library Infarmation System
Library Infarmation System
Library Information System

Library Information System v

Project

Library Information System
Library Information System
Library Infarmation System
Library Information System
Library Information System
Library Information System
Library Information System

Library Information System

For requirements, you can also choose a package from the list to narrow down the results:
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Requirement =

¥ ID

O Rzt
[ RQ:2
[JRQ:3
[ RQ:7
[JRQ:8
O RQ:9

Type: Related-tc

Comment:

Cancel

Book Management associate
All Packages

Functional System Requirements
Online Library Management System
Book Management
Edition Management
Author Management
Ability to add new authors to the system
Subject Management
Administration Functions
Data Import Functionality
Use Cases

System Qualities

s

s

s

Q Search

Project

Library Information System
Library Information System
Library Information System
Library Information System
Library Information System

Library Information System

Once you have a list of artifacts, you should select the checkboxes of the items you want to associate

with the current requirement and click the ‘Save’ button.

You can add a comment that explains the rationale for the association and choose the type of association

being created:

Related-to: this is used to specify that the two artifacts are simply related

Depends-on: this is used to specify that the current artifact has a dependency on the one being
linked to.
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5. Test Case Management

This section outlines how the use-case / test-case management features of SpiraTest® and SpiraTeam®

can be used to develop the business use-cases for the system, which specify how the different pieces of

functionality are expected to work in practice. In addition, these use/test-cases form the basis of the

business specification of the system when associated with the underlying requirements matrix. Typically

when starting a new project:

» The requirements matrix is entered first

>
implement the requirement

expected result and suggested sample-data

execution and tracking.

Then the list of use-cases is developed to outline the key scenarios that need to supported to

Then the use-cases are fleshed out into full test-cases by adding the detailed test-steps with the

Finally the tests are grouped into test-sets so that they can be assigned to users in batches for

However when migrating existing projects into SpiraTeam®, you may need to migrate the test-case list

first, and then add the supporting requirements matrix afterwards.

5.1. Test Case List

When you click on the Testing > Test Cases link on the global navigation bar, you will initially be taken to

the test case list screen illustrated below:

Bl v Internal Projects Vv
nternal Projects

Library Information System -n Planning ~  Testing~  Tracking~  Reporting

m Fred Bloges W

TestCases / TestSets Test Runs / Automation Hosts

Folders = + NewTest Case | % Delete
Displaying 1- 0 out of 12 test case(s) for this release.  Roof
4 B Root

> B Common Tests v % Name AY

> 8 Functional Tests —Any- | v
> B0 Regression Tests
4 B Scenario Tests

> & Exception Scenario Tests

Edit Add

s 0DpDD

t

Z Refresh | B Focus On

@ Edit | v | # Tools |~

Execution Status ~ Owmer o'W

~

- Show/hide columns -- | v | T Filter | v

— All Releases — v

Last Executed AW Author AW Status A'W Type AY DAY Edit

Ay |~ g | v Ay |~ | TC Edit
30-Nov-2003
30-Nov-2003
30-Nov-2003

Displayingpage| 1 |%0f0

The test case list consists of a hierarchical arrangement of the various test folders and test cases. The

structure is very similar to the folder structure in Microsoft Windows® Explorer, and users will find this

very familiar and intuitive to use. A folder tree is on the left hand side—with triangle icons to expand /

collapse each folder. Contents of the selected folder (the one marked in bold on the folder tree) are

shown on the right hand side.

When you create a new project, this list will initially be empty, and you will have to use the “New Test

Case” button to start adding test cases to the system. A new project will also not have any test folders—

only the base “Root” folder will be visible. To add a test folder, you click the “Add’ button at the bottom of

the folder tree on the left.
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The list shows all test folders (shown with a folder icon), and test cases (shown with a document icon)

inside the currently selected folder. You can place test folders and test cases into test folders. All of the
items in the list have a name, together with the most recent execution status (passed, failed or not-run),
and owner, author, execution date, active flag and test case number. Clicking on a test case’s hyperlink

will take you to the test case details page for the item in question (see section 5.2).

It is important to understand that only test cases are assigned a status themselves; the test folders
instead display a test execution bar graph that illustrates the aggregate execution status of its child test-
cases. Thus if the test folder contains two test cases, one of which passed, and one of which wasn’t run,

the graph will display 50% green and 50% gray.

To determine the exact aggregate test folder execution status information, position the mouse pointer
over the bar-chart, and the number of tests in each of the execution statuses (passed, failed, not-run,
blocked, caution) will be displayed as a “tooltip”. Note that if you change the owner of a test folder, then
all the child test cases will be assigned the same owner. This allows you to more easily associate entire

folders to test cases to be executed by a specific user.

5.1.1. Add a Test Case

Click the “New Test Case” button will add a test case in the currently displayed folder (ie the one marked
in bolder on the folder tree and also shown in the yellow information box). The new test case will be
added at the bottom of the list.

Once the new test case has been inserted, the item is switched to “Edit” mode so that you can rename
the default name and choose an owner and/or author. Note that all new test cases are initially set with an
execution status of “Not Run”.

5.1.2. Delete

Clicking on the “Delete” button deletes all the test cases and/or test folders whose check-boxes have
been selected. If any of the items are test folders, then the entire contents of that folder will also be

deleted (as you would expect in Microsoft Windows® Explorer or OS X Finder).

5.1.3. Execute

Clicking on the “Execute Tests” button (accessed from the “Tools” menu or context menu) executes all
the test cases selected, together with all the test cases contained with any selected test folders. The test

execution functionality of SpiraTeam® is explained in more detail in section 5.3.
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5.1.4. Refresh

Clicking on the “Refresh” button simply reloads the test case list. This is useful as other people may be
modifying the list of test cases at the same time as you, or executing specific test cases, and after
stepping away from the computer for a short-time, you can click this button to make sure you are viewing

the most current test case list for the project.

5.1.5. Editing a Test Case

Each test case in the list has an “Edit” button in its right-most column. When you click this button (or

double-click on any of the cells in the row), you change the item from “View” mode to “Edit” mode. The

various columns are made editable, and “Update” and “Cancel” buttons are displayed in the last column:

—_
v Internal Projects ™ Library Information System -n Planning ~  Testing~  Tracking~  Reporting n FredBloges v
TestCases / TestSets / TestRuns / AutomationHosts
Folders = + NewTestCase X Delete | & Refresh | B FocusOn || (# Edit |~ & Tools | v | —Show/hide columns-- v | T Filter | v
<
Displaying 1- 5 out of 15 test case(s) for this release. ~ Functional Tests - All Releases - v
4 B Root
> B3 Common Tests v % Name AV Execution Status  Owner AW Last Executed AW Author AW Status AW Type A Y Dav  Edit
4 B Functional Tests ~Any- | V| Ay |V gl -any- | v By | v —aye | v | TC Edit
> B3 Regression Tests Q &jAbility to or Failed Joe PSmith 30-Nov-2003 Fred Bloges ady for Test Functional TC:4 Edit
> B scenario Tests ¥ &7 Ab = Not Run Fred Bloggs v = 30-Nov-2003 FredBloggs v BB Readyfor7 v B | Functional| v B m Cancel
cdit || Add Blocked Joe PSmith 30-Nov-2003 Fred Bloges Ready for Test Functional TS Edit
Caution Fred Bloges 30-Nov-2003 Fred Bloges Ready for Test Functional TC:3 Edit
nt author | Passed Joe PSmith 30-Nov-2003 Fred Bloges Ready for Test Functional TC:6 Edit
Quick Filter e

Show| 15 V' rows per page «Displayingpage 1 =of1mp

If you click “Edit” on more than one row, the “Update” and “Cancel” buttons are only displayed on the first

row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Update” button. Also, if you want to make the same change to multiple rows (e.g. to change the owner of
five test cases from “Fred Bloggs” to “Joe Smith”), you can click on the “fill” icon to the right of the editable

item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters (ie the topmost edit button) and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Update” to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

5.1.6. Editing a Test Folder

Test folders shown on the right hand list pane do not have an “Edit” button. To edit a test folder, first click
the “Edit” button at the bottom of the left hand folder tree. This will place the whole folder tree into edit

mode—each folder will get a small “Edit” button of its own.

© Copyright 2006-2017, Inflectra Corporation Page 83 of 312 This document contains Inflectra proprietary information




Folders &> =

4 B Root

» 8 Common Tests | edit
4 B Functional Tests | Edit
> 8 Regression Tests | Edit

> 8 Scenario Tests | Edit

Done Add

Clicking on the “Edit” button of the folder you want to edit will display a pop up dialog. This allows you to:
move the folder into a new or different parent folder; edit the name of the folder; or add a more detailed
description. Click “Update” to commit the changes, “Cancel” to revert back to the original information, or
“Delete” to delete the folder (and all of its contents). Note that on clicking “Delete” a warning box will

appear to make sure you don’t accidentally delete something.

| 2
Edit Folder

Please choose the parent of this Folder:

Scenario Tests

Please edit the name of this Folder:

Exception Scenario Tests

Please enter the description for this new Folder:

B I U = := o el

Delete Cancel
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5.1.7. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test case list as columns for
the current project. To show a column that is not already displayed, simply select that column from the list
of “Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.

5.1.8. Filtering

You can easily filter the list of test cases as illustrated in the screen-shot below:

+ NewTestCase =X Delete = £ Refresh | B FocusOn || (@ Edit ~ % Tools v | --Show/hidecolumns—- ~ | ¥ Filter | v
ng 1- 3 out of 15 test case(s) for thisrelease.  Functional Tests  Filtering results b ner.  Clear Filtes --- All Releases --- v
v 4 Name AW Execution Status Owner 4W Last Executed AW Author AW Status AW Type AW IDavw Edit
— Any -- v e PSmith v us) - Any -- v — Any -- v - Any - v TC Edit
B Failed P Sm F Ready for Test Functiona TC:4 Edit
X Blocked Joe P Smith 3 Fr Ready for Test Functional TC:5 Edit
5 Passed e P Smith N FredB eady for Te Functional TC:6 dit
S v r pag D e [

To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) then click “Filter” or press the
<ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, test case humbers). In the screen-shot
above, we are filtering on Owner = (None).

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The
list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

T Filter | & | £ Edit | &  #* Tools & | -- Show/hide columns -- | s
4 ¥ Apply Filter
- . Save Filter

¥ Clear Filter 1 5tatus  Owner

Q, Retrieve Filter  _ o — any Please choose a name for this filter

B Save Filter Jos P ¢ |
Paszzed Fred Bl ) .

Share with other members of the project
Blocked Joe P |
Cancel

Caution Fred Bl |
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Because the same test case can be run against more than one release, sometimes you want to see the

execution information for the displayed test cases for different releases. If you select a release or iteration
from the dropdown marked “All Releases” on the right above the table, then the execution information for
that specific release will be displayed. If the dropdown is set to "all releases", then it shows only the most

recent execution information. In both cases, all test cases (as per any filter) are listed.

5.1.9. Copying Test Cases

To copy one or more test cases, simply select the check-boxes of the test cases you want to copy and
then select the Edit > Copy Items menu option. This will copy the current test case selection to the
clipboard. Then select the place where you want the test cases to be inserted and choose the Edit >

Paste Items option.

The test cases will now be copied to the destination you specified. The name of the copied test cases will
be prefixed with “Copy of...” to distinguish them from the originals.

5.1.10. Moving Test Cases or Folders

There are two options for moving test cases or folders:

1. Click on the test case/folder you want to move in the right hand list and drag it to the folder in the

left hand folder tree you want it moved to. The background of the new folder will change to show

where it will be inserted:

P
Vv  Internal Projects v Library Information System v -n Planning ~ Testing ~ Tracking ~ Reporting

Test Cases Test Sets Test Runs Automation Hosts

+ NewTestCase % Delete || & Refresh E>FocusOn || @ Edit ~ | ¥ Tools |~ | --Show/hidecolumns—- | v | T Filter | v

Folders & (-]
Displaying 1 - 3 out of 15 test case(s) for this release. Common Tests
4B Root
4 B> Common Tests v % Name AW Execution Status Owner 4% Last Executed 4% Author o'W Status AW Tyl
3 GF Ay | v —Any-- | v =] —Any- | v —Any- | v
> Bpe = Not Run Fred Blogzs Draft Functiona
» 8 Scenario Tests Not Run Fred Blogzs Draft Fu
Edit Add Not Run 30-Nov-2003 Fred Bloggs Ready for Test Fu

Once you have the test case/folder positioned at the correct place that you want it inserted, just release
the mouse button. To move multiple items simply select their checkboxes and then drag-and-drop one of

the selected items.

2. Alternatively you can simply select the check-boxes of the test cases you want to move and then
select the Edit > Cut Items menu option. This will cut the current test selection to the clipboard.
Then select the place where you want the test cases to be inserted and choose the Edit > Paste

Items option. The test cases will now be moved into the destination specified.
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5.1.11. Exporting Test Cases

To export a test case or set of test cases from the current project to another project in the system, select

the check-boxes of the test case(s) you want to export and then click Tools > “Export to Project”. This

will bring up a list of possible destination projects:

< Refresh & Focus On Y Filter  w || & Edit ~ | & Tools | w | -- Show/hide cc

e e P Execute Tests

ase(s) fp-s-im-mtomm-
Export ltems stus ™ Export to Project LE
Please select the project you want to export to: = Print Items

hor -— Select Project —- y
L : | | B Export to Excel e
Wk Mc

Cancel B Export to Word
Jthor _ M

—_— T4 Export to Acrobat

ok Caution ‘ Mc

i E Add to Release
to different author Passed = Ne

23 Add to Test set

] Add to Requirsment

[§ Remove from Release

Once you have chosen the destination project and clicked the “Export” button, the test cases will be
exported from the current project to the destination project. Any file attachments will also be copied to the

destination project along with the test cases.

5.1.12. Adding Test Cases to a Release, Test Set or Requirement

To quickly add a series of test cases to a Release, Test Set or Requirement, select the check-boxes of
the appropriate test cases and then click Tools > Add to Release / Test Set / Requirement. This will bring
up a dialog box displaying either a list of available releases, test sets or requirements (depending on

which option was chosen):
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Add to Release

© Please select the release you want to add to:

Release: -- —- Please Select —- —

B [T T

u 2] 10.20.0001 - Iteration 001
0

23 1.0.20.0002 - Iteration 002

'I-'f] 10.20.0003 - lteration 003
23 1.0.0.0.0001 - Iteration 001
23 1.0.0.0.0002 - Iteration 002
23 1.0.0.0.0003 - Iteration 003

11.0.0 - Library System Release 11

111.0 - Library System Release 11 SP1

23 11.0.0.0001 - Iteration 001
23 11.0.0.0002 - Iteration 002
23 11.0.0.0003 - Iteration 003

12,00 - Library System Release 2005

Once you have chosen the destination release / test set / requirement, clicking “Add” will add the

selected test cases to the destination release / test set / requirement.

5.1.13. Viewing the Test Status for a Release

By default, when you view the list of test case cases, it will display an aggregate status for all releases of
the project. l.e. the test list will include all the test cases in the system (regardless of which release they
apply to) and the execution status will reflect the most recent test run — regardless of which release it was

for.

To change the test case list to just display test cases and execution status for a particular release,
change the release selected in the drop-down list located in the yellow information panel (on the right-

hand side) from “All Releases” to a specific release:

+ NewTest Case | X Delete | & Refresh [ FocusOn || (@ Edit |~ % Tools | v | - Show/hide columns-- | v | Y Filter v

Displaying 1 - 3 out of 15 test case(s) for this release.  RegressionTests --- All Releases --- v
v % Name AV Execution Status Owner AW Last Executed 4'W Author 4w Status AW =AlklEzs—
B 1.0.0.0 - Library System Release 1
@ - Any -~ ~ - Any - v ==} - Any -~ ~ - Ay - W & 1.2.0.2 - Copy of Library System R
) ] 1.0.2.0.0003 - lteration 003
@ B Author management Passed 30-Nov-2003 Joe P Smith Ready for Test ] 1.0.2.0.0002 - Iteration 002
(] B Book management Passed 30-Nov-2003 Joe P Smith Ready for Test & 1.0.1.0-Library System Release 1
] 1.0.0.0.0001 - lteration 001
(] 23 New Test Case Not Run Fred Bloggs Draft #] 1.0.1.0.0002 - Iteration 002
¥ 1.0.0.0.0002 - Iteration 002
Sy 1 [T ©] 1.0.1.0.0003 - Iteration 003 o

) 1.0.1.0.0001 - Iteration 001
B 1.0.2.0 - Library System Release 1~
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+ NewTestCase = % Delete & Refresh B> Focus On & Edit |~ | £ Tools | v | —-Show/hidecolumns— ~ Y Filter | v

Displaying 1- 2 out of 7 test case(s) for thisrelease.  Regression Tests 1.0.1.0- Library System |~
v % Name AW Execution Status  Owner AW Last Executed 4w Author 4w Status AW Type A Y IDAw Edit
Ay~ | W —Any—- | W =] —Any- | W —Any-- |V —Any-- | ™ TC Edit
Not Run Joe P Smith Ready for Test Regression TC:9 Edit
Mot Run Joe P Smith Ready for Test Regression TC:8 Edit
Show | 15 ' rows per page Displayingpage 1 #ofl

As illustrated in the example above, when the drop-down list is changed to select a specific release, the
list of test cases is filtered to just those mapped to the release in question. In addition, the execution
status for the test releases will only reflect test runs for that specific release (and any child iterations if
applicable). As can be seen in our example, many test cases that have been run for other releases now

show the “Not Run” status since they’ve not been run for this specific release.

As a shortcut, when you select a specific release for viewing, subsequent execution of any of the test

cases via the Tools > Execute Tests menu option will default the test run to the selected release.

5.1.14. Printing Items

To quickly print a single test case, test folder or list of test cases you can select the items’ checkboxes
and then click Tools > Print Items. This will create a printable report of the selected items in a new

window.

5.1.15. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the

context menu, right-click on any of the rows in the test case list and the following menu will be displayed:

v % Name AW ExecutionStatus Owner AW Last Executed AW Author AW Status AW Type AW Dav Edit
Ay v | [—amy- |~ = Ay | v Ay | v Ay | v TC Edit
4 k Open ltem 30-Now-2003 Joe P Smith Ready for Test Regression TC:9 Edit
' Openin New Tab 30-Nov-2003 Joe P Smith Ready for Test Regression TC:8 Edit
& FocusOn Fred Bloggs Draft Functional TC:22 Edit
Show | 15 “ rows per page + Insert [« Displayingpage| 1 |[%oflew
# Edit ltems
X Delete

1 Copy ltems
3 Cut ltems

I Paste ltems

P Execute

=4 Print ltems

You can now choose any of these options as an alternative to using the icons in the toolbar.
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5.2. Test Case Details

When you click on a test case item in the test case list described in section 5.1, you are taken to the test
case details page illustrated below:

Folders & -] B cl

one | & Refresh || X Delete | P Execute & Tools w | EFEmail | vy Subscribe |
4 & Root
[ Common Tests b | b k
. Ability to create new boo

4 = Functional Tests

» [J Regression Tests
§ 5 Status:" Ready for Review Operations~ Passed

[ Scenaric Tests

= Req, Coverage Tast Runs Releases ncidents Attachments Test Sets Tasks History
est List

Display: Current Filter s | &

Author: Fred Bloggs Type Functional Est Dur. (h). 016
£ Ability to create new author

Owner Fred Blogas Component: Book Management
X Ability to ereate new book ==

view Own __ please Sele Priarity 1~ Critical
I Ability to edit existing aut Review Quner Please Sele ¥
L Ability to edit existing book Suspect? Ne
I ability to reassign book to URL: http:/ /www.libraryrefere,
Test Type Functional Test
Description:

Tests that the user can create a new book in the system

This page is made up of three areas;
1. the left pane displays the test case folders and list navigation;

2. theright pane’s header, which displays: the operations toolbar; the editable name of the selected

test case; and the info bar (with a shaded background), which also contains the workflow status
transitions (see below); and

3. the right pane’s tabbed interface with rich information related to the test case.

The navigation pane consists of a link that will take you back to the test case list, as well as a list of the
peer test cases to the one selected. This latter list is useful as a navigation shortcut: you can quickly view
the detailed information of all the peer test cases by clicking on the navigation links without having to first
return to the test cases list page. The navigation list can be switched between three different modes:

e The list of test cases matching the current filter
e The list of all test cases, irrespective of the current filter
e The list of test cases assigned to the current user

If you are editing an existing item, the fields that are available and the fields that are required will depend
on your stage in its workflow. The types of change allowed and the email notifications that are sent will
depend on how your project administrator has setup the system for you. Administrators should refer to the
SpiraTeam Administration Guide for details on configuring workflows to meet their needs.
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Depending on the user’s role and whether they are listed as the owner or author of the test case,
displayed in the info bar beneath the test case name is the current workflow status and an “operations”

button which, when clicked, will show a set of allowed workflow operations.

These workflow transitions allow the user to move the item from one status to another. For example when

the test case is in the Ready for Review status, you will be given the options to:
» Approve Test Case — changes status to “Approved”
>» Reject Test Case — changes the status to “Rejected”
> Return to Draft - changes the status to “Draft”

Please note that if digital signatures have been enabled for a particular workflow operation (and therefore
a digital signature is required to confirm the status change. Workflow operations requiring a digital
signature are marked with a padlock icon as in the example below:
Operations
Approve Test Case @
Reject Test Case

< Return to Draft 7

On attempting to save changes made after clicking a workflow operation that requires a digital signature

you will be presented with a popup similar to the one below (which is for a requirement):

| 4
Enter Electronic Signature

Please enter your login/password together with the meaning and click Sign:

Login:®  |fredblogs
Password:”

Changing Requirement RQ:4 from '‘Developed' to 'In Progress'

Meaning:”

Cancel
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The top part of the right pane allows you to view and/or edit the name of the particular test case. Once

you are satisfied with any changes made here or to the information below, click “Save”. Alternatively, if

you click the dropdown you can either click “Save and Close” (which will take you back to the list page
after saving); or “Save and New” to commit the changes and immediately create another test case. In
addition you can: create a replica of the current test case by clicking “Clone”; delete the current artifact by
choosing “Delete”; discard any changes made by clicking “Refresh”; or print or export it using from the

“Tools” dropdown.

Clicking the “Execute” button will immediately prepare the current test case for execution and then take

you to the test execution screen (see section 5.4 below)

Using the “Email” button on the toolbar, you can send an email containing details of the test case by

either specifying an email address or another user on the system:

Email this artifact to

* Project User: Army E Cribbins N

Select auser in the |."I':I_-EC'[ Lo sEnd o

Email Addresses:

Alist of email addresses, separated by

Message Subject:

Leave blank for default

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user. The content of the email is specified in the System Administration

— Notification Templates.

To be notified of any changes made to the current artifact via email, click the “Subscribe” button. If you
already subscribed, the button will instead let you “Unsubscribe” to stop receiving emails about that
particular artifact. Depending on your role, you may also see a dropdown arrow to the right of this button.

This will let you subscribe others in the project to this artifact

The lower part of the right pane can be switched between eight different views by clicking the appropriate

tab. Initially the pane will be in “Overview” mode, but it can be switched to “Requirements Coverage”,
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» o« LI LIS ” o«

“Test Runs”, “Releases”, “Incidents”, “Attachments”, “History”, and “Test Sets” modes if so desired. Each

of these views is described below.

5.2.1. Overview - Details

The Overview tab is divided into a number of different sections. Each of these can be collapsed or
expanded by clicking on the title of that section. This tab displays the fields, detailed information, and

comments associated with the test case.

The top part of this tab displays the various standard fields and custom properties associated with the test
case. Fields (both standard and custom) are grouped under the collapsible headings (marked by orange
text and underline) in the screenshot below. For instance, all fields regarding dates are grouped together
in the “Dates and Times” area.

Overview Req Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History

Author’ Fred Bloggs Type: Functional Est. Dur. (h) 016
Owner Fred Bloges Compenent: Book Management
Review Owner --- Please Sele Priority 1 - Critical

Suspect? No

URL: http://www libraryrefere

Test Type: Functional Test

The Detailed Information section contains the long, formatted description of the test case, as well as any
rich text custom fields. You can enter rich text or paste in from a word processing program or web page.

Clicking on the shaded areas of one of these detailed fields will display the rich text toolbar.

The Suspect flag is automatically set on an approved test case, when one of the requirements linking to

it changes. This lets you quickly find all the test cases impacted by a specific requirement change.

5.2.1.1. Followers
Using the “Subscribe” button on the toolbar, you can quickly follow the item, and receive updates on

certain changes to it. Depending on your role, you may also see a dropdown to this button, which let's

you add another project member as a follower to this item.

B4 Email | 1r Subscribe | s

& ~Add Follower
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Add Follower

.o QloOWeE

Select a user in the project to follow this artifact

Amy E Cribbins v

Cancel

You can also quickly see who is following an incident under the “People” section in the Overview tab.

Followers (2)
T e
]

To view information about the follower, or to unfollow them from the item, hover over their avatar to

display a user profile card.

Amy E

Cribbins Remove
follower

5.2.2. Overview - Test Steps

This view displays the name of the test case together with all the defined test steps that a tester would
need to perform to verify that the functionality works as expected. The list of test steps displays the
position number, the description, the expected result, some suggested sample data and the most recent

execution status of the individual test step:
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=+ Insert Step

% Step #

) step 1

% @
T step 4
W cten

S Insert Link 2 Refresh ]

Description

Call "Login to Application' (TCT7) &3

2 User clicks link to create book

3 User enters books name and author, then

clicks Next

User chooses book's genre and sub-genre
from list

ep 5 User clicks submit button

Show | 15

v [ows per page

Clone = = Import X Delete

Expected Result

User taken to first screen in wizard
User taken to next screen in wizard
User sees screen displaying all entered
infarmation

Confirmation screen is displayed

— Show/hide columns —— |«

Sample Data

browserName: Internet Explorer N/ &
login: librarian
password: librarian
Passed
Macbeth, William Shakespeare Passed
Play, Tragedy Passed
Passed

Displaying page

<[> Edit Parameters

Execution Status 1D

Edit

TS1 | Edit

T2 | Edit

TS3 | Edit

TS:4 | Edit

T55 | Edi
Zofl

Note: Test steps that are marked with a hyperlink and test case icon (e.g. “Call Login to Application” in the

screen shot above) are in fact linked test cases. Linked test cases are a useful way of reusing existing

test steps from other test cases. For example if you want to have a set of steps be in more than one test

case (e.g. a login step) then you would create a separate test case just containing these steps, then have

all the other test cases just link to it. This avoids the need to have duplicate test steps throughout the

project.

If you click on the step number hyperlink (e.g. Step 2) you will be taken to the test step details page which

allows you to perform additional editing of a specific test step as well as attach documents, associate pre-

existing incidents and view the change history.

5.2.2.1. Insert Step

Clicking on the “Insert Step” button inserts a new test step before the currently selected (by means of the

check-box) test step. Clicking the “Insert Step” button without selecting a test step will insert a new step

at the end of the list. When a new step is inserted, the fields are displayed in “Edit” mode, so the

description, expected result and sample data fields are editable, allowing you to enter the data:

TS1

53

TS4

TS5

T552

=+ insert Step | % Insert Link Z Refresh | [ Clone | %) Import % Delete | —— Show/hide columns — | & | </> Edit Parameters
% Step#  Description Expected Result Sample Data Execution Status 1D
P8 step 1 Call Login to Application’ (TC17] browserName: Intemat Explorer NA
login: librarizn
password: librarizn
[15] 2 User clicks link to create book User taken to first screen in wizard Passed
% @ User enters books name and author, then clicks Next User taken to next screen in wizard Macbeth, William Shakespeare Passed
@ step 4 User chooses book's genre and sub-genre from list User sees screen displaying all entered information Play, Tragedy passed
[15] User clicks submit button Confirmation screen is displayed Passed
L] o o o Not Run
B I U = = E ® =2 B I U = := E e b B I U ;== E = 2
=l = =4
4 4 4
Show | v | rows per page
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Save and New

Displaying page

Cancel

Zaf1




Once you have entered the necessary information, you can click either “Save and New” or “Save” to

commit the changes. If you choose “Save and New” another new row will be inserted which is useful if

you intend on entering lots of rows at once, whereas clicking “Save” will commit only the current row.

5.2.2.2. Insert Link

Clicking on the “Insert Link” button brings up the following dialog box that allows you to either choose an

existing test case to be inserted or create a new test case and step with parameters:

Add Linked Test Case
Do you want to: | Link Existing Test Case Create New Test Case | ?
@ Choose the test case to add as a link in the test step list

Folder: -—- Root Folder ——-

Test Case

Cancel

When linking an existing test case, first select its parent folder from the dropdown. Then select the name
of the test case you want to insert as a link from the list. If the test case has declared parameters (see the
section on Parameters below for more details) you will be given a list of parameters that needed to be
filled out.

You need to fill out the values of the parameters for the linked test case and then click the “Add” button to
complete the operation. The system will then insert the test case as a link just before the currently
selected test step. If no existing test step was selected, the link will be added at the end of the test step
list.

If you want to create a test step with specific parameters and parameter values, you can do so by clicking

the “Create New Test Case”. This will change the dialog to one where you can assign a folder, name,

and parameters to a new test case. On clicking the “Add” button: the new test case is created; a test step

is created within that new test case; the parameters specified in the dialog are assigned to that test step,
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with the values set as the defaults for the step; and the new test case is added as a linked test case in the

list of test steps.

Add Linked Test Case

Do you want to: | Link Existing Test Case Create Mew Test Case | 7

O Please choose the folder and name for the new linked test case
Folder: --- Root Folder ——-
MName:

Enter Parameters
Mame Value

[ }

Cancel

5.2.2.3. Delete

Clicking on the “Delete” button deletes the currently selected test steps, and reorders the test step

position numbers to close any gaps in numbering.

5.2.2.4. Clone

Clicking on the “Clone” button makes a duplicate of the current test step or linked test case and inserts

the copied version directly above the original one.

5.2.2.5. Refresh

Clicking on the “Refresh” button simply reloads the list of test steps. This is useful if other people are

making changes to the test list and you want to make sure that you have the most current version.

5.2.2.6. Show / Hide Columns

By default the test step list screen will display the Description, Expected Result and Sample Data fields.

However the Expected Result and Sample Data fields are optional and can be hidden if necessary to
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make more space. If you have configured custom properties for test steps, you can use the Show/Hide
features to display one or more of your custom properties instead. These fields will then be editable in this
grid-view.

5.2.2.7. Editing Test Steps

To modify an existing Test Step you simply need to click on the “Edit” button to the right of the step, or
just double-click on the cells in the row. That will switch the selected row into Edit mode. The various

columns are turned into editable text-boxes, and “Save” and “Cancel” buttons are displayed in the last

% Step #  Description Expected Result sample Data Execution D Edit
Status
] Step 1 Call ‘Login to Application’ (TC17) &7 N/A TS Egit

) ¥ Step 2 Passed TS:2 a
& B I U : U =% e B I U == ® B cancel
<

i
[0
Hw
-

User clicks link to create book User taken to first screen in wizard

4 4 4

er enters books name and author, then clicks Next  User taken to next screen in wizard Macbeth, William Shakespeare Passed TS3 e

haoses book's genre and sub-genre from list  User sees screen displaying all entered information  Play, Tragedy Passed TS4 i

ser clicks submit button Confirmation screen is displayed Passed TS5 Egit

If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first
row, and you can make changes to all the editable rows and then save the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows, you can click on the “fill” icon
to the right of the editable item, which will propagate the new value to all editable items in the same
column. When you have made your changes, you can either click “Save” to commit the changes, or

“Cancel” to revert back to the original information.

5.2.2.8. Editing Test Links

To modify an existing Test Link you simply need to click on the “Edit” button to the right of the step, or
double click on the cells in the row. That will open up the special dialog box used for editing the

parameter values associated with a specific linked test case:
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Edit Linked Test Case Parameters
@ Please fill out the parameters for this linked test case:

browserMName: Internet Explorer
login librarian
operatingSystem:

password: librarian

-

This allows you to edit the parameters being passed from the current test step to the linked test case
without having to recreate the test link from scratch. To commit the change click “Save” to close the

dialog box, or click “Cancel” to revert back to the original information.

5.2.2.9. Moving Test Steps

To move test steps in the list, click on the row you want to move and drag it where you want it moved to

within the list of test steps. An empty space will appear to show you where it will be inserted.

5.2.2.10. Parameters

Test cases can have parameters associated with them. This enables one test case to be called several
times by another test case (as a link) and have different parameters passed in each case, making the
operation different. E.g. you could have a generic “login to application” test case that others call as an

initial step, which could be provided with different login information depending on the calling test case.

To view / change the parameters associated with the current test case, click on the “Edit Parameters”

button in the toolbar and the list of current parameters will be displayed:
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The following parameters have been defined for this test case

Name Default value Operations

${author} Roald Dahl I Insert at Cursor | (& | %

${genre] Fantasy I insert at Cursor | (£ | %

. Charlie and the Chocolate ~ _ .

${name} I Insert at Cursor | (& | %
Factory

Add a new parameter to this test case

Mame: ${

Default Value + Add

Cancel

The list of existing parameters is displayed in a list. Beneath this, is a form where you can add a new
parameter and default value (used when the test case is run directly rather than being called by another
test case). You can delete an existing parameter or copy the parameter token to your computer’s
clipboard. If you want to paste the parameter token onto the current page (say into a specific test step),
position the cursor where you want and click “Insert at Cursor” This is a quick way to include the

parameter and then have it converted into the parameter value during test execution.

5.2.3. Overview - Automation

The Automation section displays any automated test scripts associated with the current test case. There
are three types of automated test:

e Attached - this is when SpiraTeam physically stores the test script as an attachment in the
system. This is only available for test automation tools that store their test scripts as plain text
files. Examples of such tools are Selenium-RC and Squish.

e Linked - this is when SpiraTeam stores the location of the test script stored on the automation
host itself or on an external network drive.

e Repository — This is a special option only available when using Rapise™, the test automation
system from Inflectra. This allows you to store an entire folder of automated test script files in

SpiraTeam and have them linked to the test case.

The screenshot below illustrates a sample Rapise automated test script attached to a test case:
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© This section defines the automated test script associated with this test case

Script Type:

Automation Engine: Rapise Document Type: Functional Specification
Filename: 3 CreateNewBook sstest

Test Script: <> Edit Parameters

Project File: CreateNewBook sstest

Script Path: CreateNewBook js

User Functions Path: CreateNewBook.userjs
Objects Path: CreateNewBook.objects js

The automation screen includes the following fields that you should populate when using SpiraTeam® to
store an automated test script:

>» Automation Engine — this should be the name of the test automation engine that the test script
should be executed with. This list is populated by a system administrator using the administration
section of the application (as described in the SpiraTeam Administration Guide)

» Script Type — This should be set to either “attached” or “linked”. If you choose to attach the test
script, the large text box at the bottom will be enabled, allowing you enter/edit the test script
directly in SpiraTeam. If you choose linked, the test script is stored externally and SpiraTeam just
stores a reference to it. The “repository” option is never selectable within SpiraTeam and will be

automatically set by Rapise when it attaches a test script to the test case.

>» Filename — If you are attaching the test script to the test case then this field just needs to contain
the filename of the test script (no folders or path needed), whereas if you are choosing to link the
test script, you need to follow the exact format that will be expected by the test automation
engine. For details, please refer to the specific test automation engine in the SpiraTest/Team
Automated Test Integration Guide.

>» Document Type - This should be set to the document type that you want the test script
associated with.

» Document Folder - This should be set to the document folder that you want the test script to be
stored in. Note that if the script type is repository then the folder is set automatically and cannot
be edited by the user.

» Version — This should contain the version number of the test script.
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» Test Script — If you are attaching a test script, this should contain the actual program code for
executing the test script. The language and syntax will be dependent on the test automation

engine being used. If you are linking the test script, this section will be disabled.

» Parameters — You can enter the various test case parameters by clicking on this hyperlink. Most
of the automation tools that SpiraTeam integrates with will support the passing of parameter
values from SpiraTeam to the automation tool.

5.2.4. Overview - Comments

The Comments section allows users to add and view discussions related to the Test Case:

Displaying =~ newest first oldest first

[

1 Thanks, appreciate it!

~
d OK will make sure that we do

~

I We need to add a better definition of the pre-conditions and post-conditions

Format - Font -~ Sz - B I U I, A-B- = := E o = HEMA= @ ¥ Bsouce

Existing comments are displayed by date (either newest-first or oldest-first) above the text box. To add a
comment to the Test Case, enter your text into the textbox, then click the “Add Comment” button.

5.2.5. Requirements Coverage

This tab displays the requirements coverage information for the test case in question:

Overview Req. Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History
Add X Remove 2 Refrash T Filter |

Displaying 1 - 2 out of 2 association(s).
v Type Name Status Importance Project Name D

— Ay — | W -- Any — | W -- Any — | W -- Any — | W RQ

Use Case ) Creatin in Completed Library Information System RQ30

Featurs ﬁ Ability 2 system Developed 1 - Critical Library Information System RQ4
Show |15 W | rows per page Displaying page | 1 = afl

The table shows the requirements, if any, mapped to this test case. Clicking on the hyperlinked names
will jump you to the details screen for the item in question.
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To map the test case to a new requirement, click the “Add” button to display the add association panel.

You can search by the ID (if known) prefixed with the appropriate token (e.g. “RQ:4” to search for

requirement 4). You can also browse by package, or search by name. Select the requirements you want

and then click the “Save” button”.

All Packages~

v D Name
RO ~ [ Functional System Requirements
RQ2 ~ [E) Online Library Management System
RQ3
RQS &3 Ability to edit existing books in the system
RO6 ) Ability to delete existing books in the system
RQ7 f-j Ability to associate books with different subjects
RQ:8 &) Ability to associate books with different authors
RQ:9 &) Ability to associate books with different editions

Cancel

Q search
Project
Library Information System
Library Information System

Library In

Library Information System

Library Infarmation Sy:

Library Information Sy:

Library Information System
Library Information System =
P

+ Create Requirement From This Test Case £3

From the same add association panel there is a short to “Create Requirement from This Test Case”.

This button will create a new requirement in the list of covered requirements that will be automatically

linked to this test case. This is useful when you have created a new test case and want to generate an

initial placeholder requirement to be fleshed-out later.

Finally, to remove coverage for this test case, select any of the added requirements (those in the bottom

table) and click the “Remove” button.

5.2.6. Test Runs

This view displays the name of the test case together with a list of the previous execution runs that the

test case has been put through. Each test run is listed together with the date of execution, the name of

the test case, the name of the test set (if applicable), the name of the tester, the release/version of the

system that the test was executed against, the overall execution status for the test case in that run and a

link to the actual test run details (see section 5.6). In addition, you can choose to display any of the

custom properties associated with the test run.

Overview Req Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History
© Refresh | Y Filter s | -- Show/hide columns - | &
Displaying 1 - 6 out of 6 test run(s) Filtering results by Test # | Clear Filters
v % Name End Date ¥ Test Set Type Tester Execution Status D Edit
[=] - Any == | W - Any - | w - Any -- W - Any - W TR Edit
) Ability to create new book 4-Dec-2003 Automated Fred Bloggs Failed TRI18 Edit
B Ability to 3-Dec-2003 Automated Joe P smith Passed TRI5 Edit
DJ Abilit 2-Dec-2003 Automated Fred Bloggs Passed TRI3 Edit
B Abilit 1-Dec-2003 Testing Cycle for Release 11 Manual Fred Bloggs Passed TR2 Edit
DJ Ability t 1-Dec-2003 Automated Fred Bloggs Failed TRI12 Edit
¥ DJ Ability to cre 1-Dec-2003 Testing Cycle for Release 10 Manual Joe P Smith Failed TR1 Edit
Show | 15 ~ | rows per page Displaying page Zofl
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The “show/hide columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of

“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Filter” button. In addition, you can quickly sort the list by clicking on one of the

directional arrow icons displayed in the header row of the appropriate field.

5.2.7. Releases

This tab displays the name of the test case together with the release mapping information for the test
case in question. It functions in a similar way to the Test Coverage tab described above: the table at the
bottom of the panel shows the releases, if any, mapped to this test case. Clicking on the hyperlinked
names will jJump you to the details screen for the item in question. You can search for and add releases to

this list using the “Add” button, or remove them using the “Remove” button.

Overview Req. Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History
Add %X Remove | & Refresh Y Filter |+

Displaying 1 - 7 out of 7 association(s)

¥ Name Type Version # & Status Project Name D
- Any —— | W -——Any — | W -—— Any — | W
Major Release 1.0.00 Completed Library Information System RL1
Minor Release 1010 Completed Library Information System RLZ
Minor Release 1020 Completed Library Information System RL3
IMajor Release 1100 In Progress. Library Information System RL4
Iteration 11.0.0.0001 In Progress Library Information System RLI7
Iteration 11.0.0.0002 In Progress Library Information System RLIE
Iteration 11.0.0.0003 In Progress Library Information System RL19

Show | 15 ™ | rows per page Displaying page Z of1

5.2.8. Incidents

This tab displays the list of incidents associated with the current test case. The incidents have either been
created during an execution of the test case (and are thereby linked to one of the test runs) or manually
linked to one of the test steps in the test case.
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Overview Req. Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History

Refresh &  — Show/hide columns — | & T Filter | &
@ Displaying 1 - 1 out of 1 incident(s) linked to this test case Filtering results by Test # | Clear Filters
¥ % Name Type Status Priority Detected By Creation Date Owner Progress
ANy — | % || —ANy — | V| ANy — | V| ANy - W B Ay — v | —Amy— W
% M Cannot add a new book to the system Bug Assigned 1 - Critical Joe P smith 3-Nov-2003 Joe P Smith
Show |15 “ | rows per page Displaying page

Each incident is listed together with the type, status, priority, name, owner, detector, detection date and a
link to the actual incident details. You can customize the fields that are displayed using the “Show/Hide

Columns” option. In addition, you can perform the following operations:

> Refresh — updates the list of incidents from the server, useful if other people are adding incidents
to this release at the same time.

» You can also filter the results by choosing items from the filter options displayed in the sub-
header row of each field and clicking the “Filter” button. In addition, you can quickly sort the list
by clicking on one of the directional arrow icons displayed in the header row of the appropriate
field.

> Edit — Clicking the “Edit” button to the right of the incident allows you to edit the incident inline.

5.2.9. Attachments

In this tab, the main pane displays the list of documents that have been “attached” to the test case. The

documents can be in any format, though SpiraTeam® will only display an icon for certain known types.

Overview Req. Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History
+ Add New % Add Existing < Refresh -- Show/hide columns -- | w T Filter | »

Displaying 1 -1 out of 1 attachment(s).

+ Filename Type Size Edited By Edited On &% Author D Edit
— ARy -- | W = - Any — W [==] - Any - W D Edit
i Sequence Diagram for Book Mgt pdf UML Diagram 35 KB Joe P Smith 9-May-2006 Fred Bloggs DC7 Edit
Show | 15 W | rows per page Displaying page | 1 Zofl

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window wiill

open. Depending on the type of file, this window will either display the document or prompt you for a
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place to save it on your local computer. To delete an existing attachment from a test case, simply click the

“Remove” button and the attachment will be removed from the list.

To attach a new document to the test case, you need to first click the “Add New” link to display the new

attachment dialog box:

Add New Document

Type" ®File ©URL O Screenshot

Filename: Choose File | Nofile chosen
Description:

Document Type:” Functional Specification | v
Document Folder:" Root Folder ~

Tags:

Add New Document

Functional Specification | v

Add New Document

Type” File OURL ® Screenshot

Screenshot"

Description:

Document Type:* Functional Specification | v
Document Folder:" Root Folder v

Tags:

There are three different types of item that can be attached to a test case:

» To upload a file, choose “File” as the type and then click the Browse button and select the file

from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then

copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN

button captures the current page and adds to the clipboard). Once the image is in the clipboard,

paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and

the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on

filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the test case. To

do that, click on the “Add Existing” button to bring up the add file association dialog box:
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http://mywebsite.com/?Document=1

Add Existing Document

Choose the location of existing document that you'd like to add:

Add Existing Document

Choose the location of existing document that you'd like to add:

®) Documents Source Code Documents [®] Source Code
Folder + Document Folder « File
> B Root Folder =7
Comment:

B Canee

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.

5.2.10. History

In this tab, the main pane displays the list of changes that have been performed on the test case artifact
since its creation. An example test case change history is depicted below:

Owerview Test Runs

Req. Coverage Relesses ncidents Attachments Test Sets Tasks History
Z Refresh | YW Filter | » | ## Admin View
Displaying 1 - 5 out of 5 changels).
Change ID Change Date ¥  Field Name Old value New Value Changed By Change Type
[2=] - ANy — | W -— ANy — | W
60 4-0ct-2017 Status Ready for Test Ready for Review _:ystem Modified
Administrator
il 2-May-2006 [Step] Expected Result User taken to first screen t,lf;éaker to next screen n Fred Bloggs Modified
9 2-May-2006 Name Library System v10.0 Library System Release 1 Fred Bloggs Modified
3 4-Mar-2005 [Step] Expected Result User taken to first screen Joe P Smith Medified
2 4-Mar-2005 Owner Fred Bloggs Joe P Smith Modified
Show | 15 “ | rows per page Displaying page 1 = of 1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” button to navigate to where you can revert any unwanted
changes.
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5.2.11. Test Sets

In this tab, the main pane displays the test sets that contain the current test case. Each test set is listed
together with its name, release, the date of last execution, the owner, the status, the execution status,
and a link to the actual test set details (see section 5.8). In addition, you can choose to display any of the

custom properties associated with the test run.

Overview Req. Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History
< Refresh | — Show/hide columns — | & | T Filter | &

@ Displaying 1 - 2 out of 2 test set(s) containing this test case

v % Name & Execution Status  Release Last Executed Owner Status D Edit
— Any —- | W — Any - w =] - Any — W - Any - w X Edit
1.0.00 1-Dec-2003 Joe P Smith In Progress X1 Edit
1-Dec-2003 Joe P Smith Not Started TX:2 Edit
Displaying page | 1 Zofl

The “show/hide columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of

“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Filter” button. In addition, you can quickly sort the list by clicking on one of the

directional arrow icons displayed in the header row of the appropriate field.

5.2.12. Tasks

This tab is only available to SpiraTeam users. It displayes a table view of any tasks that have been
associated to the test case. The only way to link a task to a test case is via test execution of a test case

with a type set to “Exploratory”.

Owverview Req. Coverage Test Runs Releases ncidents Attachments Test Sets Tasks History
+ add X Remove & Refresh T Filter |«

Displaying 1 - O out of O association(s).

¥ Type Artifact Type Mame Status Creation Date &% Creator Comment Project Mame D Edit
- Any - | v - Any - W B - Any — | v —Any — W Edit
show 13 v rows per page Displaying page | 1 Sofo
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5.3. Test Step Details

When you click on one of the hyperlinks next to a test step in the test step list (see above), you will be
taken to the test step details screen illustrated below:

Ability to create new book

2 27 Ability to create new book
% 1] Passed
@ Step 2 (T52)
@ Step 3 (T53)

Description

User clicks link to create book

Expected Result

User taken to first screen in wizard

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the test step detailed information itself, and the bottom part of the right pane contains
related information about the test step.

The navigation pane consists of a link that will take you back to the test step list, as well as a list of the
peer test steps to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the detailed information of all the peer test steps by clicking on the navigation links without having to first
return to the test step list page. You can also switch between seeing the list of test steps with the current
filter applier or simply unfiltered.

The top part of the right pane allows you to view and/or edit the details of the particular test step. You can
edit the various fields (description, expected result and sample data) and custom properties. Once you
are satisfied with them, click any “Save” button on the page to commit the changes. If you want to add a
new test step to the test case, you should click “Save and New” from the dropdown menu of the “Save”

button at the top of the page instead.

The lower part of the right pane can be switched between four different views by clicking the appropriate
tab. Initially the pane will be on “Incidents” tab, but it can be switched to “Attachments”, “History” or

“‘Requirements” tabs if so desired. Each of the views is described separately below.
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5.3.1. Incidents

In this mode, the main pane displays a list of any incidents that are associated with this test step. They

can either be linked indirectly due to being logged during a test run, or directly linked after the fact:

Incidents Attachments Histary Requirements
& Refresh | -- Show/hide columns —- |~ | Y Filter  ~ % Link Incident = % Remove

@ Displaying 1 - 1 out of 1 incident(s) linked to this test step

v % Name Type Status Priority Detected By Creation Date Owner Progress D & Edit
- Any — W — ANy —- | W — Any — W - Any - W [==] - Any - W —Any — | v IN Edit
% M) Cannot add a new book to the system Bug Assigned 1 - Critical Joe P Smith 3-Nov-2003 Joe P Smith IN7 Edit
Show | 15 v | rows per page Displaying page Zofl

Each incident is listed together with the type, status, priority, name, owner, detector, detection date and a
link to the actual incident details. You can customize the fields that are displayed using the “Show/Hide
Columns” option. In addition, you can perform the following operations:

>» Refresh — updates the list of incidents from the server, useful if other people are adding incidents
to this release at the same time.

» You can also filter the results by choosing items from the filter options displayed in the sub-
header row of each field and clicking the “Filter” button. In addition, you can quickly sort the list
by clicking on one of the directional arrow icons displayed in the header row of the appropriate
field.

> Edit — Clicking the “Edit” button to the right of the incident allows you to edit the incident inline

directly on this screen.

To create a new association between this test step and an existing incident, click the “Link Incident”

button which will display the following panel:

Incidents Attachments History Requirements.
Q, search
v D Name Project
IN:21 E_j Ability to associate multiple authors Library Information System
IN:29 Ej Ability to associate multiple authors Library Information System
IN:32 Ej Ability to be accessed by Mozilla Library Information Sy:
IN:28 Ej Ability to delete multiple authors Library Information
IN:27 B Ability to delete multiple books Library Informa
IN:25 B Ability to generate customized reports Library Information
IN-23 ¥ Ability to import data from excel Library Informa
IN18 E_j Ability to integrate with other systems Library Information System M
#
Cancel
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You need to choose the specific incident(s) you want to link to, either by choosing the item from the
scrolling selection box, or searching for them by name or ID. Before adding the chosen incidents you can

add a comment that explains the rationale for the association.

5.3.2. Attachments

This tab displays the list of documents that have been “attached” to the test step. The documents can be

in any format, though SpiraTeam® will only display an icon for certain known types.

Incidents Attachments History Requirements

Add New % Add Existing < Refresh —- Show/hide columns —— | » T Filter |~
Displaying 1 - 1 out of 1 attachment(s)
« Filename Type Size Edited By Edited On &% Author 1o} Edit
— Any - | W = — ANy - | W ==} — ANy — W DC Edit
Screen Shot 314 KB Fred Bloggs 30-Apr-2006 Fred Bloggs DCl4 Edit
Displaying page | 1 Zofl

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To delete an existing attachment from a test case, simply click the
“Delete” button and the attachment will be removed from the list.

To attach a new document to the test step, you need to first click the “Add New” link to display the new
attachment dialog box:

Add New Document Add New Document Add New Document
Type* ®File @ URL © Screenshot Type* File ®URL © Screenshot Type” File O'URL ® Screenshot
) .
Filename: Choose File | Mo file chosen URL"
Description: Description:
4 4 Screenshot"
» - . )
Document Type: Functional Specification | v Document Type:* Functional Specification | v
.
Document Folder: Root Folder hd Document Folder:" | Root Folder v Please paste your ima / ke
ags: Tags:
N Description:
Document Type:* Functional Specification | v
Document Folder:* Root Folder v
Tags:

There are three different types of item that can be attached to a requirement:
>» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.
The document will be copied from your computer and attached to the artifact.
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» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the requirement.

To do that, click on the “Add Existing” button to bring up the add file association dialog box:

Add Existing Document Add Existing Document
Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
*) Documents Source Code Documents [®] Source Code
Folder v Document Folder + File
O3 Root Folder (=]
m ~ Comment:
Cancel

m Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.

5.3.3. History
This tab displays the list of changes that have been performed on the test step artifact since its creation.

An example test step change history is depicted below:

© Copyright 2006-2017, Inflectra Corporation Page 112 of 312 This document contains Inflectra proprietary information



http://mywebsite.com/?Document=1

Incidents Attachments History Requirements
Z Refresh | T Filter | v | % Admin View

Displaying 1 - 2 out of 2 changels)

Change ID Change Date #¥  Field Name Old value New Value Changed By Change Type

[=z] ——Any — | W = Any | W

1 2-May-2006 Expected Result User taken to first screen User taken to next screen in wizard Fred Bloggs Modified
3 4-Mar-2005 Expected Result User taken to first screen Joe P Smith Modified

Show | 15 v | rows per page Displaying page 1 Zofl

5.3.4. Requirements

Normally within SpiraTest, you will link the test cases in a project with your requirements to describe
which requirements are covered by each of the test cases. When all of the tests for a requirement pass,
the requirement is considered fully tested.

However, in some industries (for example when developing Defense systems) there is an additional
requirement to report on the traceability between the individual test steps and the requirements. For
customers that have such a requirement, this tab lets you associate the current test step with specific

requirements.

Incidents Attachments History Requirements
+ Add | X Remove = & Refresh T Filter |

Displaying 1 - O out of 0 association(s)
¥ Type Name Status Importance Project Name ID
—Any — W —Any — W —Any — ¥ —Any — | v RQ

Show | 15 ~ | rows per page Displaying page | 1 Sofo

The tab displays a grid containing the requirements already mapped to this test step. You can filter that
list by the requirement type, name, status, importance, project name and ID. You can remove an existing
requirement by selecting its check box and clicking the ‘Delete’ button. This doesn’t delete the

requirement, just removes it from the test step.

Hovering the mouse over the names of the requirements will display a “tooltip” consisting of the
requirement name, place in the hierarchy and a detailed description.

To add a new test case to the requirement, simply click on the ‘Add’ button:
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All Packages ~ | Filter

v ID Name

[ RrRQ:1 7 Functional System Requirements

[ RrRQ:2 7 Online Library Management System

0 rRQ:3 7% Book Management

[ rRQ:4 “E“‘ Ability to add new books to the system

O rQ:s “E“‘ Ability to edit existing books in the system

[0 RrRQ:6 “E] Ability to delete existing books in the system

0 RrRQ:7 9 Ability to associate books with different subjects

[ rRQ:8 9 Ability to associate books with different authors
BB ARl ba accnciata haabe with Aiffarant adiinne

M pn.o

Cancel

Q search

Project

Library Information System
Library Information System
Library Information System
Library Information System
Library Information System
Library Information System
Library Information System
Library Information System v

e

You can search for a requirement by its ID if you know it (make sure to include the “RQ” prefix):

All Packages ~ RQS

v ID Name
[ RQ:6

] Ability to delete existing books in the system

Cancel

Otherwise, you can search for the requirements by choosing a parent package from the dropdown and/or

entering a partial name match:

All Packages ~ ‘ associate books

v ID Name
O RQ:1 7 Functional System Requirements

[ RQ:2 7% Online Library Management System

[ RQ:3 7 Book Management

O RQ:7 ] Ability to associate books with different subjects
[ RQ:8 & Ability to associate books with different authors
[ RQ:9 ] Ability to associate books with different editions

Cancel

One you have found the desired requirement(s), simply select their check boxes and click the ‘Save’

Q search

Q search

button to add them to the current test step:

Incidents % Attachments History Requirements &

4+ Add  XDelete | Refresh Y Filter | v

Displaying 1 -4 out of 4 association(s).

v Type 4% Artifact Name 4%

O —Ay-

[ Feature “E] Ability to associate books with different editions
[ Feature ‘E‘l Ability to associate books with different authors
[ Feature ) Ability to edit existing books in the system

[ Feature &) Ability to add new books to the system

Show 15 ~ | rows per page
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Status &%
—Any- v
Developed
Developed
Developed

Developed
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Project

Library Information System

Project
Library Information System
Library Information System
Library Information System
Library Information System
Library Information System

Library Information System

Importance &% Project Name &% ID&v
- Any - v -~ Any - v
Library Information System RQ?
Library Information System RQ8
Library Information System RQS
Library Information System RQ4
Displaying page 1 Tofl
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5.4. Execute Test Case(s)

This section describes how a tester can follow the steps defined for a series of test cases and record
what actually happened in the process. In addition, recorded failures of test cases can be used to

automatically generate new incidents that will be added to the incident tracking module (see section 6).

You start test case execution in SpiraTeam by either:
1. selecting test cases or test sets on their respective page(s) and clicking the “Execute” button;
2. clicking the “Execute” button on the test cases / test sets listed on your personalized home page
under “My Test Cases” or “My Test Sets”.

If you execute a test set then the values of the selected release and custom list properties for the test run
are automatically populated from the test set, whereas if you directly execute a test case itself, those
values can be chosen by the tester.

Regardless of the route taken to launch the test execution module, the first screen that will be displayed
will look like the following:

—_—
v Internal Projects v Library Informati.. -n Planning ~ Testing ~ Tracking ~ Reporting .SvstemAdm,,, v

TestCases >  es ution / TestSets / TestRuns / Automation Hosts

Test Execution Wizard

Please the Release and Custom Properties To E:

Release:™ 1.2.0.0- Library System Release 2005

Build: --None - v

(Note: Any custom properties that are read-only have already been populated from the Test Set.)

Web --- Please Select--- | W Operating | --- Please Select --- | v
Browser: System:

Notes:

Format - B T

=

I i

E 9 = L= M|

B 52| B Source

Cancel

Before actually executing the test scripts, you need to select the release (if not already set) and optionally
the specific build of the system that you will be testing against. You can also specify any test run custom
properties that have been defined by the project owner. This ensures that the resulting test runs and
incidents are associated with the correct release of the system, and that the test runs are mapped to the

appropriate custom properties (e.g. operating system, platform, browser, etc.).
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If you have not configured any releases for the project, then the release drop-down list will be disabled
and the test runs/incidents will not be associated with any particular release. If the test run was launched
from a test set, the release and any list custom properties will be pre-populated from the test set itself and
will not be changeable on this screen (unless they weren’t set by the test set).

Once you have chosen the appropriate release name and/or custom properties, click the “Next” button to

begin executing test steps. By default you will see the default test execution module, shown below.

There is a second test execution view: the exploratory test execution module. This has much in common
with standard test execution but differs in a number of important ways. It is discussed in more detail at
section 5.4.7. You will automatically see this module if the following three conditions are met;

1. you are executing a single test case (not a test set or a test case as part of a test set);

2. thattest case is of type “exploratory”; and

3. you have the necessary permissions (you can create test cases)

—_
Vv  Internal Projects Library Informati... -n Planning ~ Testing ~ Tracking ~ Reporting FrsdBIoggs v

Test Cases > 1/ TestSets / TestRuns / Automation Hosts
. . . Display: Split Table Mini =
Testing New Functionality rejease 1.2.00
. m
Progress (0 / 11 complete
< > n a
D Ab"ity to create new author « Pass ~ @ Blocked A Caution x Fail = N/A
)
() Step 1 User opens up Chrome anc ,
[J Ability to create new author (rc4)
e ) _—
~ StEp 2 User ogs into application Tests that the user can create a new author record in the system
) . .
(U Step 3 User clicks link to create ai O Step 1 User opens up Chrome and enters application URL: http://www.libraryinformationsystem.org
O Step 4 User enters authors name Ex The browser loads the login web page
- Samp http://www.libraryinformationsystem.org
O Step 5 User associates books with
e . N .
(U Step 6 User clicks submit buttan ActualResult | Attachments Incidents | Eal
Person loses book and needs t = =
D Format - B I T, = i E 9 = EE = [m { B souce
O Step 1 User opens up Chrome anc
O Step 2 User ogs in to application
O Step 3 User clicks link toreport Ic 4

@] Step 4 User chooses lost book fra

O Step 5 User clicks submit button

The screen is divided up into three main areas (each is explained in more detail in the sections below):

» The header area at the top of the page, which displays the name (if any) of the test run, along
with the selected release. This section also contains buttons to control how the “test execution
area” looks and functions for the tester.

» The Progress Bar, which shows a summary graphical view of the whole test run. The progress

bar also has a number of navigation buttons to help you move around the test run, or to leave the
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test execution page. Between the buttons are indicator blocks. For test runs with relatively few
test steps, each indicator block represents a single test step. A tall dotted line is used to indicate
the end of one test case and the start of another. When there are many test steps to a test run,
each indicator block represents a test case. Hovering over an indicator block will display a tooltip
with information about the test step or case represented. The color of the indicator block matches

the color of any assigned execution status for the test step or test case (see below).

» The rest of the page contains the “test execution area”. This has details about all of the steps in
the test run. It can be used to both navigate between test cases and test steps, as well as to
actions on any test case or test step (for instance assigning an execution status or logging an
incident). This area can look markedly different depending on which display mode a user has
selected. However, in every mode, a tester will be able to readily view the name and description
of the test step (and at times the parent test case), along with the description of the test step,
instructions for carrying out it, and any expected results. The test can then compare the results
with those listed as expected. As described below, depending on how the actual system

responds, you will use the buttons and fields on the page to record what actually happened.

Note: on first accessing this screen, the user will be given a guided tour of many of the features of this

page. This can be accessed at any time via the options menu (discussed below)

5.4.1. Display Modes

The display mode toolbar is at the top right of the test execution screen. There are three different display
modes. Each display mode has two sub-modes, using simple graphical images to indicate what they do

(each pair of buttons to change sub-mode becomes visible on activating a particular display mode).

Display: Split Table Mini

All of these modes affect how the test cases and test steps are displayed in the “test execution area”. The
different views have been designed to suit different ways of testing, depending on how your organization
works; or the needs of a tester for a particular test.

There are three parts in the “test execution area”, which are visible or hidden depending on the view.

» Table: this shows a list of every test case and step in the test run. The level of information it

displays depends on the display mode.
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» Inspector: this is a detailed form containing full information about a single test step (and its
associated test case as needed). It also always shows the full set of actions that can be taken on
that step

>» Iframe: if you are testing an internal website (or external site that allows access via iframes) you
can access it directly from this iframe browser. This allows you to have the test execution page
and what you are testing open in the same web browser tab.

There are three main display modes:

> Split mode: shows a simplified list of test steps on the left (in the table) and full details about the

currently selected test step on the right (in the inspector). The sub modes in the split view either

show a narrow table and wide inspector, or a wide table and narrow inspector.

—
% Internal Projects Library Informati... -a Planning ~ Testing ~ Tracking ~ Reporting FredBIoggs b

Test Cases > es ecutio / TestSets / TestRunms / AutomationHosts

Testing New Functionality geicsse 1200 plrian [ Solt o v
. m
Progress (0 / 11 complete)

< >on

&
D Ab"ity to create new author # Pass ~ @ Blocked A Caution X Fail = N/A
OStep1u Ch
\ ser opens up Chrome anc .
[J Ability to create new author (rc 4
A ) _—
(U Step 2 User logs into application Tests that the user can create a new author record in the system
O -
(J Step 3 User clicks link to create a1 O Step 1 User opens up Chrome and enters application URL: http://www.ibraryinformationsystem.org
QO S‘rep 4 User enters authors name Expected Result The browser loads the login weh page
Sample Data http://www.libraryinformationsystem.org
O Step 5 User associates books wit!
O Step 6 User cli it butt
- Step 6 User clicks submit button ActualResult | Attachments | Incidents | [al
Person loses book and needs t = -
D Format - B I I, == E 9 = LB H = lw 2 [Bsource
O Step 1 User opens up Chrome anc
O Step 2 User logs in to application
A - i} 4
9 Step 3 User clicks link toreport lc

O Step 4 User chaoses lost book fra

O Step 5 User clicks submit button
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—_—
v Internal Projects v Library Informati... -n Planning ~ Testing ~ Tracking ~ Reporting

TestCases >  les on TestSets / TestRuns / Automation Hosts

Display: Split Table Mini

Testing New Functionality pejezse 12,00 o Ts
1 1

Pr’cgress (0 / 11 complete )

»

< > n

[J Ability to create new author (TC4) Tests that the user can create a new author record in the system v - @ A = =

O STED 1 User opens up Chrome and enters application URL: http://www.libraryinformationsystem.org D Ab| I |ty tO Cl‘eate new

O Step 2 User logs in to application aUthOr Tc4)

O - +
O Step 3 User clicks link to create author Tests that the user can create a new
author record in the system

e
(U Step 4 User enters authors name and age o St

ep 1 User opens up Chrome
and enters application URL:

@] Step 5 User associates books with author

O Step 6 User clicks submit button
. . The browser loads the loginweb
D Person loses book and needs to report loss (T 12) Teststhat the user can create a new author record in the system page

Data:

O Step 1 User opens up Chrome and enters application URL: http://www.libraryinformationsystem.org
http://www.libraryinformationsystem.org

o
O Step 2 User logs in to application

O Step 3 User clicks link to report lost book Actual Result | Attachments

O Step 4 User choases lost book from list of his loans Incidents | &

O) . .

O Step 5 user clicks submit button Format ~ B I I
== i 99
= WEE=S B
52 | [@ Source

» Table mode: in this mode the table takes up the full width of the “test execution area”, with both
the inspector and iframe completely hidden. The list of test cases and steps displays all the
information about each—the same information as is shown in the inspector. This view makes it
easy to quickly scan through a number of test steps and take quick actions on many steps in
sequence. The sub-modes in this view either expand or collapse any fields with more than one
line or text in them. This is helpful to give either a very detailed or summary view to the table.
Note too that every field that takes up more than one line will have a little expand or collapse

button to its left, allowing for control of individual fields as needed.
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]
% Internal Projects Library Informati.. _n Planning « Testing ~ Tracking Reporting Fred Bloggs

TestCases » Tes ecution Test Sets Test Runs Automation Hosts
. . |. Display: Split Table Mini =
Testing New Functionality release 1.200
1 i
Progress (0 / 11 complete)
< > n a
[J Ability to create new author (TC4) Tests that the user can create a new author record in the system ¥
O Step 1 User apens up Chrome and enters application URL: http://www.ibraryinformationsystem.org v o B - - v | @
Expected Result: The browser loads the login web page
Sample Data: http://www.libraryinformationsystem.org
O Step 2 User logs in to application v o | a - = +v | @
User taken to main menu screen
Login=librarian, Password=librarian
O Step 3 User clicks link to create author v o  a - o +v | =
Ex ed Result User taken to first screen in wizard
O Step 4 User enters authors name and age v © A - - +v | @
E ed Result: User taken to next screen in wizard
Sample Data: Martin Amis, 39
O Step 5 User associates books with author v e A - - +v =
User sees screen displaying all entered information
Londen Fields, Money, Informational
O Step 6 User clicks submit button v o  a - o +v | =

>» Mini mode: this mode fills the entire “test execution area” with the inspector, or a combination of
the inspector and iframe. The table is completely hidden in this mode. The mini mode is designed

to help you maximize space for the inspector or to allow you to test a website in the embedded

mini browser (in the iframe) right next to a narrow inspector.

—=|
Vv  Internal P ts Library Informati... _n Planning ~ Testing Tracking ~ Reporting Fred Bloggs v

TestCases > Te ecution TestSets / TestRuns / AutomationHosts

Display: Split Table Mini

Testing New Functionality rejease 1.2.00

Progress (o / 11 complete)

<y m a
+ Pass ~ @ Blocked | A Caution - = N/A
[J Ability to create new author (rc4)
Tests that the user can create anew author record in the system
O Step 1 User opens up Chrome and enters application URL: http://www.libraryinformationsystem.org
Expected Result The browser loads the login web page
Sample Data http://www.libraryinformationsystem.org
Actual Result Attachments Incidents Eal
Format - B I |, 1= = E 99 e MEM= @ § [&soue
r
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—
Bl ~ Internal Projects v

TestCases >  Jes

Library Informati.. -n Planning ~

Test Sets

Testing ~ Tracking ~ Reporting

Test Runs Automation Hosts

FredBloges Vv

Testing New Functionality rejease 1200

Prcgress (0 / 11 complete)

Display: Split

Table

z
2
[}

£ > n a
v - o al¥ - € > ~
[J Ability to create new v Library Info.. ™ Planning ~ | Testing = | Tracking ~ Reporting
author (rea) TestCases ¥  Test Case Execution TestSets / TestRuns / Automation Hosts

Tests that the user can create anew
author record inthe system

O Step 1 user opens up Chrome
and enters application URL:
http://www.libraryinformationsystem.org

The browser loads the login web
page

Test Execution Wizard

Please Choose the Release and Custom Properties To Execute Against

Release:"
1.2.00-Library System Release 2005

Build:
Sample Data:
o --None -- ~
http://www.libraryinformationsystem.org
(Note: Any custom properties that are read-only have already been populated from the Test Set.)
Actual Result Attachments
‘Web Browser: Operating System:
ncidents | 8l - Plazsa Salact — v -~ Please Salact — v v
Format - B I T, - —
ooz k| inflectra= -
= HREBEE®
52 | [8 Source

5.4.2. Navigating Around a Test Run

There are several ways to move through the different cases and steps of a particular test run. In the
default “split” mode you are guided through a test run in order, however at any time, in any display mode,
you can easily and quickly move steps. Note that if you click on a test case, the first test step in that test

case will be selected as well.

» Using the progress bar buttons: the left-hand side of the progress bar has three buttons:
backward, forward, and play/pause (the last of these is discussed in more detail below). Clicking
on the backward or forward buttons will move to the previous or next progress bar indicator block

(and the associated test step or test case).

Progress (0 / 11 complete)
< > 0m

» Using the progress bar indicator blocks: clicking on any indicator block will immediately focus

the test execution area on that test step or test case.
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» Using the table: when the table view is visible (in either split mode or table mode) clicking on any

item will immediately focus the test execution area on that test step or test case.

>» Progressing through steps using the inspector: when the inspector is visible (in split or mini
display mode), on properly setting a status for a test step (see 5.4.3 for further details), the next
test step is automatically loaded into the inspector. If you were on step 3 of 5, you would be
moved to step 4. If you were on the last step of a test case, you will be moved to the next test

case, if one is available.

>» Pause/Play button: the time spent on every test step is recorded, by default, during test
execution. This allows an accurate assessment of exactly how long a test run took to complete
and these timing details are saved with the test run and its results. If you wish to pause the
behind-the-scenes timer (for instance if taking a break) click the pause/play button. To resume

the time click it again.

The currently selected progress bar indicator block will be outlined with a peach border. The currently
selected test case and test step on the table view will be indicated with a peach bar along their left edge,

and will also be highlighted in a light peach.

:,1 Person loses book and needs to report loss (TC12) Tests that the user can create a new author record in the system

«

3 Step 1 User opens up Chrome and enters application URL: v %)) A x - + v
http://www.libraryinformationsystem.org

¥

The browser loads the login web page

http://www.libraryinformationsystem.org

Step 2 User logs in to application v o Fa s - v | @
User taken to main menu screen
Login=librarian, Password=librarian

5.4.3. Viewing and Recording Execution Details

There is a small icon to the left of each test step title and test case title. For test steps this is a circle, for
test cases a square note. Once a status has been recorded for a test step (or once a test case has been
assigned a status based on the statuses of its test steps) these icons will be filled with a visual indicator of
its current status. The icons both become colored and are given a small symbol, based on the status. In

the inspector view the associated button to that status has a gray bar beneath it.
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+ Pass @ Blocked = M Caution = % Fail - N/A

v Step 2 User ogs in to application
Expected Result User taken to main menu screen

Sample Data Login=librarian, Password=librarian

The same colors and symbols used to show a status are used on the buttons to record a status. The
colors and symbols used are: green / tick = “Passed”; yellow / stop sign = “Blocked”; orange / warning
triangle = “Caution”, red / cross = “Failed”, gray / dash = “Not Run”.

Depending on the display mode and device, the buttons may show the text name of the status along with
the symbol (see examples below—the top button set is that on the inspector, the bottom from the table

(when the display mode is set to table).

+ Pass @ Blocked A Caution *® Fail - MN/A

v ) A »® -

The various statuses when recorded against test steps will appear as below, respectively:
v 02 A X -

You will notice that softer shades are used above compared to the buttons. Similarly soft shades are also

used on the progress bar indicator blocks, as shown below.

The status of a test case is determined by its test steps. If any of the steps are marked as “Caution”,
“Blocked”, or “Fail” then the overall test case is marked with the most severe status of those statuses
applied to any of the test steps from “Caution”, to “Blocked”, to “Fail” (e.g. if one is marked as “Caution,
the test case will be marked “Caution”; but if one is marked as “Caution”, and another “Blocked”, the case
will be marked “Blocked). If all the test steps passed, or if steps are marked either passed or “N/A”, then
the overall test case is marked as “Passed”; any other case results in the test case being marked as “Not

”

Run”.
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If the expected results are indeed observed, then you simply need to click the “Pass” button to mark the
test step as passed, and advance to the next test step, or if all the steps have passed, you can click

“Pass All” to pass all the steps at once.

On the inspector, the “Pass All” button is visible via a dropdown to the right of the “Pass” button
whenever the parent test case information is also displayed with the test step (typically only for the first

step in a test case). This is illustrated in the screen shot below:

v Pass | + @ Blocked

¥ Pass All
Aumnity w ureate

When in the table display mode, the “Pass All” button is shown on the right-hand side of the test case

row, as illustrated below:

Abl|lty to create new author (1C4) Tests that the user can create a new author record in the system

«

> Below the main pane there are two optional sections. The first one allows you to log an incident in
the system associated with the test step. For failures this will typically be used to log a bug
relating to the failure. However even if you pass a step you can still log an incident, which may be
useful for logging non-critical cosmetic items that are not serious enough for a failure to be
recorded. This tab also displays any pre-existing incidents that were associated with the test step

being viewed.

> The second tab displays a list of attachments that are related to the current test case and/or test
step. This list initially contains any documents that have been attached to either the test case in
general or the test step in particular. However as you perform the testing, you can attach
additional documents to this list that are relevant to the test results (e.g. screenshots of an error
page); these attached documents will be associated with both the test run itself and any incidents

that are created.

Once all the test steps have passed, you will be automatically be taken to the first step in the next test; if it

is the last test case being executed, the <Finish> button will be displayed instead.

If the actual results differ from those expected, you need to enter a description of the actual result
observed and click one of the “Fail”, “Blocked”, “Caution”, or “N/A” buttons. Unlike the “Pass” button, if

you don’t enter a description for the actual result, the system will display an error message and re-prompt

you again for input.
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In the inspector, the actual results text box is shown in the first tab below the information provided to the

tester for a test step, as illustrated below:

x Step 2 User logs in to application

User taken to main menu screen

Sample Data Login=librarian, Password=librarian
Actual Result Attachments Incidents [al

Mormal - B I I. = i 79
= M EME= @ X [souce

The password was not accepted

In the table display mode, previously entered actual results are always visible (below the information
provided to the tester for a test step). On attempting to mark a step as anything other than “Pass” the

actual results text box will automatically be displayed.

OStep 1 User opens up Chrome and enters application URL: v @ A ® - + - ]
http://www.libraryinformationsystem.org

The browser loads the login web page

http://www.libraryinformationsystem.org

You need to enter the Actual Result when recording a Blocked Test Step! Click the button below to
confirm.

Normal - B I I, = 99 @ EHEm= @

K2
22 | [ Source

I
n

@ Blocked

You can also choose to manually show the actual results text box by selecting “Actual Result” option from

the “+” dropdown menu.
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Ostep 1 User opens up Chrome and enters application URL: v @ 'y ® - + ~ | [
http:/fwww.libraryinformationsystem.org
Actual Result

Expected Result: The browser loads the login web page

nple Data http:/fwww.libraryinformationsystem.org 4 Add New Attachment
O Step 2 User logs in to application ,, % Link Existing Attachment al

- _ ) + New Incident
Expected Result: User taken to main menu screen !

Sample Data Login=librarian, Password=librarian S Link Existing Incident

—_~ - - —

5.4.4. Saving Screenshots to a Test Step

Often, testers will want to provide visual documentation of what they have found during the testing
process. A screenshot of what they are testing is a great way to do this. To add a screenshot to the
results of a test step, first copy your screenshot to the clipboard. Next, paste the screenshot into the

actual results text box.

5.4.5. Recording Extra Information

In addition to logging the result of a test step, you can optionally choose to generate a new incident at the
point of logging the execution status of a test step. When the incident form is visible (see below) enter a
name, type, priority, severity (and any custom properties) for the new incident before clicking an
execution status button. The other information needed for the new incident is automatically populated
from the test step details. The newly created incident will also be linked to the test step, allowing
traceability from within the incidents module. The functionality for managing incidents is described in more

detail in section 6.

If the inspector is visible, go to the “Incidents” tab. This will show any already linked incidents, show a

detailed form for creating a new incident.
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O Step 1 User opens up Chrome and enters application URL: http://www.libraryinformationsystem.org
Expected Result The browser loads the login web page
Sample Data: http:/www.libraryinformationsystem.org
Actual Result Attachments Incidents a)

No incidents are currently linked to this test step Link Existing Incident

New Incident

Please enter the following information to log an incident with this test step:

Name:* Cannot log into the web page correctly
Type™® Bug v Priority 1-Critical hd
Severity: 2 -High v

Component: = Author Management | Vv

Notes:

Format - B I = iz 4|y @ L E M= @ 3 B Souce

=
bl
]

i

--- Please Select --- v --- Please Select --- v Internal?:

& Difficulty:* --- Please Select -— v

--- Please Select --- v Decimal:

You can instead link the test step to an existing incident (by clicking the “Link Existing Incident” button).

The following popup will be displayed, where you can either enter an incident ID (if known), or choose

one from the list.

Add New Association

Please choose the artifact that you want to add an association to:

Enter Artifact IN
ID:
v Name
Choose from ¥ Doesn't let me add a new category
list: 3 Quote handling issues throughout

¥ Cannot install system on Oracle 9i
¥ Validation on the edit book page
¥ Cannot add a new book to the system
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When in the table display mode, open the “+” dropdown menu to show options to either add a new
incident or link an existing incident. Click on the option required to display the appropriate popup. Note

that on clicking “Add” the incident will be immediately linked to the selected test step.

If you need to attach documents to the test run (in addition to any screenshots), you can either attach a
new or link an existing document. From the inspector, go to the “Attachments” tab to see any documents
already linked, or to add a document as needed. In the table display mode, select either “Add New
Attachment” or “Link Existing Attachment” from the “+” dropdown menu. See section 5.2.9 for additional
information about how to the different available options (e.g. either upload a document, url link, or

screenshot, or to link a document or from source code).

5.4.5. Leaving the Test Execution Page

If you are not able complete the whole test run in a single session, click the “Leave” button on the right of
the progress bar—shown with an eject symbol (see below). This will return you to the page where you
began the execution from. You can resume testing at a later date by locating the test run on your ‘My
Page’ under ‘My Pending Test Runs’ and choosing to resume testing. Note that the system will remember
every result you have logged, along with the last test step you were working so you can pick up right

where you left off.

14

Once either all steps in a test have an execution status recorded, or at least one step in each test case
has been recorded with any status other than “Pass” the test run can be finished. An orange button at the
far right of the progress bar with a stop symbol will appear (see below). Clicking this button will save and
archive the entire test run (so it can no longer be amended) and the page will automatically exit the test
execution page.

=n

5.4.6. Extra Test Execution Options

There are a number of ways that some users may wish to alter the test execution page, depending on
how they work. Options to change this are available from the menu button to the right of the display

buttons.
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Display: Split Table Mini

The following actions are available from this dropdown menu:

» Refresh: this simply reloads the test run data. This is useful if other people are working on
different test cases within the same test run and you want to make sure that you have the most

current information about the statuses they have recorded.

> Always show test case: by default, the inspector only shows the test case details when the first
test step of a test case is displayed. Checking this item will mean that the test case details will be

shown on every test step.

» Show custom properties: by default, only a handful of system fields are shown for the test case
and test step. If your organization places important and relevant information into custom fields as
well, you can check this item to make them visible in the inspector for every case and step. Note

that these fields will not be visible in the table display mode.

» Show guided tour: if you missed or want to revisit the visual guided tour of the test execution

page, click this button to run the tour again.

5.4.7. Exploratory Test Execution

As mentioned above, there are a number of conditions that must be satisfied for a test to run in
exploratory mode. Exploratory testing is designed for relatively experienced testers and rather than to
record the results of a pre-determined set of steps, to instead adjust and create the testing sequence
during the act of testing itself. During exploratory testing test steps can be added, removed, edited,
moved freely, at any time.

Care must therefore be taken that this form of testing and of recording the results of a test are used

appropriately. The conditions set by the system are one means of limiting its use.

When starting exploratory testing the main screen will resemble the one below. Note that it looks broadly
similar to that for standard test execution and is made up of three different areas:
1. alist of test steps on the left;
2. details about the currently selected step on the right; and
3. information at the top of the page about the test run itself (it's name and description, release, and
how many steps it contains), along with a mini toolbar. In exploratory testing there is no progress

bar, or options to layout the page in different views.
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Exploring testing

Release 1000 TC:23 (0 /1 Steps )

(O Step I New Test Case « Pass ~ @ Blocked A Caution | % Fail  — N/a

O Sfep 1

New Test Case

Actual Result

Tasks ncidents Attachments
Please enter a name to \Cg the task

Description

Owner -- None ——

All fields in the right hand details area, or the top part of the page can often be edited. Their contents and
associated label will be grayed out if they are read only fields (for instance if they are information from a
custom property). To edit a field, click on it, change the text as required, then click out of the field. The
information will be automatically saved. Note that any test steps that come from a link test case will be

read only and as such their contents cannot be edited, nor can they be deleted.

Just like with normal test execution, you can navigate between steps using the list of steps on the left;
and steps can be passed, or failed using the execution status toolbar on the right hand section of the
page. The unique actions you can take on test steps (besides editing their fields) are below:
1. add a step: click on the plus button beneath the list of test steps on the left
2. clone an existing step: when you hover a test step in the list, you will see a button appear on its
right. Click on this to show a mini menu with an option to clone the step. This will create a clone,
at the bottom of the list of test steps, with a blank actual result
() Step 1 New Test Case () step 1: New Test Case

- . O Descripti 1 c slete
() step 2 Description () step 2: Description 1 Clone % Delete

3. delete an existing step: if you have more than one test step, any editable test step can be
deleted. Click on the button for that step (as explained above) and click delete from the mini

menu.
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4. move an existing step: to move an editable step click and drag it to the desired location in the

test step list.

Below the main detailed section there are two or three tabs. SpiraTest users will only see two tabs —
incidents and attachements. SpiraTeam users will additionally see a tasks tab. The incident and

attachment tabs function identically to normal test execution.

The task tab allows the tester to quickly create tasks based on their exploratory testing, and optionally
assign them to a user involved in the project. These tasks are attached to the test run as a whole, so any
previously entered tasks will be visible even when changing steps. Creating a task is a light touch way of
communicating with others about your findings and alerting them that some work is likely required to fix or

clarify a feature. It is quicker to enter and manage than an incident.

Tasks Incidents Attachments
Please enter a name to log the task

Description

Q

wner: -- None --

Tasks are shown as a list of cards with their left edge showing their priority by color. On creation a task’s
status will be gray — showing that no priority has yet been set. The title of the task can be clicked to open

the details page for that task.

multiple times

The toolbar at the top right of the page has a number of buttons:

mn a2 =

1. Pause/Play button: the time spent on every test step is recorded, by default, during test
execution. This allows an accurate assessment of exactly how long a test run took to complete
and these timing details are saved with the test run and its results. If you wish to pause the
behind-the-scenes timer (for instance if taking a break) click the pause/play button. To resume

the time click it again.
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2. Leave button: as with normal test execution, if you are not able complete the exploratory test in a
single session, click the “Leave” button—shown with an eject symbol. You can resume testing at
a later date by locating the test run on your ‘My Page’ under ‘My Pending Test Runs’ and
choosing to resume testing. Note that the system will remember every result you have logged,

along with the last test step you were working so you can pick up right where you left off.

3. Finish button: once either all steps in a test have an execution status recorded, or at least one
step has been recorded with any status other than “Pass” the test run can be finished. An orange
with a stop symbol will appear (see below). Clicking this button will give you two options. “Update
Test Case” will update the test case execution status, and also change its name, description, and
test steps to reflect those on this page (adding, deleting, moving, editing as necessary). “Just
Finish” will only change the execution status of the test case only—leaving all details of the test
case unchanged. Either option will archive the entire test run (so it can no longer be amended)

and the page will automatically exit the test execution page.

m =2 =
Update Test Case

Just Finish

4. Options: the right most button on the toolbar gives additional options for customizing the page.
Specifically a user can decide what fields they wish to show or hide based on how they prefer to
work in exploratory testing mode. Additionally this menu let’s you revisit the introductory tour

shown the first time the page is visited.

m a| =
& Show test case description
(O Show expected result
(O Show sample data
)

() Show custom properties

e

O Show last result

@& Show Guided Tour
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5.5. Test Run List

When you click on the Testing > Test Runs global navigation link, you will be taken to the test run list

screen illustrated below:

@ w Olibrary Information System Planning ~ | Testing = | Tracking ~ Reporting . System Administrator s
Test Cases / Test Sets Test Runs / Automation Hosts Configurations.
Quick Filter e X Delete || £ Refresh | Y Filter v | £ Tools  w || — Show/hide columns — | w
(No filters available) Displaying 1 - 15 out of 20 test run(s) for this project.
¥ % Name End Date Test Set Type Tester Execution Status D& Edit
Releases
=] —Any - | v —Any - w | —Ay - v Ay — v TR Edit

4 [ Library System

- 1-Dec-2003 Manul Joe P Smith Failed TR Edit
4 [@ Library syste.
) teration 001 1-Dec-2003 Manul Fred Eloggs Passed TR2 Edit
B Iteration 002 1-Dec-2003 Manul Fred Eloggs Passed TR3 Edit
B Iteration 003 |-Dec-2003 Manul Joe P Smith Failed R4 Edit
4 [ Library Syste |-Dec-2003 Manual Joe P Smith Passed RS Edit
B Iteration 0O
- 1-Dec-2003 Manual Joe P Smith Passed TRE Edit
B Iteration 002
- -Dec-20( anual loger Q Ramjed asse 7 Edit
) eration 003 1-Dec-2003 [ Roger Q Ramjet |Passed TR7
£ tteration 001 1-Dec-2003 Manual Roger Q Ramjet |Passed TRE Edit
B tteration 002 1-Dec-2003 Manual Fred Bloggs Caution TRIO Edit
B tteration 003 |-Dec-2003 Manusl Fred Bloggs Blocked TR Edit
[ Library Syst
4 [ Library System 1-Dec-2003 Automated Fred Bloggs Failed TRI2 Edit
[B Library Syste...
&) teration 001 2-Dec-2003 Automated Fred Bloggs Passed TRI3 Edit
= eration
B tteration 002 2-Dec-2003 Automated Fred Bloggs Passed TRI4 Edit
) iteration 002 28
B iteration 003 3-Dec-2003 Automated Joe P Smith Passed TRIS Edit
@ Library System B Ability t 3-Dec-2003 Automated Joe P Smith Blocked TRI6 Edit
Show | 15 v | rows per page Displaying page | 1 Sofzm M

The test run list screen displays all the individual test executions performed in the current project, in a
filterable, sortable grid. The grid displays the test run number together with fields such as execution
status, name, assigned tester, execution date, test set, specified release, etc. The choice of columns
displayed is configurable per-user, per-project, giving extensive flexibility when it comes to viewing and
searching test runs.

In addition, you can view a more detailed description of the test run by hovering over the test run name
hyperlink to display a “tooltip”. If you click on this test run hyperlink, you will be taken to the test run
details page described in the next section. Clicking on any of the pagination links at the bottom of the
page will advance you to the next set of test runs in the list according to the applied filter and sort-order.
There is also a drop-down-list at the bottom of the page which allows you to specify how many rows

should be displayed in each page, helping accommodate different user preferences.

5.5.1. Refresh

Clicking on the “Refresh” button simply reloads the test run list. This is useful as other people may be
completing test runs, and after stepping away from the computer for a short-time, you can click this button
to make sure you are viewing the most current test run list for the project.
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5.5.2. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test run list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.

5.5.3. Sorting and Filtering

You can easily filter and sort the list of test runs. To filter the list by any of the visible fields, you simply
choose an item from the appropriate drop-down list, and for the other fields, you enter a free-text phrase
then click <Filter> or press the <ENTER> key to apply the different filters. Note that the name field is
searched using a “LIKE” comparison, so that searching for “database” would include any item with the

word database in the name.

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the darker
arrow. In the screen-shot above, we have filtered on test runs that have failed, sorted in order of

increasing release version number.

Clicking on Filter > Clear Filter removes any set filters and expands the test run list to display all test runs
for the current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My Page’

for use in the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

As a shortcut, the left hand panel includes a set of Quick Filters that can be applied in a single-click:
e The topmost section — This displays any saved requirement filters created by the current user
alongside any ‘shared’ filters. The latter are marked with an icon showing a group of people.
e Releases — This section lists the releases and iterations defined for the current project. Clicking

on any of the releases or iterations in the list will filter the requirements by that release/iteration.

5.5.4. Printing Items

To quickly print a single test run or list of test runs you can select the items’ checkboxes and then click

the Print icon. This will display a popup window containing a printable version of the selected items.

5.6. Test Run Details

When you click on any of the individual test runs in the test run list, you are taken to the Test Run details

page (not to be confused with the Test Case details page) shown below:
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@ v Olibrary Info em Planning + | Testing v | Tracking ~

Test Sets | Test ails  / Automation Hosts / Configurations

L X Delete | O Refresh | B Re-Test | £ Tools | w

Ability to create new author
B 6-0ct-2017 (TR36)
DJ 4-Dec-2003 (TRI8)
P 4-Dec-2003 (TR19)

(2] Failed

B 3-Dec-2003 (TRT7)
B 3-Dec-2003 (TR17) Release #: 10.00 - Library System Rele. Test Set:
) 2-Dec-2003 (TR13)
B 2-Dec-2003 (TR14)
1) 1-Dec-2003 (TRI)

Build -- None — Estimated Duration (h) .

Test Case # Actual Duration (h) 150

R Test Run Type
B 1-Dec-2003 (TRI0) Tester Name: Joe P smith Y

B 1-Dec-2003 (TR2)
B 1-Dec-2003 (TR3) Operating System, -—- Please Select ——

Web Browser - Dlease Select —-

) 1-Dec-2003 (TR4)
B 1-Dec-2003 (TRS)

Notes

This page consists of three panes:

1. The left hand navigation pane displays a list of related test runs with a color indicator for their
current execution status. The display dropdown will let you choose whether the list contains test
runs that are for the same release, test case or test set, or are just a filtered/unfiltered list based
on your last search in the main test run list page.

The top right area shows headline information about the test run details of the test run itself

3. The main pane on the right displays tabs for detailed information about the test run, and its
associations. The overview tab is initially loaded and shows the name, description, release, test
set, estimated and actual duration, tester name, test run type, automation host fields, along with
others, including custom fields. Underneath this is shown the list of test run steps, and any

console output from a test automation engine such as Rapise, NUnit, JUnit, QTP, or Selenium.

5.6.1. Re-running a Test

There is a button on the main test run toolbar called ‘Re-Test”. If you click this button, SpiraTeam will
launch the test execution wizard for this specific test case, with current release and/or test set already
selected for you. This is a handy way of quickly re-running a failed test that has been addressed by the

developers.

5.6.2. Editing a Test Run

When reviewing the test run, you may find that you need to change the results of the test run (e.g. the
user selected the wrong release or custom property value). Many of the fields are editable at a later date,

and to make changes, just modify the appropriate fields and click any “Save” button.
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5.6.3. Deleting the Test Run

If you need to delete a test run that was erroneously captured, all you need to do is click on the link to
access the invalid test run and then click the “Delete” button to remove it from the system. This will then

force the system to update the status of the test case itself from the other logged test runs.

5.6.4. Test Run Steps

In the case of a manual test run, this section displays all the steps of the test case as they appeared
during the test run in question. This means that if the test steps were changed after running the test, the

list here will reflect the original information.

Step Test Step Description Expected Result Sample Data Test # / Step # Actual Result Execution
Status

1 User logs in to application User taken to main menu screen 1CI17 / IS18 Passed %
User clicks link to create  User taken to first screen in wizard 1c4 /157 Passed %
author

3 User enters authors name User taken to next screen in wizard Martin Amis, 39 Ic4 /158 Passed %
and age

4 User associates books User sees screen displaying all entered London Fields, Money, TC4 / TS9 Passed %
with author information Informational
User clicks submit button Confirmation screen is displayed IC4 / Ts10 The confirmation screen doesn't appear, instead you see a blank Failed %

screen | View Incidents o

Each test run step is displayed along with the description, expected result, suggested sample data, a link
back to the current version of the test step in question, the actual result and the execution status for this
step in this particular test run. Where an actual result was recorded, an additional “View Incidents”
button will be displayed. This allows you to view any incidents that are associated with this particular test

run step:
Incident List for Test Run Step: [RS:000013
ID Incident Name Type Status Priority Severity Owner Creation Date Detectad By
IN2 B Not able to add new author Incident Mew - - - 1-Mov-2003  Joe P Smith
u

Fomt mmemmem e e TeA eSS

Clicking on the link will open up a popup dialog box that displays a list of all the incidents associated with
the selected test run step. Each of the incidents listed will reflect the most up-to-date information

regarding that incident, including its type, status, priority, name, assigned owner, detection date and who
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first detected it. Clicking on the incident name will take you to the details page for that incident, which is

described in section 6.2.

5.6.5. Console Output

In the case of an automated test run, this tab will display the details of the test run as reported from the
test runner application. These details will vary depending on the type of automated tool being used, but
typically they include the name of the automated test runner, the number of assertions raised, the name
of the corresponding test case in the tool, the status of the test run and a detailed error message, and the
stack-trace in the case of a failure. An example test run as reported from the NUnit automated test runner

is illustrated below:

Runner Name: Assert Count:
Test Name Automation Host:
Message:

Details:

Object variable or With block variable not set.

Description: An unhandled exception occurred during the execution of the current web request. Please review the stack trace for more
information about the error and where it originated in the code

Exception Details: SystemMNullReferenceException: Object variable or with block variable not set

Source Errar

Line 213 Response.Write ("<option selected value="" & MonthCheck(MonthCount) & "">" & MonthCount & "</option>" & vbCrLf)

Line 216:Else

Line 217: Response Write ("<option value="" & MonthCheck(MonthCount) & ™>" & MonthCount & "</option>" & vbCrLf)

Line 218End If
Line 219

Details on how to use SpiraTeam® in conjunction with an automated testing tool are provided in the

SpiraTeam® Automated Testing Integration Guide, which can be downloaded from the Inflectra® website.

5.6.6. Attachments

This tab shows the list of documents that have been “attached” to the test run. The documents can be in

any format, though SpiraTeam® will only display the icon for certain known types.

Overview Attachments ncidents Tasks History
+ ~dd New | % Add Existing £ Refresh - Show/hide columns -- | & T Filter | »
Displaying 1 - 1 out of 1 attachment(s)
+ Filename Type Size Edited By Edited On &% Author D Edit
-- Any — | v = — Any — | W ==} - Any — | v DC Edit
(&) Emor Logging-in Screen-shotgif Screen Shot 48 KB Fred Bloggs 23-Apr-2006 Fred Bloggs DC3 Edit
Show | 15 w | rows per page Displaying page = of1
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The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To view the document, click on the filename hyperlink and a new web browser window will open.
Depending on the type of file, this window will either display the document or prompt you for a place to
save it on your local computer. To remove an existing attachment from a test run, check its checkbox then
click the “Remove” button and the attachment will be removed from the list.

To attach a new document or web link to the test run, you need to click on the “Add New” hyperlink to

open the “Add Attachment” dialog box. There are three different types of item that can be attached to a

test run:

» To upload a file, choose “File” as the type and then click the “Browse” button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the <Upload> button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the test run. To do
that, click on the “Add Existing” button to bring up the add file association dialog box. You can then
choose to either associate a document stored in the SpiraTeam Documents repository or (in the case of
SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case you first
select the appropriate folder, and then pick the document(s) from the file list on the right. In the case of a

source code file association you can also add a comment.
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5.6.7. Incidents

This tab displays the list of incidents associated with the current test run. The incidents will have been

logged during the creation of the test run and will be linked to one of the steps in the test run:

Owverview Attachments ncidents Tasks History
Refresh & | -- Show/hide columns —— | s~ T Filter &
@ Displaying 1 - 1 out of 1incident(s) linked to this test run. Filtering results by Test Run #.  Clear Filters
~ % Name Type Status Priority Detected By Creation Date Owner Progress D &
ANy = W | - Ay —- | v | Ay - v | - ANy - v B||--aAny— | v ||—-any—|w IN
% B Cannot 2dd a new book to the system Bug Assigned 1 - Critical Joe P Smith 3-Nov-2003 Joe P Smith INT
Show | 15 W | rows per page Displaying page <

Each incident is listed together with the type, status, priority, name, owner, detector, detection date and a
link to the actual incident details. You can customize the fields that are displayed using the “Show/Hide
Columns” option. In addition, you can perform the following operations:

>» Refresh — updates the list of incidents from the server, useful if other people are adding incidents
to this release at the same time.

» You can also filter the results by choosing items from the filter options displayed in the sub-
header row of each field and clicking the “Filter” button. In addition, you can quickly sort the list
by clicking on one of the directional arrow icons displayed in the header row of the appropriate
field.

» Edit — Clicking the “Edit” button to the right of the incident allows you to edit the incident inline
directly on this screen.

5.6.8. Tasks

This tab is only visible to users of SpiraTeam. It shows the list of tasks associated with the current test
run. Tasks can only be added to a test run created from an exploratory test case. These tasks will have
been logged during the execution of the test.

Owverview Attachments Incidents Tasks History
Add ¥ Remove | & Refresh T Filter | w

Displaying 1 - 2 out of 2 association(s)

¥ Type Artifact Type Name Status Creation Date &« Creator Comment Project Name D Edit
— Ay — | W | - ANy — | W B | —-aAy - v — Any — | W Edit
Library
the _ | System - .
Related-to Task Mot Started 6-0ct-2017 . Infarmation [Tk47] Edit
Administrator -
System
- Library
e I - . System e - .
Related-to Task In Progress £-0ct-2017 R Informatior [TK-46] Edit
Administrator -
System
Show | 15 ~ | [OWs per page Displaying page Zofl
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5.6.9. History

This tab displays the list of changes, if any, that have been performed on the requirement artifact since its
creation. An example requirement change history is depicted below:

Overview Attachments Incidents asks History
2 refresh | T Filter s | £ Admin View
Displaying 1 - 0 out of O change(s).
Change 1D Change Date #¥  Field Name old value New Value Changed By Change Type
=] -- Amy - W - Any - | W
Show | 15 W | rows per page Displaying page | 1 = of1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” button to revert any unwanted changes.

5.7. Test Set List

As well as being able to organize test cases into folders, you can also create separate groupings of test
cases called test sets which can then be assigned to testers as a package. To view the list of test sets for

a project, click on Testing > Test Sets in the global navigation:

@ w OlLibrary Information System Planning ~ | Testing = | Tracking ~ Reporting . System Administrator |
Test Cases / Test Sets / Test Runs / Automation Hosts / Configurations
orc £ - > =
oklersted e + New Test Set | X Delste | & Refrash | B> focus On | T Fiter s~ | (FEdit + &£ Tools s~ | -- Show/hide columns - | w
4 = Root Displaying 1 - 4 out of 6 test set(s) for this project.  Functional Test Sets -— All Releases —- v P
4 = Functional Test Sets
4 B> Regression Test Sets v % Name & Execution Status  Release Last Executed Owner Status o] Edit
cdit add — Ay — W — Any — | W [=] — Any — | W — Any — | W TX Edit
Fred Bloggs Deferred TX6 Edit
Quick Filter e 1000 1-Dec-2003 Joe P Smith In Progress ™1 Edit
10.0 -Dec-20( J S Not Sta 2 dit
(Mo filters available) 1100 1-Dec-2003 Joe P Smith Not Started TX:2 Edil
1200 Fred Bloggs In Progress ™S Edit
Releases
Show | 15 v | rows per page Displaying page | 1 Tofl

4 [ Library System Release 1

4 [ Library System Release 1..
B Iteration OOI
B Iteration 002
B Iteration 003

4 [@ Library System Release 1
B iteration 001
3 Iteration 002
£ Iteration 003

The test set list consists of hierarchical list of all the test sets in the current project organized into folders.
The structure is very similar to the folder structure in Microsoft Windows® Explorer, and users will find this

very familiar and intuitive to use. A folder tree is on the left hand side—with triangle icons to expand /
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collapse each folder. Contents of the selected folder (the one marked in bold on the folder tree) are

shown on the right hand side.

When you create a new project, this list will initially be empty, and you will have to use the “New Test Set”

button to start adding test sets to the system.

Each test set is listed along with the number of test cases contained (in parenthesis), the aggregate
execution status of the contained test cases (using a graphical bar-chart), the date that the test set has
been scheduled to be executed (planned date), the date that it was last executed, the person currently
assigned to execute the test set, the status and the test set id. Clicking on a test set’s hyperlink will take

you to the test set details page for the item in question.

Note: the test set status is separate from the execution status of the individual test cases and represents
where the test set is in its lifecycle:

e Not Started — The test set has been assigned to a tester or automation host and no testing has
been performed.

e In Progress — The test set has been assigned to a tester or automation host and the testing is in
progress.

e Completed — The test set was previously assigned, but has now been completed, with all test
cases having an execution status recorded and the tester having clicked the Finish button in the
test execution wizard.

o Blocked — The tester or automation host was unable to execute the assigned test set because of
a failure external to the actual test case.

e Deferred — The test set was previously assigned, but: execution had not been completed (at least
one test case does not have a recorded execution status); and the Tester deleted the Pending

Test Run entry from their My Page.

5.7.1. Delete

Clicking on the “Delete” button deletes the currently selected test sets. It will delete the association

between the test set and its contained test cases, but it will not delete the test cases themselves.

5.7.2. Refresh

Clicking on the “Refresh” button simply reloads the list of test sets. This is useful if other people are

making changes to the test set list and you want to make sure that you have the most current version.

5.7.3. Focus On

The “Focus On” button is a useful when you have performed a filter on the list of test sets and then wish

to quickly navigate to the folder of a particular test set shown in the list. After selecting a test set, clicking
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the button will move the left hand folder tree to the folder that contains the selected test set. It will also
change the list view on the right to show all of the test sets within that folder (i.e. the selected test set and

its siblings).

5.7.4. Edit

Each test set in the list has an “Edit” button in its right-most column. When you click this button, double-
click on any of the cells in the row, or select a row and click the “Edit” button in the toolbar at the top of
the page. This will change the item from “View” mode to “Edit” mode. The various columns are made

editable, and “Save” and “Cancel” buttons are displayed in the last column:

v % Name & Execution Status  Release Last Executed Owner Status D Edit
— Any — | W - Any — | W B - Ay - | W - ANy - | v > Edit
& sting [2 Fred Bloggs Deferred TX:6 Edit
23 Testing Cycle for Rele = ¥ = 1-Dec-2003 Joe P Smit v (i= Cl v E X Cancel
k] Testing Cycle fi 1100 1-Dec-2003 Jog P Smith Mot Started ™2 Edit
&'J Tes! 1200 Fred Bloggs In Progress TX5 Edit
Show | 15 v | TOWs per page Displaying page | 1 Zofl

If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first
row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows (e.g. to change the owner of
five test sets from “Fred Bloggs” to “Joe Smith”), you can click on the “fill” icon to the right of the editable

item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Save” to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

5.7.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test set list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.
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5.7.6. Filtering

You can easily filter the list of test sets. To filter the list by any of the displayed columns, you either
choose an item from the appropriate drop-down list or enter a free-text phrase (depending on the type of
field) then click “Filter” or press the <ENTER> key to apply the different filters. Note that the Name field is
searched using a “LIKE” comparison, so that searching for “database” would include any item with the
word database in the name. The other free-text fields need to be exact matches (e.g. dates, test set

numbers). In the screen-shot below, we are filtering on test sets that contain at least one failed test case.

+ MNewTestSet | X Delete £ Refresh = Focus On Y Filter | v || @ Edit |~ fFTools v | --Show/hidecolumns-- | v
Displaying 1 - 1 out of & test set(s) for this project.  Functional TestSets  Filtering results by Execution Status.| Clear Filters —- All Releases — v
v % Name AW Execution Status  Planned Date AW Release oW Last Executed 4'W Owner AW Status AW Daw Edit
0% Failed v ==} —Any-- | ¥ ==} - Any - v —~Any-- | ¥ X Edit
l‘]T&:'\ ng Cycle for ase 1.0[ 7 4-Feb-2007 1.000 1-Dec-2003 Joe P Smith In Progress T*:1 Edit
Show | 15 v | rOws per page Displayingpage 1 #ofl

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The

list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

Because the same test set can be run against more than one release, sometimes you want to see the
execution information for the displayed test sets for different releases. If you select a release or iteration
from the dropdown marked “All Releases” on the right above the table, then the execution information for
that specific release will be displayed. If the dropdown is set to "all releases", then it shows only the most

recent execution information. In both cases, all test sets (as per any filter) are listed.

5.7.7. Copying Test Sets

To copy one or more test sets, simply select the check-boxes of the test sets you want to copy and then
select the Edit > Copy Items menu option. This will copy the current test set selection to the clipboard.
Then select the place where you want the test sets to be inserted and choose the Edit > Paste ltems

option.

The test sets will now be copied into the destination you specified. The name of the copied test sets will

be prefixed with “Copy of...” to distinguish them from the originals.

5.7.8. Moving Test Sets

There are two options for moving test sets or folders:
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1. Click on the test set/folder you want to move in the right hand list and drag it to the folder in the
left hand folder tree you want it moved to. The background of the new folder will change to show

where it will be inserted:

Folders £ = + NewTestSet = % Delete & Refresh B> FocusOn | Y Filter | v @ Edit ~ | f#Tools v | --Show/hide columns—
Displaying 1 - 4 out of & test set(s) for this project.  Functional Test Sets --- All Releases — v
4 & Root
4 = Functional Test Sets ¥ @ Name AW Execution Status ~ Planned Date 4 W Release 4w LastExecuted ow  Owner 4w Status 4 W Dav Edit
o Ay | v B any - | v B Ay v | enmye v | TX Edit
e e 6-Feb-2007 1-Dec-2003 Joe P Smith Not Started T
Edit Add

4-Feb-2007 1000 1-Dec-2003 Joe P Smith In Progress ™1 Edit
6-Feb-2007 1-Dec-2003 Joe P Smith Not Started X2 Edit
Quick Filter 2 esting New Functionality [ §-Feb-2007 1.200 Fred Blages Deferred ™5 Edit
Show | 15 ' rows per page Displayingpage, 1 |mofl

& Not Executed Test Sets

Once you have the test set/folder positioned at the correct place that you want it inserted, just release the
mouse button. To move multiple items simply select their checkboxes and then drag-and-drop one of the

selected items.

2. Alternatively you can simply select the check-boxes of the test sets you want to move and then
select the Edit > Cut Items menu option. This will cut the current test set selection to the
clipboard. Then select the place where you want the test cases to be inserted and choose the

Edit > Paste Items option. The test sets will now be moved into the destination specified.

5.7.9. Printing or Exporting Items

To quickly print a single test set, test set folder or list of test sets you can select the items’ checkboxes
and then click Tools > Print Items. This will display a popup window containing a printable version of the

selected items.

Alternatively you can save the selected items into a number of formats, available via the Tools dropdown.

5.7.10. Right-Click Context Menu

SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the

context menu, right-click on any of the rows in the test set list and the following menu will be displayed:
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v % Name AW Execution Status

-- Ay -- L
22 Exploratory Testing (2
= ‘or b Open Item I
@ Openin New Tab
B> Focus O
&5 Testing New Fun| ocusEn
Show | 13 v rowsp T Insert

& Edit Items

*® Delets

7 Copy Items
3« Cut ltems

I Paste ltems

P Execute

24 Print Iterms

You can now choose any of these options as an alternative to using the icons in the toolbar.

5.8. Test Set Details

When you click on a test set item in the test set list described in the previous section, you are taken to the

test set details page illustrated below:

Folders & L] ©l Clone | & Refresh || X Delete || W Execute | # Tools |~ || B2 Email | ¥ Subscribe | w
4 = Root
4 = Functional Test Sets . | {: |
Testing Cycle for Release 1.0
> [ Regression Test Sets
-] Status:” In Progress
Overview Test Runs Attachments Incidents History
-]
<

. Owner Joe P Smith Release: 1000 - Library Creation Date:
%) Exploratory Testing .

Creator. Fred Bloges Type Manual Last Executed
2 Testing Cycle for Release 10 )

Automation Host — None — Last Updated
45 Testing Cycle for Release 11 Confiaurstion on Planned Date 02/04/2007 6:00
L Testing New Functionality onfguration: - hens -
Operating System. —— Please Select — Recurrence -- One Time -
Schedule on Build No
Post-Build Delay (s}
Description

This tests the functionality introduced in release 10 of the library system

This page is made up of three areas;

1. the left pane displays the test set folders and list navigation;
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2. theright pane’s header, which displays: the operations toolbar; the editable name of the selected
test set; and the info bar (with a shaded background), which also contains the workflow status
transitions (see below); and

3. the right pane’s tabbed interface with rich information related to the test set.

The navigation pane consists of a link that will take you back to the test set list, as well as a list of the
peer test sets to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the detailed information of all the peer test sets by clicking on the navigation links without having to first
return to the test sets list page. The navigation list can be switched between three different modes:

e The list of test sets matching the current filter

o The list of all test sets, irrespective of the current filter

e The list of test sets assigned to the current user

If you are editing an existing item, the fields that are available and the fields that are required will depend
on your stage in its workflow. The types of change allowed and the email notifications that are sent will
depend on how your project administrator has setup the system for you. Administrators should refer to the

SpiraTeam Administration Guide for details on configuring workflows to meet their needs.

Depending on the user’s role and whether they are listed as the owner or author of the test case,
displayed in the info bar beneath the test case name is the current workflow status and an “operations”
button which, when clicked, will show a set of allowed workflow operations. These workflow transitions

allow the user to move the item from one status to another.

The top part of the right pane allows you to view and/or edit the details of the particular test set. You can
edit the name and once you are satisfied any changes to the test set, click the “Save” button at the top of
the page to commit the changes (or the options available via the save dropdown). In addition you can
delete the current artifact by choosing “Delete”, discard any changes made by clicking “Refresh”, create
a duplicate of the current artifact by clicking “Clone”, or export to a number of files formats or print it via
one of the options in the Tools dropdown menu.

The “Execute” button allows you to execute all the tests in the set against the release specified in the test
set.

Using the “Email” button on the toolbar, you can send an email containing details of the requirement to an

email address or another user on the system:
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Email this artifact to

* Project User: Amy E Cribbins W

Select auser in the project to send to.

Email Addresses:

A list of email addresses, separated by ;

Message Subject:

Leave blank for default.

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration

— Notification Templates.

To be notified of any changes made to the current artifact via email, click the “Subscribe” button. If you
already subscribed, the button will instead let you “Unsubscribe” to stop receiving emails about that

particular artifact.

The lower part of the right pane can be switched between different views by clicking the appropriate tab.
Initially the pane will be in “Overview” mode, but it can be switched to “Test Runs”, “Attachments”,

“Incidents” and “History” modes if so desired. Each of the views is described separately below.

5.8.1. Overview — Details

The top part of this tab displays the various standard fields and custom properties associated with the test
set. Fields (both standard and custom) are grouped under the collapsible headings (marked by orange
text and underline) in the screenshot below. For instance, all fields regarding dates are grouped together

in the “Dates and Times” area.

The Detailed Information section contains the long, formatted description of the test case, as well as any
rich text custom fields. You can enter rich text or paste in from a word processing program or web page.

Clicking on the shaded areas of one of these detailed fields will display the rich text toolbar.
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Overview Test Runs Attachments Incidents History

Owner: Joa P Smith Release: 10.0.0 - Library. Creation Date
Creator: Fred Bloggs Type: Manual Last Executed
Automation Host -- None -- Last Updated
Configuration None Planned Date 02/04/2007 600
- - None —-
Operating System: -—- Please select —— Recurrence: —- One Time —-

Schedule on Build:

Post-Build Delay (s):

Description,

This tests the functicnality introduced in release 1.0 of the library system

Test Sets can be specified as being either for “Manual” or “Automated” test runs (via the “Type” field. If
you choose Manual, then the test set can be executed by a tester from their “My Page.” However if you
choose “Automated”, the test set will be executed by the automation host you specified. In this case, the
planned date and time will be used by the automated test engine to know when to execute the automated
test scripts. For manual test sets, only the date component is used. In addition, you can specify a
recurrence schedule for the test set by changing the recurrence dropdown from “One Time” to “Hourly”,
“Daily”, etc. so that SpiraTeam executes the same test set according to the specified frequency. The

“Planned Date” field lets you specify the date and time to execute the test using the popup time picker.

The Schedule on Build field will tell SpiraTest to automatically set the Planned Date to the current
date/time plus the Post Build Wait Time offset (in seconds) whenever a new build is performed against
the release or iteration that the test set is scheduled for. This allows you to automatically run a set of
regression tests immediately after a build is completed.

The Description section contains the long, formatted description of the test set. You can enter rich text or

paste in from a word processing program or web page.

5.8.2. Overview - Followers

Using the “Subscribe” button on the toolbar, you can quickly follow the item, and receive updates on
certain changes to it. Depending on your role, you may also see a dropdown to this button, which let's

you add another project member as a follower to this item.

— : e
-

B4 Email 7 Subscribe | s~

& Add Follower
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Add Follower

Select a user in the project to follow this artifact

Amy E Cribbins v

Cancel

You can also quickly see who is following an incident under the “People” section in the Overview tab.

Followers (2)
T e
]

To view information about the follower, or to unfollow them from the item, hover over their avatar to

display a user profile card.

Amy E

i Cribbins Remove
follower

5.8.3. Overview - Comments

The Comments section allows users to add and view discussions relating to the test set:
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Displaying =~ newest first oldest first

”

1 Thanks, appreciate it!

(]
- OK will make sure that we do

)

1 We need to add a better definition of the pre-conditions and post-conditions

Format -  Font - sz - B I U T A-B- = := E o = WE M= @ 3 O soure

Existing comments are displayed by date (either newest-first or oldest-first) above the text box. To add a
comment to the Test Set, enter your text into the textbox, then click the “Add Comment” button.

5.8.4. Overview - Parameters

As discussed in section 5.2.2.10. test cases can have parameters associated with them. This enables
one test case to be called several times and have different parameters passed in each case, making the
operation different. E.g. you could have a generic “login to application” test case that others call as an
initial step, which could be provided with different login information depending on the calling test case. In
addition these parameters may be used by certain test automation engines.

The Parameters section on the test set page lets you set a shared value for all of the parameters
contained within the different test cases of the test set. The screenshot below shows that there are three
parameters contained in the test cases that have been set at the test set level. In this example, every
case that has a Parameter called ‘browserName’ will have its value set to ‘Safari’. This is a quick way of
setting values for many test cases at once. Test Set Values will override any default values of a
Parameter (defined for each specific test case).

@ The following parameter values have been specified at the test set level | + Add Perameter Value

Parameter Test Set Value Default value Operations

E{browserMName} Safari browser [# Edit  ® Delste
${login} librarian - (# Edit | % Delste
%{password) librarian - (# Edit | % Delete

You can add any additional Parameters not already set by clicking on the “Add Parameter Value” button.

In this example, you can see that one of the parameters not yet set is called ‘url’.
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Add Parameter Va

Value: operatingSystem

e

You can also delete an existing Parameter specified for the whole test set by clicking the “Delete” button

in the Operations column of the Parameter in question. Clicking the “Edit” button will let you alter the Test

Set Value.
Parameter Test Set Value Default Value Operations
${browserName] Safari browser m Cancel | % Delete
${login} librarian - [# Edit | % Delste
${password) librarian - [# Edit | % Delete

Note that the Default Value is derived from the test cases that use a specific Parameter. It is shown in this
table for information only—to help testers know what value will be run in the absence of specifying a Test
Set Value.

5.8.5. Overview - Test Cases

This section displays the list of test cases contained within the test set. You can add, remove, reposition
and remove test cases from the list. The execution status displayed next to each test case is the most

recent execution status of the test case when run in the context of the current test set.

+ 2dd ® Remove < Refresh </> Edit Parameters | -- Show/hide columns —— | w | P Execute Tests

Est. Dur. 07h [ Act Dur. 43h

% Test Case Name Owner Priority Est. Dur. Act. Dur. Last Executed Type Execution Status 1D Edit
% &7 Ability tc - 0.2h 13h 1-Dec-2003 Functional _TC.2 Edit
B Ability to edit existing book - 0lh 15h 1-Dec-2003 Functional Passed TC3 | Edit
£ B Ability to create new author -O.Wh 15h 1-Dec-2003 Functional _TC:A Edit
&) Ability to edit existing author 2-High " 0h Functional Not Run TGS | Edit
B Ability to reassign book to different author 2 - High | 0.h Functional Not Run TC6 | Edit
&7 Book management 2-High 0l Regression  Not Run C8 | Edit
&7 Author management 2-High " 0h Regression  Not Run TC9 | Edit
Show | 15 w | [DWs per page Displaying page 1 = of1

To move the test cases, click the test case icon and drag it to the appropriate position in the list.
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To modify an existing Test Case click the “Edit” button in the right-most column, or double-click on the
cells in the row. That will switch the selected row into Edit mode. The owner field can then be set at the
test case level. This is useful in situations where you want the different test cases in the set to be

executed by different testers (e.g. in integrated, scenario tests)

Est Act. Last Execution

% Test C N, 8] Priorit; T ID Edit
@ Test Case Name ner nonty Dur. Dur. Executed ype Status !
- 1= .

L3 Ability to create new book . .21 3h -Dec-2003 ctian c2 dit
% &3 Ability to create new book Critical 0.2h 13t 1-Dec-2003  Functionzl |Eailed TC:2 | Edi

1-

L3 Ability to edit existing boak L ). 5h -Dec-2003 ctian =] dit

L) £ it Kistir k Critical 0h 15} 1-Dec-2003  Functional Passed T Edi
@ &7 Abili —Nene — v IS oh 15t 1-Dec-2003  Functional [FSiled TC4

J ADIty 10 cregte Nnew autnol o ). n -Dec-2Z00 unctional il C.

=] Critical Cancel
X3 Ability to edit existing autho 2 - High (0.h Functional Mot Run TCS | Edit

To add a new test case to the Test Set, click on the “Add” button to display the panel:

Root~ Q, Search
~ Mo matches found: ~

Cancel
¥ Remove = Refresh <[> Edit Parameters  -- Show/hide columns —— | s | P Execute Tests Est Dur. ©7h /[ Act Dur. 43h

First, select the folder containing the test cases desired. You can then select the checkboxes of the
individual test cases that you want to add to the test set (note: clicking the checkbox in the header row of
the table will select ever test case in the currently selected folder). Once you have selected the desired

items, click the “Save” button to add them to the test set.

As discussed above in section 5.8.4, test cases can have parameters defined with specific values. These
are created on the Test Case details page (see section 5.2.2.10.). If you need to specify different values
for a parameter for different test cases in the test set, you can override both any default parameter values
and any test set parameter values. To do so, click “Edit Parameters” for the required test case in this
view. You can do this by either select the checkbox of a test set and click “Edit Parameters” at the top of

the section, or right-click on the test case and choose “Edit Parameters”:
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£ Edit Test Case Parameters

@ Please fill out the parameters for this test case entry
browserName:
login:
operatingSystem:
password:

url:

Cancel

You can then specify the values of the parameters that the test set will pass to this specific test case.

Once you have entered / modified the values, click “Save” to commit the changes.

5.8.6. Overview - Comments

The Comments section allows users to add and view discussions related to the Test Set:

~ Comments

Displaying list of comments: | newestfirst | oldestfirst

] Fred Blogas
I Thanks, appreciate it!

Joe P Smith

(]
@ OKwill make sure that we do.

(] Fred Bloggs
I We need to make sure we get through this test set by the first release.

To add a new comment, enter it below and click either [Save] or [Add Comment]:

HWEE= @

Format - B I U I, = = g 99 @

Existing comments are displayed by date (either newest-first or oldest-first) above the text box. To add a

comment to the Test Set, enter your text into the textbox, then click the “Add Comment” button.
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5.8.7. Test Runs

This tab displays the list of all the test runs executed against the test set. Each test run is listed together
with the date of execution, the name of the test case, the name of the tester, the release/version of the
system that the test was executed against, the overall execution status for the test case in that run and a
link to the actual test run details (see section 5.6). In addition, you can choose to display any of the
custom properties associated with the test run.

Overview Test Runs Attachments Incidents History
i Refresh | Y Filter —- Show/hide columns —— | w
Displaying 1 - 3 out of 3 test run(s). Filtering results by Test Set. | Clear Filters
v % Name End Date ¥ Type Tester Release Execution Status Act. Dur. D Edit
=] — Any — | v —Any — | w —Any — | W — Any — | v = TR Edit
B Ability to edit existing book 1-Dec-2003 Manual Fred Bloggs 1000 Passed 15h TR3 Edit
B Ability 1-Dec-2003 Manual Joe P Smith 1000 Failed 15h TR4 Edit
% B Abilit 1-Dec-2003 Manual Joe P Smith 1000 Failed 13h TR1 Edit
Show | 15 W | rows per page Displaying page Zof1

The “Show/hide columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of

“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Filter” button. In addition, you can quickly sort the list by clicking on one of the
directional arrow icons displayed in the header row of the appropriate field.

5.8.8. Attachments

This tab displays the list of documents that have been “attached” to the test set. The documents can be in

any format, though SpiraTeam® will only display the icon for certain known types.

Overview Test Runs Attachments Incidents History
=+ Add New 9% Add Existing = Refresh —- Show/hide columns -- |« Y Filter |~

Displaying 1 - O out of O attachmentl(s)
¥ Filename Type Size Edited By Edited On & ¥
— ANy —- | W = — ANy — W =

Show | 15 w | rows per page
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The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, click on the filename hyperlink and a new web browser window will open.
Depending on the type of file, this window will either display the document or prompt you for a place to
save it on your local computer. To remove an existing attachment from a test set, select an attachment

using the checkbox and click the “Remove” button. The attachment will be removed from the list.

To attach a new document to the test set, you need to first click the “Add New” link to display the new
attachment dialog box:

Add New Document Add New Document Add New Document

Type* ® File O URL shot Type” File BIURL O Screenshot Type” File ©URL @ Screenshot

URL:™

Filename: Choose File | Nofilechosen

Description: Description:

P Screenshot:"

* - )
Document Type: Functional Specification | v Document Type:" Functional Specification | v/

Document Folder:" Root Folder v Document Folder:" | Root Folder v

- Description:

Document Type:* Functional Specification | v
Document Folder:* Root Folder hd

Tags:

There are three different types of item that can be attached to a requirement:
>» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.
The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then
click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”
to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.
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You can also associate an existing document (that’s already stored in SpiraTeam) with the test set. To do

that, click on the “Add Existing” button to bring up the add file association dialog box:

Add Existing Document Add Existing Document
Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
®) Documents Source Code Documents [#] Source Code
Folder + Document Folder « File
B3 Root Folder =V

- Comment:
Cancel

m Cance

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.

5.8.9. Incidents

This tab displays the list of incidents associated with the current test set. Each incident will either have
been: created during the execution of a test case in the test set (and are thereby linked to one of the test

runs); or manually linked to one of the test steps in a test case of the set.

Overview Test Runs Attachments Incidents Histary
Refresh & | -- Show/hide columns —- |~ | T Filter
O Displaying 1 - 2 out of 2 incident(s) linked to this test set. Filtering results by Test Set | Clear Filters
v B Name Type Status Priority Detected By Creation Date Owner Progress D & Edit

— ANy — | W | Ay — v | ANy — | v | ANy — | W B Ay — v ||[—-Ay —|w IN Edit

Incident New Joe P Smith 31-0ct-2003 IN:2 Edit

ok to the system Bug Assigned 1 - Critical Joe P Smith 3-Nov-2003 Joe P Smith IN:7 Edit

Show | 15 | rows per page Displaying page Zofl

5.8.10. History

This tab displays the list of changes that have been performed on the test set artifact since its creation.
The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator
you can also click on the “Admin View” button to revert any unwanted changes.
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5.9. Automation Host List

This section outlines how to use the Automation Host Management features of SpiraTeam® to manage
the different host systems that will be running automated tests in your environment. Typically when
scheduling automated tests you will want to execute the same tests on multiple computers running
different environments.

SpiraTeam allows you to build a master list of automation hosts in each project, which can be used to
schedule test sets containing automated test cases against. Please refer to the Test Set section of this

manual for more information on managing and scheduling test sets.

When you click on the Testing > Automation Hosts global navigation link, you will initially be taken to the
automation host list screen illustrated below:

+ New Host | X Delete || & Refresh | T Filter s | —- Show/hide columns —— | w
Displaying 1 - 4 out of 4 automation host(s) for this project.
¥ % Name Token Active Last Updated ID & Web Browser Operating System Edit
— Any W AH —Any — W - Any — | v Edit
M windows

Wing8 Yes 30-Apr-2014 Internet Explorer Windows 8 Edit

Internet Explorer Edit

Winvista2 Yes 1-May-2014 Mozilla / Firefox Edit

[
3

3-May-2014 Internet Explorer Windows 7 Edit

Show | 15 ~  rows per page Displaying page Zof1

The automation host list screen displays all the automation hosts entered for the current project, in a
filterable, sortable grid. The grid displays the automation host ID together with fields such as name,
description, last updated date, token, and any custom properties. The choice of columns displayed is

configurable per-user, per-project, giving extensive flexibility when it comes to viewing and searching
automation hosts.

In addition, you can view a more detailed description of the automation host by positioning the mouse
pointer over the host name hyperlink and waiting for the popup “tooltip” to appear. If you click on the host
name hyperlink, you will be taken to the automation host details page described in section 5.10. Clicking
on any of the pagination links at the bottom of the page will advance you to the next set of hosts in the list
according to the applied filter and sort-order. There is also a drop-down-list at the bottom of the page
which allows you to specify how many rows should be displayed in each page, helping accommodate
different user preferences.

One special column that is unique to automation hosts is the “Token” field. This needs to contain a short
textual identifier that uniquely identifies each automation host in the project. This will be used by each
host computer to identify itself to SpiraTeam.
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5.9.1. Sorting and Filtering

You can easily filter and sort the list of automation hosts. To filter the list by one of the displayed fields,
you simply choose an item from the appropriate drop-down list or enter a free-text phrase then click
“Eilter” or press the <ENTER> key to apply the different filters. Note that the name field is searched using
a “LIKE” comparison, so that searching for “database” would include any item with the word database in

the name. The other freetext fields need to be exact matches (e.g. dates, automation host numbers).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the darker

arrow.

Clicking on Filter > Clear Filter removes any set filters and expands the host list to display all automation
hosts in the current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My

Page’ for use in the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

5.9.2. New Host

Clicking on the “New Host” button adds a new automation host to the bottom of the automation host list

with a default name and token.

5.9.3. Delete

Clicking on the “Delete” button deletes the automation hosts whose check-boxes have been selected in
the host list.

5.9.4. Refresh

Clicking on the “Refresh” button reloads the list of automation hosts; this is useful when new hosts are

being added by other users, and you want to make sure you have the most up-to-date list displayed.

5.9.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the host list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.
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5.9.6. Edit

Each automation host in the list has an “Edit” button in its right-most column. When you click this button
or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit” mode.

The various columns are made editable, and “Save” and “Cancel” buttons are displayed in the last

column.

If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first
row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows (e.g. to change five
automation hosts from Active = No to Active = Yes), you can click on the “fill” icon to the right of the

editable item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Save”to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

5.10. Automation Host Details

When you click on an automation host entry in the host list, you are taken to the automation host details

page illustrated below:

Back to Host List ] 2 Refresh % Delete

Display: Current Filter| s

Q

Windows 8 Host

#

+
b

Overvizw Test Runs Attachments History

Token: wing Creation Date
Active: Yes Last Updated
Web Browser nternet Explorer

Operating System: windows 8

0S5 Version:

Description

Windows 8 with IE10, Firefox 14, Chrome and Safari 5

Show | 15 v | rows
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This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the automation host name and ID, and the bottom part of the right pane displays different

information associated with the automation host.

The navigation pane consists of a link that will take you back to the host list, as well as a list of the peer
automation hosts to the one selected. This latter list is useful as a navigation shortcut; you can quickly
view the peer hosts by clicking on the navigation links without having to first return to the host list page.
The navigation list can be switched between two different modes:

e The list of hosts matching the current filter

e The list of all hosts, irrespective of the current filter

The top part of the right pane allows you to view and/or edit the details of the particular automation host.
You can edit the various fields (name, description, token, etc.) and custom properties. Once you are
satisfied with the changes, click either the “Save” button or the alternative options from the “Save”

dropdown list. In addition you can delete the current automation host by clicking “Delete”, or discard any

changes made by clicking “Refresh”.

5.10.1. Overview

This tab shows the fields and description associated with the automation host. Standard and custom

fields are grouped by type (eg all date and time fields are grouped together).

5.10.2. Test Runs

This tab displays the list of all the test runs executed against the automation host. Each test run is listed
together with the date of execution, the name of the test case, the name of the tester, the release/version
of the system that the test was executed against, the name of the test set (if applicable), the overall
execution status for the test case in that run and a link to the actual test run details (see section 5.6). In

addition, you can choose to display any of the custom properties associated with the test run.

Overview Test Runs Attachments Histary
< Refresh | Y Filter | w -- Show/hide columns —- | s
Displaying 1 - 3 out of 3 test run(s). Filtering results by Automation Host | Clear Filtars
v % Name End Date &% Type Tester Release Execution Status Act. Dur. D Edit

B |- any — - Any - W | - ANy — W | - Ay - | W B || TR Edit

4-Dec-2003 Automated Fred Bloggs Faild 12h TRIg Edit

ook 4-Dec-2003 Automated Fred Bloggs Failed 1.2h TRI9 Edit

or 4-Dec-2003 Automated Fred Bloggs Caution 12h TR20 Edit
Displaying page Zofl
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The “Show/hide columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of

“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Filter” button. In addition, you can quickly sort the list by clicking on one of the

directional arrow icons displayed in the header row of the appropriate field.

5.10.3. Attachments

In this tab, the main pane displays the list of documents that have been “attached” to the automation host.
The documents can be in any format, though SpiraTeam® will only display an icon for certain known
types.

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window wiill
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To delete an existing attachment from a test case, simply click the
“‘Remove” button and the attachment will be removed from the list.

To attach a new document to the test case, you need to first click the “Add New” link to display the new
attachment dialog box:

Add New Document Add New Document Add New Document
Type® ® File ©URL O Screenshot Type" File ®URL © Screenshot Type" File OURL ® Screenshot
Filename:* Choose File | Nofile chasen URL:"
Description: Description:
7 P Screenshot:"
Document Type:* Functional Specification |~ Document Type:* | Functional Specification v
Document Folder:* Root Folder v Document Folder:* | Root Folder v
Tags: Tags:
- Description:
Document Type:* Functional Specification v
Document Folder:* Root Folder v
Tags:

There are three different types of item that can be attached to an incident:
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>» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the automation

host. To do that, click on the “Add Existing” button to bring up the add file association dialog box:

Add Existing Document Add Existing Document

Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
®) Documents Source Code Documents [8] Source Code

Folder v Document Folder v File

& Root Folder (=0
m ~ Comment:

Cancel
A
m Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.
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5.10.4. History

In this mode, the main pane displays the list of changes that have been performed on the automation host
artifact since its creation. The change history displays the date that each change was made, together with
the fields that were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system. In addition, if you are logged in as a

project administrator you can also click on the “Admin View” button to revert any unwanted changes.

5.11. Test Configurations List

This section outlines how to use the Test Configuration features of SpiraTeam® to create and manage
different configurations of parameters that tests (both manual and automated) can be run against. This

offers tools to quickly create every combination of different parameters.

When you click on the Testing > Test Configuration global navigation link, you will initially be taken to the

test configuration list screen illustrated below:

+ New Configuration = % Delete £ Refresh T Filter
Displaying 1 - 3 out of 3 test configuration(s) for project

v % Name Creation Date Active Last Updated D & Edit

— Any W =] TG Edit

30-Jun-2017 Yes 1-Jul-2017 TG1 Edit

1-Jul-2017 Yes 4-Jul-2017 TG2 Edit

ms and logins 2-Jul-2017 Yes 2-Jul-2017 TG3 Edit

Show | 15 | rows per page Displaying page = ofl

The test configuration list screen displays all the test configurations for the current project, in a filterable,
sortable grid. The grid displays the name, creation date, last updated date, ID, and whether the test

configuration is active.

In addition, you can view a more detailed description of the test configuration by positioning the mouse
pointer over the host name hyperlink and waiting for the popup “tooltip” to appear. If you click on the host
name hyperlink, you will be taken to the test configuration details page described in section 5.12. Clicking
on any of the pagination links at the bottom of the page will advance you to the next set of hosts in the list
according to the applied filter and sort-order. There is also a drop-down-list at the bottom of the page
which allows you to specify how many rows should be displayed in each page, helping accommodate

different user preferences.

5.11.1. Sorting and Filtering

You can easily filter and sort the list of automation hosts. To filter the list by one of the displayed fields,

you simply choose an item from the appropriate drop-down list or enter a free-text phrase then click
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“Eilter” or press the <ENTER> key to apply the different filters. Note that the name field is searched using
a “LIKE” comparison, so that searching for “database” would include any item with the word database in

the name. The other freetext fields need to be exact matches (e.g. dates, test configuration numbers).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the darker

arrow.

Clicking on Filter > Clear Filter removes any set filters.

5.11.2. New Test Configuration

Clicking on the “New Configuration” button adds a new test configuration to the bottom of the list with a

default name.

5.11.3. Delete

Clicking on the “Delete” button deletes the test configurations whose check-boxes have been selected in
the host list.

5.11.4. Refresh

Clicking on the “Refresh” button reloads the list of test configurations; this is useful when new
configurations are being added by other users, and you want to make sure you have the most up-to-date

list displayed.

5.11.5. Edit

Each test configuration in the list has an “Edit” button in its right-most column. When you click this button
or just double-click on any of the cells in the row, you change the item from “View” mode to “Edit” mode.

The various columns are made editable, and “Save” and “Cancel” buttons are displayed in the last

column.

If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first
row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows (e.g. to change five test
configurations from Active = No to Active = Yes), you can click on the “fill” icon to the right of the editable

item, which will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters and it will switch all the selected items into edit mode.
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When you have made your updates, you can either click “Save”to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

5.12. Test Configuration Details

When you click on a test configuration entry in the list, you are taken to the test configuration details page

illustrated below:

« Back to Configurations List -] £ Refresh % Delste

Display; Current Filter v | &

 Target web browsers and operating systems
] Target web browsers and operz

3 List of library information .. =
E Complete testing data, wit.

Overview Test Sets

Active. Yes Creation Date

Last Updated:
Description:
This set of data consists of all the web browsers and operating systems that the application needs to be tested with
-
+ Populate | X Remove = & Refresh
© Displaying 6 out of 6 entries in this test configuration set.

Show | 15 | L % ${browserName} $loperatingSystem} D
Internet Explorer Windows 7 1
Mezilla / Firefox Windows 7 2
Operz Windows 7
Internet Explorer Windows 8 4
Mezilla / Firefox Windows 8 5
Opera Windows 8 6

Show | 15 W | [ows per page Displaying page Sofl

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the test configuration name and ID, and the bottom part of the right pane displays different

information associated with the test configuration.

The navigation pane consists of a link that will take you back to the test configuration list, as well as a list
of the peer test configurations to the one selected. This latter list is useful as a navigation shortcut; you
can quickly view the peer configurations by clicking on the navigation links without having to first return to
the list page. The navigation list can be switched between two different modes:

e The list of configurations matching the current filter

e The list of all configurations, irrespective of the current filter
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The right pane allows you to view and/or edit the details of the particular test configuration. You can edit
the various fields (name, description, etc.) and custom properties. Once you are satisfied with the
changes, click either the “Save” button or the alternative options from the “Save” dropdown list. In
addition you can delete the current automation host by clicking “Delete”, or discard any changes made by

clicking “Refresh”.

5.12.1. Overview

This tab shows the fields and description associated with the test configuration. Standard and custom

fields are grouped by type (eg all date and time fields are grouped together).

5.12.2. Overview — Test Configuration Entries

This section shows the list of all entries from this test configuration, and that would be used by a test set
to populate parameters. Each row represents a single unique combination of the parameters (shown on
the header row of the table).

Entries can be reordered by dragging and drop one row or more. Individual entries can also be removed

by checking the checkbox for that entry and then clicking “Remove” button.

To create new entries, first click the “Populate” button. This will display the following panel:

Please choose a test case parameter and associated custom list to add to this test configuration set:

Test Parameter: —- Please Select — Custom List: —- Please Select — Add

Cancel

You must select a parameter from the left dropdown (which contains a list of all parameters defined in test
cases in the current project), and a custom list with which to populate the parameter. Then click the “Add”
button. For instance, the screenshot below would create a configuration using every operating system
defined by the custom list “Operating System” and assigning these to the parameter called

“operatingSystem.”

Please choose a test case parameter and associated custom list to add to this test configuration set:
Test Parameter: operatingsystem Custom List: Operating System Add
operatingSystem Operating System ® Rernove

Cancel

Note: Custom lists are usually used in SpiraTeam for custom fields on various artifacts. However, you can
create custom lists that are solely for the purpose of test configurations, should you so wish — for

instance, to contain a list of usernames.
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Once you are happy with the lists and parameters selected, click the “Populate” button. This will
overwrite all existing entries in this test configuration. It will create every combination based on the lists
specified. So if you select two parameters, each with a list that has ten items, one hundred entries will be
created in the test configuration.

5.12.3. Test Runs

This tab displays the list of all the test runs executed against the test configuration. Each test run is listed
together with the date of execution, the name of the test case, the name of the tester, the release/version
of the system that the test was executed against, the name of the test set (if applicable), the overall
execution status for the test case in that run and a link to the actual test run details (see section 5.6). In

addition, you can choose to display any of the custom properties associated with the test run.

Overview Test Sets
< Refresh | -- Show/hide columns — | & Y Filter | &

O Displaying 1- 0 out of 6 test set(s) using this test configuration.. Filtering results by Configuration. | Clear Filters

¥ % Name & Execution Status planned Date Release Last Executed Owner Status D Edit
— Ay — | w B - any — | v B Ay —- | w | —any— v | TX Edit
Show | 15 “ | rows per page Displaying page | 1 oofo

The “Show/hide columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of

“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Filter” button. In addition, you can quickly sort the list by clicking on one of the

directional arrow icons displayed in the header row of the appropriate field.
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6. Incident Tracking

This section outlines how the incident/defect tracking features of SpiraTeam® can be used to manage
key project artifacts during the software development lifecycle. In addition to managing the defects raised
during the execution of test cases in the test management module, the Incident Tracker is also a powerful
risk/issue/bug tracking system in its own right. When coupled with the project dashboard (see section 3.4)
it is a powerful tool for representing all the key risks and issues associated with a project in a single,
graphical format.

Unlike a standalone bug/issue tracking tool however, you can trace the incidents/defects back to the test
case and the underlying requirement that generated them, giving the project manager unprecedented
power in analyzing the “in-process” quality of a system during its lifecycle. This power is clearly illustrated
in the “Requirement Incident Count” pane in the Project Home dashboard (see section 3.4.4).

6.1. Incident List

When you click on the Tracking > Incidents global navigation link, you will initially be taken to the
incidents list screen illustrated below:

Incidents / Tasks / Resources / Source Code
(et (Rfif=r L + New incident | ¥ Delete = & Refresh | T Filter » | [ Clone ¥ Tools | v || -- Show/hide columns -- | v
& All Reopened Incidents Displaying 1 - 15 out of 60 incident(s) for this project
& New Unassigned Incidents v 2 Name Type Status Priority 4% Owner Progress o} Edit
R —Any — v || Ay — v | Ay — | v [ [ Ay - v N Edit
Componernts Bug Resolved 4 - Low Fred Bloggs INIO Edit
Administratio
+& Administration E Permissions not ed Bug Closed 4 - Low Fred Bloggs IN:14 Edit
& Author Management
B Ability fferent color schemes ~ Enhancement  Resolved 4 - Low Joe P Smith IN:24 Edit
& Book Management
Enhancement  Closed 4 - Low Fred Bloggs IN:28 Edit
Charts = Issue Closed 4 - Low Joe P Smith IN:24 Edit
Training Open 4 - Low IN:38 Edit
Training Open 4 - Low IN:39 Edit
Training Closed 4 - Low Jos P Smith IN:43 Edit
2% Limitation Closed 4 - Low Jog P smith IN:49 Edit
m Change Request Assigned 4 - Low Jos P Smith IN:S4 Edit
Risk Assigned 4 - Low Fred Bloggs INET Edit
¥ E The book listing screen doesn't sort Bug Open 3 - Medium ING Edit
ky Bug Assigned 3 - Medium Jog P smith N9 Edit
(All Closed) (All Open)
des  Bug Closed 3 - Medium Jos P Smith INT3 Edit
Enhancement  Assigned 3 - Medium Fred Bloggs IN:23 Edit
4 .
g Displaying page 1 Sofam
7
7
7
(Mone) 1-Critical
2-High ™ 3-Medium
4-Low

The incident list screen displays all the incidents entered for the current project, in a filterable, sortable

grid. The grid displays the incident number together with fields such as incident type (bug, issue, risk,
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etc.), status (new, open, etc.), priority, name, assigned owner, detection date, detector, closed date, etc.
The choice of columns displayed is configurable per-user, per-project, giving extensive flexibility when it

comes to viewing and searching incidents.

The sidebar on the left gives you quick access to saved filters, along with some useful charts to get an at-

a-glance view of incidents for this project.

In addition, you can view a more detailed description of the incident (along with a resolution if any) by
positioning the mouse pointer over the incident name hyperlink and waiting for the popup “tooltip” to
appear. If you click on the incident name hyperlink, you will be taken to the incident details page
described in section 6.2. Clicking on any of the pagination links at the bottom of the page will advance
you to the next set of incidents in the list according to the applied filter and sort-order. There is also a
drop-down-list at the bottom of the page which allows you to specify how many rows should be displayed
in each page, helping accommodate different user preferences.

6.1.1. Sorting and Filtering

You can easily filter and sort the list of incidents as illustrated in the screen-shot below:

4 New Incident | X Delete Z Refresh Y Filter w [[)Clone % Tools ~ | --Show/hidecolumns-- | s

Displaying 1 - 14 out of 14 incident(s) for this project. Filtering results by Type. ClearFilters
Detected B
v & Name 4% Type AW Status AW Priority A'W 'e ectedBy A Creation Date 47 Owner g4 Progress ID g ¥ Edit
- IN

Bug v | --Any - v - Any - v || —-Any- v E | |-Any - v | |—-Any-- N Edit
RJ Validation on the edit book page Bug Resolved 1-Critical Fred Bloggs 14-Nowv-2003 Joe P Smith IN:11 Edit
R_] Quott ng issues throughout Bug Resolved 2-High Fred Bloggs 14-Nowv-2003 Fred Bloggs IN:12 Edit
R_]’ he et cutoff on low-res modes Bug Closed 3 -Medium Joe P Smith 14-Nov-2003 Joe P Smith IN:13 Edit
R_] Permissi not updating when changed Bug Closed 4 - Low Joe P Smith 14-Nov-2003 Fred Bloggs IN:14 Edit
R_]Sess g Bug Closed 1-Critical Joe P Smith 14-Nov-2003 Joe P Smith IN:15 Edit

To filter the list by incident type, status, priority, owner or detector name, you simply choose an item from
the appropriate drop-down list, and for the other fields, you enter a free-text phrase then click “Filter” or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a “LIKE”
comparison, so that searching for “database” would include any item with the word database in the name.
The other freetext fields need to be exact matches (e.g. dates, incident numbers). There are also several
aggregate filters that are used to filter on multiple values at once (e.qg. filtering status on (All Open) will

return any incident that is in one of the open statuses — new, open, assigned, reopen).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the darker

arrow. In the screen-shot above, we are filtering on type=bug and sorting by decreasing priority.
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Clicking on Filter > Clear Filter removes any set filters and expands the incident list to display all incidents
for the current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My Page’

for use in the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

As a shortcut, the left hand panel includes a set of Quick Filters that can be applied in a single-click:

e The topmost section displays any saved incident filters created by the current user or that are
shared with the current user (the former are designated with an icon representing a single person,
the latter a group of people)

e Components — This section lists the components defined for the current project. Clicking on any
of the components in the list will filter the incidents to only show those that are associated with the
selected component.

e Releases — This section lists the releases and iterations defined for the current project. Clicking
on any of the releases or iterations in the list will filter the incident by that resolved

releasel/iteration.

6.1.2. New Incident

Clicking on the “New Incident” button takes you to the new incident screen. This is essentially the same
screen as the incident details screen shown in section 6.2 except, depending on how the workflow has
been configured for your project, certain fields may be disabled. For more details on setting and up

configuring workflow for your project, please refer to the SpiraTest Administration Guide.

6.1.3. Delete

Clicking on the “Delete” button deletes the incidents whose check-boxes have been selected in the

incident list.

6.1.4. Refresh

Clicking on the “Refresh” button simply reloads the list of incidents; this is useful when new incidents are

being added by other users, and you want to make sure you have the most up-to-date list displayed.

6.1.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the incident list as columns for
the current project. To show a column that is not already displayed, simply select that column from the list
of “Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.

© Copyright 2006-2017, Inflectra Corporation Page 170 of 312 This document contains Inflectra proprietary information




6.1.6. Edit

Each incident in the list has an “Edit” button display in its right-most column. When you click this button or
just double-click on any of the cells in the row, you change the item from “View” mode to “Edit” mode. The

various columns are made editable, and “Save” and “Cancel” buttons are displayed in the last column:

+ NewlIncident = % Delete | < Refresh | ¥ Filter v [ Clone & Tools | v Show/hide columns -
g 31 - 45 out of 60 incident(s) for this project
v % Name AV Type AV Status AW Priority AW Detected By 4 W CreationDate AY ~ Owner oW Progress IDAY Edit

Any v A v Any v Any v e Any v Any v IN Edit

K_] a Issue Assigned 3- Medium Joe P Smith IN:33 Edit

b t dat Assigned 3- Medium IN:23 Edit

) Al e = v = v E = = E3 -

L] Resolved 1- Critical IN:25 Edit

L3 2-High Joe P Smith IN:26 Edit

If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first
row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows (e.g. to change five incidents
from “Resolved” status to “Closed”), you can click on the “fill” icon to the right of the editable item, which

will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Save” to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

6.1.7. Cloning Incidents

To create a clone of an existing incident or set of incidents, simply select the check-boxes of the incidents
you want to copy and then click “Clone”. This will make a copy of the current incident with its name
prefixed ‘Copy of ...." to distinguish itself from the original. Any file attachments will also be copied along
with the incident itself.

6.1.8. Exporting Incidents

To export an incident or set of incidents from the current project to another project in the system, select

the check-boxes of the incident(s) you want to export and then click the Tools > “Export to Project”. This

will then bring up a list of possible destination projects:
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<= New Incident = ¥ Delete 2 Refresh Y Filter  wv [C1 Clone | & Tools | v || --Show/hide columns-- | v

Displaying 1 - 15 out of 60 inc™"
Export Items

Detected B
v % Name 4§ ority AW etected By A

Creation Date 4% Own¢

Please select the project you want to export to: v
--- Select Project - v PAny - | VO -Any - |V 8 |[-An
sascelecyRrojeciies Fred Bloggs 31-Oct-2003
Sample Application One ) N
' E_]N:)t able to add new autl Joe P Smith 31-Oct-2003
Sample Application Two Cancel
4 EJIZI cking on link throws fi Fred Bloggs 31-Oct-2003
not backing up correctly Bug Open Joe P Smith 1-Nov-2003

Once you have chosen the destination project and clicked the “Export” button, the incidents will be
exported from the current project to the destination project. Any file attachments will also be copied to the

destination project along with the incidents.6.1.9. Creating Requirement from Incidents

Sometimes you may have a situation where an enhancement has been logged in the incident tracker and
now that it has been approved, it needs to be converted into a formal requirement so that test cases and
tasks can be generated from it. To aid this process, there is a shortcut that allows you to create new
requirement from selected incidents and have it be automatically added to the requirements list. When
that is performed an association is automatically added that links this new requirement to the original

incident.

To activate this feature, select the checkboxes of the incidents you want to convert and then click Tools >

Convert Into Requirements.

6.1.9. Printing Items

To quickly print a single incident or list of incidents you can select the items’ checkboxes and then click
Tools > Print Items. This will display a popup window containing a printable version of the selected items.

You can also save the report in a variety of common formats from the same Tools menu.

6.2. Incident Details

When you click on an incident item in the incident list, or click the “New Incident” button (as described in

section 6.1), you are taken to the incident details page illustrated below:
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/ Tasks / Resources / Source Code

« Back

t List e [0 Clone | & Refresh || X Delete N Find f Tools | v EFEmail | 7 Subscribe | v
Display: Current Filter| » | &
Edl’rmg the date on a book is C|unl<y
B cannot log into the applica
B Not able to add new autho.

[IN:8]"®) Bug Status:” Assigned  Operations~ Progress
B Clicking on link throws fata
¥ Database n Overview Attachments Associations History
B Cannot
¥ The book listing screen doe.
¥ Cannot add 3 new book to . Detected Release 11.0.0 - Library.. Priority 2 - High 1/3/2003 7:00:00 PM
¥ Editing the date on a book is | Resolved Release: 1110 - Library Severity: 4 - Low 1/30/2003 7:00-00 PM
) Editing the date on an aut Verified Release 1200 - Library Component Book Management Start Date: 1/5/2003
¥ Do=sn't let me add 2 new Fixed Build: -- None — Operating System —— Please Select - Closed On
¥ validation on the edit book
Web Browser. —- Please Select -
E Quote handling issues thro,
N nternal: No 0.4h
B The tables get cutoff on low
h Rankin:
E Permissions not Updating w Detected By Joe P Smitl 4 Est. Effort (h):
041
B session handling [IN15] Owner Fred Bloggs
Difficulty: ——- Please Select -
Reviewer --- Please Selec

Decimal
Show | 15 Vv | rows

Review Date:

This page is made up of three areas:
o the left pane is the navigation window where you can quickly jump to other incidents;
e the upper part of the right pane contains the incident name and key information about it (it's ID
number, and what type of incident it is), as well as the current status (see below); and
¢ the bottom part of the right pane displays different information associated with the incident across
a number of tabs.

The navigation pane consists of a link that will take you back to the incidents list, as well as a list of the
peer incidents to the one selected. This latter list is useful as a navigation shortcut; you can quickly view
the peer incidents by clicking on the navigation links without having to first return to the incidents list
page. The navigation list can be switched between four different modes:

e The list of incidents matching the current filter

e The list of all incidents, irrespective of the current filter

e The list of incidents assigned to the current user

e The list of incidents detected/found by the current user

In addition to the left hand navigation, you can enter a specific incident number in the text-box in the
toolbar and click the “Find” button. In the same toolbar, there is also a shortcut for creating a copy of the
current by clicking the “Clone” button.

6.2.1. Editing an Existing Incident

If you are editing an existing incident, the fields that are available and the fields that are required will
depend on your stage in the incident workflow. For example an open incident might not require a

“Resolved Version” whereas a resolved incident may well. The types of change allowed and the email
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notifications that are sent will depend on how your project administrator has setup the system for you.
Administrators should refer to the SpiraTeam Administration Guide for details on configuring the incident

workflows to meet their needs.

Depending on the user’s role and whether they are listed as the owner or detector of the incident or not,

the dropdown next to the incident’s current status shows the allowed workflow operations:

Status:” Assigned Operations = Progress S0%

Duplicate Incident

History
Resolve Incident
Unable to Reproduce
Priority:
Severity: 4 - Low Unable to Fi'epmdl.fce
=== Mot Reproducible
Component Book Management Start Date:

These workflow transitions allow the user to move the incident from one status to another. For example

when the incident is in the Assigned status, you will be given the options to:
» Resolve the Incident — changes status to “Resolved”
>» Unable to Reproduce — changes the status to “Not Reproducible”
>» Duplicate Incident - changes the status to “Duplicate”

After changing the status of the incident by clicking on the link, you can then fill in the additional fields that
are now enabled and/or required. Once you’ve made the changes to the appropriate incident fields, you
can click “Save” or one of the options from the “Save” dropdown list to commit the changes or “Refresh”

to discard the changes and reload the incident from the database.

Please note that if digital signatures have been enabled for a particular workflow operation (and therefore
a digital signature is required to confirm the status change. Workflow operations requiring a digital

signature are marked with a padlock icon as in the example below:

Status:™ MNew Operations = Progn

Assign Incident &

ry

Review Incident
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On attempting to save changes made after clicking a workflow operation that requires a digital signature

you will be presented with a popup similar to the one below (which is for a requirement):

7
Enter Electronic Signature

Please enter your login/password together with the meaning and click Sign:

Login:" fredbloge

Password:”

Changing Requirement RQ:4 from 'Developed’ to 'In Progress'
"
Meaning:

You can print the current incident by clicking Tools > Print, which will display a printable version of the
page in a separate window. Alternatively, you can export the incident to a number of formats by selecting

the appropriate option from the Tools menu.

6.2.2. Inserting a New Incident

If you are creating a new incident, the fields that are available and the fields that are required will depend
on how your project has been for configured. For example, some projects may require that all incidents
be started with Status=New and Type=Incident, others may allow you to specify the incident type. The
types of change allowed will depend on how your project administrator has setup the system for you.
Administrators should refer to the SpiraTeam Administration Guide for details on configuring the incident
workflows to meet their needs.

Once you've filled out the appropriate incident fields, you can either click “Save” or one of the options

from the “Save” dropdown list to commit the changes or click on “Back to Incident List” to discard the

insertion and return back to the incident list.

6.2.3. Overview - Comments

The Comments section allows users to add and view discussions related to the incident:
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Displaying | newest first

Normal - Font

oldest first

Size -~

We need to change the array to a generic hist to fix this bug
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i
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e
[>]
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39 = L E M|

[@ 5% [ source

Existing comments are displayed by date (either newest-first or oldest-first) above the text box. To add a

comment to the incident, enter your text into the textbox, then click the “Add Comment” button to save.

6.2.4. Overview — Dates and Times

This section displays the general schedule and completion status of the specific incident. You can

enter/edit the start-date, closed-date (i.e. the due-date), estimate, actual and remaining effort. From these

values, the system will display the calculated percent completion, progress indicator and projected final

effort. Any custom date fields set up by the system administrator or project owner will also appear in this

section (as shown below with the Review Date field).

Start Date

Closed On:

Est. Effort (h):

Review Date:

N/3/2003 7.00:00 PM
N/30/2003 7.00:00 PM

N/3/2003

0.4h

0.41
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6.2.5. Attachments

In this tab, the lower section of the screen displays the list of documents, screenshots or web links (URLS)
that have been “attached” to the incident. The documents can be in any format, though SpiraTeam® will
only display the icon for certain known types.

Overview Attachments Associations History
+ Add New | S Add Existing X Remove & Refresh -- Show/hide columns —- | w Y Filter |

Displaying 1 - 1 out of 1 attachment(s)

¥ Filename Type Size Edited By Edited On &% Author D Edit
-- Any — | v = -- Any — | v == -- Any — | v DC Edit
] Date Editing Screenshot jpg Screen Shot 281 KB Joe P Smith 23-Apr-2006 Joe P Smith DCo Edit

Show | 15 v | 10WSs per page Displaying page | 1 Zofl

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To delete an existing attachment from an incident, click the

“Remove” button and the attachment will be removed from the list.

To attach a new document to the incident, you need to first click the “Add New” link to display the new
attachment dialog box:

Add New Document Add New Document Add New Document
Type* ® File URL © Sereenshot Type* File ®IURL O Screenshot Type* File URL ® Screenshot
) .
Filename: Choose File | Mo file chosen URL"
Description: Description:
4 4 Screenshot"
» - - )

Document Type: Functional Specification | v Document Type:* Functional Specification | v

Document Folder: Root Folder v Document Folder:* | Root Folder v o TR

Tags: Tags:

N Description

Document Type:* Functional Specification | v
Document Folder:* Root Folder v
Tags:

There are three different types of item that can be attached to an incident:
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>» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the incident. To do

that, click on the “Add Existing” button to bring up the add file association dialog box:

Add Existing Document Add Existing Document

Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
®) Documents Source Code Documents [8] Source Code

Folder v Document Folder v File

& Root Folder (=0
m ~ Comment:

Cancel
A
m Cancel

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.

© Copyright 2006-2017, Inflectra Corporation Page 178 of 312 This document contains Inflectra proprietary information



http://mywebsite.com/?Document=1

6.2.6. History

This tab displays the list of changes that have been performed on the incident artifact since its creation.

An example incident change history is depicted below:

Overview Attachments Associations History
& Refresh | ¥ Filter

Displaying 1 - 2 out of 2 changels).

Change ID Change Date «¥  Field Name old value New Value Changed By Change Type
) =] - Any — | W -— Any — | W

7 5-Mar-2005 Type Incident Bug Fred Bloggs Modified

5 4-Mar-2005 Status MNew Open Fred Bloggs Modified

Show | 15 | roWs per page Displaying page | 1 = aofl

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail

to be maintained of all changes in the system.

6.2.7. Associations

This tab displays a list of any requirements, tasks, test runs, test steps or other incidents that are

associated with this incident:

Overview Attachments Associations History
+ Add X Remove | & Refresh Y Filter | v

Displaying 1 - 4 out of 4 association(s)

v Type Artifact Type Artifact Name Status Creation Date &% Creator Comment Project Mame D Edit
—Any — | v |- Any - | v B - any — v —Any — | v Edit
Library
Related-to Requiremant Developed 17-Mar-2004 Joe P Smith Information [RQ:a] Edit
Systemn
Library
Related-to Incident Assigned 16-Mar-2004 Joe P smith Information [iN:7] Edit
System
L Library
This incident and -
Related-to Incident New 15-Mar-2004 Joe P Smith 15 INCI0eNt 3N mation [in-t] Edit
bug are related _
= System
~ Library
Related-to Requirement — Developed 14-Mar-2004 Fred Bloggs Information [RQ:5] Edit
System
Show | 15 “ | rows per page Displaying page | 1 = of1

+ Create a new requirement from this incident ﬁ

The incidents and tasks in this list are ones that a user has decided are relevant to the current one and
has created a direct link between them. In the case of requirements and test cases, the association can
be either due to the creator of an incident directly linking the incident to the requirement or test step, or it
can be the result of a tester executing a test-run and creating an incident during the test run. In this latter

case, the check-box to the left of the association will be unavailable as the link is not editable.
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Each association is displayed with the type of association (related-to, vs. a dependency), name of the
artifact being linked-to, type of artifact (requirement, incident, etc.), the name of the person who created
the association, a comment that describes why the association was made, and the project of the linked
artifact. In the case of an indirect association due to a test run, the comment will contain the name of the

test run.

You can perform the following actions on an association from this screen:
> Delete — removes the selected association to the other artifact. This will only delete the
association, not the linked artifact itself.
» Refresh — updates the list of associations from the server, useful if other people are adding
associations to this incident at the same time.
> Filter / Apply Filter — Applies the entries in the filter boxes to the list of associations

A\ 4

Clear Filter — Clears the current filter, so that all associations for the current incident are shown.
> Edit — Clicking the “Edit” button to the right of the associations allows you to edit the association

type and comment fields inline directly on this screen.

To create a new association, click the “Add” button to display the “Add New Association” panel:

Owverview Attachments Associations History
Select Artifact Type~ Q search
Cancel
% Remove < Refresh Y Filter | w

Displaying 1 - 4 out of 4 association(s).

Once you have selected the appropriate artifact type, you will then be able to browse or search for the
specific artifact you want to link to. You can also enter the ID of the artifact directly (if known). In either
case you can also add a comment that explains the rationale for the association. If you’re adding an

association to a test step, the test steps are grouped in their test cases. You can browse the list of test

cases within each test case folder.
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Overview

Test Step~

+ 1D
TC20

O TS42

[ 7543

[ T=:44
TC:21
TG

TCl6

Attachmants Associations % History #

Common Tests+ Filter by name, or search by ID (eg. undefined4)

Name
v &) Create Author

@@ Step I: Click on the 'Create new author' link <br>

m Step 2 Enter in the new author infermation<br=

@ step : Click the ‘Insert’ button<br>
» & Crea
» LY Logir
» &3 Open Up Web Browser

6.2.8. Creating a Requirement from an Incident

Q, search
Project
Library Information System
Library Information System
Library Information System
Library Information System

Library Inf

Library In ystem

Library Information System

Sometimes you may have a situation where an enhancement has been logged in the incident tracker and

now that it has been approved, it needs to be converted into a formal requirement so that test cases and

tasks can be generated from it. To aid this process, there is a button on the Associations tab that allows

you to create a new requirement from the current incident and have it be automatically added to the

requirements list. When that is performed an association is automatically added that links this new

requirement to the original incident.

6.2.9. Emailing the Incident

Using the “Email” button on the toolbar, you can send an email containing details of the incident to an

email address or another user on the system:

Email this artifact to

* Project User: Amy E Cribbins v

Select auser in the project to send to.

Email Addresses:

A list of email addresses, separated by ;

Message Subject:

Leave blank for default.
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You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user. The content of the email is specified in the System Administration

— Notification Templates.

To be notified of any changes made to the current artifact via email, click the “Subscribe” button. If you
already subscribed, the button will instead let you “Unsubscribe” to stop receiving emails about that

particular artifact.

6.2.10. Incident Followers

Using the “Subscribe” button on the toolbar, you can quickly follow the incident, and receive updates on
certain changes to it. Depending on your role, you may also see a dropdown to this button, which let's

you add another project member as a follower to this incident.

=4 Email | ¥ Subscribe | s

& Add Follower

Add Follower

Select a user in the project to follow this artifact

Amy E Cribbins s

Cancel

You can also quickly see who is following an incident under the “People” section in the Overview tab.

© Copyright 2006-2017, Inflectra Corporation Page 182 of 312 This document contains Inflectra proprietary information




Owerview Attachments Associations His

Detected Release 10.20 - Library S..
Resolved Relzase 11.0.0 - Library 5.
Fixed Build — Mone —-

Followers (2)
70
i
To view information about the follower, or to unfollow them from the incident, hover over their avatar to

display a user profile card.

Amy E

b Cribbins Remove
follower
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7. Release Management

This section outlines how to use the Release Management features of SpiraTeam® to manage different
versions of the system being tested in a particular project. This is an optional feature of the system, and
you can manage the testing for a project successfully without tracking individual releases. Typically when
you develop a system, it is important to ensure that features introduced in successive versions do not

impair existing functionality - this is known as regression testing.

In such situations, you will want to be able to execute the same set of test scripts against multiple
versions of the system and be able to track failures by version. A feature that works correctly in version
1.0 may fail in version 1.1, and the maintenance team may be testing the existing lifecycle of v1.0 in
parallel with the development team testing v1.1. Therefore by developing a master set of
releases/versions in the Release Management module, you can have the different testing teams correctly
assign their testing actions to the appropriate version.

There are two types of release artifact in SpiraTeam® - major project releases that are displayed with the
blue release icon and represent major versions of the system, and release lIterations (aka builds) that are
displayed with a yellow icon and represent intermediate builds/iterations of the system. Note: Iterations
can be contained within a Release, but not the other way round.

The main differences between releases and iterations are as follows:

» Releases are independent versions of the system being tested and as such, you can map a
requirement directly to a release, indicating the release of the system that the requirement will be
fulfilled in.

» When you report on a release (e.g. on the project home or in one of the reports) any child
iterations are automatically taken into account, and test runs and incidents that are related to the
child builds/iterations will get included in the release reports. Child releases on the other hand are

not aggregated up into the parent release.

7.1. Release List

When you click on the Planning > Releases global navigation link, you will initially be taken to the release
list screen illustrated below:
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@ + Olibrary Information System s Planning ~ Testing ~ Tracking + Reporting .5vs(ar11 Administrator |

Requitements / Planning Board / Releases / Documents
+insert | v X Delete | ¥ Indent € Outdent & Refresh || — Show Level —— wv  YFiter « | [@Edit |+ & Tools s | — Show/hide columns — | w

Displaying 15 out of 19 release(s) for this project

v @ Name Version # Test Caverage Progress Start Date End Date Plan Effort Task Effort Type Status [} Edit
— Ay - | v —Any — v ==} =] ] & | Ay - v | Ay — v RL Edit
4 [ Library System Release | 1000 29-Feb-2004  1I-Mar-2004  2160h 943h Major Release  Completed RL1 Edit
4 [[g Library System Release 15P1 1010 No Tasks 12-Mar-2004  29-Mar-2004  176.0h 03h Minor Release  Completed RL2 Edit
10100001 No Tests No Tasks 12-Mar-2004 30.0h Iteration Completed RL1I Edit
10100002 No Tests No Tasks 20-Mar-2004 4 430h Iteration Campleted RLI2 Edit
10100003 No Tests No Tasks 24-M 29-Mar-2004  640h teration Completed RLI3 Edit
1020 No Tasks 31-Mar-2004  29-Apr-2004  3520h Minor Release  Completed RL3 Edit
10200001 No Tasks 31-Mar-2004 1120h teration Completed RL14 Edit
10200002 No Tasks 10-Apr-2004 120h Iteration Completed RLI5 Edit
10200002 No Tasks 20-Apr-2004  29-Apr-2004  128.0h Iteration Campleted RLIG Edit
10000001 20-Feb-2004  3-Mar-2004  960h 320h Iteration Completed RLS Edit
10000002 4-Mar-2004 240h 320h teration Completed RL9 Edit
10000003 8-Mar-2004  1-Mar-2004  720h 300h teration Completed RLIO Edit
14-0ct-2004  26-Oct-2004  168.0h 86.5h Major Release  In Progress RL4 Edit
No Tasks 31-0ct-2004  29-Nov-2004  336.0h osh Minar Release I Progress RLS Edit
No Tests No Tasks 30-Nov-2004  30-Dec-2004  3200h Minor Release  Cancelled RL7 Edit
Show |15 v | rows per page Displaying page 1 Sofz2m M

The release list will contain all the releases and iterations associated with current project. When you

create a new project, this list will initially be empty, and you will have to use the “Insert” button to start

adding releases and iterations to the project. The hierarchical organization of releases in the list is
configurable, so you can organize the various releases in the way that makes most sense for a particular
project. Typically you have the major releases as the top-level items, with sub-releases, builds and

iterations as the lower-level items.

All of the releases in the list have a release-name, together with the assigned version number for that
release, the start-date and end-date for the release, the number of estimated project personnel working
on that release, the planned effort for the release, the total effort currently scheduled (as tasks), the
available effort for new tasking, the release id, the type of each release, its status, and a set of custom

properties defined by the project owner.

For those releases that have test cases mapped against them, the execution status of the various test
cases associated with the release is displayed in aggregate for each item as a graphical bar diagram. If
you position the mouse over the execution status indicator you will see the detailed execution information

displayed as a tooltip.

For those releases that have at least one requirement task associated with them, they will display a block
graph that illustrates the relative numbers of task that are on-schedule (green), late-starting (yellow), late-
finishing (red) or just not-started (grey). These values are weighted by the effort of the task, so that larger,
more complex tasks will be change the graph more than the smaller tasks. To determine the exact task
progress information, position the mouse pointer over the bar-chart and the number of associated tasks,

along with the details of how many are in each status will be displayed as a “tooltip”.
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Clicking on a release’s hyperlink will take you to the release details page for the item in question (see

section 7.2).

7.1.1. Filtering

You can easily filter the list of releases as illustrated in the screen-shot below:

=+ Insert v X Delete =% Indent 4= Qutdent | L Refres S Leve v ¥ Filter | v # Edit ~ £ Tools Show/hide | v
tof 19 t t. Filt T Clear Filtes

¥ @ Name Version # Test Coverage Progress Start Date End Date Plan Effort Task Effort Type Status D Edit

teration Completed RL:13

RL:11

EEEE

To filter the list by any of the displayed columns, you either choose an item from the appropriate drop-
down list or enter a free-text phrase (depending on the type of field) and click “Filter” or press the
<ENTER> key. Note that the name field is searched using a “LIKE” comparison, so that searching for
“‘database” would include any item with the word database in the name. The other freetext fields need to
be exact matches (e.g. dates, release numbers). Clicking on Filter > Clear Filters clears all the set filters

and displays all the releases for the project.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose the option
Filter > Save Filter to add the current filter to the list of saved filters that appear on your ‘My Page’. The

list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

+ Insert v X Delete = Indent = 4= Outdent | & Refresh = --- Show Leve v Y Filter |v| @Edit v #*Tools Vv
212 ot of 19 reteasels) for this brolect Eliterg results byrr ¥ _Annly Filter
Save Filter b Fiter
v @ Name Version # Tes Plan Effort T
Please choose a name for this filter: - . . —
ieve Filter 5] B
§) lteration 003 1.0.1.0.0003 ) s Filter 04 64.0h
B iterati . 1.0.2.0.0001 No —/Sharewithother members of the project 9-Apr-2004 112.0h
£ Iteratio ’ 1.0.2.0.0002 \o m Cancel 4 19-Apr-2004 112.0h
§) Iteration 002 1.0.1.0.0002 No Teere NOTHEKS 20°Mar=2004  23-Mar-2004  48.0h
7.1.2. Insert

The “Insert” button has an attached dropdown menu that allows you to choose whether to insert a

release or iteration (if you just click “Insert” it defaults to inserting a release). In either case, it will insert

the new release / iteration above the currently selected item — i.e. the one whose check-box has been

selected, at the same level in the hierarchy. If you want to insert a release/iteration below a summary
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item, you need to insert it first, then indent it with the “Indent” button. If you insert a release without first

selecting an existing release from the list, the new release will simply be inserted at the end of the list.

Once the new release has been inserted, the item is switched to “Edit” mode so that you can change the
default name, active flag, version number and creator.

7.1.3. Delete

Clicking on the “Delete” button deletes all the releases whose check-boxes have been selected. If any of
the releases have child releases/iteration, then the child releases and iterations are also deleted.

7.1.4. Indent

Clicking on the “Indent” button indents all the releases whose check-boxes have been selected. Note:

you cannot indent a release or iteration if it is below an iteration, as iterations are not allowed to have
child items.

7.1.5. Outdent

Clicking on the “Outdent” button de-indents all the releases whose check-boxes have been selected.

7.1.6. Refresh

Clicking on the “Refresh” button simply reloads the release list. This is useful as other people may be
modifying the list of releases at the same time as you, and after stepping away from the computer for a

short-time, you should click this button to make sure you are viewing the most current release list for the
project.

7.1.7. Edit

Each releasel/iteration in the list has an “Edit” button display in its right-most column. When you click this

button or click on any of the cells in the row, you change the item from “View” mode to “Edit” mode. The

various columns are made editable, and “Save” “Cancel” buttons are displayed in the last column:

+ % Name Version # Test Coverage Progress Start Date End Date Plan Effort Task Effort Type Status 0 Edit

fii
[
i
<
i
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If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first
row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows (e.g. to change five releases
from “active” to “inactive”), you can click on the “fill” icon to the right of the editable item, which will

propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Save” to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

7.1.8. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily view the
entire release list at a specific indent level. For example you may want to see all releases drilled-down to
the third level of detail. To do this you would simply choose ‘Level 3’ from the list, and the releases will be

expanded / collapsed accordingly.

7.1.9. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the release list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.

7.1.10. Copying Releases/Iterations

To copy a releasel/iteration or set of releases/iterations, simply select the check-boxes of the
releasel/iteration you want to copy and then select the Edit > Copy Items menu option. This will copy the
current release/iteration selection to the clipboard. Then you should select the place where you want the

releases/iterations to be inserted and choose the Edit > Paste Items option.

The releases/iterations will now be copied into the destination location you specified. The name of the
copied releases/iterations will be prefixed with “Copy of...” to distinguish them from the originals. Note

that copied releasesl/iterations will also include the test mapping information from the originals.
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7.1.11. Moving Releases/Iterations

To move a release/iteration in the hierarchy, there are two options:

1. Click on the releasef/iteration you want to move and drag the icon to the location you want it
moved. An empty space will appear to show you where it will be inserted. Once you have the
requirement positioned at the correct place that you want it inserted, just release the mouse
button. To move multiple items simply select their checkboxes and then drag-and-drop one of the
selected items

2. Alternatively you can simply select the check-boxes of the release/iteration you want to move and
then select the Edit > Cut Items menu option. This will cut the current release/iteration selection
to the clipboard. Then you should select the place where you want the release/iteration to be
inserted and choose the Edit > Paste Items option. The release/iteration will now be moved into

the destination location you specified.

7.1.12. Exporting Releases/Iterations
To export releases/iterations from the current project to another project in the system, select the check-
boxes of the releases/iterations you want to export and then click the Tools > Export to Project item. This

will then bring up a list of possible destination projects:

Export Items
te

Please select the project you want to export to:
- Select Project --- W
21
--- Select Project --- b
ZI
Sample Application One
Sample Application 0 Cancel 20
Sample Application Two —ance
TP TNy THUF TErYRSy Lu"l'ldl‘;'

Once you have chosen the destination project and clicked the “Export” button, the releases/iterations will
be exported from the current project to the destination project. Any file attachments will also be copied to

the destination project along with the releasel/iteration.

7.1.13. Creating Test Sets from Releases

As a shortcut you can click the Tools > Create Test Set option to create a new test set for each of
selected releases. The created test sets will include all of the test cases associated with a release. This is
useful in regression testing when you have created a new release and want to be able to quickly assign a

tester to ensure that all the functionality in the release works as expected.
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7.1.14. Printing or Saving Iltems

To quickly print a single release/iteration or list of releases/iterations you can select the items’
checkboxes and then click Tools > Print Items. This will display a popup window containing a printable

version of the selected items. You can also save the report in a variety of common formats from the same

Tools menu.

7.1.15. Right-Click Context Menu
SpiraTeam® provides a shortcut — called the context menu - for accessing some of the most commonly
used functions, so that you don’t need to move your mouse up to the toolbar each time. To access the

context menu, right-click on any of the rows in the release list and the following menu will be displayed:

v % Name Version #
4 [@Library System Release 1 SP1 with a new really lo 1.0.1.0
2 «nannngs
= k Open Item
4 (@Lirary >ysiem Release 1 7 Openin New Tab
v PRi=]! System Rele
< 5] New Release
= : : ] New Iteration i
= teration U0, (# Edit Items 22
£ teration 002 ¥ Delete )2
Bite 001 = Indent n
% £ iterat 4 Outdent )3
e 7] Copy Items i
] lterat )< 3< Cut Items )2
£ Iterat Iy Paste Items )3
4 [GLibrary System Release 1.1 =4 Print Items

You can now choose any of these options as an alternative to using the icons in the toolbar

7.2. Release Details

When you click on release item in the release list described in section 7.1, you are taken to the release

details page illustrated below:
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ck to Release List ] =

Clone = & Refresh = % Delete | ## Toolz &
Display: Current Filter| & | &
4 [ Library System Release 1

4 [@ Library System Release 15| .
J e B Type:” Minor Release Status”* Completed | Operations~
£ Iteration 00!
£ teration 002
£ Iteration 003

incidents Reqs & Tasks Test Cases Test Runs Attachments History

4 [ Library System Release 1
£ tteration 001
£ iteration 002 Owimer -- None —- Last Updated:
£ Iteration 003
B tteration 00!
B tteration 002
] tteration 003
4 [ Library System Release 11
U

T Library System Release 11

System Release 11.

This service pack fixes identified bugs and a small security vulnerability

This page is made up of three areas;
1. the left pane displays the releases list navigation;

2. theright pane’s header, which displays: the operations toolbar; the editable name of the selected
release; and the info bar (with a shaded background), which also contains the workflow status
transitions (see below); and

3. the right pane’s tabbed interface with rich information related to the release.

Please note that on smaller screen sizes the navigation pane is not displayed. While the navigation pane
has a link to take you back to the releases list, on mobile devices a ‘back’ button is shown on the left of
the operations toolbar.

The navigation pane can be collapsed by clicking on the “-* button, or expanded by clicking anywhere on
the gray title area. On desktops the user can also control the exact width of the navigation pane by
dragging and dropping a red handle that appears on hovering at the rightmost edge of the navigation
pane.

The navigation pane consists of a link that will take you back to the release list, as well as a list of the
other releases in the current project. This latter list is useful as a navigation shortcut; you can quickly view
the test run information of all the other releases by clicking on the navigation links without having to first

return to the release list page. The navigation list can be switched between two different modes:
e The list of releases matching the current filter

e The list of all releases, irrespective of the current filter
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If you are editing an existing item, the fields that are available and the fields that are required will depend
on your stage in its workflow. The types of change allowed and the email notifications that are sent will
depend on how your project administrator has setup the system for you. Administrators should refer to the

SpiraTeam Administration Guide for details on configuring workflows to meet their needs.

Depending on the user’s role and whether they are listed as the owner or author of the requirement,
displayed in the info bar beneath the requirement name is the current workflow status and an “operations”

button which, when clicked, will show a set of allowed workflow operations.

]| Type: Minor Release Status:" In Prograss Operations =
Cancel Release
Cwerview Incidents Regs & Tasks Test Cases Test Runs Attachments
Defer Release
Finish Release
Creator: Joe P Smith Version #: 1010

Releases can have the following statuses: planned, in progress, completed, closed, deferred, and
cancelled. Note that releases marked as closed, deferred, or cancelled cannot be associated with other

artifacts — for example an incident’s resolved release cannot by a cancelled release.

Workflow transitions allow the user to move the item from one status to another. For example when the

release is in the In Progress status, you will be given the options to:
» Cancel Release — changes status to “Cancelled”
>» Defer Release — changes the status to “Deferred”
» Finish Release - changes the status to “Completed”

Please note that if digital signatures have been enabled for a particular workflow operation (and therefore
a digital signature is required to confirm the status change. Workflow operations requiring a digital

signature are marked with a padlock icon as in the example below:

Operations~
Cancel Release &
Dafer Release

Finish Release
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On attempting to save changes made after clicking a workflow operation that requires a digital signature
you will be presented with a popup similar to the one below (which is for a requirement):

Enter Electronic Signature

Please enter your login/password together with the meaning and click Sign:

Login:* fredbloggs

Password:”

Changing Requirement RQ:4 from 'Developed’ to 'In Progress'
"
Meaning:

The top part of the right pane allows you to view and/or edit the details of the particular release. In
addition you can delete the current artifact by choosing “Delete”, discard any changes made by clicking
“Refresh”, or print or export it by clicking one of the options from the Tools dropdown menu. The lower
part of the right pane can be in one of eight possible modes that can be selected: “Overview”, “Incidents”,
“‘Regs & Tasks”, “Test Cases”, “Test Runs”, “Attachments”, and “History”. Each of the different views is
described separately below.

Using the “Email” button on the toolbar, you can send an email containing details of the release to an
email address or another user on the system:
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Ermnail this artifact to

* Project User

Amy E Cribbins

Select a user in the project to send to
Email Addresses:

A list of email addresses, separated by ;

Message Subject:

Leave blank for default

Cancel

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration

— Notification Templates.

To be notified of any changes made to the current artifact via email, click the “Subscribe” button. If you
already subscribed, the button will instead let you “Unsubscribe” to stop receiving emails about that
particular artifact. Depending on your role, you may also see a dropdown arrow to the right of this button.

This will let you subscribe others in the project to this artifact.

The bottom part of the right pane can be switched between six views: “Overview”, “Incidents”,
“‘Requirements and Tasks”, “Test Cases”, “Test Runs”, “Attachments”, and “History”, each of which will be

described in more detail below.

7.2.1. Overview — Details

The Overview tab is divided into a number of different sections. Each of these can be collapsed or
expanded by clicking on the title of that section. It displays the description, fields and comments

associated with the requirement.

The top part of this tab displays the various standard fields and custom properties associated with the
requirement. Fields (both standard and custom) are grouped under the collapsible headings (marked by
orange text and underline) in the screenshot below. For instance, all fields regarding dates are grouped

together in the “Dates and Times” area.
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Overview Incidents Reqs & Tasks Test Cases Test Runs Attachments

Creator: Joe P Smith Version #: 1010

Owner: -- None -- Operating System: --- Please Salect ——-

This service pack fixes identified bugs and a small security vulnerability

History

Last Updated:

Start Date: 3/12/2004
End Date: 3/29/2004
# Resources: 2

Non-Working (person 2
days)

When you make changes to the releaseliteration’s start-date, end-date, number of project personnel

resources, or number of non-working person days, the system will automatically calculate how many

hours of effort (planned effort) are available in the release/iteration for assigning tasks. As you begin

assigning tasks — either through the Tasks tab or the Iteration Planning screen — the total estimated effort

of the tasks is subtracted from this planned effort to give the “available effort”.

7.2.1.1. Followers

Using the “Subscribe” button on the toolbar, you can quickly follow the item, and receive updates on

certain changes to it. Depending on your role, you may also see a dropdown to this button, which let's

you add another project member as a follower to this item.

[

Email | ¥ Subscribe | w

& Add Follower

Add Follower

Select a user in the project to follow this artifact

Amy E Cribbins v

Cancel
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You can also quickly see who is following an incident under the “People” section in the Overview tab.

Followers (2)
e
i

To view information about the follower, or to unfollow them from the item, hover over their avatar to

display a user profile card.

Amy E

Cribbins Remove
follower

7.2.1.2. Overview — Detailed Information

The Detailed Information section contains the long, formatted description of the requirement, as well as
any rich text custom fields. You can enter rich text or paste in from a word processing program or web
page into these fields. Clicking on the shaded areas of one of these detailed fields will display the rich text

toolbar.

7.2.2. Overview - Comments

The Comments tab shows the current discussion thread for this release:
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Displaying | newest first | oldest first

(]
1 OK, that's much better, thanks for adding the additional information.
-~
“ You're right, | have added some more detail and linked to some test cases that define how the functionality is expected to work.
(]
1 Need to write a better definition of this requirement, it has too many loose-ends.
Format ~  Font -~ Sz - B I U T, A-DB- = := E 99 e L E & E @ 22| @ Source

All existing comments are listed in order by entered date (either newest-first or oldest-first). To create a

new comment, enter the text into the text box, and then click the “Add Comment” button.

7.2.3. Overview - Builds

This section displays the list of builds associated with the current release/iteration. Each build is listed
together with its name, creation date, status (whether the build succeeded or failed), and last updated
date. Clicking on the hyperlink for the build name will open up the Build Details page which is described in

section 7.3 of this manual.

< Refresh | T Apply Filter ¥ Clear Filter | pisplaying 1 - 6 out of 6 build(s) in this release/iteration

Build Name Creation Date &% Status Last Updated D
==} -- Any — | v ==} BL

3-Mar-2004 Failed 3-Mar-2004 BLS

3-Mar-2004 Succeeded BL6

2-Mar-2004 Failed BL3

2-Mar-2004 Succeeded BL4

1-Mar-2004 Succeeded 1-Mar-2004 BL:2

29-Feb-2004 Failed 29-Feb-2004 BL:1

W | rows per page Displaying page Zofl

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Apply Filter” button. In addition, you can quickly sort the list by clicking on

one of the directional arrow icons displayed in the header row of the appropriate field.
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7.2.4. Incidents

This tab displays the incidents associated with the selected release. The incident list can be one of three
modes:
>» Detected in this Release — this will display a list of all the incidents that were detected during the

testing of the selected release. This is useful in determining if there are open incidents associated
with a release that need to be dealt with.
>» Resolved in this Release — This will display a list of all the incidents that have been reportedly

resolved in this release. This is useful for double-checking that all the resolved incidents for a
release have indeed been fixed.
>» Verified in this Release — This will display a list of the incidents that have been verified as being

fixed in this release. This is useful for generating release notes for a specific release indicating

what changes and enhancements have been made in the release.

Regardless of the mode, each incident is listed together with the type, status, priority, name, owner,

detector, detection date and a link to the actual incident details (see section 6.2):

Overview Incidents Reqs & Tasks est Cases Test Runs Attachments History

Display List of Incidents: | Detected in This Release k3  Refresh T Filter | » -- Show/hide columns —- | w

Displaying 1 - 2 out of 2 incident(s) in this release/iteration. Filtering results by Detected Release. Clear Filters
v % Name Type Status Detected By Owner Progress D & Edit
— ANy — | W — Any — | W — ANy — | W — ANy — | W — ANy — | W IN Edit
Eﬂ Clicking on link throws fatal error Incident New Fred Bloggs IN:3 Edit
) Database not backing up correctly Bug Open Joe P Smith IN:4 Edit
Show |15 “ | rows per page Displaying page 1 Zofl

To change between the three modes outlined above, select the desired mode from the drop-down list

contained within the header of the incident list table.

You can perform the following actions:
>» Refresh — updates the list of incidents from the server, useful if other people are adding incidents
to this release at the same time.

» You can filter the results by choosing items from the filter options displayed in the sub-header
row of each field and clicking the “Filter” button. In addition, you can quickly sort the list by
clicking on one of the directional arrow icons displayed in the header row of the appropriate field.

> Edit — Clicking the “Edit” button to the right of the incident allows you to edit the incident inline
directly on this screen. This functionality is limited to project owners.

» Show/Hide Columns — Allows you to choose which incident columns are visible
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7.2.5. Regs & Tasks

This tab displays the list of requirements and their associated child tasks that need to be completed for

the release/iteration to be completed:

Overview Incidents Reqs & Tasks Test Cases est Runs Attachments History

+ Insert Task ® Delets & Refresh Y Filter & | -——- Show Level -—- | Est Effort 943h  Actual Effort 6LOh  Projected Effort 956h

Displaying 6 out of & iteml(s)

v % Requirement/Task Name Importance Progress Owner Est. Effort Actual Effort Projected Effort  Edit
- Any - | W - Any - | W - ANy - | W =) = = Edit
¥ 4 ) Ability to add new books to the system 1 - Critical Joe P smith 16.0h 155h 0.0h Edit
1 - Critical Fred Bloggs 80h 73h 73h Edit
1 - Critical Fred Bloggs 5.0h 5.3h 53h Edit
1 - Critical Fred Bloggs 3.0h 28h 28h Edit
) Ability to edit existing books in the system 1- Critical Jae P Smith 16.0h 16.8h 0.0h Edit
ﬁ Ability to delete existing books in the system 1 - Critical Fred Bloggs 16.0h 15.2h 0.0h Edit
ﬁ Ability to create different editions 1 - Critical Fred Bloggs 16.0h 103h 7.5h Edit
£ ;ﬂ Ability to edit existing authors in the system 2 - High Fred Bloggs 16.0h 0.0h 16.0h Edit
ﬁ Ability to delete existing authors in the system 2 - High Fred Bloggs 14.0h 32h 10.8h Edit

Show | 15 “ | 1ows per page Displaying page 1 Zafl

Each of the requirements and associated tasks is displayed together with its name, description (by
hovering the mouse over the name), priority, progress indicator, current owner, estimated effort, actual
effort, projected effort and numeric task identifier. Clicking on a requirement will bring up the requirement
details page (see section 4.2). Clicking the triangle by a requirement will expand/collapse its list of tasks.
Clicking on a task name will bring up the Task Details page which is described in more detail in section

8.2. This allows you to edit the details of an existing task.
You can perform the following actions on a task from this screen:

» Insert Task —inserts a new task in the task list under the specified requirement, with a default set
of values. The task will be associated with the specified requirement and current release/iteration.

If no requirement is selected, the task will only be associated with the current release/iteration
» Delete — deletes the task from the project.

>» Refresh — updates the list of requirements and tasks from the server, useful if other people are

adding requirements and/or tasks to this release/iteration at the same time.

» You can filter the results by choosing items from the filter options displayed in the sub-header
row of each field and clicking the “Filter” button. In addition, you can quickly sort the list by

clicking on one of the directional arrow icons displayed in the header row of the appropriate field.

» Edit — Clicking the “Edit” button to the right of the requirement or task allows you to edit the item

inline directly on this screen. Only columns visible will be editable.

© Copyright 2006-2017, Inflectra Corporation Page 199 of 312 This document contains Inflectra proprietary information




» Show Level — Allows you to quickly expand/collapse all the requirements in the list.

7.2.6. Test Cases

This tab shows the test coverage information for the release in question:

Add X Remove | & Refresh Y Filter | w
Displaying 1 - 3 out of 3 association(s)
¥ Type MName Status Execution Status Last Executed Priority Project Name D
- Any - W — ANy -- | v - Ay - | W B —-Any - v | ANy - v

Library Information

Functional Ready for Test |Passed 1-Dec-2003 1 - Critical - TC2
System
Library Information

Regressian Ready for Test |Passed 1-Dec-2003 2 - High . ;‘:] TC8
Sys!

. author to Library Information ,

Scenario Approved Not Run 3 - Medium - = = TC13

System
Show | 15 w | rows per page Displaying page Zof1

The tab displays a grid containing the test cases already mapped to this release. You can filter that list by
the test case type, nhame, status, execution status, execution date, priority, project name and ID. You can
remove an existing test case by selecting its check box and clicking the ‘Delete’ button. This doesn’t

delete the test case, just removes it from the release.

Hovering the mouse over the names of the test cases will display a “tooltip” consisting of the test case

name, place in the folder structure and a detailed description.

To add a new test case to the release, simply click on the ‘Add’ button:

Rootw Q, Search

-~ No matches found: ~
74

Canceal + Create Test Set From This Release [F

You can search for a test case by its ID if you know it (make sure to include the “TC” prefix):

Root v  TC4 Q Search
v ID Name Project
[ T1c:4 lj Ability to create new author Library Information System

Otherwise, you can search for the test cases by choosing a folder from the dropdown and/or entering a

partial name match:

© Copyright 2006-2017, Inflectra Corporation Page 200 of 312 This document contains Inflectra proprietary information




Root v book Q Search

v ID Name Project
(e X7 Ability to edit existing book Library Information System
=]

O Tc:6 X7 Ability to reassign book to different author Library Information System
[ Tc:19 X7 Adding multiple new books Library Information System
O 1c:18 L_] Adding new author and book Library Information System
O 71Cc:21 l_] Create Book Library Information System
0 T1c:12 X9 Person loses book and needs to reportloss Library Information System

One you have found the desired test case(s), simply select their check boxes and click the ‘Save’ button

to add them to the current release:

Root ~  book Q search

v ID Name Project

[ Tc:3 X7 Ability to edit existing book Library Information System
O 1C:6 l_] Ability to reassign book to different author Library Information System
TC:19 X Adding multiple new books Library Information System
TC:18 X1 Adding new author and book Library Information System
[ T1C:21 l_] Create Book Library Information System
O 1c:12 X9 Person loses book and needs to report loss Library Information System

2 Row(s) selected

Finally, as a shortcut you can click the “Create Test Set from This Release” link to create a new test set

from this release, that will include all of the test cases associated with this release. This is useful in
regression testing when you have created a new release and want to be able to quickly assign a tester to

ensure that all the functionality in the release works as expected.

7.2.7. Test Runs

This view displays the list of all the test runs executed against the release. Each test run is listed together
with the date of execution, the name of the test case, the name of the tester, the release/version of the
system that the test was executed against, the name of the test set (if applicable), the overall execution
status for the test case in that run and a link to the actual test run details (see section 5.6). In addition,

you can choose to display any of the custom properties associated with the test run.

Overview Incidents Reqs & Tasks Test Cases Test Runs Attachments History
& Refresh | Y Filter | — Show/hide columns — |

Displaying 1 - 5 out of 5 test run(s). Filtering results by Release | Clear Filters

¥ % Name End Date ¥ Type Tester Release Execution Status Act. Dur. D Edit
=] -— ANy - | W - Any -- | W — Any -- | W =] TR Edit
B} Ability to edit existing boo 1-Dec-2003 Manual Fred Bloggs 1000 Caution 0.sh TRIO Edit
) Ability to edit existing bool 1-Dec-2003 Manual Fred Bloggs 1000 Passed 15h TR3 Edit
DJ Ability t 1-Dec-2003 Manual Joe P Smith 1000 Failed 15h TR4 Edit
B Abilit, 1-Dec-2003 Automated Fred Bloggs 1000 Failed 12h TRI2 Edit
¥ DJ Ability to 1-Dec-2003 Manual Joe P Smith 1000 Failed 13h TR Edit
Show | 15 W | rows per page Displaying page 1 Zofl
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The “Show/hide columns” drop-down list allows you to change the fields that are displayed in the test run
list as columns. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of

“Hide...” column names. The displayed columns can be any standard field or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-header row of
each field and clicking the “Eilter” link. In addition, you can quickly sort the list by clicking on one of the

directional arrow icons displayed in the header row of the appropriate field.

7.2.8. Attachments

In this mode, the lower section of the screen displays the list of documents that have been “attached” to
the release. The documents can be in any format, though SpiraTeam® will only display the icon for
certain known types.

Overview Incidents Reqs & Tasks Test Cases Test Runs Attachmants History
+ Add New % Add Existing < Refresh —- Show/hide columns —— | & T Filter |~

Displaying 1 - 3 out of 3 attachment(s)

+ Filename Type size Edited By Edited On &% Author D Edit
- ANy — W =l --Any — | v [=] — Any — | v DC Edit
Functional Specification 1KB Fred Bloggs Fred Bloggs DC:20 Edit
Functional Specification KB Fred Bloggs Fred Bleggs pC21 Edit
Functional Specification 87 KB Fred Bloggs Fred Bloggs DC22 Edit

Show | 15 W | rows per page Displaying page 1 = of1

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser window will
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To delete an existing attachment from an incident, click the

“Remove” button and the attachment will be removed from the list.

To attach a new document to the release, you need to first click the “Add New?” link to display the new
attachment dialog box:
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Add New Document Add New Document Add New Document

Type* ® File O URL © Screenshot Type" File ®IURL © Screenshot Type” File OURL ® Screenshot
Filename: Choose File | Nofile chosen URL:*
Description: Description:
4 4 Screenshot:”
Document Type:” Functional Specification | v Document Type:* Functional Specification | v
Document Folder:” Root Folder v Document Folder:" | Root Folder v
Tags: Tags:
- Description:
Document Type:* Functional Specification | v
Document Folder:” Root Folder v
Tags:

There are three different types of item that can be attached to a release:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that’s already stored in SpiraTeam) with the incident. To do

that, click on the “Add Existing” button to bring up the add file association dialog box:
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http://mywebsite.com/?Document=1

Add Existing Document Add Existing Document

Choose the location of existing document that you'd like to add: Choose the location of existing document that you'd like to add:
®) Documents Source Code Documents [8] Source Code

Folder v Document Folder v File

&3 Root Folder Eli

~ Comment:
Cance!

m Canee

You can then choose to either associate a document stored in the SpiraTeam Documents repository or
(in the case of SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either
case you first select the appropriate folder, and then pick the document(s) from the file list on the right. In

the case of a source code file association you can also add a comment.

7.2.9. View History

In this mode, the main pane displays the list of changes that have been performed on the release artifact

since its creation. An example release change history is depicted below:

Overview Incidents Reqs & Tasks Test Cases Test Runs Attachments History
2 Refresh | T Filter | & & Admin View

Displaying 1 - 4 out of 4 changel(s)

Change ID Change Date #¥  Field Name old value New Value Changed By Change Type
& Ay - W =AY - W
I 10-0ct-2017 Description This service pack fixes identified bugs and a small  This service pack fixes identified bugs and a small System Modified
security vulnerability security vulnerability Administrator

7 1 - 2/78/9004 7.0 2/96/3004 13 . System

7 10-Oct-2017 End Date 3/29/2004 7.00:00 PM 3/29/2004 12.00:00 AM Modified
Administrator
Systs

7 10-Oct-2017 Status Completed In Progress ystem Modified
Administrator

= T - 21137 PR A [ RS s System

7 10-Oct-2017 Start Date 3/12/2004 7:00:00 PM 3/12/2004 12:00:00 AM Modified
Administrator

Show |15 ~ | rows per page Displaying page Zofl

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator

you can also click on the “Admin View” button to revert any unwanted changes.

7.3. Build Details

When you click on a build entry in the build list, you are taken to the build details page illustrated below:
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= Build
£ Iteration 003 .
#) Build 0015 Description
bl Status: Succeeded
o d 0013
& 8wl 0013 Creation Date

# Build 0012

Last Updated

Associations Revisions Incidents Test Runs

Artifact Name Creator Comment Artifact Type D

ed in th. Fred Bloggs  This implements the deletion screen fixes Requirement RQI0
Fred Bloggs Task TKIQ

This page is made up of three areas; the left pane is the navigation window, the upper part of the right
pane contains the build detailed information itself, and the bottom part of the right pane displays different
information associated with the build.

The navigation pane consists of a link that will take you back to the build list, as well as a list of the other
builds that belong to the same release/iteration as the current one. The top part of the right pane allows
you to view the details of the build including a detailed description of why it succeeded or failed. Since
builds are populated from an external Continuous Integration server the build information will always be
read-only inside the SpiraTeam user interface.

The lower part of the right pane contains tabs that can display different information associated with the
build. Each of the tabs — “Associations”, “Incidents”, “Revisions”, and “Test Runs” - is described
separately below.

7.3.1. Associations

This tab displays a list of SpiraTeam artifacts that have been associated with any of the source code
revisions (see section 7.4.3 below) that were included in the current build:

Associations Revisions Incidents Test Runs
Date Artifact Name Creator Comment
26-Jul-2008 ) Ability to complete
6-May-2005 % Create book object delete all m

Artifact Type D

oks stored in th Fred Bloggs  This implements the deletion screen fixes Requirement RQIO

od Fred Bloggs Task TK19
7.3.2. Revisions

This tab displays a list of the source code revisions that were included in the current build. The grid can
be sorted and filtered by using the appropriate controls:
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Associations Revisions Incidents Test Runs
Refresh Apply Filter Clear Filter
v Revision & Author summary

The artifact was changed in this version to fix the issue with the

Fred Bloggs

£ revoais

Show | 15

data access component

W | [OWS pEr page

7.3.3. Incidents

Commit Date Content a Properties a
B - any v — Any W
5-Dec-2017 Yes No
Displaying page = of1

This tab displays the list of incidents that have been fixed in the current build. The grid can be sorted and

filtered by using the appropriate controls:

Associations Ravisions Incidents Test Runs

Refresh Apply Filter  Clear Filter —- Show/hide columns - |~

Displaying 1 - 2 out of 2 incident(s) in the current build. Filtering results by Build. | Clear Filters

¥ % Name Type Status Detected By
—Any — W — Ay — W —Any — W

M System may require process changes Issue Duplicate Fred Bloggs

B User expectations from old client app Training Open Fred Bloggs

Show | 15 | rows per page

7.3.4. Test Runs

Owner Progress ID & Edit

— Any — | w — Any — | w IN Edit
IN:37 Edit
IN:38 Edit

Displaying page

This tab displays a list of all the tests that have been executed against the current build. The grid can be

sorted and filtered by using the appropriate controls:

Associations Revisions Incidents Test Runs

Refresh Apply Filter | Clear Filter —- Show/hide columns -- |

Clear Filters

Displaying 1 - 0 out of O test run(s) in the current build. Filtering results by Build

¥ % Name End Date &% Type Tester Release

[==) - ANy — | W - ANy — | W

Show | 15 W | rows per page
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8. Task Tracking

This section outlines how you can use the Task Tracking features of SpiraPlan® and SpiraTeam® to view
and manage the discrete activities that each member of the development team would need to carry out
for the requirement to be fulfilled. Each task can be assigned to an individual user as well as associated
with a particular release or iteration. The system can then be used by the project manager to track the

completion of the different tasks to determine if the project is on schedule.

The tasks can be organized into different folders as well as categorized by different types (development,
testing, infrastructure, etc.), each of which can have its own workflow which defines the process by which

the task changes status during the project lifecycle.

8.1. Task List

When you click on the Tracking > Tasks global navigation link, you will initially be taken to the tasks list

screen illustrated below:

@ + Olibrary Information System Planning ~  Testing ~ | Tracking = | Reporting . System Administrator

Incidents / Tasks / Resources / Source Code
ars O

Folders & -] + New Task | X Delete ||  Refresh || T Filter |+ | [ Clone | & Tools | v || - Show/hide columns — |«

4 = Root Displaying 1- 1 out of 1 task(s) for this project  Root

> [ Development Tasks ¥ % Name Progress Type Status Priority Owner ID & Edit
> [ Infrastructure Tasks
> [0 Oversight

Edit | Add

Quick Filter ]

Infrastructure Not Started 4 - Low Joe P Smith TR 43 Edit

& High Priority Late Tasks show | 15 v | rows per page Displaying page Tofl
Components
& Administration

& Author Management

& Book Management

The task list screen displays all the tasks entered for the current project by folder, in a filterable, sortable
grid. The grid displays the task number together with fields such as priority, name, assigned owner, start
date, end date, scheduled release, etc. The choice of columns displayed is configurable per-user, per-

project, giving extensive flexibility when it comes to viewing and searching tasks.

In addition, you can view a more detailed description of the task by positioning the mouse pointer over
the task name hyperlink and waiting for the popup “tooltip” to appear. If you click on the task name
hyperlink, you will be taken to the task details page described in section 8.2. Clicking on any of the
pagination links at the bottom of the page will advance you to the next set of tasks in the list according to
the applied filter and sort-order. There is also a drop-down-list at the bottom of the page which allows you
to specify how many rows should be displayed in each page, helping accommodate different user

preferences.
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One special column that is unique to tasks is the ‘progress indicator’. This illustrates graphically both the
percentage completion of the task and also if the task is either starting late or finishing late. The following

table illustrates the different type of status that can be conveyed by the indicator:
Indicator Display Progress Description

Task has not yet started, but the scheduled start date is still in

the future.

Task has not yet started, and the start date has elapsed. This

is considered a ‘Late Starting Task’

Task has started, and is approximately 25% complete. The

scheduled end date is still in the future.

Task has started, and is approximately 50% complete.
However the scheduled end date has elapsed already. This is

a considered a ‘Late Finishing Task’.

Task has been 100% completed.

Essentially, the gray section of the bar indicates the % of the task yet to be completed, and the green/red
section of the bar indicates the % of the task that has already been completed. If the bar changes from
green to red it means that the end date has been reached and the task is not yet complete, and if the
background changes from gray to yellow it means that the task has not yet started, but the scheduled

start date has passed.

8.1.1. Task Folders

SpiraTeam lets you group project tasks into different folders to make organization easier. In the left-hand

Quick Filters panel, the system displays the various task folders defined in the project:

© Copyright 2006-2017, Inflectra Corporation Page 208 of 312 This document contains Inflectra proprietary information




Folders o> =

4 = Root
4 & Development Tasks
3 Back-End Developmel

[ Front-End Developme

[ Infrastructure Tasks
(3 Oversight

Edit Add

If you are a project administrator, you will see the ‘Edit’ and ‘Add’ buttons beneath the folder tree, this lets

you add, edit and delete task folders in the project. To add a new folder, click the ‘Add’ button:

Add Folder

Please choose the parent Folder to add this under:

- MNone - W

Please enter the name for this new Folder:

Choose the parent folder that you want to add the new folder under (or None if you are adding a new top-
level folder) from the dropdown list and then enter the name of the new folder. Then click ‘Add’ to save
the new folder.

To edit or delete an existing folder, simply click the “Edit” button to switch the folder tree to edit mode. To
edit or delete a specific folder, click on the “Edit” button next to the folder:
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Edit Folder

Please choose the parent of this Folder:

Development Tasks W

Please edit the name of this Folder:

Front-End Development

Delete Cancel

You can change the parent folder and/or name of the folder and click “Update” to commit the change or

click “Delete” to delete the folder entirely.

To move a task / tasks between folders, click and drag the relevant task/tasks from the table on the right,
and drag them over the desired folder in the tree view on the left. The destination folder will be highlighted

to show where the task will be placed.

8.1.2. Sorting and Filtering

You can easily filter and sort the list of tasks as illustrated in the screen-shot below:

+ New Task = % Delete < Refresh Y Filter W ) Clone % Tools » - Show/hide columns — | s

Displaying 1 - 2 out of 2 task(s) for this project  Front-End Development  Filtering results by Progress.| Clear Filters
v @ Name oYW Progress Type AW Status AW Priority AW Owner AW Release W IDAY Edit
Running La| v ~Any- |V ~Any- v ~Any- v ~Any- |V ~Any - | v [ Edit
¥ Develop new edition entry screen Development In Progress 1- Critical Fred Blogzs TK:21 Edit
"J & Development In Progress Amy E Cribbins 1200 TK:44 Edit

Show 15 W |rows per page 4 4 Displayingpage 1 Taoflpp

To filter the list by progress, status, priority, owner or release, you simply choose an item from the
appropriate drop-down list, and for the other fields, you enter a free-text phrase and click “Filter” or press
the <ENTER> key to apply. Note that the name field is searched using a “LIKE” comparison, so that
searching for “database” would include any item with the word database in the name. The other freetext

fields need to be exact matches (e.g. dates, task numbers).

To change the column that is sorted, or to change the direction of the current sort, simply click on the
up/down arrow icon in the appropriate column. The currently sorted column is indicated by the darker
arrow. In the screen-shot above, we have filtered on tasks that are finishing late, sorted in order of

decreasing priority.
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Clicking on Filter > Clear Filter removes any set filters and expands the task list to display all tasks for the
current project, and clicking on Filter > Save Filter allows you to save the filter to your ‘My Page’ for use in

the future. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

As a shortcut, the left hand panel includes a set of Quick Filters that can be applied in a single-click:

e The topmost section displays any saved filters created by the current user or that are shared
with the current user (the former are designated with an icon representing a single person, the
latter a group of people)

e Components — This section lists the components defined for the current project. Clicking on any
of the components in the list will filter the tasks to only show those that belong to the selected
component. Tasks are linked to components indirectly through their associated requirement.

e Releases — This section lists the releases and iterations defined for the current project. Clicking

on any of the releases or iterations in the list will filter the requirements by that release/iteration.

8.1.3. New Task

Clicking on the “New Task” button creates a new task in the grid with an initial set of information. You can

click on the name of the task to edit its information.

8.1.4. Delete

Clicking on the “Delete” button deletes the tasks whose check-boxes have been selected in the task list.

8.1.5. Refresh

Clicking on the “Refresh” button simply reloads the list of tasks; this is useful when new tasks are being

added by other users, and you want to make sure you have the most up-to-date list displayed.

8.1.6. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the task list as columns for the
current project. To show a column that is not already displayed, simply select that column from the list of
“Show...” column names and to hide an existing column, simply select that column from the list of
“Hide...” column names. This is stored on a per-project basis, so you can have different display settings
for each project that you are a member of. The fields can be any of the built-in fields or any of the custom

properties set up by the project owner.

8.1.7. Edit

Each task in the list has an “Edit” button display in its right-most column. When you click this button or
just click on any of the cells in the row, you change the item from “View” mode to “Edit” mode. The various

columns are made editable, and “Save” “Cancel” buttons are displayed in the last column:
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+ NewTask X Delete < Refresh Y Filter |~ [ Clone | # Tools v --Show/hide columns— |~
Displaying 1 - 15 out of 15 task(s) for this project ~ Front-End Development

v % Name 4¥ Progress Type AW Status 4 W Priority 4'W Owner 4'¥ Release 4'W IDAY Edit

- Any -- v - Any - v - Any - v - Any - e - Any - v -~ Any — ~ TK Edit

¥4 Develop new book entry screen Development Completed 1-Critical Fred Bloggs TK:1 Edit
¥ Develop edit book details scre & Developme iE Completed v B | 1-Critical v §& FredBlogz: v B = Cancel
ar tor book screen to incluc Completed 1-Critical | v Joe P Smith v

TK:10 Edit

Develop book-subiect association screen Development Completed 1-Critical Fred Bloges

L8

If you click “Edit” on more than one row, the “Save” and “Cancel” buttons are only displayed on the first

row, and you can make changes to all the editable rows and then update the changes by clicking the one
“Save” button. Also, if you want to make the same change to multiple rows (e.g. to change five tasks from
“Not Started” status to “In Progress”), you can click on the “fill” icon to the right of the editable item, which

will propagate the new value to all editable items in the same column.

If you want to edit lots of items, first select their checkboxes and then click the “Edit” button on the same

row as the Filters and it will switch all the selected items into edit mode.

When you have made your updates, you can either click “Save” to commit the changes, or “Cancel” to
revert back to the original information. Alternatively, pressing the <ENTER> key will commit the changes

and pressing the <ESCAPE> key will cancel the changes.

8.1.8. Duplicating Tasks

To create a clone of a task or set of tasks, select the check-boxes of the tasks you want to clone and then
click “Clone”. This will make a clone of the current task in the current folder with its name prefixed ‘Copy
of ...." to distinguish itself from the original. Any file attachments will also be copied along with the task

itself.

8.1.9. Exporting Tasks to Another Project

To export a task or set of tasks from the current project to another project in the system, select the check-
boxes of the task(s) you want to export and then click Tools > Export to Project. This will bring up a list of

possible destination projects:
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R in s . i - C o e

Export Items

Please select the project you want to export to:

i - Select Project --—- v

£ | ——Select Project -
Sample Application One
Sample Application Two Cancel

Once you have chosen the destination project and clicked the “Export” button, the tasks will be exported
from the current project to the destination project. Any file attachments will also be copied to the

destination project along with the tasks.

8.1.10. Printing and Saving Items

To quickly print a single task or list of tasks you can select the items’ checkboxes and then click Tools >
Print Items. This will display a popup window containing a printable version of the selected items. You can

also save the report in a variety of common formats from the same Tools menu.

8.2. Task Details

When you click on a task item in the lists displayed on either the main task list page or on the requirement

/ release details pages, you are taken to the task details page illustrated below:

Folders & e B clone | & Refresh | % Delete || # Tools | B3 Email | 17 Subscribe | v
4 B Root
‘5 et e Refactor book details screen to include edition drop-down
Back-End Developmer

4 = Front-End Developme . .
P k=] Status:” Completed Operations~

Overview Associations Attachments History

Display: Current Filter| v | &

Priority 1- Critical
a Develop new book entry sc (10/18/2004 - 10/22/2004) Type: Development

#) Develop edit book details s
Requirement: Start Date: 10/18/2004

@] Refactor book screen to in

5 Fre End Date: 10/13/2004
73 Develop book-subject asso. Creator. red Bloggs

9 Refactor book details scree
3 Refactor book details screen t. Reviewer ——- Please Select -, Est. Effort (h) 300

o Difficulty --- Please Select --—-
#] Add ‘delete all' button to b v Actual Effort (h} 283

73 Develop new edition entry Remaining Effort (h)*  0.00
@) Develop edit

ithor details
& Refactor author screen to i
2 Ref;

& Develop author-subject ass

actor author details pag Description

73 Develop new subject entry

#) Develop edit subject detai
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This page is made up of three areas;
1. the left pane displays the tasks list navigation;

2. theright pane’s header, which displays: the operations toolbar; the editable name of the selected
task; and the info bar (with a shaded background), which also contains the workflow status
transitions (see below); and

3. theright pane’s tabbed interface with rich information related to the task.

Please note that on smaller screen sizes the navigation pane is not displayed. While the navigation pane
has a link to take you back to the tasks list, on mobile devices a ‘back’ button is shown on the left of the

operations toolbar.

The navigation pane can be collapsed by clicking on the “-* button, or expanded by clicking anywhere on
the gray title area. On desktops the user can also control the exact width of the navigation pane by
dragging and dropping a red handle that appears on hovering at the rightmost edge of the navigation

pane.

The navigation pane consists of a link that will take you back to the task list, as well as a list of tasks, and
another list of the other related tasks, nested under their parent task. This latter list is useful as a
navigation shortcut; you can quickly view the peer tasks by clicking on the navigation links without having
to first return to the tasks list pages. The navigation list can be switched between five different modes:

e Current Filter - The list of tasks matching the current filter organized by task folder

o All ltems - The list of all tasks, irrespective of the current filter, organized by task folder

e Assigned - The list of tasks assigned to the current user grouped by their parent requirement

o For Release - The list of tasks assigned to the current release or iteration, grouped under that

parent release/iteration.
e For Requirement — The list of tasks associated to the same requirement as the current task as

well as other tasks at the same level in the requirement hierarchy.

On the main right hand side of the page, which of the fields for the currently selected task are available
and which are required will depend on your stage in the task workflow. For example, a completed task
might not require a “Release” whereas an In Progress task could well do. The types of change allowed
and the fields that are enabled/visible/required will depend on how your project administrator has set up
the system for you. Administrators should refer to the SpiraTeam Administration Guide for details on

configuring the task workflows to better meet their needs.

Depending on the user’s role and whether they are listed as the owner or author of the task, displayed in
the info bar beneath the task name is the current workflow status and an “operations” button which, when

clicked, will show a set of allowed workflow operations:
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b | Status:” In Progress Operations~

Block Task
Oversiew Associations Attachments
Complete Task
Defer Task
Release / Iteration: 10.0.0 - Library 5. 4 - Low
Rectart Pevelopment
(2/20/2004 - 3/1/2004) oAl DEvelopment

nfrastructure
These workflow transitions allow the user to move the item from one status to another. For example when
the task is in the In Progress status, you will be given the options to:

» Block Task — changes status to “Blocked”

» Complete Task — changes the status to “Completed”

» Defer Task — changes the status to “Deferred”

» Restart Development — changes the status to “Not Started”

Please note that if digital signatures have been enabled for a particular workflow operation (and therefore
a digital signature is required to confirm the status change. Workflow operations requiring a digital
signature are marked with a padlock icon as in the example below:
COperations«
Block Task &
Complete Task

Defer Task

i Restart Development

On attempting to save changes made after clicking a workflow operation that requires a digital signature

you will be presented with a popup similar to the one below (which is for a requirement):
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Enter Electronic Signature

Please enter your login/password together with the meaning and click Sign:

LOSin:. :[t'lll'lli;"_!’.'-

Password:"

Changing Requirement RQ:4 from 'Developed’ to ‘In Progress'
Meaning:”

Cancel

Once you’ve made the changes to the appropriate task fields, you can either click “Save” or one of the
options from the “Save” dropdown to commit the changes, or “Refresh” to discard the changes and
reload the task from the database. In addition you can print or export the current task to a number of
common formats via the Tools menu.

To send the task to a colleague click the email button:

F
Email this artifact to
* Project User: Amy E Cribbins 2%
Select 3 user in the project to send to.
Email Addresses:
A list of email addresses, separated by ;
Message Subject:
Leave blank for default.
m Cancel
e

You can specify the subject line for the email, and either a list of email addresses, separated by

semicolons, or an existing project user .The content of the email is specified in the System Administration
— Notification Templates.

The lower part of the right pane can be in one of four possible tabs that can be selected: “Overview
Properties”, “Attachments”, “History” and “Associations”. Each of the different views is described
separately below.
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8.2.1. Overview — Details

The Overview tab is divided into a number of different sections. Each of these can be collapsed or
expanded by clicking on the title of that section. It displays the description, fields and comments
associated with the task.

The top part of this tab displays the various standard fields and custom properties associated with the
task. Fields (both standard and custom) are grouped under the collapsible headings (marked by orange
text and underline) in the screenshot below. For instance, all fields regarding dates are grouped together
in the “Dates and Times” area.

Overview Associations Attachments History

Release / Iteration: 1.0.0.0 - Library S Priority: 4 - Low
Type: nfrastructure
Requirement: Change Start Date 2/29/2004
Creator: Joa P Smith End Date’ 31172004
Owner: Joe P Smith Difficulty -—- Please Select -—-
Reviewer --- Please Selact - Est. Effort (h)’ 200
Actual Effort (h):
Remaining Effort (h} 300

Description:

8.2.1.1. Effort Fields

You can enter/edit the start-date, end-date (i.e. the due-date), estimated, actual and remaining effort.

From this the system will calculate the progress, percentage complete and projected final effort.

The different effort values mean the following:

>» Estimated Effort — This is the original estimate for how long the task would take to complete.

» Actual Effort — This is the current amount of effort that has been expended in completing the
task. This does not indicate the completion progress

>» Remaining Effort — This is the estimate for how it will take from the current state to complete the
task. The % complete is calculated from this value in conjunction with the estimated effort:
% Complete = 100% - (Remaining Effort / Estimated Effort)

>» Projected Effort — This is value that the system is projecting it will take to complete the task. This
is calculated from the Actual Effort and Remaining Effort:
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Projected Effort = (Actual Effort + Remaining Effort)
Note: If the actual effort is not specified, the projected effort will be the same as the estimated effort.

Note: if the task is currently assigned to a release or iteration, the start-date and end-date of the task
must lie within the date-range of the parent release/iteration. If your task looks like it will not be completed
in the available timeframe, you will need to contact the project manager to get them to either extend the

date-range of the task, or consider moving the task to the next iteration.

8.2.1.2. Followers

Using the “Subscribe” button on the toolbar, you can quickly follow the item, and receive updates on
certain changes to it. Depending on your role, you may also see a dropdown to this button, which let's

you add another project member as a follower to this item.

77 Subscribe |

<l
m
3
[

& ~Add Follower

Add Follower

Select a user in the project to follow this artifact

Amy E Cribbins A

Cancel

You can also quickly see who is following an incident under the “People” section in the Overview tab.

Followers (2)
T e
i

To view information about the follower, or to unfollow them from the item, hover over their avatar to

display a user profile card.
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Amy E

Cribbins Remove
follower

8.2.2. Overview — Comments

The comments tab will display the comments associated with the task:

Displaying =~ newest first | oldest first

Format - Font - sz - B I U I, A-R@- !

[
i
8
3]
.
=H
1]

@ 22| [ Source

All existing comments are displayed in date entered underneath the textbox. To enter a new comment,
enter the text into the textbox, and then click the “Add Comment” button.

8.2.3. Attachments

This tab displays the list of documents that have been “attached” to the task. The documents can be in

any format, though SpiraTeam® will only display the icon for certain known types.

Overview Associations Attachments History
+ Add New % Add Existing & Refresh -- Show/hide columns —— | & T Filter |

Displaying 1 - 0 out of 0 attachment(s)

¥ Filename Type size Edited By Edited On &% Author D Edit
- Any — | W ) — ANy — | v =] — ANy — | v DC Edit
Show | 15 “ | rows per page Displaying page | 1 oo

The attachment list includes the filename that was originally uploaded together with the file-size (in KB),
name of the person who attached it and the date uploaded. In addition, if you position the pointer over the

filename and hold it there for a few seconds, a detailed description is displayed as a tooltip.
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To actually view the document, simply click on the filename hyperlink and a new web browser window wiill
open. Depending on the type of file, this window will either display the document or prompt you for a
place to save it on your local computer. To remove an existing attachment from a task, click the

“Remove” button and the attachment will be removed from the list.

To attach a new document or web link to the task, you need to click the “Add New” button to open the

“Add Attachment” dialog box. There are three different types of item that can be attached to a task:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”

to attach the image.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

You can also associate an existing document (that's already stored in SpiraTeam) with the task. To do
that, click the “Add Existing” button to bring up the add file association dialog box. You can then choose
to either associate a document stored in the SpiraTeam Documents repository or (in the case of
SpiraPlan/SpiraTeam but not SpiraTest) from the linked source code repository. In either case you first
select the appropriate folder, and then pick the document(s) from the file list on the right. In the case of a

source code file association you can also add a comment.

8.2.4. History

This tab displays the list of changes that have been performed on the task since its creation. An example

task change history is depicted below:
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http://mywebsite.com/?Document=1

Qverview Associations Attachments History
i Refresh | T Filter | & &% Admin View

Displaying 1 - 0 out of O change(s).
Change ID Change Date #¥  Field Name old value New Value Changed By Change Type
=] - Any - | W - Any - | v

Show | 15 W | rows per page Displaying page Zoaof1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator

you can also click on the “Admin View” hyperlink to revert any unwanted changes.

8.2.5. Associations

In this mode, the main pane displays a list of any incidents, source code revisions or other tasks that are

associated with this task:

Overview Associations Attachments History
Add %X Remove | & Refresh Y Filter | w

Displaying 1 - 2 out of 2 association(s).

v Type Artifact Type Name Status Creation Date #¥ Creator Comment Project Name D Edit
—Any — W |- Any — | W B - Any - W — Any — | W Edit
= Need to refactor the Library
Related-to Incident :9 30-Jun-2010 Joe P Smith screen before fixing the Infarmation [in:1] Edit
- bug System
Need to create the screen Library
Depends-on Task 30-Apr-2010 Joe P Smith e U7 Information [Tk-4] Edit
before refactoring -
System
Show | 15 “ | rows per page Displaying page 1 = ofl

Each association is displayed with the type of association (related-to, vs. a dependency), name of the
artifact being linked-to, type of artifact (task, incident, etc.), the name of the person who created the

association, and a comment that describes why the association was made.

You can perform the following actions:
>» Remove — removes the selected association to the other artifact. This will only delete the
association, not the linked artifact itself.
> Refresh — updates the list of associations from the server, useful if other people are adding
associations to this task at the same time.
> Apply Filter — Applies the entries in the filter boxes to the list of associations

» Clear Filters — Clears the current filter, so that all associations for the current task are shown.

» Edit — Clicking the “Edit” button to the right of the associations allows you to edit the association

type and comment fields inline directly on this screen.
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To create a new association, click the “Add” button to display the add association panel:

Select Artifact Type ~ Filter by nam earchby ID (e.g 1) Q search

Cancel

If you know the ID of the item you want to associate, you can enter its ID prefixed by the appropriate

token (“TK” for task or “IN” for incident):

Select Artifact Type v IN® Q Search
+ ID Name Project
O IN:9 R_] Editing the date on an author is clunky Library Information System

Type: Related-to ~

Comment:

Cancel

Otherwise you should choose the Artifact Type. You can narrow down your search by entering a keyword.

Task = Back-End Development Q, Search
v D All Folders Project
K28 o S =tian S
TK:28 ~ Development Tasks iethod Library Information System
TK:25 Back-End Development nethod Library Information System
TK:35 Front-End Development g delete method Library Information System
TK:34 ¥ Infrastructure Tasks g insert method Library Information System
TK:36 Application g queries Library Information System
TKA9 Database methad Library Information System
Oversight _
TK8 _ thod Library Information System
TK:2 # Create book object insert method Library Information System =

Type:. Related-to~

Comment:

Cancel

Once you have a list of artifacts, you should select the checkboxes of the items you want to associate

with the current task and click the ‘Save’ button.

You can add a comment that explains the rationale for the association and choose the type of association
being created:

o Related-to: this is used to specify that the two artifacts are simply related

Depends-on: this is used to specify that the current artifact has a dependency on the one being linked to.
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9. Resource Tracking

This section outlines how you can use the Resource Tracking features of SpiraPlan® and SpiraTeam® to
view the total workload for each of the project personnel resources assigned to a specific project. This
allows you to verify that the work is evenly distributed amongst the project members and that no individual

resource is overloaded.

When you click Tracking > Resources on the global navigation bar, you will initially be taken to the project

resources list screen illustrated below:

@ ~ OlLibrary Information System Planning v  Testing ~ | Tracking * = Reporting . System Administrator

Incidents / Tasks / Resources / Source Code

£ Refrash | TFilter &

Displaying 1 - 12 out of 12 resources in the current project / group. ~— Library Information Syst v | 9

¥ Resource Name & Role Allocation Available Effort Req / Task Effort Incident Effort Total Effort Remaining Effort [}

- Any - | v - Any - | v =] =) =i ] ] us
Incident User ooh 0oh och us13
Developer 0oh 0oh och usa
Tester ooh ooh och Usé
Manager 1361h nsh 147.6h u
Tester 0oh 0oh och u
Developer ooh 0oh och u
Observer 1373h 145h 1522h uUs3
Tester ooh ooh och Usio
Developer ooh 0oh o0ch uss
Developer 0oh 0oh och usa
Tester 0oh ooh och Uss
Project Owner 0.0h 0.0h 0.0h usa

Displaying page o

This screen lists all the personnel (project resources) that belong to the current project together with the
total value of the projected effort of all the work assigned to them, the available effort based on the length
of the current release/iteration, and the remaining effort (the difference between the previous two values).

The effort is shown for tasks and incidents as well as a total of the two together.

Using the dropdown on the far right, you can display the workload:
e For the project as a whole (as above).
e For a specific release (including all child iterations)
e For a specific iteration
You can also display the workload for the entire program by selecting the program from the

project/program selector from the navigation bar

There is a colored progress bar column called “Allocation” that graphically illustrates the % of the person’s
available effort that has been scheduled. If a person is over-scheduled, this bar will turn red. In addition, if
any project resources have been assigned more work that they have time to complete during the length of
the release/iteration, the background color of the remaining effort value will be also be colored in red,

indicating that you need to offload some of the work to other project resources.
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Clicking on a resource name will take you to the Resource Details page.

9.1 Resource Details

The resource details page will show you what artifacts a resource has been assigned, and time values for
the items. A small panel on the left will show current configured values for the project for # of hours per

workday, # of days per week, and how many non-work hours per month there are.

To Resource List ]

Al’ﬁy E Cribbins Resource Detall

Name:

Display: Current Filter| v | &

& Amy Cribbins

User Logo
&, Bernard Tyler
&, Donna Harkness
&, Fred Bloggs

& Henry Cooper

& Jack Van Stanten

& Joe smith

& Martha Noble oroiect Role

& Ricky Pond
& Rory Jones Current Project Planning Settings

& Rose smith Hours / Day: 8
= 5

& system Administrator Bl
Non-work Hours / o

Month,

(O Send Message = Add Contact

There are two options related to the instant messenger beneath the user’s avatar. When you click the
“Send Message” button it will open up a new instant message window to start a conversation with the
selected resource. If the resource is not a contact of the current user, clicking the “Add Contact” button
adds the selected resource to the user’s ‘My Contacts’ list on the ‘My Page’ dashboard. Similarly if the
resource is already a contact of the current user, clicking ‘Remove Contact’ will remove the resource as a

contact.

Tabs along the bottom will show assigned requirements and tasks, incidents, test cases, test sets and
recent actions. The views for each item are a subset of available columns, to show progress and
completion information for all items listed. Clicking on an artifact's name will take you to the artifact details
page. The data in all of these tabs can be filtered by all releases, by a release and its children, or by a

specific iteration.

9.1.1. Regs & Tasks

This tab displays the list of requirements and child tasks that are assigned to the current resource:
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Display data for:

--- All Releases -— v P

Reqs & Tasks Incidents Test Cases

2 Refresh | T Filter | & —- Show Level -—

v % Requirement/Task Name

[m] b & Ability to delete existing books in the system

& & Ability to completely erase all books stored in the
system with one click

] b & Abilit

to create different editions

Abilit

to edit existing authors in the system

Abilit

to delete existing authors in the system

Abilit

to link authors to their contact information

Abilit

to import from legac

system x

9.1.2. Incidents

Test Sets

Actions

+ | Displaying 17 out of 8 1tem(s).

Importance

— Any —

Progress

W - ANy - | W

No Tasks

Owner Est. Effort
- ANy - | W

Fred Bloggs 16.0h
Fred Bloggs 10.0h
Fred Bloggs 16.0h
Fred Bloggs 16.0h
Fred Bloggs 14.0h
Fred Bloggs 0.0h
Fred Bloggs

This tab displays the list of incidents that are assigned to the current resource:

Display data for:

—— All Releases — v >

Reqs & Tasks Incidents Test Cases

Name D

B Ability to associate multiple suthors [IN:000021]
B Test System Limitation [IN:000046]
B Test Training Item [IN:000040]
B Editing the date an a book is clunk; [IN:000008]
B Test Training Item [IN:000041]
B Test Change Request [IN:0000s3]
B Ability to import data from excel [In:000023]
B Test System Limitation [IN:0c0D48]
B Sample Risk 3 [IN:000061]

9.1.3. Test Cases

This tab displays the list of test cases that are assigned to the current resource:

Display data for:

--- All Releases ——- v P
Reqs & Tasks

Incidents

Name

& Ability to create new book

=

Ability to edit existing book

9.1.4. Test Sets

Test Cases

D

Test Sets

Creation Date
16-Nov-2003
3-Dec-2003
2-Dec-2003
3-MNov-2003
2-Dec-2003
6-Dec-2003
24-Nov-2003
3-Dec-2003

9-Dec-2003

Test Sets

[Tc-000002]
[TC:000003]

Severity

Progress

4 - Low

2 - High

3 - Medium

Actions
Status Priority
Assigned
Assigned
Assigned -
Assigned |2 =High
Assigned |2 =High
Assigned 3 - Medium
Assigned 3 - Medium
Assigned 3 - Medium
Assigned 4 - Low

Actions

Last Executed

30-Nov-2003

30-MNov-2003

4 - Low

Execution Status
Passed

Caution

Actual Effort  Projected Effort Edit
= B | | Edit
15.2h 0.0h Edit
95h 0.0h Edit
10.3h 75h Edit
0.0h 16.0h Edit
32h 10.8h Edit
0.0h 0.0h Edit
Edit
Est. Effort  Projected Effort
03 04
07 o8
05 05
04 04
07 o7
05 05
05 05
13 15
07 09
Priority Est. Dur.

This tab displays the list of test sets that are assigned to the current resource:
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Display data for:

-—- All Releases ——- 3>
Reqs & Tasks Incidents Test Cases Test Sets Actions
D Status Planned Date Execution Status Last Executed Est. Dur Act. Dur.
[Tx:000006] Deferred - - h h
[Tx.000003] Completed - - 03h h
[Tx:000005] In Progress 9-Feb-2007 - 03h h

9.1.5. Actions

This tab displays the list of recent actions make by the user in the project. It lets you quickly see all the

changes they have made:

Reqs & Tasks Incidents Test Cases Test Sets Actions
£ Refresh | Y Filter | & Displaying 1- 8 out of 8 items

¥ Change Date &7 Project Artifact Type Artifact Name Artifact ID Change Type

m — ANy — | W — Any — | W =) — Any — | v

2-May-2006 Library Information System [PRi] Incident Cannot add a new book to the system [IN:7] Modified
2-May-2006 Library Information System [PRi] Requirement &) Ability to add new ks to the system [RQ:4] Modified
2-May-2006 Library Information System [PRi] Test Step er_cli nk to author [15:31 Modified
2-May-2006 Library Information System [PRi] Release [RL] Modified
2-May-2006 Library Information System [PR:1] Test Case [1c2l Modified
5-Mar-2005 Library Information System [PRi] Incident [IN:71 Modified
5-Mar-2005 Library Information System [PRi] Incident [IN:6] Modified
4-Mar-2005 Library Information System [PR:1] Incident [IN:B] Modified

Show | 15 ~ | [ows per page Displaying page | 1 —ofl

This can be useful when auditing the changes made by a specific user.
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10. Document Management

This section outlines the document management features of SpiraTeam® that can be used to upload,
manage and share documents between the different members of the project. This module includes
support for uploading files and URLSs, versioning of documents, the ability to organize into folders and

categorize and search using meta-tags.

In addition the document management features are fully integrated into the rest of the system, so that
documents attached to other artifacts (e.g. requirements, test cases, etc.) are automatically connected to

the project documentation repository.

10.1. Document List

When you click Project Home > Documents on the global navigation bar, you will initially be taken to the

project documents list screen illustrated below:

@ ~  Olibrary Information System w Planning ~ | Testing ~  Tracking ~  Reporting .Syslem Administrator v

Requirements / Planning Board / Releases / Documents

lers o " . .
iz s L] + Add Document || €2 Refresh || items in Current Folder v  YrFiter & || ##Tools | v || - Show/hide columns — | v

4 B> Root Folder Displaying 1 - 5 out of 5 document(s) in the current folder  Design Documents

4 B> CreateNewAuthor ¥ Filename Type Size Edited By Edited On ¥ Author D Edit
g eateNewBook 3
O Createnzwgook —any —| v B |—ay—|v E —any—| v | |bc Edit
4 [= Design Documents
ML Diagra 5 K Joe P S -May-200 d Bloggs 7 dit
. [ editexistingAuthor UML Diagram 35KB joe P Smith 9-May-2006 Fred Blogg: DC: Edi
> [ EditExistingBook Sereen Layout 1009 KB Joe P Smith 30-Apr-2006 Joe P Smith DCi3 Edit
> [3 Misc Documents
; UML Diagram 43 KB Fred Bloggs 22-Apr-2006 Fred Bloggs DCa2 Edit
> [ Screen Captures
s cations Screen Layout 533 KB Fred Bloggs 1-Apr-2006 Joe P Smith oce Edit
[3 Specifications Y et P’
> [ Test Results Screen Layout 392 KB Fred Bloggs 31-Mar-2006 Joe P Smith oci Edit
> [ Test Scripts
Show | 15 ~ | rows per page Displaying page of1
Edit || Add
Tag Cloud -]
management

error functional
specification

libraries .

This screen consists of three main sections:

> The top left-hand pane displays a hierarchical list of the various folders that have been setup for
the current project. Clicking on the triangle icon will expand the child folders and clicking on the
name of the folder will display the list of documents in the folder in the main pane to the right.

» The main right-hand pane displays a list of all the documents contained within the currently
selected folder. This list can be filtered and sorted, and you can choose how many rows of
documents to display on the page at one time.

» The bottom left-hand pane contains the “Tag Cloud”. This is a list of all the tag names associated

with documents in the project. The size of the font is proportional to the number of documents
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associated with the tag. Clicking on a tag name will automatically filter the list of documents to
find items that contain the selected tag.

The main toolbar contains icons for all the operations that can be performed on the document list. You
can add documents to the current folder, delete existing documents from the project, refresh the list of
documents, export documents to another project, apply a filter, and clear the current filter. In addition
there is the option to either display just the documents in the current folder or all documents in all folders.

The latter is useful when you want to search for a specific document by keyword or tag name.

10.1.1. Add New Document

To attach a new document to the incident, you need to first click the “Add New” button to display the new
attachment dialog box:

Add New Document Add New Document Add New Document
* » *
Type ® File O URL O Screenshot Type File ®URL © Screenshot Type File ©VURL ® Screenshot
Filename:* Choose File | Mol chosen URL"
Description: Description:
4 4 Screenshot:"
o i nal Sos ion
Document Type: Functional Specification | v Document Type:* Functional Specification | v

>
Document Folder: Root Folder v Document Folder:* | Root Folder v

Description:

Document Type:” Functional Specification | v
Document Folder:* Root Folder v

Tags:

There are three different types of item that can be attached to an incident:

» To upload a file, choose “File” as the type and then click the Browse button and select the file
from your local computer, optionally enter a detailed description then click the “Upload” button.

The document will be copied from your computer and attached to the artifact.

» To attach a web-link (URL) to the artifact, you need to choose “URL” as the type and then enter

the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description and then

click the “Upload” button to attach the web-link.

» To attach a screenshot to the artifact, you need to choose “Screenshot” as the type and then
copy the image to your computer’s clipboard (e.g. on Windows computers, the PRINT SCREEN
button captures the current page and adds to the clipboard). Once the image is in the clipboard,
paste it into the editor using CTRL+V (or the equivalent keystroke for your operating system) and
the item will appear in the preview window. You can then fill in the other fields and click “Upload”
to attach the image.
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http://mywebsite.com/?Document=1

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file extensions on
filenames (e.g. .xls for an Excel sheet) automatically, then you will need to manually add the file extension

to the filename before uploading if you want it to be displayed with the correct icon in the attachment list.

10.1.2. View Document Information

When you hover the mouse pointer over any of the documents displayed in the document list, an
information panel will be displayed that contains the name, description, version, document type and meta-

tags of the document:

+ Add Document £ Refresh | ltemsin Current Folder |~ | ¥ Filter |~ || £ Tools | --Show/hidecolumns-- s
Displaying 1 - 5 out of 5 document(s) in the current folder ~ Design Documents
v Filename 4'¥ Type AW Size AW Edited By A'W EditedOn AV Author AW DAY Edit
~Any- v B Ay | v ] —Any- | v | DC Edit

1gt.0¢ R D6 Fred Blogzs DC:7 Edit
Sequence Diagram for Book Mgt.pdf

‘G'auhics Design Mockups.psd 06 Joe P Smith DC:13 Edit
(&) Use Case Diazramyvsd Filename: Sequen‘ce Diagram for Book Mgt.pdf (&' 06 Fred Bloggs DC:12 Edit
Document Type: UML Diagram
c;]j Author Management Screen Wiref  File Type: PDF 1 16 Joe P Smith DC:8 Edit
i Book Management Screen Wirefra o Se-!qulence dla‘g‘lam n UMLfO_I_mat rljat 006 Joe P Smith DC:11 Edit
Description: provides additional detail surrounding the
Show | 15 ' rowsper page book managament use-case / test case |4 4Displaying page| 1 |mof1mp
Version: 1.2
Tags:
Created By: Fred Bloggs 5/2/2006 8:00:00 PM
Edited By: Joe P Smith 5/9/2006 8:00:00 PM
ID: [DC:000007]

View Details Cancel

You can click on the document URL to actually open the document itself in a new window, click on the
meta-tag links to find related documents that contain the same meta-tag, or click on “View Details” to see
more information regarding the document, including an ability to edit its meta-information and see the
different versions of the document.

10.1.3. Edit Document Folders

If you are a project administrator, you will see the “Edit” and “Add” buttons beneath the folder tree:
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Folders =

4 = Root Folder

(D CreateNewAut
D CreateNewBoc

4 [= Design Documi
3 EditExistingAu
(3 EditExistingBot
(2 Misc Documen
3 Screen Capture
[ Specifications
(D Test Results
(3 Test Scripts

Edit Add

This lets you add, edit and delete task folders in the project. To add a new folder, click the “Add” button:

Add Folder

Please choose the parent Folder to add this under:

-- None -- W

Please enter the name for this new Folder:

Add Cancel

Choose the parent folder that you want to add the new folder under (or None if you are adding a new top-

level folder) from the dropdown list and then enter the name of the new folder. Then click ‘Add’ save the
new folder.

To edit or delete an existing folder, click the ‘Edit’ button to switch the folder tree to edit mode:
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Folders o =2

4 [= Root Folder Edit
' [3J CreateNewAuthor Edit
' (3 CreateNewBook Edit

4 [= Design Documents Edit
- [ EditExistingAuthor Edit

' [30 EditExistingBook Edit
' [3 Misc Documents Edit
- [3 Screen Captures Edit
' [0 Specifications Edit
" [ Test Results Edit
" [0 Test Scripts Edit
Done Add

To edit or delete a specific folder, click on the ‘Edit’ button next to the folder:

Edit Folder

Please choose the parent of this Folder:

Root Folder

Please edit the name of this Folder:

EditExistingAuthor

Delete Cancel

You can change the parent folder and/or name of the folder and click “Update” to commit the change or

click “Delete” to delete the folder entirely (including its contents).
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10.2. Document Details

When you click on an item in the document list described above, you are taken to the document details
page illustrated below:

% Delete T Refresh | B3 Email | v% Subscribe |«

Sequence Diagram for Book Mgt.pdf
[0 CreateNewBook
4 = Design Documents & m

= Creator Fred Bloggs File Type (Size): ] Creation Date
o Edited By: Joe P Smith Document Folder Design Documents Last Edited
Document Type: UML Diagram

L sequence Diagram for Book M

k] n Mockups..

Current Version:

Tags sequence diagram, baok

Classification: --- Please Select -—-

Pl Book Management Screen Notes

Sequence diagram in UML format that provides additional detail surrounding the book managament use-case / test case

Show | 15 v | rows Preview Versions Associations History

This page is made up of three areas;
1. the left pane displays the documents list navigation;

2. theright pane’s header, which displays: the operations toolbar; the editable name of the selected
document; and the info bar (with a shaded background), which also contains the workflow status
transitions (see below); and

3. theright pane’s tabbed interface with rich information related to the document, including, where
available, a preview of the document, the list of document versions, the list of artifacts that the
document is associated with, and history of changes made to the document).

Please note that on smaller screen sizes the navigation pane is not displayed. While the navigation pane
has a link to take you back to the documents list, on mobile devices a ‘back’ button is shown on the left of

the operations toolbar.

The navigation pane can be collapsed by clicking on the “-“ button, or expanded by clicking anywhere on
the gray title area. On desktops the user can also control the exact width of the navigation pane by
dragging and dropping a red handle that appears on hovering at the rightmost edge of the navigation
pane.

The navigation pane consists of a link that will take you back to the project document list, as well as a list

of other documents in the current folder. This latter list is useful as a navigation shortcut; you can quickly
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view the detailed information of all the peer documents by clicking on the navigation links without having
to first return to the main document list page.

Using the “Email” button on the toolbar, you can send an email containing details of the requirement to an
email address or another user on the system:

Email this artifact to
*Project User

Amy E Cribbins

Select & user in the project to send to

Email Addresses:

A list of email addresses, separated by ;

Message Subject

Leave blank for default

Cancel

You can specify the subject line for the email, and either a list of email addresses, separated by
semicolons, or an existing project user .The content of the email is specified in the System Administration
— Notification Templates.

To be notified of any changes made to the current artifact via email, click the “Subscribe” button. If you
already subscribed, the button will instead let you “Unsubscribe” to stop receiving emails about that
particular artifact. Depending on your role, you may also see a dropdown arrow to the right of this button.
This will let you subscribe others in the project to this artifact.

The top part of the main pane allows you to view and/or edit the details of the particular document. You
can edit the various fields (name, description, etc.) and once you are satisfied with them, click one of the
“Save” buttons to commit the changes. In addition, you can delete the current document by choosing

“Delete”, or discard any changes made by clicking “Refresh”.

The lower part of the main pane can be switched between four different views by clicking the appropriate
tab. Initially the pane will be in “Versions” mode. The functionality in each of these views is described
below.
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10.2.1. Preview

This tab displays a preview of the currently active version of the document. Previews are shown for a

number of file types, notably plain text or code files, and images.

Praview Versions Associations History

function TestInit()

//Input variables - allows SpiraTest to configure as parameters
//Provide backup values if not defined

if ('undefined' == typeof(g_author_age))

g_author_age = 35;

if ('undefinad' == typeof(g_author_name))

g_author_name = 'Roger Hammersmith';

E.

Tester.SstReportittribute("Browser”, g_browserlLibrary);
KillBrowser();

[/ #HAHRE Script Steps HEREHHHERHARE

function Test()
{
var author_id = 2;
Login{);
EditAuthor(author_id, g_author_name, g_author_age);
Logout();
¥

g_load_libraries=["%g_browserLibrary:Internet Explorer HTMLY"];

If a format cannot be previewed (for example a PDF or Microsoft Word document), the following message

is displayed:

Preview Versions Associations History

Preview Not Available for this File.

10.2.2. Document Versions

This view displays the list of different versions that exist for the current document. When you initially
create a new document there will be only a single version (e.g. v1.0), however as revisions are made to
the document, rather than having to create a whole new document, you can just upload the new revision

as a new version (e.g. v1.1) and it will be added to the list of versions.

Each version in the list is displayed with its name, a description of what changed in the version, the
version number assigned to the revision, the file-size, who uploaded the new version and a link to actually

open the new version:
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Preview Versions Associations History

Active Version Version Comments Size Author  Upload Date w Operations
c y o itiona S .
v Version 12 & Sequence diagram in UML format that provides additional detail surrounding the book = (D Fred 9-May-2005

managament use-case / test case Bloggs
Sequence diagram in UML format that provides additional detsil surrounding the boak Fred

) Version 1wy ) = ' =t mate s s 30 KB 4-May-2006 | Make Active || Delete
managament use-case [ test case Bloggs
5 Y " - - -

) Version 10 & Sequence diagram in UML format that provides additional detail surrounding the book AR Joe P 2-May-2006 Make Active Delete
managament use-case / test case Smith

Upload New Version

On this page, you have the option to delete an existing version, make a different version the active one
(the one that users see when they view the document list and click on the link) and upload a new revision.

To upload a new version, click on the ‘Upload New Version’ hyperlink:

Upload New Version

Filename:* Choose File |No file chosen

B r u ;=:

E = 1Y
Description:  Sequence diagram in UML format that provides additional detail surrounding the book managament use-case /

test case

Version:® « Make this the active version

Upload

In the popup dialog, you need to enter the URL / browse to the file, enter a description of the changes
made, a new version number and whether the new version should be made the active one, then click the

[Upload] button to confirm the changes.

Note: If the original document was a file (instead of a URL) then all revisions will need to be files, similarly

if the original document was a URL, all revisions will need to be URLSs.

10.2.3. Document Associations
This view displays a list of the artifacts in the current project that are associated with the current
document. If you originally uploaded the document as an attachment to a requirement, test case, etc.

then an initial association will be already listed, otherwise it will be empty.

Preview Versions Associations History
Date Artifact Name Creator Artifact Type D Operations
30-Nov-2003 &7 Ability to create new book Fred Bloggs Test Case TC2 Delste

Add Association

© Copyright 2006-2017, Inflectra Corporation Page 235 of 312 This document contains Inflectra proprietary information




From this screen you can either delete an existing artifact association or add a new association from the
current document to a pre-existing artifact in the system. To add the association, click on the “Add

Association” button at the bottom of the grid:

Add New Association

Please choose the artifact that you want to add an association to:

Artifact Type™: = Automation Host v
1

Artifact ID™:

L&

Then, you need to select the type of artifact being associated (requirement, test case, incident, etc.) and

the numeric ID of the artifact and click “Add Association” to confirm the addition.

For example to add an association to Requirement RQ00005 you would choose Artifact Type =
Requirement and Artifact ID = 5.

10.2.4. History

This tab displays the list of changes that have been performed on the document since its creation.

Preview Versions Associations History
2 Refresh | W Filter s | & Admin View

Displaying 1 - O out of O change(s).
Change ID Change Date ¥  Field Name Old Value New Value Changed By Change Type
=] - ANy - | W - Any — | w

Show | 15 W | rows per page Displaying page Zof1

The change history displays the date that each change was made, together with the fields that were
changed, the old and new values and the person who made the change. This allows a complete audit trail
to be maintained of all changes in the system. In addition, if you are logged in as a project administrator

you can also click on the “Admin View” hyperlink to revert any unwanted changes.
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11. Reports Center

This section describes the reporting features of SpiraTeam®, including an overview of each of the report
types that are available. When you click on the “Reports” tab on the global navigation bar, you will initially
be taken to the reports home page illustrated below:

@ + Olibrary Information System Planning ~  Testing v  Tracking ~ | Reporting . System Administrator

Planning / Testing / Tracking / Reporting

Library Information System repor: Cener 2@ |=

None Available Graph Name: | Incident Open Count | Filter: | -- Al - v Date Range! 10/30 - 12/10

L

103012002 1110412008 1110812008 1171412008 1171012008 1112412008 1112012008 1210412008 1210812008
1 - Critical 2 - High 3 - Medium 4-Low (None)

This page consists of three main areas:

» The top left hand pane displays a list of any reports that have either been saved by the currently
logged in user, or those reports created by other members of the project, that have been marked
(by that user) as ‘shareable’.

» The bottom left-hand main pane displays a list of the printable reports available in the system,
categorized by the artifact they primarily relate to (requirements, test cases, incidents and
releases). Clicking on any of the report hyperlinks will take you to the configuration page for the
report in question (see section 11.1 below for details).

» The right-hand pane is a dashboard that contains the set of graph widgets configured by the
current user. By default the dashboard will display: the Incident Progress Rate, Test Run
Progress Rate, Requirement Summary, Test Case Summary, Incident Aging and Task
Burndown.

In addition to the graphs displayed by default, you can click on the “Add Items” buttons to add additional
graphs to the reporting dashboard:
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Add/Remove Items

Choose which items you'd like to add:

Closed Widgets (0

v Available Widgets ’
Incident Date Range Graphs
Testing Date Range Graphs
Requirement Summary Graph
Test Case Summary Graph
Test Run Summary Graph
Test Set Summary Graph

Task Summary Graph

Incident Summary Graph
Requirement Graphs
Incident Graphs

Task Graphs
5 Addto Side Bar v Add Close 1

TEEd Ditn Deanvars Data

Each of the graphs is described in more detail in sections 11.7 — 11.9.

11.1. Reports Configuration

The configuration page for each report differs slightly, but the general format is illustrated below (please
note all sections are shown in orange text with a line beneath and are shown here in the collapsed state —

click the orange text to expand the section):

© Copyright 2006-2017, Inflectra Corporation Page 238 of 312 This document contains Inflectra proprietary information




Requirements Detailed Report

Please choose from the various options below to specify how you would like this report to appear.
You can filter the results displayed by various parameters as well as choose which elements of the report are displayed

If would like to save this report for future use, please give it a name below before clicking the [Create Report] button:

Report Mame:

| would like to share this report with other members of the project

Cancel

You can configure the reports in the following ways:

>» Report Format — This allows you to specify the display format of the report. Depending on the
specific report, they can be displayed as a web-page (HTML), downloaded as a Microsoft Word
document, downloaded as a Microsoft Excel spreadsheet or downloaded as a Microsoft Project

file. In addition there is a raw-XML format that allows you to export the underlying report data into

any external reporting system that supports XML import.

Format: Adobe Acrobat )
® HTML ]
MS-Word 2003+ Iﬂ_]
MS-Word 2007+ mi]

XML

>» Report Elements — This allows you to determine which types of information to include in the
report. This varies by report type, but includes the dependent items related to the artifact being

reported on (attachments, test steps, coverage, history, etc.)

This document contains Inflectra proprietary information
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Requirements
Details:

¢ Artifact Change History

¥ Associated Tasks

# Linked Incidents

¥ Linked Reguirements

# List of Attached Documents
# Source Code

# Test Case Coverage

» Standard Field Filters — This allows you to constrain the range of data being reported on, based
on the various fields associated with the artifact in question. These filters are typically selections

from multi-valued-dropdown lists and date-ranges.

Author: — All — v
Component: - All — v
Importance: - All - v
Owner: —— All — v
Status: — All — v
Type: - All —- v
Creation Date: &=

Last Updated: &

1D

Progress: — All — v
Test Coverage: — All — v
Name:

» Custom Property Filters — This allows you to constrain the range of data being reported on,
based on the custom fields associated with the artifact by your project administrator. These filters

can be either freetext or drop-down lists.
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URL:

Difficulty: — All — v
Classification: — All — v
Notes:

Review Date: &=

Ranking: =

Decimal: =

>» Sort Options - This option is only available for the non-hierarchical data reports (i.e. for test
cases, test sets, test runs, incidents and tasks) and allows you to specify the sort order of the
results returned in the report. For the hierarchical-data based reports the sort order is always the

order of the hierarchy.

Sort Field: --Default Sort -- N

¢ Sort Ascending

>» Report Name — If you would like to save the report configuration so that you can quickly re-run it
at a later date, you just need to enter a name for the report and indicate (by selecting the
checkbox or not) whether you want this report to be private or shared by all members of the

project.

If would like to save this report for future use, please give it 2 name below before clicking the [Create Report] button:
Report Mame:

| would like to share this report with other members of the project

Cancel

Once you have selected the format, elements and filters, clicking the “Create Report” button launches

the report in a new window. Each of the reports is described in sections 11.2 — 11.6 below:
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11.2. Requirement Reports

11.2.1. Requirements Summary Report

This report displays all of the requirements defined for the current project in the order they appear in the

requirements list. The requirement's details and coverage status are displayed in a summary list form:

= Print Report
Requirements Summary Report

Project 1: Library Information System

Req #Name Description  Priority Status
Functional In
1 System Progress

Requirements

Online Library
2 Management
System

In
Progress

Sample application that allows users to manage books, authors and lending records for a typical branch library

This report displays all of the requirements defined for the current project in the order they appear in the requirements list. The requirement’s details and coverage status are displayed in a summary list form.

Author Owner Creation Date Test Coverage Task Progress Last Modified Release # Planned Effort Task Effort Actual Effort URL

Fred
Bloggs

Fred
Bloggs

01-Dec-2003

01-Dec-2003

0 Covering.

0 Failed,
0 Passed,

0 Blocked,

0 Caution

0 Covering.

0 Failed,

0 Passed,
0 Blocked
0 Caution

42 Tasks:

60% On

Schedule,

6% Running

Late, 01-Dec-2003
4% Starting

Late,

29% Not

Started

42 Tasks:

60% On

Schedule,

6% Running

Late, 01-Dec-2003
4% Starting

Late,

29% Not

Started

145 hours 0
mins

145 hours 0
mins

190 hours 188 hours
0 mins 40 mins

190 hours 188 hours
0 mins 40 mins

11.2.2. Requirements Detailed Report

This printable report displays all of the requirements defined for the current project in the order they

appear in the requirements list. For each individual requirement, the name, priority, author, status and

coverage status are displayed, along with tables containing the list of covering test cases, linked

incidents/requirements, associated tasks, attached documents, and the change history:

Req #4 - Ability to add new books to the system

Requirement Type:

Test Coverage:

Test# Name

TC2 Ability to create new book

T8 Book management

TC13 Adding new book and auther to library

Linked Requirements

NHame
Ability to delete existing books in the system

Associated Incidents

Name
Cannot install system on Oracle 9i
Cannot add a new book to the system

Associated Tasks;

Priority: 1 - Critical

Author: Fred Bloggs

Coverage: 3 Covering, 1 Failed, 1 Passed 0 Blocked 0 Caution
Owner: Joe P Smith

Release #: 1.00.0

URL: hittp:/fwww libraries. arg

Difficulty: Moderate

Created By
Fred Bloggs

Created By
Fred Bloggs
Joe P Smith

The ability to add new books into the system. complete with ISBN, publisher and other related information

Status: Completed
Creation Date: 01-Dec-2003
Last Modified: 01-Dec-2003
Planned Effort: 15 hours 0 mins:
Task Est. Effort: 16 hours 0 mins.
Task Actual Effort: 15 hours 30 mins
Status Est. Duration
Failed 0 hours 10 mins
Passed 0 hours 4 mins
Mat Run
Comment

These two requirements are related

Comment
This bug affects the requirement
Test Run: Ability te create new book

Last Execution Date
04-Dec-2003
01-Dec-2003

Date
12-Mar-2004

Date
14-Mar-2004
04-Nov-2003

ReqId
RQE

Inc Id
IN5
N7
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11.2.3. Requirements Plan

This report displays a complete work breakdown structure of the project from a requirements perspective,
including all requirements and tasks organized by schedule:

Requirements Plan Report
This report displays a complete work breakdown structure of the project, including all requirements and tasks organized by schedule.

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

1D # Name Type Status Priority Owner Start Date End Date Release # % Complete Plan Effort Est. Effort Actual Effort
1 Functional System Requl . :;1 145 hours 0 190 hours 0 188 hours 40
rogress mins mins mins
‘ , o In 145 hours 0 190 hours 0 188 hours 40
2 Online Library Management System Requirement Progress mins mins mins
3 Book Management Requirement Completed 1 . W hours 0 %. hours 0 gﬁ. hours 0
Critical mins mins mins
) . Joe P 15 hours 0 16 hours 0 15 hours 30
4 Ability to add new books to the system Requirement  Completed | 1- Critical Smith 1.000 ming mins mins
1 Devekp new book entry screen Task Completed 1 - Critical Fred Bioggs  01-Mar-2004  02-Mar-2004  1.0.0.0.0001 &hours O mins 7 hours 20 mins

2 Create book object insert method Task jeted 1-Crtical  Fred Bloggs | 01-Ma -Mar-2004 | 1.0.0.0.0001 Shours Omins | & hours 20 mins
3 Virite book sbject insen quenies Task Complsted 1-Critcal | FredBloggs | 01-Mar-2004 | 02-Mar-2004 | 1.0.0.0.0001 % Ihours Dming | 2 hours 50 mins
. - 1
5 Ability to edit existing baoks in the system | Requirement | Completed | 1- Critical | 92¢ P 1000 f5hows0  [16houwrs0 | 16 hours 50
Smith mins mins mins
4 Develop edt book defais screen Task 1-Criical | Fred Bioggs | 03-Mar-2004  04-Mar-2004 | 1.0.0.0.0001 | 100 % Bhours Omins | 7 hours 20 mins
5 Create took object update method Task 1 = Critical Joe P Smith 03-Mar-2004 4 1.0.0.0.0001 100 % §hours O mns | & hours 0 mins
& Write book object update queries. Task Completed 1 = Critical Joe P Smith 03-Mar-2004 4 1.0.0.0.0001 100 % 3hours O mins 3 hours 30 mins
il ) i i . m 14 he 16 5
6 Ability to delete existing books in the Requirement  Completed | 1 - Critical Fred 1000 4 hours 0 6 hours 0 15 hours 10
system Bloggs mins mins mins

11.2.4. Requirements Traceability Matrix

This report displays a matrix of the requirements in the system with their list of covering test cases and

associated, mapped requirements:

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

Requirements Forward Traceability

This section displays a list of all the requirements with the associated test cases/requirements.
Req# Name Importance  Status Release # Test Traceability Requirements Traceability
RQt Functional System Requirements In Progress
RQ2 Online Library Management System In Progress
RQ3 Book Management 1 - Critical Completed
RQ4 Ability to add new books to the system 1 - Critical Completed 1.0.0.0 TC2. TCB. TC13 RQ6
RQ&5 Ability to edit existing books in the system 1 - Critical Completed 1.0.0.0 TC3.7C8 RQ7
RQE Ability to delete existing books in the system 1 - Critical Completed 1.0.0.0 TC8. TC12 RQ4
RQ7 Ability to associate books with different subjects 1 - Critical Completed 11.00 TC4, TC8 RQ5
RQ8& Ability to associate books with different authors 1 - Critical Completed 1.1.0.0 TC6. TC13
RQI Ability to associate books with different editions 1 - Critical Completed 11.00 TC4, TC8, TC12
RQ10 Ability to completely erase all books stored in the system with one click 1 - Critical Completed 1200 TC4, TC8, TC12
RQ11 Edition Management 1 - Critical In Progress
RQ12 Ability to create different editions 1 - Critical In Progress 1.0.0.0

11.3. Test Case Reports

11.3.1. Test Case Summary Report

This report displays all of the test cases defined for the current project in the order they appear in the test
case list. The test case's details and execution status are displayed in a summary grid form with the test
steps optionally displayed:
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Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

Test # Name Description Priority Test Step Test Step Description Test Step Expected Result Test Step Sample Data Status  Author Owner Est. Duration Created On Last Modified|
Functional WA Fred | Fred 01-Dec- 13-0ct-2009
Tests Bloggs | Bloggs 2003 15:07:47
Tests that
Ability to the ugar can
2 create new  create a c '[ A Failed gfd ged g;b[;ec— :gf?;:?oug
book new book in | ="'® loggs | Bloggs :
the system
Call Login to .
1 Application Hat Run
2 User clicks link to User taken to first screen Mot Run
create book in wizard
3 "U:::‘:rtsrsa;:zrs User taken to next screen  Macbeth, William Mot Run
then clicks Next in wizard Shakespeare
User chooges book's | User sees screan
4 genre and sub-genre | displaying all entered Play, Tragedy Mot Run
from list information
c User clicks submit Confirmation screen is Mot R
N button displayed ot un

11.3.2. Test Case Detailed Report

This report displays all of the test cases defined for the current project in the order they appear in the test

case list. The test case's details and execution status are displayed, along with sub-tables containing the

list of test steps, test runs, attached documents, the change history, and a list of any associated open

incidents:

Test #2 - Ability to create new book
Tests that the user can create a new book in the system

Status: Failed

Author: Fred Bloggs

Owner: Fred Bloggs

URL: hittp:fiwewnr libraryreferences.org
Test Type: Functional Test

Step Description

1 Call Legin to Application
2 User clicks link to create book
3 User enters books name and author, then clicks Next
4 User chooses book's genre and sub-genre from list
5 User clicks submit button

Test Runs:

Run# Tester Test Set

TR18  Fred Bloggs

TR1E  Joe P Smith

TR13  Fred Bloggs

TR12  Fred Bloggs

TR2 Fred Bloggs Testing Cycle for Release 1.1
TR Joe P Smith Testing Cycle for Release 1.0

Requirements Coverage:

Req #
RQ4

HName
Ability to add new bocks to the system

Open Incidents:

Priority:
Creation Data:
Last Execution:

Expected Result

User taken to first screen in wizard

User taken to next screen in wizard

User sees screen displaying all entered information

Confirmation screen is displayed

Release

Iteration 003
Iteration 002
Iteration 001

Library System Release 1
Library System Release 1 SP1
Library System Release 1

Version
1.1.0.0.0003
1.1.0.0.0002
1.1.0.0.0001
1.0.0.0
1.0.1.0
1.0.0.0

1 - Critical
01-Dec-2003
04-Dec-2003
Sample Data Last Status
Net Run
Mot Run
Macbeth, William Shakespeare Not Run
Play, Tragedy Mot Run
Not Run
Status Est. Duration Actual Duration Execution Date
Failed 2 mins 70 mins 04-Dec-2003
Passed 2 mins 70 mins 03-Dec-2003
Passed 2 ming 70 mins 02-Dec-2003
Failed 10 mins 70 mins 01-Dec-2003
Passed 10 mins 90 mins 01-Dec-2003
Failed 10 mins 75 mins 01-Dec-2003
Status Priority
Completed 1- Critical

11.3.3. Test Set Summary Report

This report displays all of the test sets defined for the current project in the order they appear in the test

set list. The test set's details and execution status are displayed in a summary list form:
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Test Set Summary Report

This report displays all of the test sets defined for the current project in the order they appear in the test set list. The test set's details and execution status are displayed in 3 summary list form

Project 1: Library Information System

Sample application that allows users to manage books, authers and lending records for a typical branch library

Test Set # Name Description Status Release Creator Owner Created On Planned Date Last Modified Last Executed # Passed # Failed # Caution # Blocked # Not Run Notes
Functional In Fred 02-Jan- ,
X8 Test Sets Progress Bloggs 2007 05-Feb-2007  13-Oct-2009 - 0 ] 0 1] 0
This tests
the
Testing functionality
™i Cyclofor | imroduced fln 1000 Fred (JoeP [02dan g cop o007 | 13.0012008  01-Dec2003 |4 2 0 0 4
Release 10 ™ release | Progress Bloggs | Smith | 2007
1.0 of the
library
system
This tests
the
Testing functionality
) Cycle for !’“mf””d ot 11.0.0 F'fd J”“.T‘ “3";"' 07Feb-2007  13-0ct2009  01Dec2003 | 3 0 0 0 6
Reloase 11 1N release Started Bloggs | Smith | 200
2.0 of the
library
system
o

11.3.4. Test Set Detailed Report

This report displays all of the test sets defined for the current project in the order they appear in the test
set list. The test set's details and execution status are displayed, along with sub-tables containing the list

of test cases, test runs, attached documents, and the change history:

Test Set #1 - Testing Cycle for Release 1.0
This tests the functionality introduced in release 1.0 of the library system
Owner: Joe P Smith Creator: Fred Bloggs
Release: 1000 Creation Date: 02-Jan-2007
Status: In Progress Last Execution: 01-Dec-2003
Planned Date: 05-Feb-2007 Last Updated: 13-0ct-2009
Hotes:
Operating System:
Test Cases:
Test # Name Priority Est. Duration Status Last Execution Date
TC2 Ability to create new book 1 - Ciitical 10 mins Failed 01-Dec-2003
TC3 Ability to edit existing book 1 - Critical 5 mins Passed 01-Dec-2003
TC4 Ability to create new author 1 - Critical & mins Failed 01-Dec-2003
TC5 Ability to edit existing author 2 - High 5 mins Mot Run -
TCB Ability to reassign book to different author 2 - High 8 mins Mot Run
TC8 Book management 2 - High 4 mins Mot Run
TC9 Author management 2 - High 4 mins Mot Run
Test Runs:
Run # Tester Release Version Status Est. Duration Actual Duration Execution Date
TR4 Joe P Smith Library System Release 1 1.0.0.0 Failed 8 mins 90 mins 01-Dec-2003
TR3 Fred Bloggs Library System Release 1 1000 Passed 5 mins 90 mins 01-Dec-2003
TR1 Joa P Smith Library System Release 1 1000 Failed 10 ming 75 ming 01-Dec-2003

11.3.5. Printable Test Scripts

This printable report is useful when you want to be able to conduct the testing activities offline on paper,

or when testers need paper copies of the test script in addition to using the online test execution wizard.

In either case, this report simply displays all of the test cases defined for the current project in the order
they appear in the test case list together with their detailed test steps and a list of any attached

documents.
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Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

Test #2 - Ability to create new book

Tests that the user can create a new book in the system

Test Steps:
Step Description Expected Result Sample Data Status Actual Result
4 User opens up browser and enters application URL The browser loads the login | |00 L o rmationsystem comvbeta [(JPassed []Failed
http://www_libraryinformationsystem com/beta web page (U ry 3% DlBlocked [ Caution

User taken to main menu [(Passed [IFailed

2 User logs in to application Login=librarian, Password=password1

screen [OBlocked []] Caution
User taken to first screen in [Passed [JFailed
2 User clicks link to create book "
vizard [JBlocked [[]Caution
User taken to next screen in [OPassed [Failed
3 User enters books name and author, then clicks Next Macbeth, William Shakespeare
vizard P [IBlocked [ Caution

[JPassed [Failed
[O8Blocked [[]Caution

User sees screen displaying

4 User chooses book’s genre and sub-genre from list all entered information

Play. Tragedy

Confirmation screen is [JPassed CIFailed
§  User clicks submit button
displayed [[J8locked []Caution
File Atachments:
Filename Description Author Date Uploaded
Sequence Diagram for Book Mgt. pdf Sequence diagram in UML format that provides detail the book use-case / test case Fred Bloggs  03-May-2006

11.3.6. Test Run Summary Report

This report displays all of the test runs defined for the current project. The test run's details and execution
status are displayed in a summary grid form:

Test Run Summary Report
This report displays all of the test runs defined for the cumrent project in date order {most recent first). The test run's details and execution status are displayed in a summary list form
Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Test Run # Name Test Case #Release Test Set Type Tester Est. Duration Actual Duration Start Date End Date Status  Runner Message MNotes Web Browser Operating Syste}
Ability to .
TRID | edit existing | TC3 1000 Manual | Fred |Ohours5  [Ohous50  01Dec- | 01Dec- oy,
book Bloggs  mins ming 2003 2003
. Expectad
Ability to
Fied | Ohours 10 | 1 hours 10 01-Dec- | 01-Dec- 1but 2 X
TR12 Elea:e new |TC2 1.0.00 Automated Bloggs | mins mine 2003 2003 Failed | NUnit was Opera Windows 2003
o0 found
. Expected
Ability to
Fred 0 hours 2 1 hours 10 02-Dec- | 02-Dec- 1but 2
TR13 EIEEL[E new | TC2 1.1.0.0.0001 Automated Bloggs | mins mins 2003 2003 Passed | JUnit was
o0 found
. Expected
Ability to
: Fred 0 hours 5 1 hours 10 02-Dec-  02-Dec- 1but 2
TR14 g:::xlstmg TC3 1.1.0.0.0001 Automated Bloggs | mins mins 2003 2003 Passed  JUnit was
found

11.3.7. Test Run Detailed Report

This report displays all of the test runs defined for the current project in date order (most recent first). The
test run's details and execution status are displayed, along with sub-tables containing the list of test run
steps, and a list of any associated open incidents:
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Tests that the user can create a new book in the system

Test Case #: TC2

Release #: 1.0.0.0

Tester: Joe P Smith
Type: Manual

Est. Duration: 0 hours 10 mins

Hotes:
Web Browser:
Operating System:

Intemet Explorer
Windows XP

Step Description

Test Run #1 - Ability to create new book

Expected Result

Status:

Execution Date:

Test Set:

Actual Duration:

Sample Data

Failed

01-Dec-2003

Testing Cycle for Release 1.0
1 hours 15 mins

ActualResult

Status
1| Userlogs in to application User taken to main menu screen Passed
2 | User clicks link to create book User taken to first screen in Passed
wizard
3 User enters books name and author, then clicks User taken to next screen in Macbeth, William An exror page is displayed - "Mo such object or wath block vanable at line Eailed
Next wizard Shakespeare 473"
Associated Incidents:
Inc # Type Status Severity Name Owned By Detected On
7 Bug Assigned 1 - Critical 3 - Medium Cannot add a new book to the system Joe P Smith 04-Now-2003
File Attachments:
Filename Description Author Date Uploaded
Error Logging-in Screen-shot gif Captured scraen-shot of the error that was raised when attempting 10 log in to the library application Fred Bloggs 24-Apr-2006

11.3.8. Test Case Traceability

This report displays a matrix of the test cases in the system with the list of mapped releases, incidents
and test sets:

Test#
TC1
TC2
TC3
TC4
TCS
TC6
TC?
TCE
TCO
TC10
TN
TC12
TC13
TC15
TC16
TCc?
TC18
TC19
TC20

= Print Report

Test Case Traceability Matrix

This repert displays a matrix of the test cases in the system with the list of mapped releases, incidents and test sets

Test Case Forward Traceability
This section displays a list of all the lest cases with the associated releases. incidents and test sets

Name

Functional Tests

Ability to create new book

Ability to edit existing book

Ability to create new author

Ability to edit existing author

Ability to reassign book to different author

Regression Tests

Book management

Author management

Scenario Tests

Exception Scenario Tests

Person loses book and needs to report loss

Adding new book and author o library
Common Tests

Open Up Web Browser

Login to Application

New Test Case (Ability 1o add new books to the system)
New Test Case (Ability 1o edit existing bocks in the system)
New Test Case {Ability to delete existing books in the system)

Priority

[

Wi

MR- -

- Critical
- Critical

Critical

- High
- High

- High
- High

- Medium
- Medium
- Medium

Releases

Test Sets Incidents
RL1, RL2, RL3, RL4, RL17, RL18, RL19 TX1,TX2 INT
RL1, RLZ, RL3, RL4, RL17, RL18, RL18, RLE TX1, TX2
RL1, RL2, RL3, RL4, RL5, RL18, RL19, RLE TX1, TX2, TX5 IN2
RL1, RL2, RL3, RL4, RL5, RL19, RLE X1, TX2
RL1, RLZ. RL3. RL4, RL5, RL6 TX1.TX2, TS
RL1, RL2, RL3. RL4, RLS TX1, TX2, TX3, TX4
RL1, RL2, RL3, RL4, RLS, RLE TX1, TX2, TX3, TX4
RL4, RLS, RLE TX2, TXS, TX6
RL4, RL5, RLE TX2, TX5, TX6

11.4. Incident Reports

11.4.1. Incident Summary Report

This report displays all of the incidents tracked for the current project. The incident's details are displayed

in a summary list form:
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Incident Summary Report
This repont displays all of the incidente tracked for the current project. The incident’s details are displayed in a summary list form
Project 1: Library Information System
Sample application that allows users to manage books, authers and lending records for a typical branch library
Inc # Name Description Resolution Type Status Priority Severity Detected By Owned By Detected On Last Modified Closed On Detected Release Resolved Release
When trying to
leg into the
application with a
Cannot log
wvalid usemname Fred 01-Mow-
-Dec-2003  —
1 :!toht::ho" and password, Incident MNew Bloggs 2003 01-Dec-2003 1.000 1.01.0
PP the system
throws a fatal
exception
When | try and
click on the
button to add a
Mot able to
) new author the Joe P 01-Now-
2 ::ldh:le“ system simply Incident Mew Smith 2003 01-Dec-2003 - 1000 1.0.1.0
displays the
main screen and
does nothing
When | click on
the logout link,
3 ikt ToMCR Incident N Fred Mot 01.Dec-2003 - 1010 1020
flanta\ e:;‘:s logging out, | get neiden o Bloggs 2003 ee
an ASP session
not valid emor

11.4.2. Incident Detailed Report

This printable report displays all of the incidents tracked for the current project sorted by incident number.
For each individual incident, the name, type, priority, status, opener, owner and close date are displayed,
along with tables containing the detailed description and resolutions as well as a tabular list of attached

documents, linked requirements/incidents and the change history:

Project 1: Library Information System
Sample application that allows ugers to manage books, authors and lending recerds for a typical branch library

Inc #1 - Cannot log into the application

When trying to log inta the 3 with a valid and password, the system throws a fatal exception
Type: Incident Priority:
Status: Mew Severity:
Opened By: Fred Bloggs Opened On: 01-Mow-2003
Assigned To: Last Modified: 01-Dec-2003
Detected In Release:  1.0.0.0 Closed On: -
Resolved In Release:  1.0.1.0 Verified In Release: 1.01.0
Notes:

Operating System:

Associations:

Artifact Type Name Created By Comment Date Artifact Id
Test Run Sample Test Fred Bloggs Test Run: Sample Test 01-Movw-2006 TR9
Incident The book listing screen doesn't son Joe P Smith This incident and bug are related 16-Mar-2004 IN &
Raquirement Ability to create new users in the system Joa P Smith Test Run: Sample Test 01-Dec-2003 RQ 26

File Attachments:

Filename Description Author Date Uploaded
Bug Stack Trace txt Joe P Smith 04-May-2006

Error Logging-in Screen-shot gif Captured screen-shot of the error that was raised when attempting to Iog in to the library application Fred Bloggs | 24-Apr-2006

11.5. Task Reports
11.5.1. Task Summary Report

This report displays all of the tasks tracked for the current project. The task's details are displayed in a

summary list form:
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Task # Name

23 Wirite edition object
insert queries
Develop edit author

24
details screen
Create author

25 object update
method
Wirite author object

26
update queries
Refactor author

27 screen to include
delete button

Description

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

Status
Not
Started
Not
Started

Not
Started

Not
Started

Not
Started

Priority
$a

Critical
2 - High
2 - High

2 -High

2 - High

Owned By Created On Last Modified Release #
01-Dec-

Fred
Bloggs
Joe P
Smith

Joe P
Smith

Joe P
Smith

Fred
Bloggs

2003

01-Dec-

2003

01-Dec-

2003

01-Dec-

2003

01-Dec-

2003

01-Dec-2003 1.0.0.0.0003 RQ12 ;30’;3'
01-Dec-2003 1.0.0.0.0002 RQ15 ggor:a.
01-Dec-2003 | 1.0.0.0.0002 RQ15 o
01-Dec-2003  1.0.0.0.0002 RQ15 Lo
01-Dec-2003 | 1.0.0.0.0003 RQ16 s

12-Mar-

2004 9%
o
B o

Requirement # Start Date End Date % Complete Est. Effort Actual Effort
3 hours 0

mins

8hours 0
mins

Shours 0

mins

3hours 0

mins

6hours 0

mins

11.5.2. Task Detailed Report

This report displays all of the tasks tracked for the current project. The task’s details are displayed, along

with a tabular list of attached documents and the change history:

Requirement ID:
Release #:
Assigned To:
Start Date:

End Date:

% Complete:

Task Detailed Report

This report displays all of the tasks tracked for the current project. The task’s details are displayed. along with a tabular list of attached documents and the change history.

RO 12
1.0.0.0.0003
Fred Bloggs
11-Mar-2004
12-Mar-2004
0%

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

Task #23 - Write edition object insert queries

Status:

Priority:
Created On:
Last Modified:
Estimated Effort:
Actual Effort:

Mot Started

1 - Critical
01-Dec-2003
01-Dec-2003

3 hours 0 mins

11.6. Release Reports

11.6.1. Release Summary Report

This report displays all of the releases and iterations defined for the current project in the order they

appear in the release/iteration hierarchy. The release's details are displayed in a summary list form:
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Release Summary Report
This report displays all of the releases and iterations defined for the current project in the order they appear in the releasefiteration hierarchy. The release’s details are displayed in a summary list form
Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
General Testing Information
Rel # Name Version Number Description  Creator Creation Date lteration Active Start Date End Date # Failed # Passed # Blocked # Caution # Not Run Task Progress Planned Effort
18 Tasks:
. 50% On
This is the b
Library initial ?g::de:I:ning
1 System 1000 release of Fred 16.Feb.2004 N 01-Mar- | 12-Mar- 0 0 1 n Late 216 hours 0
Release the Library Bloggs 2004 2004 9% Starti mins
1 Management L::e o
System 26% Not
Started
This serace ggaéks'
. pack fixes v Ln
Library identified Schedule
System oe P , y 13-Mar-  30-Mar- 0% Running 176 hours 0
2 Release 10 :;g:‘land 3 gmity 05May-2004 N 2004 2004 3 ! 0 3 Late mins
15P1 X 0% Starting
Sjﬁla‘?;}t’:llny Late, 0% Not
Started

11.6.2. Release Detailed Report

This report displays all of the releases and iterations defined for the current project in the order they

appear in the release/iteration hierarchy. The release's details are displayed, along with sub-tables

containing the list of requirements added, mapped test cases, test runs executed, incidents resolved,

attached documents, scheduled tasks and the change history:

1.1.0.0 - Library System Release 1.1

This version adds additional reperting functionality to the 1.0 version

Operating System:

Version #: 1.1.00 Active: ¥

Creator: Fred Bloggs Creation Date: 15-0ct-2004
Start Date: 15-0ct-2004 Planned Effort: 168 hours 0 mins
End Date: 27-0ct-2004 Available Effort: 82 hours 0 mins
# Resources: 3 Task Est. Effort: 86 hours 0 mins
HNon-Working Days: 6 Actual Effort: 85 hours 40 mins
Notes:

Requirements Added:
Req # Name Status Priority
RQ1 Functional System Requirements In Progress
RQ2 Online Library Management System In Progress
RQ3 Book Management Complated 1 - Critical
RaQr Ability to associate books with different subjects Completed 1- Cntical
RQ& Ability to associate books with different authors Completed 1 - Critical
RQ9 Ability to associate books with different editions Completed 1 - Critical
RQ13 Author Management In Progress 2 - High
RO17 Ability to link authors to their contact information Requested 2 - High
Mapped Test Cases:
Test# Name Status Last Execution Date
TC4 Ability to create new author Failed 01-Dec-2003
TC2 Ability to creste new book Failed 04-Dec-2003
TCS Ability to edit existing author Blocked 01-Dec-2003

11.6.3. Release Plan Report

This report displays a complete work breakdown structure of the project from a release perspective,

including all releases, iterations, requirements, tasks and incidents organized by schedule:
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11.7.

Priority  Owner
1-Critical  Joe P Smith
1- Critical  Joe P Smith
1-Criical  Fred Bloggs
1-Creical | Fred Bioggs
2-High  Fred Bloggs
2.High  Fred Bloggs

. Jos P
1- Critical | oin

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library
ID# MName Type Status
RL1 1.0.0.0 - Library System Release 1 Release
RO4 Abiity to 8dd new books to the system Requirement | Compieted
ROS Abilty to edit existing books in the system Requirement | Completed
RO§ Abity to delete existing books in the system Requiement | Completed
RO12 Abity to create different edtions Requirement :mgre”
RO1S Abity to edit &xisting authars in the system Requirement | Planned

n
RO1E bty to delete existing authors in the system Reqursment o o
RL2 1.0.1.0 - Library System Release 1 SP1 Release
N Gennot log into the application incigent | New
2 Not able io add new authar Incident New
w7 Cennot 80d & new Book o the system Bug Asgigned
RL11 1.0.1.0.0001 - Iteration 001 Iteration
RL1Z2 1.0.1.0.0002 - lteration 002 lteration
RL13 1.0.1.0.0003 - Mteration 003 lteration
el oL lian Slon Belase LOES Solease

Start Date:
01-Mar-
2004

13-Mar-
2004

06-Mev-2003
13-Mar-
2004

21-Mar-
2004

25-Mar-
2004

01-Apr-

End Date
12-Mar-
2004

30-Mar-
2004

20-Mar-
2004

24-Mar-
2004

30-Mar-
2004

30.Apr-

% Complete Plan Effort

0%
0%

216 hours 0
mins

15 hours O ming
18 hours ) mins
14 hours 0 mins

15 hours 0 mins
10 hours O mins

176 hours 0

mins

Est. Effort

94 hours 0
mins

18 hours 0 mins
18 hours 0 mins
16 hours 0 mins

16 hours 0 mins.
16 hours 0 mins

14 hours 0 mins

0 hours 20 ming

80 hours 0 mins | -

48 hours 0 ming -

64 hours 0 mins -

352 hours 0

Actual Effort
93_ hours 30
mins

15 hours 30 ming
16 howrs §0 mins.
15 hours 10 mins
16 hours 0 mins:

16 hours 0 ming

14 hours 0 mins

Summary Graphs

11.7.1. Requirements Summary Graph

The requirements summary graph shows how many requirements are currently in a project. The number
of requirements is displayed according to the criteria that you specify. You can specify the type of data
displayed along the x-axis, and the requirement information which is used to group the data. When you
first open the graph you will be asked to pick the field that you would like to display on the x-axis and the

field that you would like to group the data by. Once you have chosen the appropriate fields the graph will

be displayed:

-

=R <]

[ = |

=]

=

Axis | Status w
Completed Developed
4- Low 2 - High
[Zal~
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In this version of the report, the x-axis represents the requirements’ status, and the individual bars are

grouped by requirement importance. Each data-value can be viewed by positioning the mouse pointer

over the bar, and a “tooltip” will pop-up listing the actual data value.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph:

| Requirement Summary

Requirement Summary Graph

Graph

Status (Mone) 1 - Critical 2 - High 3 - Medium 4 - Low

Completed 5 2
Developed
In Progress

0
2
Planned O
O

o o ~om

Requested O

Download Data As C5V

o

o W =

1

B ow o o

(a]

Moo o o

Clicking on the “Download Data as CSV” button will export the datagrid into Comma Separated Values

(CSV) format that can be opened in MS-Excel. Some browsers also support the ability to save the graph
as an image file (JPEG, PNG and GIF formats).

E | -
JPEG
EMP

Grap PNG

11.7.2. Test Case Summary Graph

The test case summary graph shows how many test cases are currently in a project. The number of test

cases is displayed according to the criteria that you specify. You can specify the type of data displayed

along the x-axis, and the test case information which is used to group the data. When you first open the

graph you will be asked to pick the field that you would like to display on the x-axis and the field that you

would like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:

© Copyright 2006-2017, Inflectra Corporation

Page 252 of 312 This document contains Inflectra proprietary information




¥-Axis | Execution Status ~ = Group-By: | Priority hd

Blocked Caution Failed Met Run Passed

(Mone) 1 - Crifical 2 - High 3 - Medium

In this version of the report, the x-axis represents the test case execution status, and the individual bars
are grouped by test case priority. Each data-value can be viewed by positioning the mouse pointer over

the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” button

will display the underlying data that is being used to generate the graph. In addition, clicking on the

“Download Data as CSV” button will export the datagrid into Comma Separated Values (CSV) format

that can be opened in MS-Excel. Some browsers also support the ability to save the graph as an image
file (JPEG, PNG and GIF formats).

11.7.3. Test Run Summary Graph

The test run summary graph shows how many test runs are currently in a project. The number of test runs
is displayed according to the criteria that you specify. You can specify the type of data displayed along
the x-axis, and the test run information which is used to group the data. When you first open the graph
you will be asked to pick the field that you would like to display on the x-axis and the field that you would

like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:
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In this version of the report, the x-axis represents the test run execution status, and the individual bars are
grouped by test run type. Each data-value can be viewed by positioning the mouse pointer over the bar,

and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” button will

display the underlying data that is being used to generate the graph. In addition, clicking on the
“Download Data as CSV” button will export the datagrid into Comma Separated Values (CSV) format

that can be opened in MS-Excel. Some browsers also support the ability to save the graph as an image
file (JPEG, PNG and GIF formats).

11.7.4. Incident Summary Graph

The incident summary graph shows how many incidents are currently in a project. The number of
incidents is displayed according to the criteria that you specify. You can specify the type of data displayed
along the x-axis, and the incident information which is used to group the data. When you first open the
graph you will be asked to pick the field that you would like to display on the x-axis and the field that you
would like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:
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In this version of the report, the x-axis represents the incidents’ status, and the individual bars are
grouped by the type of incident. Each data-value can be viewed by positioning the mouse pointer over the

bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” button will

display the underlying data that is being used to generate the graph. In addition, clicking on the
“Download Data as CSV” button will export the datagrid into Comma Separated Values (CSV) format

that can be opened in MS-Excel. Some browsers also support the ability to save the graph as an image
file (JPEG, PNG and GIF formats).

11.7.5. Task Summary Chart

The task summary graph shows how many tasks are currently in a project. The number of tasks is
displayed according to the criteria that you specify. You can specify the type of data displayed along the
x-axis, and the task information which is used to group the data. When you first open the graph you will
be asked to pick the field that you would like to display on the x-axis and the field that you would like to
group the data by. Once you have chosen the appropriate fields the graph will be displayed:
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In this version of the report, the x-axis represents the tasks’ priority, and the individual bars are grouped
by the status of task. Each data-value can be viewed by positioning the mouse pointer over the bar, and a

“tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” button will display

the underlying data that is being used to generate the graph. In addition, clicking on the “Download Data

as CSV” button will export the datagrid into Comma Separated Values (CSV) format that can be opened
in MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and
GIF formats).

11.7.6. Test Set Summary Graph

The test set summary graph shows how many test set are currently in a project. The number of test sets
is displayed according to the criteria that you specify. You can specify the type of data displayed along
the x-axis, and the test set information which is used to group the data. When you first open the graph
you will be asked to pick the field that you would like to display on the x-axis and the field that you would

like to group the data by. Once you have chosen the appropriate fields the graph will be displayed:
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K-Axis | Status ~ = Group-By: | Owner v

Completed Deferad In Progress Mot Started
M (None) M Fred Bloggs M Joe P Smith

In this version of the report, the x-axis represents the test set status, and the individual bars are grouped
by the name of the tester (owner). Each data-value can be viewed by positioning the mouse pointer over
the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data Grid” button

will display the underlying data that is being used to generate the graph. In addition, clicking on the
“Download Data as CSV” button will export the datagrid into Comma Separated Values (CSV) format

that can be opened in MS-Excel. Some browsers also support the ability to save the graph as an image
file (JPEG, PNG and GIF formats).

11.8. Snapshot Graphs
11.8.1. Requirements Coverage Graph

The requirements coverage graph shows how many requirements are currently in a project, according to

their test coverage status.
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Graph Mame: | Requirements Coverage w Filter: | - All Releases ——- v

om0 O R s

(5]

Passed Failed Blocked Caution Mot Run Not Covered

1 - Critical 2 - High 3 - Medium 4 - Low (None)

The x-axis of the report represents the various test execution statuses that a requirement can have as its
coverage status (plus the Not-Covered status), and the individual bars are grouped by the requirements
importance. Each data-value can be viewed by positioning the mouse pointer over the bar, and a “tooltip”

will pop-up listing the actual data value.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. You can also filter the graph to just display data for a specific releasef/iteration as well as for

the project as a whole. In addition, clicking on the “Download Data as CSV” button will export the

datagrid into Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers

also support the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.2. Requirements Burndown Graph

The Requirements Burndown graph shows the remaining number of story points that needs to be
completed for each release/iteration in the project with separate lines for the estimated and ideal
burndown. In addition, the graph includes bars for the completed number of story points in each time

period on the x-axis:
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Graph Mame: | Requirement Burndown ~w | Filter: —- All Releases ——- v

1.0000.0 1.0.1.0 1.0.2.0 1.1.0.0 1.1.1.0 1200

Completed Points Ideal Burndown Remaining Points

The y-axis of the graph displays the total remaining number of story points that needs to be done (the
actual burndown), with a blue line indicating the ideal burndown. In addition, there are bars displayed at

each interval of the x-axis that shows the completed number of story points for that interval.
The x-axis can be configured to display three different levels of granularity:

>» All Releases — This shows the total remaining number of story points that needs to be done for

each of the releases in the project

» Specific Release — This shows the total remaining number of story points that needs to be done

for each of the iterations in the selected release

» Specific Iteration — This shows the total remaining number of story points that needs to be done

for each working day in the date-range covered by the selected iteration.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support

the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.3. Requirements Burnup Graph

The Requirements Burnup graph shows the cumulative number of story points outstanding for each
releaseliteration in the project with separate lines for the estimated and ideal burnup. In addition, the

graph includes bars for the number of completed story points in each time period on the x-axis.

© Copyright 2006-2017, Inflectra Corporation Page 259 of 312 This document contains Inflectra proprietary information




Graph Name: | Requirement Burnup v | Filter: | — All Releases —- e

Start 1.0.0.0 1.0.1.0 1.0.2.0 1.1.0.0 1.1.1.0 1.2.0.0

Completed Points |deal Burnup Actual Bumup

The y-axis of the graph displays the cumulative increase in number of story points for the project (the
actual burnup), with a blue line indicating the ideal burnup. In addition, there are bars displayed at each

interval of the x-axis that shows the number of completed story points for that interval.
The x-axis can be configured to display three different levels of granularity:

>» All Releases — This shows the increase in number of story points for each of the releases in the

project

» Specific Release — This shows the increase in number of story points for each of the iterations in

the selected release

» Specific Iteration — This shows the increase in number of story points for each working day in

the date-range covered by the selected iteration.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support

the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.4. Requirements Velocity Graph

The Requirements Velocity graph shows the total number of story points that have been completed (or

planned to be completed) in a particular release, iteration or time-period (called the velocity). The actual
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velocity is displayed along with the overall average velocity (in blue) and the rolling average velocity (in

green):
Graph Mame: | Requirement Velocity A" Filter: | —— All Releases ——- v
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The y-axis of the graph displays the total number of story points, and the x-axis can be configured to

display three different levels of granularity:
>» All Releases — This shows the total number of story points for each of the releases in the project

» Specific Release — This shows the total number of story points for each of the iterations in the

selected release

» Specific Iteration — This shows the total number of story points for each working day in the date-

range covered by the selected iteration.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support

the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.5. Incident Aging Graph

The incident aging chart displays the number of days incidents have been left open in the system. The

chart is organized as a stacked histogram, with the count of incidents on the y-axis and different age
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intervals on the x-axis. Each bar-chart color represents a different incident priority, giving a project

manager a snapshot view of the age of open project incidents by priority.

Graph Name: | Incident Aging v Filter: | —- All - v
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This report can be filtered by the type of incident, so for example you can see the aging of just bugs, or

just issues for the project in question. Clicking on the “Display Data Grid” button will display the

underlying data that is being used to generate the graph. In addition, clicking on the “Download Data as

CSV” button will export the datagrid into Comma Separated Values (CSV) format that can be opened in
MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and
GIF formats).

11.8.6. Incident Turnaround Time Graph

The incident turnaround time chart displays the number of days incidents have taken to be closed (from
the time they were first raised) in the system. The chart is organized as a stacked histogram, with the
count of incidents on the y-axis and different turnaround time intervals on the x-axis. Each bar-chart color
represents a different incident priority, giving a project manager a snapshot view of the turnaround time of

project incidents by priority.

© Copyright 2006-2017, Inflectra Corporation Page 262 of 312 This document contains Inflectra proprietary information




Graph Mame: | Incident Turnaround Time  w Filter: | —- &l —-
12
1
10
g
]
5
5
4
k]
2
1
]
0-7 214 1521 2228 2035 47 43-40 50-56
1 - Critical 2 - High 3 - Medium
B [l

E7-83

4 - Low

8470 TI-TT T334 8400 00

(None)

This report can be filtered by the type of incident, so for example you can see the turnaround time of just

bugs, or just issues for the project in question. Clicking on “Display Data Grid” button will display the

underlying data that is being used to generate the graph. In addition, clicking on the “Download Data as

CSV” button will export the datagrid into Comma Separated Values (CSV) format that can be opened in

MS-Excel. Some browsers also support the ability to save the graph as an image file (JPEG, PNG and

GIF formats).

11.8.7. Task Velocity Chart

The Task Velocity graph shows the total estimated and actual effort (in number of hours) delivered in

each project release and/or iteration:
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Graph Name: | Task Velocity v | Filter: | — All Releases —— v
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The y-axis of the graph displays the total estimated and actual effort delivered (in hours), and the x-axis
can be configured to display three different levels of granularity:

» All Releases — This shows the total estimated and actual effort for each of the releases in the
project

» Specific Release — This shows the total estimated and actual effort for each of the iterations in

the selected release

» Specific Iteration — This shows the total estimated actual effort for each working day in the date-

range covered by the selected iteration.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate
the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.8. Task Burnup Chart

The Task Burnup graph shows the cumulative amount of work outstanding for each releasel/iteration in
the project with separate lines for the estimated and ideal burnup. In addition, the graph includes bars for

the remaining and completed effort in each time period on the x-axis.

© Copyright 2006-2017, Inflectra Corporation Page 264 of 312 This document contains Inflectra proprietary information




Graph Name: | Task Burnup w | Filter: -—- &ll Releases --- v
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The y-axis of the graph displays the cumulative increase in work (in hours) for the project (the actual
burnup), with a blue line indicating the ideal burnup. In addition, there are bars displayed at each interval

of the x-axis that shows the remaining effort and completed effort for that interval.
The x-axis can be configured to display three different levels of granularity:
» All Releases — This shows the increase in work for each of the releases in the project

» Specific Release — This shows the increase in work for each of the iterations in the selected
release

» Specific Iteration — This shows the increase in work for each working day in the date-range
covered by the selected iteration.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.8.9. Task Burndown Chart

The Task Burndown graph shows the remaining work (in hours) that needs to be done for each
releasel/iteration in the project with separate lines for the estimated and ideal burndown. In addition, the

graph includes bars for the remaining and completed effort in each time period on the x-axis.
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Graph Mame: | Task Burndown v Filter: | ——- All Releases ——- v
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The y-axis of the graph displays the total remaining work that needs to be done (the actual burndown),
with a blue line indicating the ideal burndown. In addition, there are bars displayed at each interval of the
x-axis that shows the remaining effort and completed effort for that interval.

The x-axis can be configured to display three different levels of granularity:

» All Releases — This shows the total remaining work that needs to be done for each of the
releases in the project

>» Specific Release — This shows the total remaining work that needs to be done for each of the
iterations in the selected release

>» Specific Iteration — This shows the total remaining work that needs to be done for each working
day in the date-range covered by the selected iteration.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate
the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).
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11.9. Date-Range Graphs

11.9.1. Test Run Progress Rate Graph

The test run progress rate graph shows how many tests have been executed during a period of time, and
what execution status was recorded. The report can be displayed for a specific date-range and for the

entire project or for a specific release/iteration:

Graph Name: | Test Run Progress Rate v Filter: | — All Releases -— v Date Range 11/29 - 12/05 | £
2
0

[

s

1112012003 11302003 21012008 1200212003 20032003 120472008 200520

Failed " Passed = NotRun " N/A  Blocked W Caution

B [

In this version of the report, the y-axis represents the number of test runs executed in each 24 hour
period, and the x-axis represents a specific week in the time-span. Each data-bar can be viewed by
positioning the mouse pointer over the point, and a “tooltip” will pop-up listing the actual data value. You
can filter the report by the release/iteration that the test run was executed against, and also change the
date range. If you choose a smaller date-range, the x-axis will switch from weekly to daily and if you

choose a larger date-range, the x-axis will switch to monthly.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support

the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.9.2. Test Case Progress Rate Graph

This graph displays the number of test case executions for the specified date range for that specific date
interval. That means it will display for each day, the total number of test cases executed ignoring the
status from any previous days. Any test cases not executed that day will be considered “not run” and will
appear in the “not run” category. For example, if you have 10 test cases created on day 1 you will see 10
test cases “not run” on day 1. On day 2, you execute 5 test cases and fail them all, you will now see 5 test
cases failed and 5 not run. On day 3, you execute 3 of the previous 5 test cases and pass them. You will

now see 3 test cases passed, O failed and 7 not run.
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Graph Name: | Test Case Progress Rate | w | Filter: | — All Releases — v Date Range: 11/29 - 12/05 |
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11.9.3. Test Case Cumulative Progress Graph

This graph displays the number of test case executions cumulatively over the specified date range. That
means it will display for each day, the total number of test cases executed plus the status from any
previous days that have not been changed. Any test cases not executed up to that point will be
considered “not run” and will appear in the “not run” category. For example, if you have 10 test cases
created on day 1 you will see 10 test cases “not run” on day 1. On day 2, you execute 5 test cases and
fail them all, you will now see 5 test cases failed and 5 not run. On day 3, you execute 3 of the previous 5

test cases and pass them. You will now see 3 test cases passed, 2 failed and 5 not run.

Graph Name: | Test Case Cumulative Prog w | Filter. | —- All Releases --- ~ Date Range| 11720 - 12/05 | £
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11.9.4. Incident Progress Rate Graph

The incident progress rate chart displays the total number of incidents created and closed over a

particular date-range, either for all incident types or for a specific incident type:

Graph Name: | Incident Progress Rate | v Filter: | — All -- v Date Range: 10/30 - 12/10 £
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In this version of the report, the y-axis represents the number of incidents (either created or closed in a 24
hour period), and the x-axis represents a specific day in the time-span. Each data-point can be viewed by
positioning the mouse pointer over the point, and a “tooltip” will pop-up listing the actual data value. You
can filter the report by the type of incident, and also change the date range (e.g. displaying only the bugs
for the date range). If you choose a smaller date-range, the x-axis will switch from weekly to daily and if

you choose a larger date-range, the x-axis will switch to monthly.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.9.5. Cumulative Incident Count Graph

The cumulative incident count chart displays the cumulative total number of incidents logged in the
system for the current project over a particular date-range, either for all incident types or for a specific
incident type. The report displays two data series, one illustrating the total count of all incidents, the other

the total count of all open incidents (i.e. with status not set to fixed or closed):

Graph Name: | Incident Cumulative Count ~ | Filter: | - All -- v Date Range: 10/20 - 12/10 | (8
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In this version of the report, the y-axis represents the number of incidents, and the x-axis represents a
specific week in the time-span. Each data-point can be viewed by positioning the mouse pointer over the
point, and a “tooltip” will pop-up listing the actual data value. You can also filter the type of incident being
reported, as well as change the date interval. If you choose a smaller date-range, the x-axis will switch

from weekly to daily and if you choose a larger date-range, the x-axis will switch to monthly.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate

the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).
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11.9.6. Open Incident Count Graph

The open incident count chart displays the net number of open incidents in the system for the current
project over a particular date-range categorized by incident priority, either for all incident types or for a
specific incident type. For this chart, “open” is defined as any incident with an empty “Closed On” date.
The incident status is not used for this chart.

Graph Name: | Incident Open Count v | Fitter: | — all - v Date Range| 10/30 - 1210 | @2

1-Critical M 2-High © 3-Medium ~ d-Llow = (None)

In this version of the report, the y-axis represents the number of incidents, and the x-axis represents a
specific week in the time-span. The exact count of each bar in the stacked histogram can be viewed by
positioning the mouse pointer over the bar, and a “tooltip” will pop-up listing the actual data value. You
can also filter the type of incident being reported, as well as change the date interval. If you choose a
smaller date-range, the x-axis will switch from weekly to daily and if you choose a larger date-range, the
x-axis will switch to monthly.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate
the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).

11.9.7. Incident Count by Status Graph

The incident status count chart displays the number of open incidents in the system for the current project
over a particular date-range categorized by incident status, either for all incident types or for a specific
incident type. For this chart, “open” is defined as any incident with an empty “Closed On” date. The
incident status is not used for this chart.
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Graph Name: | Incident Count by Status | w | Filter: — All — v Date Range: 10/30 - 12/10 | &8
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In this version of the report, the y-axis represents the number of incidents, and the x-axis represents a
specific week in the time-span. The exact count of each bar in the stacked histogram can be viewed by
positioning the mouse pointer over the bar, and a “tooltip” will pop-up listing the actual data value. You
can also filter the type of incident being reported, as well as change the date interval. If you choose a
smaller date-range, the x-axis will switch from weekly to daily and if you choose a larger date-range, the
x-axis will switch to monthly.

Clicking on the “Display Data Grid” button will display the underlying data that is being used to generate
the graph. In addition, clicking on the “Download Data as CSV” button will export the datagrid into

Comma Separated Values (CSV) format that can be opened in MS-Excel. Some browsers also support
the ability to save the graph as an image file (JPEG, PNG and GIF formats).
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12. Source Code

This section outlines the source code integration features of SpiraPlan® and SpiraTeam® that can be
used to browse the source code repository associated with a particular project and link artifacts in

SpiraTeam to revisions / commits made in the source code repository. This functionality allows project
members to quickly view files in the repository through a convenient web interface and also to see the
end-to-end traceability from requirements, tasks and incidents to the code changes that addressed the

requirement, fulfilled the task or resolved the incident

The software can be integrated with a variety of different version control / Software Configuration
Management (SCM) systems by means of different plug-ins. This section will outline the general features
irrespective of the type of version control provider being used. For details on using a specific provider
(e.g. Subversion) please refer to the separate SpiraPlan/Team Version Control Integration Guide. This
section also assumes that an administrator has already configured the project to be integrated with the
version control provider. The steps for using the administrative interface are described in the separate

SpiraTeam Administration Guide.

12.1. Source Code File List

When you click on Tracking > Source Code on the global navigation bar, you will be taken to the source

code repository file list screen illustrated below:

@ w Olibrary Information System + Planning ~  Testing ~ | Tracking = | Reporting em Administrator w

Incidents / Tasks / Resources / Source Code

Repository Browser & ZRefresh || Current Branch: | b Master | v | T Filter  w

Displaying 1 - 15 out of 25 file(s) in the current folder Design

El=a
4 (> Design V¥ Filename & size Author Latest Revision Last Edited
> [3 Business Design F] =
> [ Technical Desigr -
3684 KB Administrater
> [0 Development
2064 KB John #dams
> [ Test
> [ Documentation 2966 K8 John Adzms
> [ Training 1494 KB Administrater
1281 KB Administrator
TestVersionControlProvider2 2104 KB John Adams
502 KB Administrator
Other Operations
485 KB Administrator
75 KB John Ad
View Revision Log e ohn #dams
1027 KB John Adams
1824 KB Administrator
241 KB John Adams
758 KB Administrater
1938 KB John &dams
1680 KB Administrator

show | 15 v | rows per page

This screen consists of three main sections:

» The top left-hand pane displays a hierarchical list of the various folders that exist in the source
code repository. Clicking on the expand icon will expand the child folders and clicking on the

name of the folder will display the list of files in the folder in the main pane to the right.

© Copyright 2006-2017, Inflectra Corporation Page 272 of 312 This document contains Inflectra proprietary information




» The main right-hand pane displays a list of all the files contained within the currently selected
folder. This list can be filtered and sorted, and you can choose how many rows of documents to
display on the page at one time.

» The bottom left-hand pane contains the option to view the overall revision log for the project,

clicking on that will display the revision log page (see section 12.3 for details).

Above the main right-hand pane, there is the branch selector. This lets you choose which branch in the

source code repository is being viewed:

s Master
[ Branch_12
ke Fork20160517

L, Master

Some source code management systems (e.g. CVS, Visual SourceSafe) do not have the formal concept

of branches, so the dropdown list will simply list the one main branch (usually called “Trunk”).

12.2. Source Code File Details

When you click on a file in the source code file list described above, you are taken to the file details page
illustrated below:

Back to File List e Curent Branch: | s Master | v
o en Source Code Fle: B Document Filename 35.py =
&3 Document Filename 31cpp
Author: Filz Path: Last Edited:
File Type (Size)
Latest Revision ) revo004

port unittest
import spiratestextension

# sample PyUnit test case
class TestSequenceFunctions(unittest.TestCase):

This page is made up of three areas; the left pane is for navigation, the upper part of the main pane
contains information regarding the file, and the bottom part of the right pane contains three tabs that
display a preview of the file (if textual), the list of file revisions stored in the version control system, and a
list of associated artifacts.

The navigation pane consists of a link that will take you back to the source code file list, as well as a list of
other files in the current folder. This latter list is useful as a navigation shortcut; you can quickly view the
detailed information of all the peer files by clicking on the navigation links without having to first return to
the main file list page.
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The top part of the main pane allows you to view the details of the particular file in the version control
system. Clicking on the “Source Code File” hyperlink will open the file in a separate window, and
depending on the type of file, it may display in the page or prompt you to download it to your local
computer. The “Latest Revision” hyperlink allows you to view details of the latest revision (see section
12.4 below).

The lower part of the main pane can be switched between the three different views by clicking the
appropriate tab. Initially the pane will be in “Preview” mode, but it can be switched to “Revisions”, or

“Associations” as well. The functionality in each of these views is described below:

12.2.1. Preview

This view is only available for files that are textual and it will display the contents of the file inside the tab,

with the text color-coded to match the syntax of the programming language it is written in:

Praview Revisions Associations

import random
import unittest
import spiratestextension

# sample PyUnit test case
class TestSequenceFunctions(unittest.TestCase):

def setUp(self):

self.seq = range(18)

def testshuffle_ 2(self):
# make sure the shuffled sequence does not lose any elements
random. shuffle(self.seq)
self.seq.sort()
self.assertEqual(self.seq, range(1@))
def testchoice_ 3(self):
element = random.choice(self.seq)
self.assert_(element in self.seq)

The syntax highlighting is based on the file type and file extension, so if you save a file with an incorrect
extension (e.g. using .txt for a JavaScript file) it may not display the correct color-coding. For text files that
are not for a specific programming language, it will simply display as plain text

12.2.2. Revisions

This view displays the list of revisions that have been committed for the current file:

Praview Revisions Associgtions

< Refresh | T Filter | w
¥ Revision & Author summary Commit Date Content & Properties &
[=2] - Amy v -- ANy v
The artifact was changed in this versian to fix the issue with the data access
i) revooo Fred Bloggs = 10-Qct-2017 Yes es
- component
The artifact was changed in this version to fix the issue with the data access
) revooo2 Fred Bloggs = 17-0ct-2017 Yes No
- component
Show | 15 W | rows per page Displaying page Sofl
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Each revision in the list is displayed with its name, the name of the person who made the revision, a
description of what was changed, the date the change was made and two flags that denote whether the
content was changed and/or if any of the properties of the file were changed. Clicking on the revision

name will take you to the appropriate revision details page (see section 12.4).

12.2.3. Associations

This view displays a list of the SpiraTeam artifacts in the current project that are associated with the
current file. This allows you to see which requirements, test cases, incidents, tasks, etc. are linked to the
file. Clicking on the hyperlink for the artifact will take you to the appropriate artifact page inside the project

(assuming your user has permissions to access that information).

Praview Revisions Associations

Date Artifact Name Creator Comment Artifact Type D Operations

10-Oct-2017 &) Ability to 2dd new books to the system Fred Bloggs Requirement RQ4 Remove

Add Association

In addition, you can use the “Add New Association” button to add a new association from the current

source code file to an existing artifact in SpiraTeam:

Add New Association

Please choose the artifact that you want to add an association to: n
Y Artifact Type:*  Automation Host v
L¢
Artifact ID:"
L
c
Comment:

To add the association, you just need to select the type of artifact being associated (requirement, test

case, incident, etc.) and the numeric ID of the artifact and then click the “Add Association” button.

For example to add an association to Requirement RQ00005 you would choose Artifact Type =

Requirement and Artifact ID = 5.
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12.3. Source Code Revision List

If you click on the “View Revision Log” button on the main Source Code page, it will take you to the

Revision List page that displays all the revisions made to the project in a sortable, filterable list:

€« Refresh | Y Filter | w || Cument Branch B Master |

Displaying 1 - 15 out of 16 revision(s) in the current repository

¥ Revision & Author Summary Commit Date Content & Properties &

g [ v —Any v

e Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves Yes
® Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves No
& e Fred Bloggs Fixes [IN7] and [IN:8] and implements requirement [RQ:5] No No
F) Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves No
) Fred Bloggs Campletes task [TK:2] and fixes bug [IN7] No No
& Fred Bloggs The artifact was changed in this version to fix the issue with the data access component Ves No
& e Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves ves
F) Fred Bloggs The artifact was changed in this version to fix the issue with the data access component Yes Yes
& Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves ves
&5 Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves ves
e Fred Bloggs The artifact was changed in this version to fix the issue with the data access component Ves No
& Fred Bloggs Implements requirement [RQ5] and also completes task [TK:1] ves No
F) Fred Bloggs The artifact was changed in this version to fix the issue with the data access component No Yes
& Fred Bloggs The artifact was changed in this version to fix the issue with the data access component No Yes
&) revoois Fred Bloggs The artifact was changed in this version to fix the issue with the data access component ves No
Show | 15 ' rows per page Displaying page | 1 Sof2m M

Each revision in the list is displayed with its name, a description of what changed in the revision, the
name of the person who committed the revision, and whether the revision was a change of the actual
content, or just a change of the properties of the content. Clicking on the hyperlink for the revision name

will take you to the Revision Details page for that revision (see section 12.4 below).

Above the main right-hand pane, there is the branch selector. This lets you choose which branch in the

source code repository is being viewed.

12.4. Source Code Revision Details

When you click on a revision hyperlink in either the project revision log or the file revisions tab described

above, you are taken to the revision details page illustrated below:

= e current Branch: | b Master | v

Source Code Revision: & revQQ12

Notes:
K
Author Content A: Last Edited
Properties A
Build: ) Build 001
Files Associations
Z Refresh | YFilter | v
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This page is made up of three areas; the left pane is for navigation, the upper part of the main pane
contains the details of the revision, and the bottom part of the right pane contains the list of files that were

changed in this revision and the list of artifacts that the revision is associated with.

The navigation pane consists of a link that will take you back to the source code revision list, as well as a
list of other revisions associated with the current file. This latter list is useful as a navigation shortcut; you
can quickly view the detailed information of all the peer revisions by clicking on the navigation links

without having to first return to the main revision list page.

The top part of the main pane allows you to view the details of this revision in the version control system,
including the description of what was changed, the date that the change was made, and the name of the

person who made the change.

The lower part of the main pane can be switched between two different views by clicking the appropriate
tab. Initially the pane will be in “Files” mode, but it can be switched to “Associations” as well. The

functionality in each of these two views is described below:

12.4.1. Files

This view displays the list of files that were changed in the current revision:

Files Associations

£ Refresh | Y Filter | &

¥ Filename & Size Author Latest Revision Action Last Edited
=i =}

2332 KB John Adams ev0003 Deleted 10-0¢ct-2017
2289 KB John Adams Modified 10-0ct-2017
2474 KB Administrator Replaced
2199 KB John Adams Replaced 10-0ct-2017
2029 KB John Adams Replaced 10-0ct-2017
581 KB John Adams ev0015 Added 10-0ct-2017

Each file in the list is displayed with its name, the file-size, who made changes to the file, what action was
performed on the file (added, deleted, replaced, updated, etc.) and the most recent revision that exists for
that file. Clicking on the filename will take you to the appropriate file details page (see section 12.2), and

clicking on the revision hyperlink will take you the appropriate revision.

12.4.2. Associations

This view displays a list of the SpiraTeam artifacts in the current project that are associated with the
current revision. This allows you to see which requirements, incidents or tasks were affected by this

specific change to the source code:
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Filzs Associations

Date Artifact Name Creator Comment Artifact Type 1D Operations
10-Oct-2017 "rﬂ Abil
10-Oct-2017 ¥ Develop

sting books in the system Fred Bloggs  Implements requirement [RQ:S] and also completes t. Reguirement RQ3

Fred Bloggs  Implements requirement [RQ:5] and also completes t.. Task TKI

Add Association

Clicking on the hyperlink for the artifact will take you to the appropriate artifact page inside the project

(assuming your user has permissions to access that information).

In addition to the associations that are created from within the source code management system, you can
add associations between source code revisions and SpiraTeam artifacts from within SpiraTeam interface

itself. To do this, you simply need to click on the ‘Add Association’ button:

Add New Association

? Please choose the artifact that you want to add an association to:

Artifact Type:*  Automation Host v

Artifact ID:*

Comment:

To add the association, you just need to select the type of artifact being associated (requirement, test

case, incident, etc.) and the numeric ID of the artifact and then click the “Add Association” button.

For example to add an association to Requirement RQ00005 you would choose Artifact Type =

Requirement and Artifact ID = 5.
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13. Planning Board

The SpiraTeam planning board is a great way to visualize the backlog items (requirements, tasks, test
cases and incidents) planned for your project. Based on the principles of agile methodologies such as

Scrum and Kanban, the planning board is a great tool for planning agile projects.

To access the SpiraTeam project planning board, select a project and go to Planning > Planning Board

and the following screen will be displayed:

@ w OlLibrary Information System Planning ~ Testing ~ Tracking ~ Reporting Fred Bloggs

Requirements / Planning Board / Releases / Documents
Planning: - Product Backlog — < el ey Tasks  Test Cases Group By: By Component
»  (Unassigned Items)
» & Administration

» & Author Management

» 4 Book Management

To access the SpiraTest project group planning board, select a project group and go to the Planning

menu and the following screen will be displayed:

@ v Pinternal Projects Planning Fred Bloggs w

Planning

Planning: -- program Backlog —- Detailed View  Tasks  Test Cases Group By: By Priority

Q

»  (uUnassigned Items)

» 1 - critical

¥ 2 - High

» 3 - Medium

Y4 Low

We shall first discuss the project planning board, and then in section 13.5 we will cover the project group

planning board.

By default, the system will display the project planning board in the product backlog view, with the

backlog organized by component. You can change the view by click on the ‘Planning’ drop down list:

e Product Backlog — This displays a list of all the backlog items that are not currently scheduled
for a specific release or iteration. The items can be organized by component, package, priority or

person.

¢ All Releases — This displays a list of all the releases as well as the product backlog and is

designed to let you easily move items from the product backlog to a specific release.

e Release View — This displays a list of all the backlog items that are scheduled for the selected

release and lets you organize them by iteration, status, or person.
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e lteration View - This displays a list of all the backlog items that are scheduled for the selected
iteration (also known as a Sprint in some methodologies) and lets you organize them by status, or

person.

The ‘Group By’ dropdown list is used to change how the view is organized. This list of options available

in the ‘Group By’ dropdown will depend on the view being displayed.
The planning board will include the following backlog items:

e Requirements and Incidents — these are displayed as ‘story cards’ and are the primary items

that can be moved in the planning board.

e Tasks and Test Cases — these are secondary artifacts and are considered part of a requirement.
So within the planning board they are displayed as being part of a specific requirement, and if you

move a requirement, the associated tasks and test cases will move as well.

The backlog items themselves can be configured to display in different ways. The choice of display will
depend on how many backlog items you have to display, how large your screen is and what information

you need. The display is controlled by the four checkboxes at the top of the planning board:

e Standard View — This is the view that will be displayed when ‘detailed view’ is unchecked. It
displays the minimum necessary information in each story card, but maximizes how many story
cards can be displayed on the screen. Each story card will contain the icon, ID, name, user

avatar, and estimate (in story points) of the requirement.

~

= rQ23
A

Ability to completely backup the
database

e Detailed View — This view includes additional information in each story card. It adds the long
description, a progress bar indicator (that indicates what percentage of the item has been
completed) and for requirement artifacts it includes the number of tasks (red background) and

number of test cases (yellow background) in the two small boxes under the user:

o
=l RQ:23 )
Ability to completely backup the
database - The database needs to be
backed-up outside of the database
server's own backup system, eg. into

(]

XML files

© Copyright 2006-2017, Inflectra Corporation Page 280 of 312 This document contains Inflectra proprietary information




e Incidents — The planning board will always include requirement backlog items, but because the
number of incidents can be very large, there is the option to include/exclude them from the
planning board. When you have the “Incidents” checkbox selected, incidents will appear in the
planning board with their own story card format. The main difference is that the effort is recorded

in hours rather than story points:

-~

B n23 z
. i |

Ability to import data from excel - O5h

Can we hawve a way of allowing an excel

user to import data easily into the

system?

e Tasks — When the Tasks option is selected, the planning board will display the tasks associated
with the requirements as part of each story card. Each task will be displayed with its ID and a

miniature progress bar:

o

= RQ20 o
Ability to add new subjects to the 15
system

L

e Test Cases — When the Test Cases option is selected, the planning board will display the test
cases associated with the requirements as part of each story card. Each test case will be

displayed with its ID and a miniature test coverage bar-chart:

o ""'ﬁ

=l RQ6 &
. - i |

Ability to delete existing books in 30

the system - The ability to mark

books as inactive, since technically

nothing can get truly delsted for

L

archival purposes

Fod
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Regardless of the view, backlog items can be moved using “drag and drop” between the different parts of
the planning board. To drag and drop multiple items, you should first select the items so that they are

highlighted. Then you can drag and drop the entire selection:

o o

|J RO:4 H |J RO:S H

Ability to add new books to the system 20 Ability to edit existing books in the 20
system

You can add new requirement backlog items by clicking the “+” button. This will display the following

dialog box:
W
Add Requirement
Name:
Description:
v
Status: Importance: -- None —-
Type: User Story Component -- None —
Release -- None —- URL.
Author: Fred Bloggs Difficulty: --- Please Select ——-
Owner: —— None —— Classification: -—- Please Select —-
Ranking:
Decimal:
Estimate 1.0
Review Date:

On this screen you can enter the fields for a new requirement, click “Add Requirement” and the

requirement will be added to the appropriate section of the planning board.
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Scroll Arrows

In some of the views of the planning board there will be more data that can be displayed on one screen,
in which case you will be able to scroll the planning board left and right using the specially provided arrow
buttons (see above).

Each of the views is now described in more detail in the sections below.

13.1. Product Backlog Planning

The product backlog view is designed to let you view the backlog items that have been created for the
project and have not yet been assigned to a specific release or iteration. The backlog items can be
requirements or incidents, and in the case of requirements, you can see the tasks and test cases

associated with a specific requirement.

In this view you can drag and drop the backlog items from one section (e.g. component) to another and
also rearrange the backlog items in their relative order. By default, the items are sorted according to their
priority/importance value (the color of which is indicated in the left-hand side of the story card), but you
can drag and drop them into a different order. This is particularly useful when you have several items of

the same priority and you need to rank them. This process is typically called backlog grooming.

13.1.1. Product Backlog — By Component

This view is designed to let you see the product backlog organized by Component. Each of the
components is displayed on the left-hand side and the backlog items displayed in the same row on the

right. The backlog items can be requirements (with associated tasks and test cases) or incidents.
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Planning - Product Backlog — o Detailed View Incidents Tasks Test Cases Group By By Companent
*  (Unassigned Items)

~ 4 Administration

#ro23 A | #ggae 0 | Begx A Frgas ’-‘
Ability to completely backup the an Ability to create new users in the I Ability to modify existing users in the aa Ability to impert from legacy system x I
database system system

B o3 ¥ 39

55D

Ability to import data fram exce Exporting data to excel

~ 4 Author Management

A | #gg2e B | Fegx A Frgas "’
aa Ability to create new users in the I Ability to modify existing users in the aa Ability to import from legacy system x I
system system
B BN
okn || Bxporting date to excel
~ & Book Management
= B B 33 [}
Management of chilcrens loans s

The top section will contain the list of items that are not assigned to a component, with the other sections

containing the items that belong to the specific component.

13.1.2. Product Backlog — By Package

This view is designed to let you see the product backlog organized by requirement package (a summary
requirement). Each of the packages is displayed on the left-hand side in a hierarchical structure, and the
backlog items displayed in the same row on the right. The backlog items can be child requirements (with
associated tasks and test cases) or incidents. In this view the incidents are the ones linked to the

package through an association.

Planning: -- Product Backlog — a Detailed View  Incidents Tasks Test Cases Group By, By Package
»  (Unassigned Items)

» I3 Functional System Regquirements

» [ Online Library Management System

» G Ability d autho he e
v [F Subject Management
= & rRg20 A Epgn @
system system
»  [@ Administration Functions
¥ [ Data Import Functionality
- Flpoas "

Abitity to import from legacy system x

» [E Use Cases

» 3 System Qualities

The top section will contain the list of items that are not assigned to a package, with the other sections

containing the items that are children of the specific package.
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13.1.3. Product Backlog — By Priority

This view is designed to let you see the product backlog organized by requirement importance. Each of
the possible importance values is displayed on the left-hand side and the backlog items displayed in the
same row on the right. The backlog items in this view will only be requirements (with associated tasks and
test cases).

Planning: -- Product Backlog — s} Detailed View  Incidents  Tasks  Test Cases Group By: By Priority
*» (Unassigned ltems)

- Critical

&l roaa IrQas
Retiatility requirements Ty S
¥ 2 - High
~ 3 - Medium
& re20 A | FEgoa M | Fpex A | Frgas M
Abilty to add mew subjects to the AR | bty to <ot existing subjects mthe M | 40t 1o completely backup the Ability to create new users n the !
- system Gataase system
& ro27 A | Froas
Ability to modify existing users in the A | ity requirements
¥ 4- Loy
Fre2s )

Ability to import from legacy system x

The top section will contain the list of items that are not assigned a priority, with the other sections
containing the items that have been assigned to the specific priority.

13.1.4. Product Backlog — By Status

This view is designed to let you see the product backlog organized by requirement status. Each of the
possible status values (for an unscheduled item) is displayed as a heading, with the backlog items
displayed in the same column underneath. The backlog items in this view will only be requirements (with
associated tasks and test cases). This view is commonly called a Kanban board:

Planning - Product Backlog — o Detailed View Incidents Tasks Test Cases Group By. By Status

* (Unassigned Items)

~ Requested ~ Under Review = Rejectsd ~  Accepted

Ability ta import fro

1 ro2s ) 1 Ro26 8 HEpgy
i

system x Ability to create naw us

system syztem

Each of the vertical sections is one of the requirements’ statuses, in order of the requirement lifecycle
(Requested > Accepted). Once a requirement is assigned to a release or iteration it will come
automatically ‘Planned’ and not appear in this view. You can drag and drop the requirements between the
different statuses.

© Copyright 2006-2017, Inflectra Corporation Page 285 of 312 This document contains Inflectra proprietary information




13.2. Release Planning

The release planning view is designed to let you view the backlog items that have been created for the
project and associate them with different releases defined for the project. The backlog items can be
requirements or incidents, and in the case of requirements, you can see the tasks and test cases

associated with a specific requirement.

Planning (Al Releases) = Detailed View Incidents  Tasks  Test Cases Group By: By Release

> (Unassigned Items)

B 10.0.0 - Library System Release 1 System Release 1 stem Release
> [@1000 Rel Rel R 1
Flros a Eyy B3 Flror iz
1ros a o Eyy By g 1 roe ° Ene 4
Ability o edit existing books in th AR et able to scd new author Datobase not backing up comrecty Ability o associate books with diferent Editng th uthor is clunky

— Crier
F1rgs 8 B 4 Elrgs i
e et s ot scd ok to the system A Ability o associate baoks with diferent
— editions
E1ro12 ) B rou 2
y to create different editions ! Ability o link authors to their contact L
<
Q15 o )
1 Ro1s o
bty to de

The ‘Unassigned ltems’ section at the top allows you to see all the items not currently planned, and you
can then drag and drop them into one of the lower sections that correspond to a specific release. Using

the scroll arrows you can cycle through the releases and move any items from one release to another.

The header of each release section shows the overall progress and utilization of the release:

System Release

aly oYy

Clicking on the Release hyperlink will switch the planning board into the ‘Release Backlog’ view described

in section 13.3 below.

13.3. Release Backlog Planning

The release backlog view is designed to let you view the backlog items that have been assigned to the
selected release. You can always see the items not currently assigned to any release by expanding the

‘Unassigned Items’ section and then drag those items into the current release.

The lower section of the board allows you to segment the items by either iteration/sprint (typically used in

Scrum), by status (typically used in Kanban), or by person.
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Planning: 1100 - Library System Re. z Detailed View Incidents Tasks Test Cases Group By: By lteration

{5

The screen above illustrates the items being segmented by iteration/sprint for the current release.

13.3.1. Release Backlog — By lIteration

This view is designed to let you see the release backlog organized by iteration / sprint. Each of the
iterations defined for the current release is displayed as a heading, with the backlog items displayed in
the same column underneath. The backlog items in this view can be either requirements (with associated

tasks and test cases) or incidents. This view is commonly called a Scrum board:

Planning 1100 - Library System Re o Detailed View Incidents Tasks Test Cases Group By. By Iteration

Hlrgs ° | Elroi
Ability to sssociate books with diffren Abiiy to sssociate authors with
e authors aation: e

You can drag and drop the requirements between the different iterations. If you schedule a requirement
for a specific iteration, all the child tasks that have not yet been started, will follow the parent requirement
in being associated with the iteration. Once the backlog item has been added to the iteration, the utilized

effort for the iteration will increase, and the available effort will decrease by the same amount.

Note: The system will allow you to assign more backlog items to an iteration than it is possible to
complete, however this will result in a negative value for ‘available effort’. If this happens, the “Available
Effort” value will be displayed in red, and you need to rebalance the items, extend the iteration length or

add project personnel resources to the iteration.
Clicking on the Iteration hyperlinks in the headers will switch the planning board into the ‘Iteration

Backlog’ view described in section 13.4 below.

13.3.2. Release Backlog — By Status

This view is designed to let you see the release backlog organized by requirement status. Each of the

possible status values (for a planned item) is displayed as a heading, with the backlog items displayed in
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the same column underneath. The backlog items in this view will only be requirements (with associated

tasks and test cases). This view is commonly called a Kanban board:

Planning: 1100 - Library System Re =) Detailed View Incidents Tasks Test Cases Group By By Status

»  (Unassigned Items)

[ 110.0 - Library System Release 1

~  Planned ~ In Progress ~ Developed ¥ Tested ~ Completed

Blrow

Abilit

Each of the vertical sections is one of the requirements’ statuses, in order of the requirement lifecycle
(Planned > Completed). You can click on the expand/collapse icons to hide any statuses that are not
used. You can drag and drop the requirements between the different statuses. If you have the planning
options enabled to have requirements status’ automatically update based on changes to the associated
tasks and test cases, then items will automatically move between the statuses based on tasks being
completed and test cases being executed.

13.3.3. Release Backlog — By Person

This view is designed to let you see the release backlog organized by resource / person. Each of the
users that is a member of the current release is displayed as a heading, with the backlog items displayed
in the same column underneath. The backlog items in this view can be either requirements (with
associated tasks and test cases) or incidents.

Planning: 110.0 - Library System Re. z Detailed View Incidents Tasks Test Cases Group By By Person

* (Unassigned Items)

¥ [@1100 - Library System Release 11

M| Jack van stanten x Rory lones
i n h

Bron o %1 n6 Q

Ability 1o link authors to their contact The book listing screen dossn't sort
nformation

You can click on the expand/collapse icons to hide any resources that are not relevant. The system will
display a progress bar for each resource to illustrate the allocation for that resource. Any resource that

has a progress bar that is completely green has been fully scheduled and should not have any additional
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items assigned. If the progress bar for that resource turns red, it means that they have been over-

scheduled and you need to reassign some of the items.

Above the resource headings there is a section with the release name; that contains backlog items that
are scheduled for the current release but have not yet been assigned to a resource. You can drag and
drop the backlog items between resources or to/from the release backlog. Any backlog items not

assigned to a resource and release will be listed in the (Unassigned Items) section at the top.

13.4. Iteration Backlog Planning

The iteration backlog view is designed to let you view the backlog items that have been assigned to the
selected iteration / sprint. You can always see the items not currently assigned to any release or iteration
by expanding the ‘Unassigned Items’ section and then drag those items into the current release or
iteration.

The lower section of the board allows you to segment the items by either status (typically used in

Kanban), or by person. You can also view the Task artifacts by person or status for the current iteration.

Planning: 10.2.0.0001 - Iteration 001 = Detailed View Incidents Tasks Test Cases Group By: By Status

¥ (Unassigned Items)

~ Planned ~ In Progress ~ Developed v Tested ~ Completed

The screen above illustrates the items being segmented by resource for the current iteration / sprint.

13.4.1. lteration Backlog — By Status

This view is designed to let you see the iteration / sprint plan organized by requirement status. Each of
the possible status values (for a planned item) is displayed as a heading, with the backlog items
displayed in the same column underneath. The backlog items in this view will only be requirements (with
associated tasks and test cases).
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Planning: 10200001 - Iteration 001 fs? Detailed view Incidents  Tasks  Test Cases Group By: By Status

»  (Unassigned ltems)

~ Planned ~ In Progress ~ Developed v Tested ~ Completed

# o

Aty

Each of the vertical sections is one of the requirements’ statuses, in order of the requirement lifecycle
(Planned > Completed). You can drag and drop the requirements between the different statuses. If you
have the planning options enabled to have requirements status’ automatically update based on changes
to the associated tasks and test cases, then items will automatically move between the statuses based on

tasks being completed and test cases being executed.

13.4.2. Iteration Backlog — By Person

This view is designed to let you see the iteration / sprint plan organized by resource / person. Each of the
users that is a member of the current iteration is displayed as a heading, with the backlog items displayed
in the same column underneath. The backlog items in this view can be either requirements (with

associated tasks and test cases) or incidents.

Planning: 10200001 - Iteration OO1 o Detailed View Incidents Tasks  Test Cases

»  (Unassigned ltems)

nd == Jack Van Stanten

Eo B

™1 ro23 = ] Rg20 Q
Ability to completely backup the 1 Ability to sdd new subjects to the 5
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Ability to modify existing users in the i
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You can click on the expand/collapse icons to hide any resources that are not relevant. The system will
display a progress bar for each resource to illustrate the allocation for that resource. Any resource that
has a progress bar that is completely green has been fully scheduled and should not have any additional
items assigned. If the progress bar for that resource turns red, it means that they have been over-

scheduled and you need to reassign some of the items.

Above the resource headings there are sections with the release and iteration name; they contain backlog
items that are scheduled for the current release or iteration but have not yet been assigned to a resource.
You can drag and drop the backlog items between resources or to/from the release/iteration backlog. Any
backlog items not assigned to a resource and releasel/iteration will be listed in the (Unassigned Items)

section at the top.

13.4.3. Iteration Backlog — Tasks by Person

This view is designed to let you see the tasks in the current iteration / sprint plan organized by resource /
person. Each of the users that is a member of the current iteration is displayed as a heading, with the

tasks displayed in the same column underneath. This view is often called the Task Board:

Planning: 1.0.20.0001 - Iteration GO Fe] Detailed View Incidents Tasks Test Cases Group By: Tasks By Person

»  (Unassigned Items)

* 1020000 ] 1

) Donna Harkness T . Rose Smith M T . Amy Cribbins
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Develop new sub) e
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. Al

wie subfoct o 3on

You can click on the expand/collapse icons to hide any resources that are not relevant. The system will
display a progress bar for each resource to illustrate the allocation for that resource. Any resource that
has a progress bar that is completely green has been fully scheduled and should not have any additional
tasks assigned. If the progress bar for that resource turns red, it means that they have been over-

scheduled and you need to reassign some of the tasks.

Above the resource headings there are sections with the release and iteration name; they contain tasks
that are scheduled for the current release or iteration but have not yet been assigned to a resource. You
can drag and drop the tasks between resources or to/from the release/iteration backlog. Any tasks not

assigned to a resource and releasel/iteration will be listed in the (Unassigned Items) section at the top.

© Copyright 2006-2017, Inflectra Corporation Page 291 of 312 This document contains Inflectra proprietary information




13.4.4. Iteration Backlog — Tasks by Status

This view is designed to let you see the tasks in the current iteration / sprint plan organized by their

status. Each task status (not started, in progress, completed, blocked, deferred) is displayed as a

heading, with the tasks displayed in the same column underneath:

Planning: 10.2:0.0001 - iteration Q01 = Detailed View Incidents  Tasks

¥ (Unassigned Items)

H 5

Test Cases Group By: Tasks By Status

5

You can click on the expand/collapse icons to hide any resources that are not relevant.

Above the status headings there are sections with the release and iteration name. You can drag and drop

the tasks between statuses or to/from the release/iteration backlog. Any tasks not assigned to a

releasel/iteration will be listed in the (Unassigned Items) section at the top.

13.5. Project Group Planning

The project group planning board is designed to let you view the backlog items that need to be planned

for all of the projects in a specific group as well as view all of the planned items in each of the individual

projects. It is designed to let you see a project-group wide view of all requirements and associated test

cases and tasks.

The project group planning board has the following views:

Program Backlog — by Priority
Program Backlog — by Status
All Projects — by Project
Project — by Status

Project — by Person

Each of these views is described below:
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13.5.1. Program Backlog — by Priority

This view is designed to let you see the program backlog organized by requirement importance. Each of
the possible importance values is displayed on the left-hand side and the backlog items displayed in the

same row on the right. The backlog items in this view will only be requirements (with associated tasks and

test cases).

@ v D interal Projects Planning

Planning
Planning - program Backlog —— o Detailed View

»  (Unassigned Items)

v 1= Critical

Broas Hroas

¥ 2- High
€ Elro2s

v 3 - Medium

¥ 4-Low =

Tasks  Test Cases

. System Administrator v

Group By: By Priority

The top section will contain the list of items that are not assigned a priority, with the other sections

containing the items that have been assigned to the specific priority.

13.5.2. Program Backlog — by Status

This view is designed to let you see the program backlog organized by requirement status. Each of the

possible status values (for an unscheduled item) is displayed as a heading, with the backlog items

displayed in the same column underneath. The backlog items in this view will only be requirements (with

associated tasks and test cases). This view is commonly called a Kanban board:

Planning: - Program Backlog —-

Q

}  (Unassigned Items)
¥ Under Review

¥ Reguested

#ro2s

Ability to import from legacy system x

Detailed View Tasks Test Cases

¥ Rejected

Group By. By Status

¥ Accepted

=
£1Ro26

Aty ta create new users in the
system

Each of the vertical sections is one of the requirements’ statuses, in order of the requirement lifecycle

(Requested > Accepted). Once a requirement is assigned to a release or iteration it will come

automatically ‘Planned’ and not appear in this view. You can drag and drop the requirements between the

different statuses.
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13.5.3. All Projects — by Priority

This program planning view is designed to let you see all of the backlog items that have been scheduled

for all of the projects in the current program, organized by requirement importance/priority.

Each of the possible importance values is displayed on the left-hand side and the backlog items displayed
in the same row on the right. The backlog items in this view will only be requirements (with associated

tasks and test cases).

Planning: (Al Projects) a Detailed View Tasks Test Cases Group By- By Priority

»  (Unassigned Items)
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The top section will contain the list of items that are not assigned a priority, with the other sections

containing the items that have been assigned to the specific priority.

13.5.4. All Projects — by Project
The program planning view is designed to let you view the open (not-completed) backlog items currently
planned per project. The backlog items are themselves only requirements, however you can see the

tasks and test cases associated with a specific requirement.

Planning: (All Projects) = Detailed View Tasks Test Cases Group By By Project

»  (Unassigned Items)

~ O Library Information System
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Clicking on the project hyperlink will switch the planning board into the ‘Project Backlog’ view described

in section 13.5.4 below.

13.5.5. All Projects — by Status

This view is designed to let you see the scheduled backlog items for the entire program organized by
requirement status. Each of the possible status values (for a planned item) is displayed as a heading, with
the backlog items displayed in the same column underneath. The backlog items in this view will only be

requirements (with associated tasks and test cases). This view is commonly called a Kanban board:

Planning: (All Projects) o Detailed View Tasks Test Cases Group By: By Status
*  (Unassigned ftems)

~ Planned ~ In Progress ¥ Developed v Tested ~ Completed
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Each of the vertical sections is one of the requirements’ statuses, in order of the requirement lifecycle
(Planned > Completed). You can click on the expand/collapse icons to hide any statuses that are not
used. You can drag and drop the requirements between the different statuses. If you have the planning
options enabled to have requirements status’ automatically update based on changes to the associated
tasks and test cases, then items will automatically move between the statuses based on tasks being

completed and test cases being executed.

13.5.6. All Projects — by Person

This view is designed to let you see the program backlog organized by resource / person. Each of the
users that is a member of any of the projects in the current program is displayed as a heading, with the

backlog items displayed in the same column underneath.
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Planning: (All Projects) z Detailed View Tasks  Test Cases Group By: By Person
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You can click on the expand/collapse icons to hide any resources that are not relevant. Above the
resource headings there is a section called ‘Unassigned ltems’; that contains backlog items that are
scheduled but have not yet been assigned to a person.

13.5.7. Project — by Status

This view is designed to let you see the project backlog organized by requirement status. Each of the
possible status values (for a planned item) is displayed as a heading, with the backlog items displayed in
the same column underneath. The backlog items in this view will only be requirements (with associated

tasks and test cases). This view is commonly called a Kanban board:

Planning: Library Information System <] Detsiled View  Tasks  Test Cases Group By: By Status

¥ (Unassigned Items)
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Each of the vertical sections is one of the requirements’ statuses, in order of the requirement lifecycle
(Planned > Completed). You can click on the expand/collapse icons to hide any statuses that are not
used. You can drag and drop the requirements between the different statuses. If you have the planning
options enabled to have requirements status’ automatically update based on changes to the associated
tasks and test cases, then items will automatically move between the statuses based on tasks being

completed and test cases being executed.
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13.5.8. Project — by Person

This view is designed to let you see the project backlog organized by resource / person. Each of the
users that is a member of the current project is displayed as a heading, with the backlog items displayed
in the same column underneath.

Planning: Library Information System z Detailed View Tasks  Test Cases Group By: By Person

*  (Unassigned Items)
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You can click on the expand/collapse icons to hide any resources that are not relevant. Above the
resource headings there is a section with the project name; that contains backlog items that are

scheduled for the current project but have not yet been assigned to a person.
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14. Mobile Access

This section describes the functionality available in SpiraTeam® when accessing the system from a
mobile device such as an iOS® smartphone / tablet (iPod Touch®, iPhone® and iPad®) or an Android®
smartphone / tablet (Galaxy, Nexus, Droid, Kindle Fire®, etc.).

The application has been designed to be fully “responsive”, which means that it will dynamically rearrange
the page based on the screen-sized used, to create an optimal experience on any device. As much as
possible the application provides a consistent set of functions for any device. However, in order to make
using the application on smaller devices as easy as possible, hecessarily the experience on say, a
smartphone, is less complete than on a desktop.

Whenever this user guide has referred to performing an action by ‘clicking’ if the same functionality is
available, then ‘tapping’ on a mobile device will yield the same result. Due to the limitations of mobile

devices, hovering over an element to display a “tooltip” is not possible.

Below, some illustrations of how the application looks at different screen sizes are provided.

14.1. My Page

Desktop (a tablet in landscape mode will appear largely identical)

@ v O Library Information System Planning ~ Testing ~ Tracking ~ Reporting Fred Bloggs +
My Page > My Timecard / Administration
My Poge Fred Bloggs All Projects | Current Project @+ =
Project Name Group Creation Date Headline Author Publish Date

Internal 30-Nov-2005 webmasterginflectracom  10/9/2017
webmasterginfiectracom  10/6/2017
30-Nov-2005 webmaster@inflectracom  10/2/2017
webmasterginflectracom  9/26/2017
webmaster@infiectracom  9/22/2017
Project
Library Information System Delete 3]
Create Incident in: | Library Information Systen v | 4
Library Information System Delete 8
Library Information System Delste 3]
Library Information System Delete (3] .
! Department Online  Operations
ary Infarmation System Jelete E
Library Information System Delet: 3 o8 o Remove
Library Information System Delete 8 e [ Remove
£
N ’_J
Name Project Importance  Status Name Project Type Priority  Date Opened
ﬁ Ability Library Information 2 - High Planned
/ Library Information .
! Enhancement  (RSICHEIESIN 16-Nov-2003
) Ability Library Information .. 3 - Medium  Accepted
&) Ability Library Information . 4 - Low Under Review Library Information imitation SRt 2 Dec_2003
Library Information .
- ¥ Training 1= Critical ™ 2-Dec-2003
)
Name Project Status  Last Executed Library Information Bug 2 High  3-Nov-2003
Library Information Passed 30-Nov-2003 »>
! Library Information 9
! Training 2 - High | 2-Dec-2003
Library Information Caution | 30-Nov-2003 >

B Tact Chance Dernact Library INfOrmation -, _ .. noruisct 2 - Maditim. £_Nar_3002
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Table in portrait mode

@ v OlLibrary Information System « Planning ~ Testing ~ Tracking ~ Reporting

My Page

as

My Polge Fred Blo

All Projects Current Project

Project Name Creation Date

Library Information System 30-Nov-2005
30-Nov-2005

30-Nov-2005

b

Name Project
"B ed Requirements Library Information System B
Library Information System B
Library Information System B
Library Information System B
Library Information System F_'_'J
Library Information System B
R
Name Project Importance
& Ability t Library Information 2 - High
) Ability ¢ Library Information . 3 - Medium
m X Library Information - 4 - Low
3
Name Project Status
Library Information Passed >

Smartphone in portrait mode

© Copyright 2006-2017, Inflectra Corporation Page 299 of 312

This document contains Inflectra proprietary information




All Projects Current Project

Project Name Group

Library Information System Internal Projects
Sample Application One Internal Projects
Sample Application Two External Projects

14.2. My Profile

Desktop (a tablet in landscape mode will appear largely identical)

@ & By T &

My Profile

Testing ~  Tracking ~  Reporting

Please review the information listed below and make any changes if necessary

Click [Savel to save changes

User Logo:

User Name/ID:
First Name:
Middle Initial
Last Name:
Enable RSS Feeds

RSS Token

Department:
Organization

Start Page

Tablet in portrait mode
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)

winy

The Avatar image cannot be more than 100K in size and no larger than 100x100 pixels square. Only

JPG, GIF. and PNG image types are allowed. You will need to clear your browser cache to see the new

avatar,

Fred

Bloges

Yes

QA

My Page

m Cancel

Generate Mew
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@ w Olibrary Information System % Planning ~ Testing ~ Tracking ~ Reporting v

My Profile

Please review the information listed below and make any

Click [Savel to save changes.

User Logo h
..

!

The Avatar image cannot be more than 100k in si
100x100 pixels square Only JPG, GIF, an:

You will need to clear your brows;

User Name/ID:

First Name: Fred

Middle Initial:

Last Name. Bloggs
Enable RSS Feeds Yes
RSS Token

Department: QA

Organization
Start Page My Page

Cancel

Smartphone in portrait mode
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cache to see the new

hanges if necessary

and no larger than

are allowed

tar

Generate New
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S v

My Profile

Please review the information listed below and

make any changes if necessary.
Click [Save] to save changes.

User Logo:

wniny

The Awvatar image cannot be more than 100k in size and no
larger than 100x100 pixels square. Only JPG, GIE and PNG
image types are allowed. You will need to clear your browser

cache to see the new avatar

User Name/ID:

First Name: Fred
Middle Initial

Last Name: Bloggs
Enable RSS Feeds Yes

14.3. Example List Page

Desktop (a tablet in landscape mode will appear largely identical)

@ +~ Olibrary Information Planning ~
Requirements / Planning Board / Releases / Documents
Quick Filter e +inzert ~ X Delete | P indent € Outdent & Refresh | ——- Show Le v
3 Critical Not-Covered Requ - Show/hide columns — | v
Displaying 15 out of 35 requirement(s) for this project
Components v % Name Test Coverage  Progress
& Administration any—| v —any —
# Author Management 4 @ Functional System Requirements ]
4 Book Management
4 [ Online Library Management System | |
Releases 4 [ Book Management | |
i s v to add new books to the syste
+ [Fy Library System Releas ) #) Ability to add new books to the system
4 [@ Library System Relea, &) Ability to existing books in th
] Iteration 0O
B eratior &) Ability to delete existing books in th
] iteration 002
) Ability to associate books with different subjects ]
] Iteration 003 a
=3 Ability to associate books different author:
+ I3 Library System Relea #) Ability to associate bool erent authors
& Iteration 001 ) Ability to associate books with different editions ]
] Iteration 002 &) Ability to completely erase all books stored in the syster ]
B Iteration 003
B treration 003 > [ Edition Management Not Covered |
9 iteration 001
= » [E) Author Management 1
] iteration 002
£ teration 003 b [®) Subject Managament Not Covered
» (@ Library System Releas > [E) Administration Functions Not Covered Mo Tasks
[ Librarv System Release.. 7 4 T3 Use Cases No Tasks
show | 15 v [OWS per page
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Y Filter

v

v £ Edit

Status

—any —
In Progress
In Progress
Developed
Developed
Developed
Developed
Developed
Developed
Developed
Developed
In Progress
In Progress
In Progress
Accepted

Completed

v

v ¥ Tools

Type
Ay —

Package
Package
Package
Feature
Feature
Feature
Feature
Feature
Feature
Feature
Package
Package
Package
Package

Package

v

v

D
RQ
RO
RO2
RO
RQ:4
RQS
RQ:6
RQT
RQ:8
RQS
RQI0
RQM
ROI3
RQI9
RQ22

RQ29

Displaying page | 1

Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit
Edit

cof2m M
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Tablet in portrait mode

y Information m w  Planning = Testing

Reporting

Tracking -

# Insert | v --—- Show Level — w | T Filter | w

ying 15 out of 35 reguirement(s) for this project

P ; wstem Beguire

4 [13) Online Library Management System

4 TZ| Book Management

Show 15 “  [oWs pEr page

Smartphone in portrait mode

S v

Requirements.

+ insert | v | — Show Level —— ~ | T Filter | w

Displaying 15 out of 35 requirement(s) for this project.

Name

4 [ Functional System Requirements

4 [ Online Library Management System

4 [F Book Management
= Ability to

system

add new books to the

edit existing books in the system

=) Ability to

delete existing books in the system

&) Ability to associate books with different subjects

& Ability to associate books with different authors

&) Ability to associate books with different editions

ﬁ Ability to completely erase all books stored in the
system with one click

> g Edition Management
> [ Author Management
> [§) Subject Management
> [E) Administration Functions

4 [F Use Cases

© Copyright 2006-2017, Inflectra Corporation

Test Coverage

— ANy - W

Mot Covered

Mot Covered

t Covered

=]

Displaying page

Page 303 of 312

Progress

- ANy -- W
1
1

Mo Tasks

Ho Tasks

Zof 2 M
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14.4. Example Details Page

Desktop (a tablet in landscape mode will appear largely identical)

@ ~ Olibrary Information a Planning ~ | Testing ~  Tracking ~  Reporting

W~

Requirements > t Details Planning Board / Releases / Documents

R i PR LR AN ] e B save ~ | [C1Clone | £ Refresh || X Delete || £ Tools |~ || B2 Email | ¥ Subscribe | »

Display: Current Filter| v | &

Ability to add new books to the system

Z| Functional System Requirements

Online Library Management Syst

#Re ement [RQ:4] Type:™ Feature Status:™* Developed Operations~
4 [E Book Management
= .
I ] Ability to add new books to the Test Coverage Tasks Attachments History Associations
&) Ability to edit existing books
] Ability to delete existing book.. Releases Propertie; Date: Time
) Ability to associate books wit. Importance: 1 - Critical
2= 2 bility ciat
B Ability to associate boo s Component: Book Managem
&) Ability to associate books wit. VAL hitp:/ v libraries
] Ability to completely erase all Author: Fred Bloggs
Difficulty Moderate .
» T3 Edition Management Owner. Joe P Smith Estimate (points) 20 e
Classification --- Please Sele.. I
» T Author Management Review Date 71312012
Rankini 1
» T@ Subject Management g
» T8 Administration Functions pecimal 1234

4 [F Use Cases

The ability to add new books into the system, complete with ISBN, publisher and cther related information

Show | 13 v rows

Tablet in portrait mode
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€ = v

[0 Clone

& Refresh

£ Email

v Tracking * HReporting

7 Subscribe W

Ability to add new books to the system

Status: Developed

Author:

Ownier:

Importance:
Component:
URL
Difficulty:
Classification:
Ranking,

Decimal

Estimate (points):

Smartphone in portrait mode

B Requirement [

RO:4]  Type: Feature

Operations

Fred Eloggs

Jos P Smith

1 - Critical

Boock Management

http/ Mwww libraries.org

Maoderate

--- Pleaze Select --
234

20 16.0h
Tr3fzonz
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S v

Reguirements

€ E save  w | D clone | & Refresh

E4 Email | 1% Subscribe | s

Ability to add new books to the system

& Requirement [RQ:4

Type:" Feature

Status: Developed Operations~
Overview v

Author: Fred Bloggs

owner Joe P Smith

Importance 1 - Critical

Component: Book Management

URL: http://www libraries.org

14.5. Test Execution

Desktop (a tablet in landscape mode will appear largely identical)

-

Test Cases > TestSets / TestRuns / Automation Hosts

Display: Split Table Mini

Testing Cycle for Release 1.1 rejease 1.1.00 .
I

Progress (o / 45 step

< > n a
O Step 1 User opens up Microsoft Ed v 2o IEEER - - NA
) Step 2 User logs in to application
. [J Person loses book and needs to report loss (rc 12
) Step 3 User clicks link to report los
) Step 4 User chooses st book fron O Step 1 user opens up Microsoft Edge and enters application URL: http://www.libraryinformationsystem.org
) The browser loads the login web page
O Step 5 User clicks submit button . " "
http/www.libraryinformationsystem.org
[ Ability to create new book
D Step 1 User opens up Microsoft Ed ActualResult | Attachments | Incidents | G
D Step 2 User logs in to application Fomat - B I |I = &= |9y o EBEMmM= @ ¥ Bsource
D Step 3 User clicks link to create boc
O Step 4 User enters books name anc
4

O Step 5 User chooses book's genre :
D Step 6 User clicks submit button
[~ Ability to edit existing book |

D Step 1 User opens up Microsoft Ed

Tablet in portrait mode
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Testing Cycle for Release 1.1 rejease 1.1.0

Display Split Table =
Progress
<C|1 > n S
St 1 User pens o Microsont Edee o o BB - =
D Step 2 Userlog
[J Person loses book and needs to report
R loss
Step 4 User ch ;
Step 1 User opens up Microsoft Edge and enters application
Step 5 Use ks submit butt URL: http://www.libraryinformatic N.Org

[] Ability to create new book

The browser loads the login web page

Step 1 User ope ft Edge

http//www libraryinformationsystem.org
Step 2 Use
Step eale

Actual Result ttachment | ent Ea
Step4

Format - B I 2 29 = [~
Step 5

na
L2l

Step 6 Use

[J Ability to edit existing boo

Smartphone in portrait mode
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Testing Cycle for Release 1.1

Progress

< P | | a2

v - o al® -
[_J Person loses book and needs
to report loss
O Step 1 User opens up Microsoft Edge and

enters application URL

http://www libraryinformationsystem.org

ttp://wwwi.libraryinformationsystem.org

Actual Result

15. Keyboard Shortcuts

SpiraTeam® includes an array of keyboard shortcuts to speed up navigation and use of the application.
All functionality can be performed using a mouse and clicking and therefore using a keyboard shortcut is
never required. However, keyboard shortcuts can be an efficient way of performing common tasks. A list

of the keyboard shortcuts and what they do is available throughout the application in two ways:

¢ Viathe user profile action menu

Fred Bloggs w

& My Profile
™ Log Out

E Keyboard Shortcuts
? Help

e By typing “?” anywhere in the application (not when the cursor is in a text field). For example, on
Windows machines typing shift and the ? key together.
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There are two main ways of using the shortcuts: either pressing a key or key(s) at the same time
(indicated by a single key or “a + b”); or pressing a number of keys in succession as with normal typing
(indicated by “a ... b”). The popup menu explaining the shortcuts is illustrated below (please note that the

keyboard shortcuts displayed will vary depending on the current page:

Keyboard Shortcuts

Keyboard Shortcut Reference List Page Shortcuts

| shift i g Toggle keyboard navigation of the list

Site Wide Navigation table

Access to pages varies by user and Toggle current row marked row as
project checked

Go to My Page Go to next row

Go to Project Group Home Go to previous row

Go to Project Home Open selected item

Open selected item in new browser
window

Go to Requirements
Go to Planning Board

Goto Releases

Details Page Shortcuts

[} Gotonexttab

EEao
RGO

Go to Documents

n Go to previous tab
Goto Test Cases

Go to Test Sets
Goto Test Runs

Test Execution Shortcuts

Go to Automation Hosts

Change the Display

Show Split View
Show Table View

Goto Incidents

Go to Tasks

Show Mini View

Go to Resources

Go to Source Code Select the left sub view

Select the right sub view

FoFoFf-]-
OEODDO

Toggle always showing test run details
Go to Reporting

Gotr User Profile Switch Tabs in the Inspector

Go to Administration Switch to the Actual Results Tab

ooo
oo

Switch to the Attachments Tab

Switch to the Incidents Tab

cfollc
1 1 1
(-~ Qo N
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Legal Notices

This publication is provided as is without warranty of any kind, either express or implied, including, but not

limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement.

This publication could include technical inaccuracies or typographical errors. Changes are periodically
added to the information contained herein; these changes will be incorporated in new editions of the
publication. Inflectra® Corporation may make improvements and/or changes in the product(s) and/or

program(s) and/or service(s) described in this publication at any time.

SpiraTest®, SpiraPlan®, SpiraTeam® and Inflectra® are registered trademarks of Inflectra Corporation in
the United States of America and other countries. Microsoft®, Windows®, Explorer® and Microsoft
Project® are registered trademarks of Microsoft Corporation. iOS, iPod, iPad and iPhone are registered
trademarks of Apple Corporation, Android® is a registered trademark of Google Corporation, and Kindle
Fire® is a registered trademark of Amazon LLC. All other trademarks and product names are property of
their respective holders.

Please send comments and questions to:
Technical Publications

Inflectra Corporation

8121 Georgia Ave

Suite 504

Silver Spring, MD 20910

U.S.A.

support@inflectra.com
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